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About the TDS5000B Series Oscilloscope 
 

 

 

Welcome to the Tektronix TDS5000B Series 
Oscilloscopes. 

The TDS5000B Series of Digital Phosphor Oscilloscopes (DPOs) 
provide the performance, simplicity, and connectivity needed for 
today’s ever-changing electronics, computer, and 
communications industries. The easy-to-use interface includes a 
large display screen and an optional touch-screen interface on a 
Microsoft Windows platform. Choose the methods of controlling 
oscilloscope operations that are most convenient for you: 
customary front-panel controls, menus and toolbar buttons, or the 
touch screen. 

User interface 

The user interface is built on the Windows operating system and 
has a similar look and feel. Switch between menu bar mode and 
toolbar mode by clicking Buttons or Menu in the upper-right 
corner of the screen. The instrument is also fully compatible with 
a wide range of PC hardware and software accessories such as, 
networked instrumentation and printers.   

Optional touch screen interface 

If you have the optional touch screen interface, you can access menu items and on-screen controls 
with the touch of a finger. The TOUCH SCREEN OFF button on the front panel toggles this 
option. The button is not present if your instrument was not ordered with the touch screen. 

Product Description 
Models 

The online help supports six very similar oscilloscopes: 

 TDS5032B Digital Phosphor Oscilloscope 

 TDS5034B Digital Phosphor Oscilloscope 

 TDS5052B Digital Phosphor Oscilloscope 

 TDS5054B Digital Phosphor Oscilloscope 

 TDS5104B Digital Phosphor Oscilloscope 

 TDS5054BE Digital Phosphor Oscilloscope 

Differences between the instruments are noted when necessary. 



 24 

Key Features 

TDS5000B Series oscilloscopes are high-performance solutions for verification, debugging, and 
characterization of sophisticated electronic designs. The series features exceptional signal 
acquisition performance, operational simplicity, and open connectivity to the design environment. 
Classic analog-style controls, a large display with an optional touch-sensitive screen, and graphical 
menus provide intuitive control. Open access to the Windows operating system enables 
unprecedented customization and extensibility. Key features include: 

 Up to 1 GHz bandwidth and 5 GS/s real time sampling rate 

 Record lengths up to 16,000,000 samples 

 Fast acquisition at up to 100,000 acquisitions per second  

 1.5% DC vertical gain accuracy 

 Two or four input channels (each with 8-bit resolution) 

 Auxiliary trigger input and output 

 Sample, envelope, peak-detect, high-resolution, average, and waveform database acquisition 
modes 

 Full programmability, with an extensive GPIB command set and a message-based interface 

 Extensive suite of advanced triggers including edge, logic, pulse, video, communication 
(optional), and sequence  

 Powerful built-in measurement capability, including histograms, automatic measurements, 
and measurement statistics 

 Basic math as well as advanced equation editor and spectral analysis 

 A large 10.4 inch (264.2 mm) color display that supports color grading of waveform data to 
show sample density 

 Customizable MyScope control windows  

 An intuitive graphical user interface (UI) with online help 

 Internal disk storage 

 Wide array of probing solutions, options, and upgrades 

 GPIB Controller 

 Comprehensive Suite of Right-Click Menus 

Acquisition Features 

Separate Digitizers. Ensure accurate timing measurements with separate digitizers for each 
channel. The digitizers can also be combined to yield a higher sample rate on a single 
channel. 

Fast Acquisition. Acquire up to 100,000 waveforms per second to see rapidly changing 
signals or intermittent signal irregularities. 

Long Record Lengths. 2M per channel and 8M on a single channel is standard. Extend the 
maximum record length up to 16M with memory options.  

Peak Detect Acquisition Mode. See pulses as narrow as 400 ps, even at the slower time base 
settings. Peak detect helps you see noise and glitches in your signal.  

Acquisition Control Acquire continuously or set up to capture single shot acquisitions. 
Enable or disable optional acquisition features such as equivalent time or roll mode. 
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Horizontal Delay. Use delay when you want to acquire a signal at a significant time interval 
after the trigger point. Toggle delay on and off to quickly compare the signal at two different 
points in time. 

Average, Envelope, Hi Res Acquisition, and WfmDB. Use Average acquisition mode to 
remove uncorrelated noise from your signal. Use Envelope to capture and display the 
maximum variation of the signal. Use Hi Res to increase vertical resolution for lower 
bandwidth signals. WfmDB mode is the only mode that can be used when mask testing with 
an optical standard. 

Signal Processing Features 

Waveform Math. Set up simple math waveforms using the basic arithmetic functions 
including FFT, or create more advanced math waveforms using the math expression editor. 
Waveform expressions can even contain measurement results and other math waveforms. 

Spectral Analysis. Display spectral magnitude and phase waveforms based on your time-
domain acquisitions. Control the instrument using the traditional spectrum analyzer controls 
such as span, center frequency, and resolution bandwidth. 

FastFrame. Use FastFrame to capture a series of triggered acquisitions at high resolution 
without wasting acquisition memory on the dead time in-between the acquisitions.  

Mask Testing. Use mask testing for signal violation detection and pass/fail testing. Test 
signals against a user defined mask, or with Option SM you can test against industry standard 
masks. 

Limit Testing. Use Limit Testing for pass/fail comparison with an active signal. 

Display Features 

Color LCD Display. Identify and differentiate waveforms easily with color coding. 
Waveforms, readouts, and inputs are color matched to increase productivity and reduce 
operating errors. 

Digital Phosphor. A Digital Phosphor Oscilloscope can clearly display intensity modulation 
in your signals. The oscilloscope automatically overlays subsequent acquisitions and then 
decays them to simulate the writing and decay of the phosphor in an analog oscilloscope CRT 
(cathode-ray tube). The feature results in an intensity-graded or color-graded waveform 
display that shows the information in the intensity modulation. 

Fit to Screen. The Digital Phosphor technology performs the compression required to 
represent all record points on the screen, even at the maximum record length settings. 

MultiView Zoom. To take advantage of the full resolution of the instrument, you can zoom in 
on a waveform to see fine details. Both vertical and horizontal zoom are available. You can 
also zoom in on multiple areas of a single waveform simultaneously and on multiple 
waveforms at the same time. 

Measurement Features 

Cursors. Use cursors to take simple voltage, time, and frequency measurements. 

Automatic Measurements. Choose from a large palette of amplitude, time, histogram, and 
communication measurements. You can customize the measurements by changing reference 
levels or by adding measurement gating. Statistics (mean, maximum, minimum, standard 
deviation and population) are available for each measurement value  
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Trigger Features 

Simple and Advanced Trigger Types. Choose a simple edge trigger, or choose from up to 
twelve advanced trigger types to help you capture a specific signal fault or event. 

Dual Triggers. Use the A (main) trigger system alone or add the B trigger to capture more 
complex events. You can use the A and B triggers together to set up a delay-by-time or delay-
by-events trigger condition. 

Convenience Features 

Autoset. Use Autoset to quickly set up the vertical, horizontal, and trigger controls for a 
usable display. 

Myscope. Allows you to create your own control windows for easy access to the controls you 
use most often. 

Touch Screen Interface. (Optional) You can operate all instrument functions (except the 
power switch) from the touch screen interface. You can also install a mouse and keyboard to 
use the interface. 

Toolbar or Menu Bar. You can choose a toolbar operating mode that is optimized for use 
with the touch screen, or a PC-style menu-bar operating mode that is optimized for use with a 
mouse. 

Open Desktop. The instrument is built on a Microsoft Windows software platform; the 
instrument application program starts automatically when you apply power to the instrument. 
You can minimize the instrument application and take full advantage of the built-in PC to run 
other applications. Moving waveform images and data into other applications is as simple as a 
copy/paste operation. 

Dedicated Front Panel Controls. The front panel contains knobs and buttons to provide 
immediate access to the most common instrument controls. Separate vertical controls are 
provided for each channel. The same functions are also available through the screen interface. 

Data Storage and I/O. The instrument has an optional removable hard disk drive, a floppy 
disk drive, and a CD-RW drive that can be used for storage and retrieval of data. The 
instrument has GPIB, USB, Centronics, RS232, VGA out, extended desktop support, and 
Ethernet ports for input and output to other devices. 

Integrated Thermal Printer (Optional).  The optional built-in thermal printer allows you to 
print a long continuous waveform as a banner. Banner printing shows more detail, drawing 
samples that might otherwise overlap on the screen.  

Online Help. The instrument has a complete online help system that covers all its features. 
The help system is context sensitive; help for the displayed control window is automatically 
shown if you click the help button. Graphical aids in the help windows assist you in getting to 
the information you need. You can also access the help topics through a table of contents, 
index, or full text search. 
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Product Software 
The instrument includes the following software: 

 System Software. The product software runs on a specially configured version of Windows 
2000. Windows 2000 is preinstalled and enables you to install other compatible applications. 
To reinstall Windows 2000, use the Operating System Restore CD-ROM, a standard 
accessory with your instrument. Do not attempt to substitute any version of Windows that is 
not specifically provided by Tektronix for use with your instrument.  

 TDS5000B Product Software. This preinstalled software is the instrument application and 
runs on Windows 2000. It provides the user interface (UI) and all other instrument control 
functions. You can minimize or even exit/restart the instrument application as your needs 
dictate. However, it is recommended that you exit the instrument application only when 
installing new software. 

 Support Software. The TDS5000B Series Product Software CD-ROM, included with the 
instrument, contains additional software and files that may be useful to you. 

 Readme file. This text file contains release notes and updates that are not included in other 
product documentation. 

 GPIB Programmer Online Help software. This software is available as WinHelp or as a 
PDF file. It contains the information you need to program the instrument through its GPIB 
interface.  

 Specifications Performance Verification Procedures. The product CD-ROM contains 
instrument specifications and instructions to perform a manual performance verification. 

See the instructions for the TDS5000B Series Product Software CD-ROM for information about 
installing the support software. 

Occasionally new versions of software for your instrument may become available at our Web site, 
see Support Information. 

Firmware Upgrade 

Tektronix may offer firmware upgrade kits for the instrument. Contact your Tektronix service 
representative for more information. 
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User Interface Map 
See the figure below for a description of the elements of the user interface. These elements 
provide complete control of the instrument. 
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Installing Software 
The instrument system and application software is preinstalled at the factory. If you have to 
reinstall the software for any reason, refer to the instructions that accompany the CD-ROMs 
shipped with the instrument. 

Software Release notes 

Read the software release notes (README.TXT) on the product software CD-ROM before 
performing installation procedures. This file contains additional information that supercedes other 
product documentation.  

To view README.TXT, start the Windows Notepad accessory and open the file from the 
TDS5000B Series Product Software CD-ROM. 

Accessory Software 

The TDS5000B Series Product Software CD-ROM contains accessory software and files that you 
can install on the instrument or another PC. Refer to the instructions that accompany the CD-ROM 
for installation information. 

Desktop Applications 

You can install desktop application software on the instrument. The instrument has been tested 
with the following software products installed: 

 Microsoft Office 2000 (Word, Excel, PowerPoint, etc.) 

 MathCad 

 MATLAB 

Other software products may be compatible but have not been tested by Tektronix. If the 
instrument malfunctions after you install software, uninstall the software and then reinstall the 
instrument application to restore proper operation. 

Before installing other desktop applications, exit the instrument application. To do this, click Exit 
on the File menu. 
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Using Online Help 

  

The online help is designed to assist you with all the features of 
the instrument. 

Use the online help to quickly get information about a function or 
assistance in performing a task. These types of online help are 
available: 

Context-Sensitive help. In toolbar mode, click Help to display 
online help for the active window. From the menu bar, click Help 
to display a list of help options. In either mode, the F1 function 
key also displays help for the active window. 

Note 

If you are using the optional touch screen, you can also touch the 
Help button in either mode. 

Microsoft Windows help. Help is also available as part of 
Windows. For information about Windows features, refer to the 
Windows online help by clicking Start in the Windows toolbar 
and then selecting Help. 

Navigating the Online Help 
You can search for help using methods that most users of PCs are familiar with: From the menu 
bar, select Help, and then select Contents and Index. 

From the online help finder, choose one of the three tabs: Contents, Index, or Find. From the 
Contents tab, click a topic to select it for display, and then click the Display button to open the 
topic. From the Index tab, when you enter the subject you are looking for, the list scrolls to that 
topic. Click Display to open the topic. For a full text search use the Find tab. You must first 
choose the method for word list generation, click Next, and then click Finish. Enter the subject 
you want to find. Every topic that contains the subject will be displayed. Select a topic and click 
Display to open that topic.  

There are several ways to use the online help that are unique to the instrument:  

Jumps. Blue-underlined text represents hyperlinks to other topics. Click the text to jump to the 
related topic. For example, to jump to the topic on Using Online Help click the text. Click Back to 
return to this window. 

Pop-ups. Pop-up windows are identified by blue text with no underlines. Click the blue text to 
display a brief help message. 

Help on Graphics. Some of the graphics in the help windows contain areas highlighted with 
orange boxes. Click the area inside the box to either open a pop-up window with a brief help 
description or to jump to a related help topic. 
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Note 

If you are using the optional touch screen, you can also touch the blue text or orange highlighted 
graphic areas. 

Documentation 
In addition to this online help, these documents are available: 

 

TDS5000B Series Digital Phosphor Oscilloscopes Quick Start 
User Manual (071-1355-xx). The Quick Start User Manual has 
information about installing and operating your instrument. The 
Quick Start User Manual is available in seven languages in 
addition to English. 

TDS5000B Series Digital Phosphor Oscilloscopes 
Programmer Online Guide. The Programmer Guide is provided 
as online help and as a printable PDF file. See the TDS5000B 
Series Product Software CD-ROM for installation information.  

Optional TDS5000B Series Digital Phosphor Oscilloscopes 
Service Manual (071-1362-xx). A service manual is available as 
an optional accessory; it includes procedures to service the 
instrument to the module level. 

Getting Started with OpenChoice Solutions Manual with CD 
(020-2513-xx). A book and CD that explore some options for 
getting data from your instrument into any one of several 
available analysis tools. 

TDS5000B Series Digital Phosphor Oscilloscopes Specifications and Performance 
Verification Technical Reference Manual (071-1420-xx). This is a .pdf only manual and 
includes both specifications and the performance verification procedure. Complete specifications 
are also available from the Help menu. 

Optional Applications. The Optional Applications Software for Tektronix Windows-Based TDS 
Instruments CD-ROM (020-2450-xx) contains free five-time trials of optional application 
software that you can install on your instrument. These applications provide application specific 
measurement solutions, such as power, jitter, optical storage, disk drive, and others. 

Other Documentation. Your instrument also comes with booklets for the Product CD-ROM 
(063-3692-xx) and System Restore CD-ROM (063-3759-xx). 

 For quick access to PDFs of the user manual, probe manuals, programmer guide, primers and 
applications, specifications and  performance verification manual, service and installation 

manuals, and a printable version of the online help, click the Documentation icon  on your 
desktop, or select Documentation on your desktop. 
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Support Information 

  

For information on getting support for your Tektronix 
product: 
Product Support 

For application-oriented questions about a Tektronix 
measurement product, call toll free in North America: 
1-800-833-9200 
6:00 a.m. - 5:00 p.m. Pacific time  

For product support outside of North America, contact 
your local Tektronix distributor or sales office. 

Service Support 

Tektronix offers extended warranty and calibration 
programs as options on many products. Contact your 
local Tektronix distributor or sales office. 

http://www.tektronix.com 

For other 

information:  

In North America: 
1-800-833-9200 
An operator will direct 
your call. 

 To write us: 

 Tektronix, Inc. 
 Department or name (if known) 
 14200 SW Karl Braun Drive 
 P.O. Box 500 
 Beaverton, OR 97077 
 USA 

  To e-mail us: 

 techsupport@tektronix.com 
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Feedback 

 

Tektronix values your feedback on our products. To help 
us serve you better, please send us any suggestions, ideas, 
or other comments you may have regarding your 
instrument. 

Direct your feedback to us via email to 
support@tektronix.com, or FAX at (503) 627-5695, and 
include the following information. In the subject field, 
please indicate NEW and IMPROVED Scope Customer 
Feedback. Please be as specific as possible. 

Recommended Information: 
 Instrument hardware (for example, display, chassis) 

 Application software version  

 Probes 

Optional Information: 

Your name, company, mailing address, phone number, 
FAX number 

Please indicate if you would like to be contacted by 
Tektronix regarding your suggestion or comments. 

Tips 

To include screen shots of the user interface, select Copy from the Edit menu to copy the image to 
the clipboard. Paste the image into Microsoft Paint and save the image as a .BMP file. You can 
then attach the file to your email (depending on the capabilities of your email editor). 
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Standard Accessories 
The following accessories are shipped with your instrument: 

 TDS5000B Series Digital Phosphor Oscilloscopes Quick Start User Manual  

English (Option L0, 071-1355-xx) 
French (Option L1, 071-1357-xx)  
German (Option L3, 071-1358-xx) 
Japanese (Option L5, 071-1356-xx) 
Korean (Option L9, 071-1359-xx) 
Russian (Option L10, 020-2609-xx) 
Simplified Chinese (Option L7, 071-1360-xx) 
Traditional Chinese (Option L8, 071-1361-xx) 

 Accessory Pouch (016-1935-00) 

 Getting Started with OpenChoice Solutions Manual with CD (020-2513-xx) 

 Important Documents Folder  

Includes Certificate of Calibration documenting NIST traceability, 2540-1 compliance, and 
ISO9001 registration 

 Front Cover (200-4651-00) 

 Power Cord  

 North America (Option A0, 161-0104-00) 

 Universal Euro (Option A1, 161-0104-06) 

 United Kingdom (Option A2, 161-0104-07) 

 Australia (Option A3, 161-0104-05) 

 240V North America (Option A4, 161-0104-08) 

 Switzerland (Option A5, 161-0167-00) 

 Japan (Option A6, 161-A005-00) 

 China (Option A10, 161-306-00) 

 No power cord or AC adapter (Option A99) 

 Optical Wheel Mouse (119-6936-xx) 

 TDS5000B Series Product Software CD-ROM (063-3692-xx) 

 Includes: application, online help, TDS5000 Series Programmer Online Guide (GPIB online 
help and PDF), Specifications and Performance Verification PDF, release notes, VISA 
information, and other related documentation. 

 TDS5000B Series Operating System Restore CD-ROM (063-3759-xx) 

 Optional Applications Software for Windows-Based Oscilloscopes CD-ROM and manuals 
(020-2450-xx) 

 LabVIEW 30-day Evaluation Copy (020-2476-xx) 

 MATLAB 30-day Evaluation Copy (063-3609-xx) 

 One 500 MHz, 10x passive probe per channel (P5050) 
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Recommended Accessories 
The following optional accessories are recommended for your instrument: 

 TDS5000B Series Digital Phosphor Oscilloscopes 
Service Manual (071-1362-xx) 

 Keyboard (118-9402-00) 

 Stylus (119-6107-00) 

 Set of 2 blank CD-RW (020-2434-00) 

 Transit Case (016-1937-00) 

 Video Display Clamp (013-0278-xx) 

 Thermal Printer Paper (016-1897-00) 

 Probe Calibration, Compensation and Deskew 
Adapter  
(067-0405-02). Requires a separate pulse generator. 

 Power Deskew Fixture (067-1478-00) 

 Extra Front Removable Hard Drive (065-0692-xx) 

 P6101B 15 MHz 1X Passive Probe 

 Extra P5050 500 MHz 10X Passive Probe 

 TCP202 Current Probe 

 CT1, CT2, and CT6 High Speed AC Current Probes 

 CT-4 AC Current Probe 20 kA 

 TCPA300, TCPA400 Series Current Measurement 
Systems (requires TCPA300 / TCPA400 style probe) 

 AM5030S DC/AC current measurement system 

 P6021, P6022 AC current measurement probes 

 P6701B optical/electrical converter (multi-mode) 

 P6703B optical/electrical converter (single-mode) 

 P5100 High Voltage Probe 

 P5200 High Voltage Differential Probe 

 P5205 High Voltage Differential Probe 

 P5210 High Voltage Differential Probe 

 P6015A High Voltage Probe 

 P6158 3 GHz, 20X Low C Probe  

 P6243 1 GHz Active Probe  

 P6245 1.5 GHz Active Probe  

 P6247 1 GHz Differential Probe 

 P6248 1.5 GHz Differential Probe  

 P6246 400 MHz Differential Probe  

 ADA400A Differential Preamplifier 

 AMT75 1 GHz 75 Ω Adapter 
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 AFTDS Differential Signal Adapter 
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Additional accessory information 
Item Description 

Monitor If you use a nonstandard monitor, 
you may need to change the 
Windows 2000 display settings to 
achieve the proper resolution for 
your monitor. 

Printer Connect an external printer to the 
Centronics parallel port connector 
directly. If your printer has a DB-
25 connector, use the adapter 
cable that came with your printer. 
For information on printer usage, 
see Using Print Screen. 

Rackmount For installation information, refer 
to the instructions that came with 
your rackmount kit. 

Other Refer to the Readme file on the 
TDS5000B Series Product 
Software CD for possible 
additional accessory installation 
information not covered in this 
manual. 
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Options 
The following options are available for your instrument: 

 Touch Screen (18) 

 Front panel removable hard drive (FHD) 

 Scope Cart (1K) 

 Extended Memory 16/8/4M on 1/2/4 channels (3M) 

 Thermal Printer—1P (655-4920-00) 

 TDS5000 Series Rackmount Kit—1R (016-1946-xx) 

 Serial Communications Mask Testing (SM) 

 TDSCPM2—ANSI/ITU telecom pulse compliance software (CP2) 

 TDSDVD—Optical storage analysis software (DVD) 

 TDSET3—Ethernet compliance test software (ET3) 

 TDSDDM2—Hard disk drive application software (J2) 

 TDSJIT3E—Jitter and timing analysis software essentials (J3E) 

 TDSJIT3—Jitter and timing analysis software with Rj/Dj and BER (JT3) 

 TDSPWR3—Power measurement software (PW3) 

 TDSUSBS—USB2.0 compliance test software only (USB) 

 Calibration Service 3 years (C3) 

 Calibration Service 5 years (C5) 

 Calibration Data Report (D1) 

 Calibration Data Report 3 years (with Option C3) 

 Calibration Data Report 5 years (with Option C5) 

 Repair service 3 years (including warranty) (R3) 

 Repair service 5 years (including warranty) (R5)  
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Windows Interface Guidelines 
Because the instrument uses the Microsoft Windows interface, you have open access to the 
Windows operating system. You can access the Windows desktop to load and run other Windows-
based applications such as Microsoft Excel, WordPad, and Paint. 

Although you have access to the Windows interface, you should avoid making operating system 
changes that may cause problems or annoyances while trying to use the instrument. Here are some 
guidelines: 

 The instrument has been tested with Windows 2000 Professional version. The instrument is 
not intended to operate with any other version of Microsoft Windows than the one provided 
on the Operating Restore CD.  

 If the instrument powers on in Windows Safe Mode, the optional touch screen is inoperative. 
You may need to use a mouse or keyboard to restore normal operation. 

 To keep the start-up time to a minimum, keep the network support to a minimum.  

 Be careful when making changes in the Control Panel. Avoid making changes to any controls 
with which you are unfamiliar. 

 Do not change the LCD monitor color resolution (True Color 24 bit) and screen area settings 
(640 by 480 pixels). If the settings change the video port may not work properly. 

 Avoid using antivirus software on the instrument. If you must install it, disable it after use for 
best instrument performance. 

 Some third-party applications may not work properly with the instrument. If your instrument 
stops working after you install third-party software, try reloading the instrument software 
from the TDS5000B Series Product Software CD-ROM. 

 If you do not have an external monitor attached to the instrument, avoid changing the taskbar 
properties to "Always on top" and "Auto hide." The Windows taskbar may obscure buttons or 
readouts on the screen. However, if you do have an external monitor attached and the 
instrument is set to dual monitor mode, you can drag the taskbar from the instrument display 
to the external monitor display and use these settings. 

 Disable the Windows screen saver to prevent it from turning on while you are taking 
measurements or viewing the display. If the screen saver comes on while taking 
measurements, touch the screen (if the touch screen is installed and enabled), move the 
mouse, or press any key on the attached keyboard. 

 Do not delete or change any system fonts. Changing or removing fonts may affect the quality 
of the display. 

 Avoid changing the system Display Properties such as the Background, Appearance, Effects, 
or Settings. Making such changes can affect the usability of the instrument and the touch 
screen. 

 Avoid making changes to the contents of the Windows folder or to the contents of the 
TekScope folder. 

 Avoid making changes to the BIOS settings. Changing the BIOS settings can affect the 
overall operation of the instrument. 

 Avoid changing the Windows power management system. 

If you think that your Windows interface may cause problems with the instrument, contact your 
local Tektronix support center for assistance. 
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Analysis and Connectivity Support 
This instrument offers several tools that you can install to support data export for use with data-
analysis tools. 

 

You can use these analysis and connectivity tools with your 
TDS5000B instrument to: 

 Gather instrument data (waveforms, 
measurements) and port it to familiar, off-the-shelf 
analysis tools, such as Excel 

 Interface with a popular software development 
environments, such as Lab Windows and 
LabVIEW 

See the following tools to find out how they can help you 
connect to your instrument and analyze the data it collects: For 
more information see the Getting Started with OpenChoice 
Solutions Manual.  

 VXI Plug-and-Play Instrument Driver  

 TekVISA  

 TekVISA ActiveX Control (TVC)  

 TekVISA Excel Toolbar  

 VXI 11.2 LAN Server  

 Tektronix Toolbar for Word  

 Report Generator  

 IVI Drivers  

Getting the Analysis and Connectivity Support 
Tools 

This instrument offers several tools that you can install to support data export for use with data-analysis 
tools. 
These tools ship with the Tektronix instrument that this online help supports. You can find them on the 
product software CD that ships with this instrument. Find the Readme file on the CD for analysis and 
connectivity tool installation instructions. 

For More Information 

 For general information and examples on how each of these tools can help you use your 
instrument, these tools, see the book Getting Started with OpenChoice Solutions Manual with 
CD.  

 For online information about the VXIplug&play driver, access the driver online help in from 
the help system of your software development environment in which you install the driver. 
The driver online help describes each function of the driver and presents these components in 
a hierarchical outline corresponding to the standard VXIplug&play model. 

 For further reference information on TekVISA, read the book TekVISA Programming 
Manual. 

 For online information on the TekVISA Excel toolbar, access the online help for the 
TekVISAExcel Toolbar from the Excel Help menu once you have installed the toolbar. 
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VXI Plug-and-Play Instrument Driver 
The VXIplug&play instrument driver is a collection of software components, organized according 
to the standard VXIplug&play model established by the VXIplug&play Systems Alliance. Use 
this VXIplug&play instrument driver to simplify programming tasks when using the following 
software development environments: 

 LabWindows/CVI 

 LabVIEW 

 MATLAB 

 Visual C++ 6.0 

 Visual Basic 6.0 

 HP-VEE 

TekVISA 
TekVISA is a library of industry-standard compliant software components, organized according to 
the standard VISA model established by the VXIplug&play Systems Alliance. Use TekVISA in 
software to write interoperable instrument drivers to handle communicating between software 
applications and your TDS5000B series instrument. TekVISA offers the following features and 
benefits: 

 Provides end users with a consistent methodology for using instrument drivers from a variety 
of vendors 

 Provides programmers with language interface libraries for use with multiple Application 
Development Environments  

 Provides a configuration utility for setting up additional VISA resources 

 Allows software installation and connectivity on any number of PCs 

TekVISA ActiveX Control (TVC) 
The TekVISA Control (TVC) uses Microsoft Windows ActiveX control technology to simplify 
access from Microsoft Office and Visual BASIC applications to TekVISA and the underlying 
instrument. It does this by providing support for key TekVISA features within an ActiveX control 
object that is compatible with Excel’s Visual BASIC for Applications, Visual BASIC 6.0, and 
other popular programming environments for Microsoft Windows. 

TekVISAExcel Toolbar 
The TekVISA Excel Toolbar allows direct, fast transfer of instrument measurements or captured 
waveforms to an Excel 97 and/or Excel 2000 worksheets. Transfer is via a toolbar that is 
integrated into Excel, implemented using the TekVISA ActiveX Control (TVC) and the Visual 
BASIC for Applications macro editor built into Excel. 

Source code for the toolbar is accessible through Excel’s built-in VBA editor for use as a learning 
tool for using the TekVISA ActiveX Control, or to cut-and-paste selected components to new VB 
applications. 

VXI 11.2 LAN Server 
The VXI 11.2 LAN Server provides software connectivity between your instrument and remote 
PCs over an Ethernet LAN. This tool is a client-side component built-in with TekVISA on each 
remote PC, you must install another copy of TekVISA to make use of its client-side component. 
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The VXI-11 standard specifies a protocol for communication with devices over a network via a 
network instrument server. This protocol uses the ONC/RPC (Open Network Computing/Remote 
Procedure Call) standard that, in turn, is based on TCP/IP. 

Supported ADEs 
TekVISA supports these Application Development Environments: 

 Microsoft C/C++ 

 Microsoft Visual Basic 

 LabVIEW graphics software using the G language 

 MATLAB analysis software 

Tektronix Toolbar for Word 
The Tektronix Toolbar for Word, an add-in to Microsoft Word, lets you capture and graph 
oscilloscope data in Microsoft Word 2000 and 2002 documents. 

Report Generator 
Report Generator, an MS Windows application, lets you create custom reposts displaying your 
oscilloscope data. Report Generator enables you to generate and print reports directly from the 
oscilloscope. It enhances the application capabilities by simplifying the process of creating and 
maintaining reports. 

IVI Drivers 
IVI drivers conform to specifications produced by the IVI Foundation. Unlike VXI-plug&play 
drivers, they provide a standard interface to different classes of instruments, including 
oscilloscopes and spectrum analyzers. IVI drivers have the ability to simulate instruments, 
automatically check ranges, and multithread safety features. 

Menu Bar Mode 
  

The menu bar menus provide access to commands that control all of the instrument features and 
functions.   

When you select a feature setup command, the instrument displays the associated control window 
on the lower half of the screen. Each control window provides access to the individual instrument 
controls. The display graticule is redrawn to fit in the upper half of the screen. 

Some of the control windows appear on the right side of the screen. This allows you to operate the 
instrument in full screen mode while accessing the controls in the control window or from the 
front panel. 

Toolbar Mode 
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The toolbar buttons give you instant access to most instrument features without having to navigate 
through several menus. Click a toolbar button to display an associated control window on the 
lower half of the screen. Each control window provides access to the individual instrument 
controls. The display graticule is redrawn to fit in the upper half of the screen. 

Not all features of the instrument are accessible from the toolbar. To access some of the less 
common controls, you must change to menu bar mode. To do this, click the Menu button in the 
upper-right corner of the screen. 

 

Working with the TDS5000B Series Instrument 
The following topics describe features of your TDS5000B Series oscilloscope. Even if you are an 
experienced user, you may want to browse through these topics to learn new ways of doing 
familiar tasks. 

Basic Operations 
 Using the Instrument Interface see page 44   

 Changing Control Settings see page 44  

 Moving and Docking Control Windows see page 45  

 Controlling from within the Graticule Area see page 45 

 Initializing the Instrument see page 46  

 Choosing and Connecting Probes see page 46 

 Creating your Own Control Windows see page 47 

Waveform Operations 
 Using Time Bases and Triggering see page 47 

 Looking at Waveform Details see page 47  

 Using Fast Acquisition and DPO see page 48  

 Using Waveform Math see page 48 

 Using Mask and Limit Testing see page 49 

 Using Spectral Analysis see page 49 

 Characterizing a Signal see page 49 

 Adding Application-Specific Measurements see page 50  
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Windows Environment 
 Connecting to a Network see page 50 

 Printing a Hard Copy see page 51 

 Using Other PC Applications see page 51 

 Using a Second Monitor see page 52 

 Connecting to Other Instruments see page 52  

 Access Shortcut Menus with Right-click see page 46  

Using the Instrument Interface 
—convenient ways you can operate the instrument 

Use familiar knobs and buttons on the front panel to perform most vertical, horizontal, and 
triggering functions. Make quick adjustments to your displayed signals with the dedicated vertical 
controls for each channel. 

The screen interface gives you access to the complete functionality of the instrument. The toolbar 
interface is optimized for optional touch screen operation. Touching (or clicking) a button on the 
toolbar opens a control window that you can use to select the instrument settings. 

With a mouse, you may prefer to use the PC-style menu bar to open control windows or directly 
select many instrument settings. 

Changing Control Settings 
—several ways to set numerical parameters 

As you configure the instrument, you may need to set a numerical parameter such as a reference 
level or delay time. There are several different ways to set these parameters. 

 In a control window, touch or click the parameter to select it. Once selected, one of the 
multipurpose knobs is assigned to the parameter. Turn the upper or lower knob (as indicated 
by the knob graphic next to the parameter) to adjust the setting. Push the FINE button to use 
the knob to make small changes, for example to add another decimal place for greater 
accuracy. 

 This online help usually refers to using the multipurpose knobs to change control settings, 
although the following methods are generally available: 

 Some parameters with discrete values have increment/decrement buttons. Touch or click them 
to change to the next available value. 

 Some parameters supply a pop-up keypad or keyboard that you can use to enter a new value.  

 If you have an external keyboard attached, you can also use it to type in a new value. 

 You can also adjust parameter values using the mouse wheel. Press the mouse wheel to access 
fine mode. Press it again to return to normal mode. 
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Moving and Docking Control Windows 
—access control settings while viewing the full screen 

Control windows that open on the lower half of the screen can be set to "float" to any location. To 
do this, double-click the handle on the leftmost edge of the window, or click the handle and drag 
with the mouse to another position on the screen. The waveform display goes to full-screen mode 
and the control window changes its format to have a title bar.  

The window can now be moved freely to any position on the screen or to a second monitor (if you 
have set up a dual display) by dragging it by the title bar. Note, however, that it cannot be resized. 
All controls on the window can be accessed and function as usual. 

To dock the control window at its normal position, double-click on the title bar or float the 
window to its initial boundaries at the bottom half of the screen. The window snaps back into 
place and returns to its original format. 

Control windows that appear on the rightmost side of the screen cannot be moved. 

Controlling from within the Graticule Area 
—things you can touch or click in the waveform graticule 

Use the mouse or your finger (if the optional touch screen is installed) in the graticule area to do the 
following things: 

 Click and drag (or touch and drag) an on-screen cursor to another position on the waveform. 

 Click and drag (or touch and drag) a waveform handle to change the vertical position of a waveform. 

 Click and drag (or touch and drag) a waveform label or other screen text that you have entered to 
reposition it. 

 Click and drag (or touch and drag) the horizontal reference marker to set the horizontal position. 

 Click and drag (or touch and drag) the trigger level marker to set the trigger level. 

 Click and drag (or touch and drag) across part of a waveform to select it and investigate it further. 
Once the selection is made, choose one of the following actions: 

—Create a Zoom waveform that covers just the selected area 

—Create a histogram to analyze the selected area 

—Turn on measurement gates that take measurements only in the selected area 

—Cancel the selection 
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Access Shortcut Menus by Right-Clicking 
—fast access to most common commands is available by right-clicking 

Right-click on the graticule, on an object, or a readout for quick access to shortcut menus. These 
shortcut menus are dynamic and will change with the area or object where you right clicked. 
Right-click on any of the following for a dynamic shortcut menu: 

 Waveform handle 

 Cursors 

 Labels 

 Histogram display 

 Masks 

 Templates 

 Trigger level marker 

 Readouts (the menu varies with the type of readout) 

 Graticule  

 Regions (Menu bar, Toolbar, Multipurpose Knobs) 

Initializing the Instrument 
—returning to a known starting point 

After you complete a task, you may want to initialize the instrument settings before using the 
instrument with your next task. This may be especially important if you share the instrument with 
others; previous settings may make it difficult for you to do what you need to do. 

To quickly restore the instrument to its default settings, push the front-panel DEFAULT SETUP 
button. 

If data security is important to you, use the Tek Secure Erase feature to overwrite all internal 
waveforms and set up memory with null values.  

Choosing and Connecting Probes 
—important things to remember about probes 

Choose from a wide variety of passive, active, and specialty probes to use with your instrument. 
The instrument automatically configures the input impedance when you attach a probe that is 
compatible with the TekProbe interface. Remember the following when connecting a probe: 

 Adjust the low frequency compensation on most passive probes after you connect them to a 
channel input.  

 Compensate for gain (and offset) error in many probes. Connect the probe tip to the probe 
compensation connectors and execute the built-in calibration procedure to optimize the 
system accuracy. 

 Compensate for propagation delay differences between voltage probes using the probe 
deskew feature. Attach up to two probe tips at a time to the probe compensation terminals and 
execute the deskew procedure to time align the display for each channel. The deskew 
adjustment range is ±75 ns. 
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Creating Your Own Control Windows 
—new ways to make your job easier 

For quick access to the controls that you use most often, you can create your own MyScope 
control window. Choose from a list of controls to include and make each control window unique 
to your needs. MyScope allows you to have up to eight tabs in a control window, increasing the 
flexibility and ease of use for your unique MyScope control windows. You can create and save 
any number of controls windows for future use.  

Triggering, Timebase, and Horizontal Delay 
—a comparison with oscilloscopes of the past 

The architecture of an analog oscilloscope requires its time bases and triggering to be linked. The 
main trigger triggers the main time base, and then you can use a delayed trigger to trigger a 
delayed time base. Many digital oscilloscopes have also been designed using this traditional but 
complex paradigm. 

This instrument uses a simpler paradigm that cleanly separates the concepts of triggering and time 
bases. You can still do everything that you could with an analog oscilloscope and more. Now 
these features are easier to set up and use. 

The trigger event can be simple or complex. Examples of a simple trigger are the rising edge of 
Channel 1 or a glitch narrower than 10 ns on Channel 2. You can set up a complex trigger where 
the trigger system is armed by a condition on one channel and then is triggered by a condition on 
another channel. In either case, simple or complex, there is just one trigger event. 

The time base can be either delayed or not delayed. If it is not delayed, acquisition occurs 
surrounding the trigger event depending on the amount of pretrigger and posttrigger data that you 
have selected. If you turn on horizontal delay, you can delay the acquisition to a point well beyond 
the trigger event (similar in effect to a delayed time base). By alternately turning horizontal delay 
on and off, you can make quick, detailed comparisons between two segments of a signal that are 
separated from each other by a fixed amount of time. In any case, the time base is always triggered 
by one trigger event. 

Looking at Waveform Details 
—taking advantage of the full resolution of the instrument 

Use the instrument MultiView Zoom function to magnify an acquisition vertically, horizontally, or 
in both dimensions to let you see the fine detail in your signals. The MultiView Zoom function 
affects only the display, not the actual waveform that is being acquired. 

The fastest way to set up a Zoom display is to click (or touch) and drag across the segment of the 
waveform that you want to see in greater detail. Then, when you touch or click the on-screen 
Zoom menu item, that waveform appears in the Zoom (lower) graticule, while the entire waveform 
appears in the Acquisition (upper) graticule. Markers in the main graticule give you position 
context for what you are seeing in the Zoom graticule. 

Another way to set up the MultiView Zoom function is to push the front-panel MultiZoom button. 
Then you can set parameters in a control window to focus your Zoom waveform on the signal 
segment of interest. 

To see more waveform detail you can also use horizontal delay (as described in the previous topic) 
to focus the acquisition on a segment of a waveform separated from the trigger event by a 
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significant interval of time. This technique lets you increase the horizontal resolution (sample 
faster) on a segment of a signal, even when you cannot trigger on that particular segment. 

The multizoom function also allows you to zoom on multiple areas of a waveform or on multiple 
waveforms simultaneously. You can lock the zoomed areas and scroll through them together or 
unlock the zoomed areas and scroll through them independently.  

Using Fast Acquisition and DPO 
—analog performance from digital technology 

When you turn on FastAcq, you can acquire up to 100,000 waveforms per second. In fast 
acquisition mode, the "dead time" between acquisitions can be very short, approaching that of the 
finest analog oscilloscopes. Reduced dead time means that your chances of capturing an infrequent 
event are greatly improved. More time is spent acquiring and displaying your signal. And with the 
digital phosphor (DPO) technology, you can easily differentiate between the normal shape of your 
signal and that infrequent anomaly that you want to capture. 

As a comparison, high quality analog real-time oscilloscopes can sweep at high repetition rates 
with little dead time between sweeps, which makes it possible to capture an infrequent event. 
Typical digital oscilloscopes (DSOs) have relatively long dead times between acquisitions; 
infrequent events are much more difficult to capture. With fast acquisition and digital phosphor 
technology, the oscilloscope acquires at a high repetition rate and then overlays the acquired 
information into a three-dimensional database that is updated on the display 30 times per second. 

The digital phosphor oscilloscope shows you not only the displayed waveform, but also the 
sample density. You can choose to see sample density represented in a color palette or as shades of 
gray or shades of green. The DPO display in monochrome green bears a strong resemblance to the 
CRT of a high-quality analog oscilloscope. When you increase waveform brightness with the 
front-panel INTENSITY knob, areas of lower sample density appear more clearly. 

DPO provides display benefits whether fast acquisition is on or off. When it is on, DPO helps you 
identify an infrequent anomaly in a repetitive signal, especially when either the spectral or 
temporal color palettes are used. The repetitive signal appears in one color and the anomalies 
appear in another. When fast acquisition is off, DPO improves the waveform display quality when 
long records are compressed for display with the 500 horizontal pixels in the graticule. The 
compression algorithm works with the intensity-graded display to show brighter pixels where 
many points have been compressed and dimmer pixels where fewer points have been compressed. 

Using Waveform Math 
—almost any live calculation that you can imagine 

Waveform math in the instrument can be as simple as basic arithmetic or as powerful as building a 
complicated math expression. 

With the Equation Editor, you can build a complicated math waveform expression using multiple 
waveform sources, constants, variables, operators, and functions. The waveform sources can be 
any channel, reference, or math waveform. You can enter constants with a keypad. Live results 
from the measurement system can be used as variables, and there is a full assortment of arithmetic 
operators and math functions to use. As you enter the waveform expression, you will see it appear 
as an equation in the control window. You can define up to four separate math waveforms (or two, 
if using a 2-channel model). 
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Using Spectral Analysis 
—operate the instrument like a spectrum analyzer. 

When you are displaying an FFT (spectral) math waveform, you can use either of these two ways 
to operate the instrument: 

 Use the conventional time-domain instrument controls, such as vertical and horizontal 
position and scale. 

 Use the spectrum analyzer controls, such as center frequency, span, resolution bandwidth, and 
reference level. 

When you use the spectrum analyzer control set, the instrument automatically sets its time domain 
parameters, including record length and sample rate, as necessary to give you the view of the 
spectral waveform that you want to see. And you can switch back to using the conventional time-
domain controls at any time. 

Spectral waveforms can be simple magnitude or phase waveforms calculated from the data 
acquired on a single channel. Or you can combine spectral operations with other math operations 
to do complex analysis of your signals. 

Characterizing a Signal 
—deriving statistical information from your signals 

Signal characterization begins with taking measurements. To gain even more insight into your 
measurements, you can add measurement statistics to calculate the average measurement value, 
the standard deviation, and the maximum range of the measurement value.  

Another way to characterize a signal is to compile a histogram from the acquired waveform. You 
can set up either a vertical histogram to analyze amplitude values or a horizontal histogram to 
analyze timing. As an example, the vertical histogram is useful for characterizing noise and the 
horizontal histogram is useful for characterizing jitter. 

While the histogram is being compiled from the acquired waveform, you can take continuous 
measurements on the histogram data to determine its mean value and other useful statistics. 

Mask and Limit Testing 
—applying masks and templates to waveforms for compliance testing 

Mask testing is used with communication signals. You can create your own user mask or (with 
Option SM) use industry standard masks for compliance testing.  

Limit testing allows you to compare the performance of products coming off a manufacturing line 
with a known good reference product or template.  

You can create any number of User masks and templates for future use, however, you can only use 
one mask at a time and only on one channel at a time. Limit testing can be done on all four 
channels at the same time.  
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Application-Specific Measurements 
—extending your measurement capability 

You can load optional measurement extensions as needed to enhance the capabilities of the 
instrument for specific applications. These applications build on the precision signal acquisition 
performance of the instrument to address your specific design requirements.  

Here are some examples of the application packages: 

 Jitter and Timing Analysis—Use the TDSJIT3 or TDSJIT3E software to characterize the 
timing performance of semiconductor systems. Analyze clock jitter, setup and hold times, and 
many other timing measurements on a cycle-by-cycle basis over long, single-shot 
acquisitions. Measurement statistics are presented as numerical statistics, or graphically in a 
histogram, cycle trend, time trend, or spectral plot.  

 Disk Drive Measurements—Use the TDSDDM2 software to measure disk drive signals 
according to IDEMA standards. 

 Optical Storage Analysis and Measurements—Use the TDSDVD software for automatic 
amplitude and timing measurements. 

 Ethernet Compliance Testing—Use the TDSET3 software to perform 10/100/1000 Base T 
Ethernet compliance testing. 

 USB2 Signals—Use the TDSUSB2 software to characterize USB2 signals including mask 
testing and parametric testing. 

 Mask and Measurement Compliance—Use the TDSCPM2 software for mask and 
measurements compliance testing for ITU-T G.703 and ANSI T1.102 communications 
standards. 

 Power Measurements—Us the TDSPWR3 software to quickly measure and analyze power 
dissipation in power supply switching devices and magnetic components. 

Additional packages may be available. Contact your Tektronix representative for more 
information. 

Connecting to a Network 
—as easy as networking a PC 

The instrument is built on a PC-based platform that runs Microsoft Windows as its operating 
system. Like any other Windows computer, you can connect the instrument to a network to enable 
printing, file sharing, Internet access, and other communications functions.  

To make a network connection, perform the steps to enable network access.  Consult your network 
administrator for assistance. 
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Printing Hard Copy 
—flexible printing options 

To make hard copies, use the optional built-in thermal printer, a printer attached to one of the rear-
panel ports, or connect to a network printer if your instrument is on a network. You can print the 
full screen, just the graticule area, or a long continuous waveform as a banner. Banner printing 
shows more detail, drawing samples that might otherwise overlap on the screen. Banners can only 
be printed on the integrated thermal printer. 

The instrument uses Windows print drivers, so the process to install printers is the same as it is on 
any other PC.  

The Page Setup dialog box contains some useful options to optimize your printing:  

 Choose a print palette that is independent from the display palette. For example, you can print 
grayscale images to a black and white laser printer while you choose to view the display in 
color. The color and grayscale palettes both render the intensity-graded waveform information 
generated by the DPO display. 

 Choose the Ink Saver feature to print a hard copy with a white background. This function 
saves printer ink while it preserves the color coding of the waveforms and readouts. Ink Saver 
also works with the monochrome print palettes. 

 Choose to print a Summary Waveform at either or both ends of your banner. This gives you a 
concise overall view of the instrument display before banner printing commenced. 

Using Other PC Applications 
—intuitive image and data transfer 

Transferring images and data from the oscilloscope to other PC applications is as simple as a 
copy/paste operation. With a word processing, spreadsheet, or analysis application running on the 
built-in PC, you can easily transfer these items using the familiar Windows clipboard system: 

 Copy a full screen or graticule-only image and paste it into your document in either .BMP, 
.PNG., PCX, .TIF, or .JPG format. 

 Copy a waveform and paste the waveform data into a spreadsheet in a comma-delimited 
(.CSV) format. 

 Copy a waveform and paste the waveform data into an analysis program in Mathcad (.DAT) 
format. 

 Copy the displayed measurements or a snapshot of all measurements and paste them into a 
document in text (.TXT) format. 

 Copy the displayed measurements or a snapshot of all measurements and paste them into a 
spreadsheet in a comma-delimited (.CSV) format. 
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Using a Second Monitor 
—the convenience of a built-in PC 

To optimize your access to the PC that is built into the oscilloscope, connect a keyboard, mouse, 
and monitor to the side panel of the instrument, and then configure Windows for dual-display 
mode. 

In this configuration, the oscilloscope retains full dynamic oscilloscope performance while 
Windows and other applications such as publishing, analysis, or Web browsing tools reside on the 
external monitor. You can copy/paste bitmaps and waveform data from the oscilloscope to the 
locally running application or view Web-based reference information while using the oscilloscope 
for design work. 

You can also drag up to five dockable HSCWs (half-screen control windows) from the TekScope 
application onto the display of the second monitor. For example, this feature allows you to have 
the Horizontal/Acquisition, the Horizontal Zoom, and the Display Setup Control Windows (half 
screen) open on the second monitor at the same time. In addition to the five dockable windows on 
the second monitor, you can have one dockable window open on the main display. If you open a 
seventh dockable window, the window that has not been used for the longest amount of time will 
automatically close. 

To drag an HSCW window, click and drag on the left edge of the window. 

Connecting to Other Instruments 
—useful connections to other instruments 

The oscilloscope provides four signal inputs and outputs that you can connect to other 
instrumentation: 

 Use the rear-panel vertical signal output (SIGNAL OUT) to connect to a buffered version of 
the signal that is attached to the Channel 3 input (4-channel models only). The typical output 
amplitude is 50 mV/div 20% into a 1 MΩ  load, or 25 mV/div ±20% into a 50 Ω load 

 Use the rear-panel auxiliary output (AUX OUT) to obtain a TTL-compatible, negative 
polarity pulse when the oscilloscope triggers.  

 Use the rear-panel external reference input (EXT REF) to synchronize the oscilloscope time 
base to an external 9.8  10.2 MHz reference frequency source. The reference input voltage 
range is 200 mV p-p to 7V p-p.  

 The trigger level range for the front-panel auxiliary input (AUX IN) is adjustable from +8 V 
to –8 V. The maximum input voltage is ±20 V. 
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TDS5000B Series Options 
You can order the following options with the oscilloscope: 

Hardware options 

FHD Front-panel removable hard drive 

18 Touch-screen interface 

1P Built-in thermal printer 

SM Serial Communication Mask Testing 

  

Acquisition memory options 

3M 16M/8M/4M on 1/2/4 channels  

Mounting options 

1K K420 oscilloscope cart with mouse accessory tray 

1R Rackmount kit 

  

Software options 

DVD TDSDVD—Optical storage analysis software 

J2 TDSDDM2—Disk drive measurements software 

JT3 TDSJIT3—Jitter & timing analysis with Rj/Dj and 
BER estimation 

J3E TDSJIT3E—Jitter & timing analysis software 
essentials 

PW3 TDSPWR3—Power measurement analysis 
software 

USB TDSUSBS—USB2.0 compliance test software 
only 

ET3 TDSET3— Ethernet compliance test software 

CP2 TDSCPM2—ANSI/ITU telecom pulse compliance 
software (Requires Option SM) 

Service options 

D1 Calibration data report 

C3 Additional 2 years of calibration 

D3 Calibration data report for Option C3 
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R3 Additional 2 years of repair 

C5 Additional 4 years of calibration 

D5 Calibration data report for Option C5 

R5 Additional 4 years of repair 

Local language manual options 

L1 French Quick Start User manual 

L3 German Quick Start User manual 

L5 Japanese Quick Start User manual 

L7 Simplified Chinese Quick Start User manual 

L8 Traditional Chinese Quick Start User manual 

L9 Korean Quick Start User manual 

L10 Russian Quick Start User manual 

You can order the following upgrade kits to extend the performance of your instrument after its 
initial purchase. Contact your local Tektronix representative for details and the most current 
information. 

To upgrade your instrument, order the TDS5UP Upgrade Kit and the appropriate option(s) from 
this list. You must order at least one option. 

TDS5UP 
Upgrade 

Description 

Option M03 Upgrade memory depth from standard to Option 
3M  

Option J2 Upgrade to TDSDDM2—Disk Drive 
Measurements software 

Option JT3 TDSJIT3 Advanced Jitter Analysis application 
with random and deterministic jitter analysis 

Option J3E TDSJIT3E Jitter and timing analysis software 
essentials 

Option PW3 Upgrade to Power Analysis Measurements 

Option 18 Touch-screen interface 

Option SM Serial Mask Communication Testing 

Option 1P Built-in thermal printer 

Option 
DVD 

TDSDVD-Optical storage analysis software 

Option USB TDSUSBS-USB2.0 compliance test software only 
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TDS5UP 
Upgrade 

Description 

Option IF Service installation of selected options 

Option 1K K420 oscilloscope cart with mouse accessory tray 

Option 1R Rackmount kit 

Option CP2 TDSCPM2: ANSI/ITU telecom pulse compliance 
software 

Option ET3 TDSET3 – Ethernet compliance test software 
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Controls and Connections 
Multipurpose Knobs 

 

 

The multipurpose knobs can be used to set screen interface parameters. 

To use, click a control on the screen to map it to the multipurpose knob(s). 
Note that they are automatically mapped when certain functions are 
performed, for example, when the MultiView Zoom button is pushed. You 
can undo any mapping by right-clicking the multipurpose knob(s) and 
selecting Deassign Multipurpose Knobs or from the Utilities menu select 
the Deassign Multipurpose Knobs command. The mapping is deassigned 
until your perform that function again. 

Turn the knob(s) or scroll with the mouse wheel until the desired selection appears in the readout 
mapped to the knob. Push the FINE button or click the mouse wheel to use the knob to make small 
changes, for example, to add another decimal place for greater accuracy. 

When no control windows are open and cursors are turned on, the multipurpose knobs control the 
cursor positions.  

Vertical Controls 
Use the VERTICAL controls to adjust the vertical display parameters of live data channels 
connected to the vertical inputs. Each input channel has identical controls. 

 

 
Use the dedicated channel (CH n) buttons to turn channel displays on and off. The 
channel button is lighted when the selected channel is on. 

 

Use the dedicated POSITION and SCALE knobs to adjust the vertical position and 
scale of the waveform. 

For channel waveforms (waveforms connected to the vertical inputs), the scale 
setting controls the vertical size of the acquisition window as well as the display 
scale. The range and resolution of the scale value depends on the attached probes 
and on any other external factors you have specified. 

For reference or math waveforms, the scale setting controls the display only. 
Scaling these waveforms has no effect on the acquisition hardware. 

 

Push the termination button to toggle the termination between 50 Ω and 1 MΩ. The 
correct termination is automatically set when you attach a probe with a TekProbe 
interface to the instrument. However, if you use other than a recommended probe, 
you may have to set the termination manually. In general, select 1 MΩ to use high 
impedance passive probes. Select 50 Ω to use most active probes and low 
impedance (Zo) probes. 
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Horizontal Controls 
Use the HORIZONTAL controls to adjust the horizontal parameters of waveforms. The horizontal 
controls globally affect all displayed waveforms. 

 

 

Use the dedicated POSITION knob to adjust the horizontal position of all 
waveforms. Use this knob to adjust the trigger point so that you can select the 
amount of pretrigger data or posttrigger data. In Delay Mode, this knob can be used 
to set the delay time. 

 

Use the dedicated SCALE knob to adjust the horizontal scale (time base) of all 
channel waveforms. For math and reference waveforms, only the selected 
waveform is scaled. 

 

Use the RESOLUTION knob to change the number of acquired points (record 
length) in the waveform, which changes the sample density. The actual resolution 
cannot be set directly but is derived and displayed on the horizontal readouts. 

 
Push the DELAY button to turn on horizontal delay and then use the POSITION 
knob to set the delay time. Delay is useful when you want to acquire waveform 
details that are separated from the trigger event by a significant interval of time.  

 

MultiView Zoom Controls 
Push the MultiView Zoom button to open a magnified window or windows in the lower half of the 
screen.  

  

The MultiView Zoom button is lighted when the Zoom mode is on.  

The HORIZ button opens the Zoom control window and assigns the multipurpose 
knobs to the horizontal position and scale controls in the Zoom graticule. 

The VERT button opens the Zoom control window and assigns the multipurpose 
knobs to the vertical position and scale controls in the Zoom graticule. 
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Trigger Controls 
Use the TRIGGER controls to set basic trigger parameters. 

 

By default, the instrument uses the Edge trigger. To return to the Edge trigger from 
any other A (main) event trigger, push the EDGE button. Pushing this button does 
not open the Edge Trigger control window unless another A event trigger is already 
displayed. 

 

  
To select other trigger types, push the ADVANCED button. The Trigger Setup 
control window shows the previously selected, nonedge trigger type. Select one of 
the advanced trigger types by clicking one of the Trigger Type buttons. 

 

 

Select the trigger source for 
the Edge trigger by pushing 
the up or down arrow 
buttons until the desired 
SOURCE is lighted. These 
buttons are only valid for 
the A event Edge trigger. 

 Select the trigger coupling 
for the Edge trigger by 
pushing the up or down 
arrow buttons until the 
desired COUPLING is 
lighted. These buttons are 
only valid for the A event 
Edge trigger. 

 

 

 

 

Push the button in the SLOPE column to toggle between positive and negative 
trigger slopes for the Edge trigger. The selected trigger slope is lighted. These 
buttons are only valid for the A event Edge trigger. 

 

Push the button under the MODE column to toggle between normal (NORM) and 
auto (AUTO) modes; the selected trigger mode is lighted. 

 

Push the LEVEL knob to set the trigger level to 50%. To set a different trigger 
level, rotate the LEVEL knob. The trigger level appears on the screen. The trigger 
level knob only affects the Edge, Width, Glitch, Timeout, and Video trigger types. 

 

Run Controls 
Use the Run controls to start, stop, and to monitor the status of acquisitions. 

 

Push the RUN/STOP button to start and stop acquisitions. Push the RUN/STOP 
button once to stop the acquisition; the instrument displays the number of 
acquisitions on the screen. Push the RUN/STOP button a second time to begin 
acquisitions again.  

Push the SINGLE button to run a single sequence of acquisitions. In Sample, Peak 
Detect, or High Res mode, the instrument acquires a waveform record with the first 
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trigger event and then stops. In Envelope, Average, or WfmDB mode, the instrument 
makes the specified number of acquisitions to complete the averaging or enveloping 
task, and then stops. 

 

The Acquisition Status lights indicate the state of the acquisition: 

 When TRIG’D is on, the instrument has recognized a valid trigger and is 
filling the posttrigger portion of the waveform. 

 When READY is on, the instrument can accept a valid trigger event and is 
waiting for the trigger event to occur. 

 When ARM is on, the instrument is filling the pretrigger portion of the 
waveform record. 

 When TRIG’D and READY are both on, the instrument has recognized a valid 
trigger and is waiting for a delayed trigger. When the instrument recognizes a 
delayed trigger, it will fill in the posttrigger portion of the waveform. 

 When ARM, TRIG’D, and READY are not on, the acquisitions have stopped. 

General Purpose Controls 
Use the following controls to do general-purpose tasks such as Autoset the instrument, print, and enable 
cursors. 

 
Push the AUTOSET button to automatically set up the instrument to 
obtain and display a stable waveform of usable size. For information on 
the Autoset default settings click Autoset. 

 
Push the DEFAULT SETUP button to reset the instrument to the factory 
default settings. 

 
Push the PRINT button to make a hard copy of the screen. The printed 
image is sent directly to the selected (internal or attached) printer. To 
change the print settings, click the File menu Print command and change 
the settings in the Print dialog box. 

 
Push the CURSORS button to enable cursors on the screen. The Cursor 
Type Setup control window opens so that you can specify the cursor 
parameters. 

 
Push the FastAcq button to turn Fast Acquisition On or Off. The FastAcq 
button is lighted when Fast Acquisition is turned on. 

 

Use the INTENSITY knob to adjust the brightness of the waveform. High 
intensity settings show less frequently acquired points more clearly. 
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Front Panel Connectors 
The instrument features these front panel connectors:  

  
 The trigger level range for the auxiliary input (AUX IN) is adjustable from +8 V to –8 V. The 

maximum input voltage is ±20 V. 

 Use the probe compensation terminals (PROBE COMP) to compensate, calibrate, and deskew 
passive or active voltage probes. 

 Connect up to four probes (two probes for 2-channel models) to input channels (CH n) of the 
instrument. Each vertical input channel has its own vertical control settings. Each probe input 
channel has its own TekProbe interface. 

 Use the ground (GND) terminal to connect the instrument to the same ground as the unit 
under test. 

Rear Panel Connectors 
 The instrument features these rear panel connectors:  

 
 Use the EXT REF connector to synchronize the instrument time base to an external 9.8 − 

10.2 MHz reference frequency source. The reference input voltage range is 200 mVp-p to 7Vp-p.  

 Use the AUX OUT connector to obtain a TTL-compatible, negative polarity pulse when the 
instrument triggers. 

 Use the SIGNAL OUT connector to connect to a buffered version of the signal that is 
attached to the Channel 3 input (4-channel instruments only). The amplitude is 50 mV/div 
±20% into a 1 MΩ load, or 25 mV/div ±20% into a 50 Ω load.  



 61

Side Panel Connectors 
The instrument features these side panel connectors:   

 

Use the PS-2 connectors to connect a PS-2 keyboard or a 
mouse to the instrument. 

 

   

 

Use the USB connectors to connect a USB mouse, a 
keyboard, or other USB devices to the instrument. 

Note 

Plug USB devices directly into the USB 
connectors on the instrument to improve 
reliability rather than connecting the devices 
serially. If the USB mouse locks up, disconnect 
and reconnect the USB connector to restore 
normal operation. If the instrument front panel 
and/ or touch screen do not respond, press the 
On/Standby switch for 5 seconds to cycle power. 

 

 

Use the upper VGA port to connect a monitor for 
extended desktop operation. For example, use the front 
panel to display the contents of the instrument and use the 
monitor for Windows operation. 

  

 

Use the COM1 serial port to connect to other devices 
through the serial port. 
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Use the parallel port (Centronics) to connect a printer or 
other device. 

 

 

Use the RJ-45 connector to connect the instrument to a 
network. 

  

Use the audio ports for stereo microphone input and 
stereo line output. 

 

  

 

Use the GPIB connector to connect the instrument to a 
GPIB controller for GPIB operation. 

 

  

 

 

Use the lower VGA port to obtain the instrument display 
for use with projectors or larger monitors. 

 

 

The CD-RW drive is accessible from Windows 2000. 
Press the cover to open the drive. 
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Optional Touch Screen 
If the optional touch screen is installed, you can use touch to control the instrument in addition to 
the front-panel controls, toolbar buttons, and menu options. Generally, touch can be used 
anywhere that click is mentioned in this online help. 

 

To disable the touch screen, push the front-panel TOUCH SCREEN OFF 
button. When the touch screen is off, the button is lighted. You can still 
access the on-screen menus with a mouse or keyboard. If the button is not 
present, the touch screen has not been installed on this instrument. 

To adjust the touch screen operation to your personal preferences, run the touch screen program 
from the shortcut on the Windows desktop or select Touch Screen from the Utilities menu. 

Note 

If the instrument is powered on in Windows Safe Mode, the touch screen is inoperative. You may 
need to use a mouse or keyboard to restore normal operation. 

On/Standby Switch 
 

  

 

Use this button to power the instrument on or to shut down 
(set the instrument to standby). 

Before shutting down, it is recommended that you first exit 
the instrument application and any other active Windows 
applications to avoid error messages on shutdown or the 
next power up.  

 To exit the instrument application and shut down in one step, select the File menu Shutdown 
command. 
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File Menu 
Use the File menu for basic file operations such as saving, recalling, and deleting waveforms or 
setups. You can also use the File menu for standard Windows operations such as printing files and 
loading the most recent setup. 

Reference Waveform Controls 
Access this control window from the File menu, Reference Waveform Controls… command. 

Overview 

Use the Reference Waveform controls to display and control reference waveforms. Reference 
waveforms are shown with the horizontal settings in effect at the time they are saved. You cannot 
adjust these settings. 

To Use 

Select the Ref 1-4 waveform from the list. Click On to display the Ref waveform. Click Position 
or Scale and use the multipurpose knobs to make adjustments. Enter a label for the waveform in 
the Label text box. Click Save to access the Save As dialog box and save the waveform as a 
Reference waveform or save it to a file. Click Recall to access the Recall dialog box and recall a 
waveform from memory. 

Behavior 

Clicking Save or Recall activates the respective dialog boxes. Typing a name in the Label text box 
places the label on the graticule. You can move the label on the graticule by clicking and dragging 
it. The label is saved with the Reference waveform. 

 To easily change the vertical position of a reference waveform, click the waveform handle on the 
left side of the screen, and drag the waveform to the new position. To easily change the vertical 
scale of a reference waveform, click the waveform handle, and then use the multipurpose knobs 
to change the waveform scale. You can also use the multipurpose knobs to change the waveform 
position. 

Save As Dialog Box: Waveform 
Access this control window from the File menu, Save As control or from the Reference Waveform 
controls, Save button. 

To Use 

Use this dialog box to save a waveform to a reference location or to a specified folder. To save to 
a reference location, select the Source, and then click the reference location in oscilloscope 
memory.  

To save to a file, enter a file name, use the default file name, or select Auto-increment file name if 
you want to save a series of files without typing in a new name each time. The file extension 
specified in the Save as type list will automatically be appended to the file name. 
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Behavior 

This dialog box opens when you select Save As from the File menu or click Save from the 
Reference Waveform controls. The default file type is a Tektronix waveform file (.wfm). If you 
select a different file type from the Save as Type list, you can also define the options for saving the 
waveform.  

The default folder for reference waveforms is C:\TekScope\Waveforms. The following file 
formats are available: 

• .wfm. Internal instrument formats 

• .csv. Usable by spreadsheets such as Microsoft Excel 

• .dat. Usable by Mathcad and MATLAB 

• .txt. Standard text file format 

Note 

Any characters that you enter in the file name box become part of the file name. The instrument 
does not use any user-defined file extensions. 

Recall Dialog Box: Waveform 
Access this control window from the File menu, Recall control or from the Reference Waveform 
controls, Recall button. 

To Use 

Use this dialog box to recall a saved waveform file to a reference location. From the Destination 
list, select the Ref 1-4 location that you want to recall the waveform to. The default folder for 
reference waveforms is C:\TekScope\Waveforms. Use the pop-up keyboard to enter a file name, 
or click the file name to select it. 
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 If you don’t see the file that you want to recall, check that the Files of type list shows the correct 
file format. You may also need to check other folders if the file was stored in a location other 
than the C:\TekScope\Waveforms folder. 

Behavior 

This dialog box opens when you click Recall from the File menu or when you click the Recall 
button from the Reference waveform controls. Waveforms are stored in WFM file format, which 
is an internal format of the instrument. When you click Recall, the Ref 1-4 waveform is displayed 
in the graticule.  

Note 

When you recall a reference waveform, a temporary file containing the waveform data is written 
to C:\TekScope\Waveforms. The file is named TDS_REFn.WFM, where n is the reference 
waveform number. This file is deleted when the reference waveform is deleted. 

Save As Dialog Box: Instrument Setup  
Access this control window from the Save toolbar button or the File menu Save As command. 

Overview 

Use the Save As dialog box to save instrument setups for later use.  

To Use 

To save in Oscilloscope memory, click one of the setup location icons under Save in Oscilloscope 
Memory. If you want to rename the setup, click the keyboard icon, and enter a label for the setup. 
Click Enter, and then click Save. To save the setup in a different location, select the location from 
the Save in list. Enter a name in the Name text box, and then click Save. 
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Behavior 

You can display up to ten saved instrument setups in this dialog box. Additional setups can be 
saved to the hard drive. When you save a setup, the label adjacent to the setup icon changes from 
its previous value to User. You can save setups to any location labeled Factory without 
overwriting a saved setup. 

The data in reference waveforms is not saved with the instrument setup. However, the setup 
information does include which reference waveforms are turned on and which reference 
waveforms are used with math waveforms and automatic measurements. If you want to save the 
reference waveform data, save the reference waveform separate from the instrument setup. 

The instrument preference settings are not saved with the setup. They are saved when the 
instrument power is powered off.  

Note 

Before saving an instrument setup, make sure that the location does not contain a setup that you 
have previously saved. The previously saved setup will be overwritten. 

Recall Dialog Box: Instrument Setups 
Access this dialog box from the Recall toolbar button or the File menu Recall command. 

Overview 

Use the Recall dialog box to recall instrument setups. 

To Use 

Setups are recalled from an internal file on your hard drive or from a setup file that you have 
named. Click one of the icons under Look in Oscilloscope Memory, and then click Recall to 
restore the setup. To recall the default factory setup for the instrument, click the Factory Defaults 
icon.  
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Select the File menu Recall Default Setup command to instantly restore the default setup. 

To recall an instrument setup from a file, select the location of the setup from the Look in list. 
Select the setup you want to recall, and then click Recall. 

  

Behavior 

The setups are restored from an internal file on your hard drive as soon as you click Recall. The 
labels adjacent to the icons were created when the setups were first saved. Any of the setups with 
the label "Factory" will restore the default factory setups. 

The data in reference waveforms is not saved with the instrument setup. However, the setup 
information does include which reference waveforms are turned on and which reference 
waveforms are used with math waveforms and automatic measurements. If you want to save the 
reference waveform data, save the reference waveform separate from the instrument setup. You 
can then recall the saved waveform to the setup from the Reference Waveform Controls. 

Note 

If a restored setup attempts to use an undefined reference waveform (or to use it in a math 
waveform or with an automatic measurement), then an undefined reference waveform is created. 
This reference waveform becomes a 500-point waveform filled with null data. Any math 
waveforms or any measurements done on this waveform will contain invalid or unusable data. 
However, you can recall a valid saved waveform to the new reference waveform so that the math 
waveforms and the automatic measurements will become valid. 

Delete Setups and Reference Waveforms 
Access this command from the File menu. 
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To Use 

Select the setup or reference waveform that you want to delete from the Delete command on the 
File menu. To delete all Setups at the same time, select All Setups, to delete All Reference 
Waveforms at one time select All Refs. 

Behavior 

You can only delete setups and reference waveforms stored in oscilloscope memory from this 
command.  

Setups or waveforms stored in Windows directories can be deleted by clicking the  in the Save 
or Recall dialog boxes 

Page Setup Dialog Box 
Overview 

Use the Page Setup dialog box to define the page setup before sending the data to a printer. 

To Use 

The controls in this window are similar to the Page Setup dialog box in most Windows 
applications. The Paper settings are dependent on the type of printer connected to the instrument. 
A reduced preview image appears at the top of the window. To view a larger image, click Print 
Preview at the bottom of the window. 

Click Print when you have selected all of your desired settings. 

Behavior 

The Type of printing should be Screen-copy for all screen shots. Banner printing should only be 
used to print long continuous waveforms on the integrated thermal printer. For instructions on 
printing banners, see Printing Banners. 

Print Preview Dialog Box 
Overview 

Use the Print Preview dialog box to preview an image before sending the data to a printer. 

To Use 

Use the controls at the top of the window to zoom in and out to view the details of the image. To 
return to the Page Setup dialog box, click Page Setup at the top of the control window. Click Print 
to open the Print dialog box. 

Print Dialog Box 
Overview 

Use the Print dialog box to send data to a printer. 
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To Use 

The controls in this window are similar to the Print dialog box in most Windows applications. The 
settings are dependent on the type of printer connected to the instrument.  

Behavior 

If you have the integrated printer installed, the default Name is Integrated Thermal Printer. The 
integrated printer is available as an option for your instrument.  

Using Print Screen 
Overview 

If you have an attached keyboard you can use the Print Screen (Prt Sc) key to copy the screen 
contents to the Windows clipboard. This bitmap does not include the waveforms or graticule. The 
waveforms and graticule are displayed by the graphics adapter outside of normal Windows 
mechanisms. 

To Use 

To capture the instrument screen with its graticule and waveforms, use the Edit menu Copy 
command after selecting Image in the Copy Setup menu, or to build a bitmap file, select the File 
menu Save As command. Click Options under Screen Capture, and then select Full Screen under 
View. For additional information see Save As Dialog Box: Screen Captures  

You can display the current date and time on screen so that they appear on hard copies you print. 
To do this, toggle the Display Date/Time button On from the Display Setup control window 
Objects tab. If you need to reset the date and time for any reason, right-click on the date and time 
and then select Set Date/Time. 

Behavior 

Pressing the Print Screen key on an attached keyboard copies the screen image minus the 
waveform and graticule to the Windows clipboard. Using the Edit menu Copy command copies 
the screen image with the waveform and graticule.  

Save As Dialog Box: Screen Capture 
Access this dialog box from the File menu Save As command. 

Overview 

Select Screen Capture to save images to a file for use with other applications. 

To Use 

Select Screen Capture from the Save As dialog box, and then click Options…. Select the palette 
for the image: Color, Grayscale, or Black & White.  

Select the image under View. To save an image of the entire screen, select Full-screen; to select an 
image of the selected graticule, select Graticule(s) only. If you want to save the image without 
including the Menu bar or Toolbar, select the Hide Menu/Toolbar check box. 

Select the type of image from the Image list. To save the image exactly as it appears on the screen, 
select Normal. To export the image on a white background, select Ink-Saver Mode. 
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Select a file type from the Save as type drop-down list. 

Assign your own file name, and then save the file to a specified folder. By default, the image will 
be saved to C:\TekScope\ScreenCaptures. Click Save to save the screen capture or cancel to 
close the dialog box without saving. 

  

Behavior 

The Palette, View, and Image selections are identical to those in the Page Setup dialog box. 

Current file types are .bmp, .jpg, .pcx, .png, and .tif. 

Waveform Options Dialog Box 
Access this dialog box from the Save As dialog box, Waveform Options button. 

Overview 

Use the Waveform Save Options dialog box to set the parameters for the waveform that you want 
to save. 

To Use 

Select the data format (Data destination) for the waveform that you want to save. Select a valid 
waveform from the Source list.  

Select the number of samples that you want to save under Waveform Data Range. Select a range 
of samples, only the samples between the cursors, samples from a specific Zoom Area, or all 
samples. If you select Samples between cursors, you can use the multipurpose knobs to adjust the 
positions if the cursors are already active. If they are not, the cursors are activated in their most 
recent positions. 

Select Spreadsheet (TXT) to include spreadsheet data separated by white space. Select 
Spreadsheet (CSV) to include spreadsheet data separated by commas. 
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Select the Include waveform scale factors check box if you want to include waveform details like 
header information (record length, sample interval, trigger point information, and so on). If you 
only want to include the waveform voltage values, clear the selection. 

If you are saving Fast Acquisition data, select the data ordering from the list. 

After making the above selections, click OK to return to the Save As dialog box where you can 
assign your own file name and save the waveforms to a specified folder. By default, the file is 
saved to the C:\TekScope\Waveforms folder.  

Behavior 

The waveform data is saved as numeric values. The data destination that you select here is the file 
type selection used in the Save As dialog box. Use the Save As dialog box to finalize the 
selections and to save the waveform to a file. 

Save As Dialog Box: Measurement 
Access this dialog box from the File menu Save As command. 

Overview 

Select Measurement to save the measurement to a file for use with other applications. 

To Use 

Click Options to set the parameters of the measurement that you want to save. In the 
Measurement Save Options dialog box, select the Measurement Format from the drop-down list 
for the measurement that you want to save.  

Select either Displayed Measurements or Measurements Snapshot. 

After making the above selections, click OK to return to the Save As dialog box. Use the default 
name or enter a unique in the Name text box. Select the type of file (either .txt or .csv) to save 
from the Save as type list. By default, the file will be saved to the C:\TekScope\Data folder. Click 
Save to accept any changes and close the dialog box. 

Behavior 

When you select Displayed Measurements, all displayed measurements are saved. 

When you select Measurement Snapshot, the current snapshot data is saved. If there is no valid 
snapshot data, the default snapshot values are exported. 

Save As Dialog Box: Histogram 
Access this dialog box from the File menu Save As command. 

To Use 

To save histogram data with the default file name, click Save. To enter a different file name, click 
the keyboard icon and use the pop-up keyboard or select Auto-increment file name if you want to 
save a series of files without typing in a new name each time. The file extension specified in the 
Save as type list will automatically be appended to the file name. 
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Behavior 

Histogram data is saved in C:\TekScope\data unless you select a different location. To access the 
Histogram Save As dialog box, you may need to select it from the More submenu. 

Save As Dialog Box: Timestamp 
Access this dialog box from the File menu Save As command. 

To Use 

To save a Timestamp Table with the default file name, click Save. To enter a different file name, 
click the keyboard icon and use the pop-up keyboard or select Auto-increment file name if you 
want to save a series of files without typing in a new name each time. The file extension specified 
in the Save as type list will automatically be appended to the file name. 

Behavior 

Timestamp tables are saved in C:\TekScope\data unless you select a different location. To access 
the Timestamp Save As dialog box, you may need to select it from the More submenu. 

Auto-increment file name 

Select Auto-increment file name to save numerous similar files without retyping the entire file 
name each time.  

Enter a Base file name and click Save. For the initial save the default count is 000, but you can 
overwrite this number if you choose. Your first file is saved as [Basefilename][count].ext, where 
ext is the file extension. On subsequent saves, the instrument searches for the highest numbered 
file name and increases the number by one, as in Basefilename001.ext. 

For example, if you are saving a series of rise time data files, you can use "Risetime" as the base 
file name. Your first file is saved as Risetime000.ext, where ext is the file type extension. The next 
file will be Risetime001.ext, and so on. 

If Count reaches 999, it is suggested that you change the base file name to Basefilename1 (for 
example, Risetime1) on the next save. Your next file will then be saved as Risetime1000.ext. You 
will receive a warning message if you are going to overwrite any files with the same name.  
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Edit Menu 
Use the Edit menu for copying images, waveforms, or measurements to the clipboard for use in 
other applications. You can select items from the menu or you can select Copy Setup to fine tune 
the parameters with the Copy Setup control window before copying items to the clipboard.  You 
can also use the Edit menu to clear data and undo the last Autoset. 

Clear Data control 
Access this control from the Edit menu. 

Use the Clear Data control to reset waveform, measurement, and histogram data, mask hit data, 
template violations, persistence, statistics, mask pass/fail test data, and limit test pass/fail data. The 
Clear data control only clears the accumulated data; it does not turn off any functions. 

 

Copy Setup: Images 
Access this control window from the Edit menu. 

Overview 

Use this control window to copy images to the clipboard for use with other applications. 

To Use 

Select the Palette for the image: Color, Grayscale, or Black & White.  

Select the type of View. To copy an image of the entire screen, select Full-screen; to copy an 
image of the selected graticule, select Graticule(s) only. 

Select the type of Image. To copy the image exactly as it appears on the screen, select Normal. To 
copy the image on a white background, select InkSaver Mode. To copy the image on a white 
background with colors especially designed to print on the white background, click InkSaver with 
Enhanced Waveform Color. 

Bitmap is the only available Data Format.  

Behavior 

The Palette, View, and Image selections are identical to those in the Page Setup dialog box and in 
the Screen Capture Save Options dialog box. The copy operation takes place after you click Copy. 
Clicking OK saves the changes and closes the dialog box but does not copy the image. 

Copy Setup: Waveforms 
Access this control window from the Edit menu Copy Setup command. 

Overview 

Use this control window to copy waveforms to the clipboard for use with other applications. 

To Use 

The Data Destination (data format) is set to Spreadsheet. Select a valid waveform from the Source 
list.  
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Select the number of samples that you want to copy. Select all samples, a range of samples, or 
only the samples between the cursors. If you select Data between cursors, you can use the 
multipurpose knobs to adjust the positions if the cursors are already active. If they are not, the 
cursors will be turned on at the positions they were in the last time they were used. 

Select the Include waveform scale factors check box if you want to include waveform details such 
as header information (record length, sample interval, trigger point information, and so on). If you 
only want to include the waveform voltage values, clear the selection. 

If you are copying Fast Acquisition data, select the data ordering from the list. 

Behavior 

The Waveform curve data range can be anywhere from one sample to the record length of the 
selected waveform. 

The copy operation takes place after you click Copy. 

If you select Data between cursors, another set of cursors may temporarily appear on your screen 
while the copy is in progress. 

Copy Setup: Measurements 
Access this control window from the Edit menu. 

Overview 

Use this control window to copy measurements to the clipboard for use with other applications. 

To Use 

Select the data format for the measurement that you want to copy. For Histogram Data, the data 
format is always CSV. 

Select the type of measurement.  

Behavior 

When you select Displayed Measurements, all displayed measurements will be copied to the 
clipboard. 

When you select Measurement Snapshot, the current snapshot data is copied to the clipboard. If 
there is no valid snapshot data, the default snapshot values will be sent to the clipboard.  

When you select Histogram Data, the histogram data for the waveform will be copied in the CSV 
format. 

The copy operation takes place after you click Copy. Clicking the OK button accepts the changes 
and closes the dialog box but does not copy the measurements. 
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Autoset Undo Control Window 
This control window opens automatically after an Autoset operation. 

   

Overview 

Use this control window to undo the last Autoset operation.  

To Use 

Click Undo. Only the parameters that were set by the last Autoset are undone. 
Parameters that you changed that are not controlled by Autoset retain their 
settings. 

Behavior 

The Autoset Undo control window remains on the screen until you open 
another control window. After Autoset Undo closes, you can still undo the last 
Autoset by selecting the Undo Last Autoset command from the Edit menu or 
the Horiz/Acq menu. Although the last Autoset is immediately undone, the 
Autoset Undo control window does not open again. 
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Vertical Menu 
Use the Vertical menu options to set vertical parameters for waveforms. This menu also provides 
access to the Zoom controls and the probe calibration, deskew, and attenuation functions. 

Vertical Setup Control Window 
Access this control window from the Vertical menu Vertical Setup command, or the Vert toolbar button. 

Overview 

Use the Vertical Setup control window to set the vertical parameters for live (channel) waveforms. 
The controls for each channel are independent. Use the tabs at the top of the control window to 
select the channel you want to change. 

  

Zoom Setup Control Window 
Access this control window from the Vertical or Horiz/Acq menu Zoom Setup command. 

Overview 

Use the Zoom Setup control window to define the overall settings of the Zoom controls. 

  

To Use 

Click the Zoom 1 – 4 tabs to set up each zoom area. The controls under each tab apply only to that 
zoom area. Click the Zoom (1-4) Display On to turn on the display of that area. (MultiView Zoom 
must also be turned on to display any of the zoom areas.) Use the Zoom Source drop-down list to 
select a source for the zoomed area. Click the Zoom button On to turn on Zoom. You can also 
toggle Zoom on and off with the MultiView Zoom button on the front panel. 
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Use the Channel drop-down list under Vertical to select which waveform (Ch1-4, Math1-4, or 
Ref1-4 on 4-channel instruments or Ch 1-2, Math 1-2, or Ref 1-2 on 2-channel instruments) the 
Vertical Position and Factor controls adjust.  

The Position and Factor controls change the position and factor (or scale) in the Zoom area. They 
can be adjusted with the multipurpose knobs. To reset the Position and Factor controls, click 
Reset. 

Select the size of the Acquisition and Zoom windows from the Graticule Size drop-down list. 
Select 80-20 to allocate 80% of the available display for the zoomed graticule and 20% for the 
acquisition window. Select 50-50 to allocate half of the available display for the zoomed graticule 
and half of the available display for the acquisition window. Select Full to use the entire display 
for the zoomed graticule.  

Click the Zoom Lock and Scroll tab to scroll the zoomed area(s). To scroll a single zoomed area, 
select the zoom area (1-4), and then click an Auto Scroll button. You can also set the scroll speed. 
To scroll multiple zoomed areas simultaneously, click Lock, and then click the zoomed areas (1-4) 
you want to scroll through. This locks the zoomed areas in their relative horizontal positions. 

 Use the Vertical or Horiz/Acq menu Zoom Graticule Size submenu to directly access the 
Graticule Split options.  

Behavior 

Use the Zoom Setup control window to magnify (zoom in on) a waveform without changing the 
main acquisition parameters. Use Zoom when you want to temporarily look at details of a 
waveform.  

If the zoom areas are unlocked, the Horizontal Position and Factor controls affect only the selected 
zoom area. The Horizontal Position and Factor will affect all zoom areas that are locked together, 
such that a change to one zoom area will change the horizontal position and factor of all the locked 
zoom areas.  

On the Vertical Zoom tab, the Scale and Factor controls only affect the selected waveform. 
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Zoom Control Window 
Access this control window from the Vertical or Horiz/Acq menu Zoom Controls command, or push the 
front-panel MultiZoom button. 

  

Overview 

Use the Zoom control window to set the position and factor of the 
selected waveform in the Zoom window, select the Zoom Area and 
Source, and to lock and scroll the zoomed areas. 

To Use 

Click Horiz to set the Horizontal Zoom controls or Vert to set the 
Vertical Zoom controls. Select the Zoom Area from the Area drop-
down list. The changes you make in this control window apply only to 
the zoom area selected. Use the Zoom Source drop-down list to select 
the waveform or Zoom area that you want to zoom in on. Adjust the 
Position and Factor controls using the multipurpose knobs. Click Setup 
to display the Zoom Setup control window where you can access 
additional Zoom controls. 

Behavior 

The Factor and Position controls only affect the waveforms in the 
lower (Zoom) window. To change the Factor and Position controls in 
the upper (Acquisition) window, use the front panel HORIZONTAL or 
VERTICAL POSITION and SCALE knobs. You can access the 
controls for both the Acquisition and Zoom windows from the front 
panel. Selecting Zoom (1-4) as the Zoom Source allows you to zoom 
on zoom.  

 You can easily zoom in on a waveform by clicking and dragging a box around the area of 
interest. Then select Zoom (1-4) from the shortcut menu. 



 80 

AutoScroll Control Window 
Access this control window from the Vertical or Horiz/Acq menu Zoom Controls command, and then 
click the Scroll tab. 

  

Overview 

Use the AutoScroll control window to set the scroll speed and lock 
zoomed areas together. 

To Use 

To scroll a single zoomed area, select the zoom area (1-4), and then 
click an Auto Scroll button. You can also set the scroll speed. To scroll 
multiple zoomed areas simultaneously, click Lock, and then click the 
zoomed areas (1-4) you want to scroll through. This locks the zoomed 
areas in their relative horizontal positions. 

Behavior 

If the zoom areas are unlocked, the Horizontal Position and Factor 
controls affect only the selected zoom area. The Horizontal Position 
and Factor will affect all zoom areas that are locked together, such that 
a change to one zoom area will change the horizontal position and 
factor of all the locked zoom areas.  
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Graticule Zoom Control Window 
Access this control window from the Vertical or Horiz/Acq menu, Graticule Size submenu, Size 
command. 

  

To Use 

Click one of the Graticule Size buttons to set the proportion of the 
display area for the acquisition window and zoom window. Click Setup 
to access the Zoom Setup control window. 

Behavior 

Click the 50-50 button to allocate half of the available display for the 
zoomed graticule and half of the available display for the acquisition 
window. Click 80-20 to allocate 80% of the available display for the 
zoomed graticule and 20% for the acquisition window. Click Full to 
use the entire display for the zoomed graticule. 

 

Waveform Display Control Window 
Access this control window from the Vertical menu Display On/Off command. Display On/Off is also 
available on the Math menu. 

 

Overview 

Use the Waveform Display control window to turn the selected 
waveform on or off. 

To Use 

Click Display to turn the selected waveform on or off. Use the Channel 
Selector tabs to select a valid channel, math, or reference waveform.  

Behavior 

The Display button applies only to the selected waveform. Each 
waveform (channel, math, or reference) has its own Display button.  

Any displayed channel, math, or reference waveform can be turned off 
without impacting any math functions, measurements, or histograms 
done on that waveform. You may want to turn some waveform displays 
off to make the remaining waveforms easier to view and analyze. 

 Use the dedicated front panel buttons to turn the channel waveforms on or off. 
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Waveform Label Control Window 
Access this control window from the Vertical menu Label command. Label is also available on the Math 
menu. 

 

Overview 

Use the Waveform Label control window to attach a label to the 
waveform. 

To Use 

Use the Channel Selector tabs to select a valid channel, math, or 
reference waveform. Assign a label to the selected waveform with the 
pop-up keyboard to make it easier to identify on the screen. Click the 
X Pos and Y Pos controls to activate them and use the multipurpose 
knobs to position the label on the graticule. You can also position the 
label anywhere on the screen by clicking and dragging it to the 
desired location. 

Behavior 

The label applies only to the selected waveform. Each waveform 
(channel, math, or reference) has its own label. If you do not enter a 
label for the selected waveform, the label will be left blank. A label 
only appears when its associated waveform is turned on. 

The X Pos and Y Pos control values are relative to the upper-left corner of the display. The values 
are expressed in pixels. 

Position/Scale Control Window 
Access this control window from the Vertical menu Position/Scale command. Position/Scale is also 
available on the Math menu. 

  

Overview 

Use the Position/Scale control window to set the vertical position 
and scale of the selected waveform.  

Use the Channel Selector tabs to select a waveform. 

In addition to using the controls in this control window, you can also 
use the dedicated controls on the front panel to perform the same 
functions. 
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Position/Scale Control Window: Position 

 

To Use 

Use the Position control to set the vertical position of the selected 
waveform. Click the control to map it to one of the multipurpose 
knobs, and then use the knob to move the waveform. 

Behavior 

The Position control moves the vertical position of the waveform 0.2 divisions (0.02 divisions 
with FINE control). Increasing the position value moves the waveform up, and decreasing the 
position value moves the waveform down. 

The Position control differs from the Offset control; for information on the Offset control for 
channel waveforms refer to the Vertical Offset Control Window on page 84. 

 Several alternatives are available for adjusting the position of a waveform: 
• Use the dedicated knob on the front panel for the selected waveform. 
• Enter a value with the onscreen pop-up keypad. 
• Use an attached keyboard to type a value directly into the position field. 

Position/Scale Control Window: Scale 

 

To Use 

Use the Scale control to set the vertical scale value of the selected 
waveform. Click the control to map it to one of the multipurpose 
knobs and use the knob to move the waveform.  

Behavior 

Each waveform has its own vertical scale parameter. For a signal with constant amplitude, 
increasing the scale causes the waveform to appear smaller. Decreasing the scale causes the 
waveform to appear larger. 

The scale affects all waveforms, but affects channel waveforms differently: 

 For channel waveforms, the scale setting controls the vertical size of the acquisition window 
as well as the display scale. The range and resolution of the scale value depends on the 
attached probes and any other external factors you may have specified. 

 For reference or math waveforms, the scale setting controls the display only. Scaling these 
waveforms has no affect on the acquisition hardware. 

 Several alternatives are available for adjusting the scale of a waveform: 

 Use the dedicated knob on the front panel for the selected waveform. 

 Enter a value with the onscreen pop-up keypad. 

 Use an attached keyboard to type a value directly into the position field. 
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Vertical Offset Control Window 
Access this control window from the Vertical menu Offset command.  

 

Overview 

Use the Vertical Offset control window to set the offset value of the 
selected waveform to shift the vertical acquisition window to match the 
waveform data you want to acquire. 

To Use 

Click a Channel button to select the vertical input channel. Click the 
Offset control to map it to one of the multipurpose knobs, and use the 
knob to set the offset value. 

Behavior 

The main purpose of the Offset control is to eliminate clipping the 
waveform. The Offset control affects the vertical acquisition window by 
subtracting a DC bias from the waveform. This moves the level at the 
vertical center of the acquisition window of the selected channel. 
Visualize offset as scrolling the acquisition window toward the top of a 
large signal for increased offset values, and scrolling toward the bottom 
for decreased offset values. 

The Offset control affects the waveform display by defining the channel reference indicator to match the 
offset rather than the ground level. The offset affects only channel waveforms as compared to the position 
control that affects all waveforms, including math and reference waveforms. The range of the vertical offset 
available depends on the vertical Scale setting. 

Termination Control Window 
Access this control window from the Vertical menu Termination command. 

 

Overview 

Use the Termination control window to select the channel input 
resistance (50 Ω or 1 MΩ). 

To Use 

Click a Channel button at the top of the control window to select the 
vertical input channel. If you are not using a probe with a TekProbe 
interface, click one of the Termination buttons to set the termination for 
your probe. 

Behavior 

The correct termination is set automatically when you attach a probe 
with a TekProbe interface to the instrument. However, you may have to 
set the termination manually if you use a probe without the TekProbe 
Interface. In general, select 1 MΩ to use high impedance passive 
probes. Select 50 Ω to use most active probes and low impedance (Zo) 
probes. 
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Note 

The 50 Ω termination becomes an open circuit if you set the channel input coupling to GND. 

Consider the following when using 50 Ω termination with any channel: 

 The instrument does not accurately display frequencies under 200 kHz with AC coupling. 

 The instrument reduces the maximum vertical scale setting for the channel to 1 V from 10 V 
(to 10 V from 100 V with a 10 X probe attached), since the amplitudes appropriate for the 
higher settings would overload the 50 Ω input. 

 The instrument switches to 50 Ω and disables AC coupling (and switches coupling to DC if 
AC is selected) if you connect an active probe. The active probes also reduce the maximum 
vertical scale setting as described above. This behavior results in 50 Ω, nonAC coupling, 
which is appropriate for active probes. 

Note 

If you remove an active probe, the instrument does not switch coupling back to 1 MΩ or AC. 
When you restore 1 MΩ coupling, the instrument does not return to the vertical scale setting that 
was reduced because of the 50 Ω selection. You must set the vertical scale, coupling, and 
termination appropriate for your input coupling scheme. Be sure to switch to 1 MΩ for any input 
signal not from a 50 Ω system. 

 Use the button on the front panel of each vertical input channel to manually select the 
termination. 

Coupling Control Window 
Access this control window from the Vertical menu Coupling command. 

 

Overview 

Use the Coupling control window to select the coupling for the signal 
from the attached probe to the instrument. 

To Use 

Click a Channel button at the top of the control window to select the 
vertical input channel. Click one of the Coupling controls to couple 
the signal from the probe to the instrument. 

Behavior 

Select DC coupling to display the waveform with the DC and AC 
components. 

Select AC coupling to display the waveform with the DC component 
removed. 

Select GND to display a zero-volt waveform. Use this selection to 
establish the ground reference point on the display 
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Bandwidth Control Window 
Access this control window from the Vertical menu Bandwidth command. 

 

Overview 

Use the Bandwidth control window to filter unwanted high 
frequency noise from the waveform and to decrease the noise 
bandwidth. Specify the range of frequencies that you want to 
acquire by selecting the appropriate button in the control 
window. 

To Use 

Click a Channel button at the top of the control window to 
select the vertical input channel. Click one of the Bandwidth 
buttons to select the bandwidth of frequencies that you want to 
acquire. 

Behavior 

The bandwidth refers to the range of frequencies that the 
instrument can acquire and display accurately with less than 
3dB attenuation. Each input channel has its own bandwidth 
selection.  

To acquire all frequencies on the selected channel, click Full. To limit frequencies above 150 
MHz, click 150 MHz; to limit frequencies above 20 MHz, click 20 MHz. 

To take accurate measurements, the input frequency should be much less than the rated bandwidth 
of the instrument. A good rule to follow is to ensure the bandwidth of the instrument system is 
three to five times the bandwidth of the signal that you want to measure. 
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Probe Calibration Control Window 
Access this control window from the Vertical menu Probe Cal command. 

 

Control Window Overview 

Use the Probe Calibration control window to check the probe 
status and to compensate the entire signal path, from the probe 
tip to digitized signal, to improve the probe gain and offset 
accuracy. 

Probe calibration is one of several features of the instrument 
that can optimize measurement accuracy. In addition to the 
probe calibration, you should also perform the following 
procedures: 

 Probe Compensation. Use this procedure with passive 
probes to compensate them to ensure maximum distortion-
free inputs to the instrument and to avoid high frequency 
amplitude errors. 

 Signal Path Compensation. Use this procedure to 
compensate the internal signal path used to acquire 
waveforms based on the ambient temperature. 

 Probe Deskew. Use this procedure to compensate probes for 
delays due to differences in cable length. 

The Probe Status control indicates the status of the probe calibration for the selected channel. If 
the probe status does not indicate Pass, the instrument may not take accurate measurements. You 
may want to perform the probe calibration procedure before taking any measurements with the 
selected probe. 

Probe Calibration Control Window: Probe Status 
To Use 

The Probe Status control provides information on the status of the probe connected to the vertical 
input channel. This control provides information only; the data in the control cannot be changed 
directly. 

Behavior 

The instrument automatically detects the type of probe that you have installed and displays the 
probe status information.  

 Initialized. The instrument was unable to detect any information from the probe in its 
memory. This message often appears when you connect a probe where you have not 
performed the probe calibration. You should perform the probe calibration before you use the 
probe. This message also appears when you disconnect a probe from the vertical input. 

 Pass. The instrument recognized the probe information stored in nonvolatile memory and that 
the probe had previously passed the probe calibration procedure. 

 Fail. The instrument was unable to complete the probe calibration procedure. If the Fail 
message appears, try performing the signal path compensation procedure before continuing 
with the probe calibration. If the Fail message still appears after performing the probe 
calibration procedure, you may have a faulty probe. You should have the probe checked by 
Tektronix service personnel. 
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Probe Calibration Control Window: Probe 
Calibration 

To Use 

Click a Channel button at the top of the control window to select the vertical input channel for the 
attached probe. Connect the probe tip to the appropriate signal and ground connections of the 
probe compensation terminals. Click Clear Probecal to clear the old calibration values. Then click 
Calibrate Probe to begin the calibration procedure. 

Behavior 

The instrument lets you compensate the probe, based on the channel to which it is connected, to 
improve the gain and offset accuracy of the probe. When you perform the probe calibration on the 
selected channel with the probe attached, you can optimize the instrument to make accurate 
measurements using that channel and probe. The probe calibration makes significant performance 
improvements when performed with active probes or older passive probes. 

You should perform a probe calibration any time you want to ensure that the measurements you 
take are made with the most accuracy possible. You should also perform the probe calibration if 
you have changed probes since the last time a probe calibration was performed. 

 If you are compensating a passive probe, you must first compensate the low frequency response 
of the probe. Refer to the Probe Compensation Procedure on page 355 for more information. 

Some types of probes can be gain compensated, some can be offset compensated, and some can be 
compensated for both. If the probe has a TekProbe interface, the instrument can determine the type 
of compensation needed and will display the appropriate instructions when you perform the probe 
calibration procedure. Some probes cannot be compensated; for information on these probes, refer 
to probe calibration restrictions on page 95. 
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Deskew Control Window 
Access this control window from the Vertical menu Deskew command. 

 

Overview 

Use the Deskew control window to compensate for propagation delays 
of different length probes connected to the vertical input channels. 

To Use 

Connect the probes to a signal source. Use the horizontal and vertical 
controls to center the fastest signal on the screen. Click a channel button 
at the top of the control window to select the slower channel. Use the 
multipurpose knob to adjust the deskew time so that the two signals 
align. To clear the deskew value, click Set to 0.0s. 

Behavior 

Each input channel has its own deskew settings. Deskew compensates 
individual channels for probes or cables of different lengths. The 
instrument applies the delay values after each completed acquisition. 
The deskew values, which have a range of ±75 ns, do not affect 
triggering or the XY display format. 

The deskew values are saved as part of the instrument setup. The deskew values for the selected 
channel will be retained until you change the probe, you restore a saved setup, or you recall the 
factory setup. 

Deskew is supported in Fast Acquisitions mode when you acquire one or two channels. If you 
acquire three or more channels, the Fast Acquisition mode is turned off and the message, Deskew 
not applied in FastAcq when three or more channels are acquired, is displayed. When you switch 
back to acquiring one or two channels, the message, Deskew is re-enabled, is displayed and 
deskew values are applied again. 
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Attenuation Control Window 
Access this control window from the Vertical menu Attenuation command. 

 

Overview 

Use the Attenuation control window to describe the input/output ratio of 
any external attenuation or gain between the signal and input channels. 

To Use 

Click a channel button at the top of the control window to select the 
vertical input channel for the attached probe. To set the external 
attenuation as a multiplier or ratio, use the multipurpose knob to enter a 
value in the top control. To set the external attenuation as dB values, use 
the multipurpose knob to enter a value in the lower control. To set the 
external attenuation to the default value, click Set to Unity. 

Behavior 

Each input channel has its own external attenuation settings. The 
attenuation control is automatically set to the correct value when you 
attach a probe with a TekProbe interface to the instrument.  

You can change the external attenuation by entering a multiplier or ratio in the top control, or by 
entering a dB value in the lower control. When you return the attenuation to the default value, the 
multiplier returns to 1, and the dB value returns to 0. 

Display On/Off 

  

To Use 

Click Display to turn the channel waveform display on and off. Assign 
a label to the waveform with the pop-up keyboard to make it easier to 
identify on the screen. Set the units of vertical scale in the Units text 
box. 

Behavior 

The tab selector at the top of the Vertical Setup window identifies the 
channel waveform source. The Display button, the label, and units 
apply only to the selected waveform.  

Each waveform (channel, math, or reference) has its own Display button, label, and units. If you 
do not enter a label for the selected waveform, the label will be left blank. You can position the 
label anywhere on the graticule by clicking and dragging it to the desired location. 

Any displayed channel waveform can be turned off without impacting any math functions, 
measurements, or histograms done on that waveform. You may want to turn some waveform 
displays off to make the remaining waveforms easier to view and analyze. 

 Use the dedicated front-panel CH buttons to turn the channel waveforms on or off. 
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Vertical Position/Scale 

 

To Use 

Use the Position control to set the vertical position of the waveform, and 
the Scale control to set the vertical scale. Click on the controls and use 
the multipurpose knobs to change the waveforms.  

Behavior 

Each waveform has its own vertical Position control. The control increases or decreases the 
vertical position of the waveform 0.2 divisions (0.02 divisions using the FINE knob). Increasing 
the position value of the waveform moves the waveform up, and decreasing the position moves 
the waveform down. 

Each waveform also has its own vertical Scale control. For a signal with a constant amplitude, 
increasing the scale causes the waveform to appear smaller. Decreasing the scale causes the 
waveform to appear larger. 

For channel waveforms, the scale setting controls the vertical size of the acquisition window as 
well as the display scale. The range and resolution of the scale value depends on the attached 
probes and any other external factors that you may have specified. 

 Use the dedicated POSITION and SCALE knobs on the front panel to control the position and 
scale of the selected waveform. 

Offset 

 

To Use 

Use the Vertical Offset controls to set the offset value of the selected 
waveform to shift the vertical acquisition window to match the 
waveform data that you want to acquire. 

Click a channel at the top of the control window to select the vertical input channel. Click the 
Offset control to map it to one of the multipurpose knobs, and use the knob to set the offset value. 

Behavior 

Use the Offset control to eliminate clipping the waveform. The offset control affects the vertical 
acquisition window by subtracting a DC bias from the waveform. This moves the level at the 
vertical center of the acquisition window of the selected channel. Visualize offset as scrolling the 
acquisition window toward the top of a large signal for increased offset values and scrolling 
toward the bottom for decreased offset values. 

The offset control affects the waveform display by defining the channel reference indicator to 
match the offset rather than the ground level. The offset affects only channel waveforms as 
compared to the position control that affects all waveforms, including math and reference 
waveforms. 
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Termination 

 

To Use 

Use the Termination controls to select the channel input resistance (50 Ω or 
1 MΩ). In general, select 1 MΩ to use high impedance passive probes. Select 
50 Ω to use most active probes and low impedance (Zo) probes. 

Note 

The 50 Ω termination becomes an open circuit if you set the channel input coupling to GND. 

Behavior 

The correct termination is set automatically when you attach a probe with a TekProbe interface to 
the instrument. However, you may have to set the termination manually if you use a probe without 
a TekProbe Interface.  

Consider the following when using 50 Ω termination with any channel: 

 The instrument does not accurately display frequencies under 200 kHz with AC coupling. 

 The instrument reduces the maximum vertical scale setting for the channel to 1 V from 10 V 
(to 10 V from 100 V with a X10 probe attached), since the amplitudes appropriate for the 
higher settings would overload the 50 Ω input. 

 The instrument switches to 50 Ω and disables AC coupling (and switches coupling to DC if 
AC is selected) if you connect an active probe. The active probes also reduce the maximum 
vertical scale setting as described above. This behavior results in 50 Ω, nonAC coupling, 
which is appropriate for active probes. 

 Use the front-panel button for each vertical input channel to manually select the termination. 

Channel Invert 

  

To Use 

Use the Invert button to toggle inversion of the selected channel 
waveform. 

Behavior 

When Invert is On, the selected waveform appears mathematically inverted (flipped) on the zero 
volt axis. No trace of the normal waveform is left on the screen. Set Invert to Off to view the 
normal waveform. 

An inverted channel waveform can be used for math or measurement functions. But if used as a 
trigger source, the normal, not inverted, waveform is used. 



 93

Coupling Setup 

 

To Use 

Use the Coupling controls to couple the signal from the attached probe to the 
instrument. 

Behavior 

Select DC to display the waveform with the DC and the AC components. 
Select AC to display the waveform with the DC component removed. 

Select GND to display a zero-volt waveform. Use this selection to establish the ground reference 
point on the display. 

Note 

The 50 Ω channel input termination becomes an open circuit when you select GND coupling. 

Bandwidth 

 

To Use 

Use the Bandwidth controls to filter unwanted high frequency noise from 
the waveform and to decrease the noise bandwidth. Specify the range of 
frequencies that you want to acquire by clicking the appropriate button in 
the control window. 

Behavior 

The bandwidth refers to the range of frequencies that the instrument can 
acquire and display accurately with less than 3dB attenuation. Each input 
channel has its own bandwidth selection.  

To acquire all frequencies on the selected channel, click Full. To limit frequencies above 
150 MHz, click 150 MHz; to limit frequencies above 20 MHz, click 20 MHz. 

To take accurate measurements, the input frequency should be much less than the rated bandwidth 
of the instrument. A good rule to follow is to ensure the bandwidth of the instrument system is 
three to five times the bandwidth of the signal that you want to measure. 

Probe Controls 

 

The Probe controls provide access to the Probe Calibration, Deskew, and 
Attenuation control windows.  

Use the Probe Calibration control window (Cal) to check the status of the 
attached probe and to compensate the entire signal path from the probe tip 
to the digitized signal. 

Use the Deskew control window to compensate the vertical channels for 
propagation delays of different length probes. 

Use the Attenuation control window (Atten) to change the default 
attenuation or gain for the selected probe channel. 
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Channel Invert Control Window 
Access this control window from the Vertical menu Invert command. 

  

Overview 

Use the Channel Invert control window to invert a live channel 
waveform. 

To Use 

Click one of the channel buttons to select a valid channel. Click Invert 
to toggle inversion of the selected waveform. 

Behavior 

When Invert is On, the selected waveform appears mathematically 
inverted (flipped) on the zero volt axis. No trace of the normal 
waveform is left on the screen.  

 

Using Offset to Avoid Clipping Signals 

 

Clipping 

The circled portion of the 
incoming waveform is clipped, 
and therefore, is not acquired.  

The clipped portion cannot be 
processed or displayed.  

Offset can move the acquisition 
window vertically relative to 
the incoming waveform.  

 

Offset removes clipping 

By setting an offset to vertically 
shift the acquisition positive 
relative to the waveform, the 
clipped portion can be acquired. 

Position, which up to now has 
been unchanged, can be used to 
position the graticule anywhere 
in the acquisition window.  
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High Impedance Probes 
Most general-purpose probes have high input impedance. The high input resistance of passive 
probes (typically 10 MΩ) provides negligible DC loading and provides accurate DC amplitude 
measurements. Most passive probes require the instrument input impedance to be 1 MΩ. 
However, their 8 pF to 12 pF (over 60 pF for 1X) capacitive loading can distort timing and phase 
measurements. Use high resistance passive probes for measurements involving the following: 

 Device characterization (above 15 V, thermal drift applications) 

 Maximum amplitude sensitivity using 1 X probe 

 Large voltage range (between 15 V and 500 V) 

 Qualitative or go/no-go measurements 

Low Impedance Probes 
Most low impedance (Zo) passive probes measure frequencies or timing measurements more 
accurately than general-purpose probes, but they take less accurate amplitude measurements. They 
offer a higher bandwidth to cost ratio. 

The low input impedance passive probes must be terminated in a 50 Ω instrument input. Input 
capacitance is much lower than high impedance passive probes, typically 1 pF, but input resistance 
is also lower (500 Ω to 5000 Ω typically). Although that DC loading degrades amplitude accuracy, 
the lower input capacitance reduces high frequency loading to the circuit under test. That makes 
low input impedance passive probes ideal for timing and phase measurements when amplitude 
accuracy is not a major concern. Low input passive impedance probes are useful for measurements 
up to 40 V. 

Active Probes 
Active voltage probes often contain preamplifiers that provide high resistance and low capacitance 
at the probe tip. Some active voltage probes contain differential amplifiers that provide high 
Common Mode Rejection Ratio (CMRR).  

Active current probes often contain Hall-effect sensors that extend the probe bandwidth down to 
DC. 

Many active probes, especially high frequency probes, can drive a 50 Ω instrument input. 

Probe Calibration Restrictions 
Some probes cannot be calibrated or compensated. This might be because the probes have an 
attenuation factor greater than 20X. You will get an error message if you try to compensate such a 
probe. 

The instrument cannot compensate for probes that may have gain and/or offset errors that are too 
great (>2% or >50 mV offset). If these errors are within the specified limits of your probe, you 
may want to use another probe. If the errors are outside the limits, have your probe checked by 
service personnel. 

Probe calibration is not recommended for the P5050 passive probe. This probe typically has little 
gain and offset error, and therefore, the performance improvement after a probe calibration is not 
worth the time needed to do the probe calibration. 
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Horizontal/Acquisition Menu 
Use the Horizontal/Acquisition menu options to set the horizontal and acquisition parameters for 
waveforms. This menu also provides access to the Zoom controls, Autoset, FastFrame, and Fast 
Acquisitions. 

Horizontal/Acquisition Setup Control Window 
(Horizontal Tab) 

Access this control window from the Horiz/Acq menu Horizontal/Acquisition Setup command, or the 
Horiz toolbar button. 

Overview 

Use the Horizontal/Acquisition Setup control window to set the horizontal and acquisition 
parameters of waveforms. The horizontal and acquisition controls are common to all channels.  

  

The Horizontal tab controls manage the horizontal setups such as scale and position. Normally, the 
horizontal axis displays time information. However, in some cases, the horizontal axis can 
represent frequency rather than time.  

Record Length 

 

To Use 

Click Rec Length to map it to one of the multipurpose knobs and use the 
knob to change the record length. You can also use the 
increment/decrement buttons beneath the control, or the pop-up keypad. 
The record length specifies the number of sample points that make up the 
waveform record. 

Behavior 

The maximum record length depends on the following: 

 The amount of memory 

 The ability to combine the memory length of unused channels 

 The number of frames selected in FastFrame mode 
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Hi Res mode requires twice the acquisition memory of other acquisition modes. When you select 
Hi Res mode, the instrument sets the record length accordingly to keep it from running out of 
memory.  

Record lengths of less than 500 samples are not supported except in FastFrame, where Frame 
Length can be set as low as 50 samples. 

When you change the record length, you can choose to hold either the sample rate or the 
horizontal scale constant. The remaining variables will change in response to the record length 
changes. See User Preferences: Record Length on page 222 to make this choice. 

Horizontal Scale 

 

To Use 

Click the Scale control to map it to one of the multipurpose knobs and 
use the knob to change the value. You can also use the 
increment/decrement buttons beneath the control or the pop-up 
keypad. 

Behavior 

Use the Scale control to adjust the time base. This control scales all live displayed waveforms 
(both channel and math waveforms). You can use the Horizontal Zoom control window to change 
the horizontal scale and position of reference waveforms within the Zoom window(s). 

When the horizontal delay is off, the scale expands or contracts around the trigger point. When the 
horizontal delay is on, the scale expands or contracts around the horizontal reference point.  

The scale units depend on the waveform type. In most cases the horizontal units will be time, but 
they can also be frequency.  

 Use the dedicated front-panel HORIZONTAL SCALE knob to change the horizontal scale. 

Horizontal Control Window Readouts 

 

To Use 

You cannot change the readouts of the Horizontal controls directly. The 
readout values are determined by other Horizontal control settings. 

Behavior 

Use the horizontal readouts to obtain a quick overview of the horizontal 
settings. 

Resolution is similar to the acquisition interval. It can be thought of as the 
time between sample points. In most cases, the acquisition interval is the 
same as the resolution.  

Sample Rate is the number of acquisition samples per second. The faster the 
sample rate, the more accurately the instrument can represent fine details in 
a fast signal.  

Duration specifies the time across the 10-division screen.  
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Horizontal Delay and Horizontal Position 
To Use 

Use the multipurpose knob or the front-panel HORIZONTAL POSITION knob to set the 
horizontal position when the horizontal Delay Mode is Off. 

When Delay is On, use the multipurpose knobs to set the Horiz Delay (Horizontal Delay) and the 
Ref Point (Reference Point).  

Behavior 

The Position control moves the trigger point within the acquired waveform. Use the control to 
select the amount of data that appears before the trigger event. 

The Horiz Delay and Ref Point controls only appear when the Delay Mode is On. Horiz Delay 
enables the instrument to look for a trigger and then wait a specified time before acquiring data. 
This is useful when you know that the data you are interested in occurs a set time after the trigger. 
Use the Ref Point control to specify the amount of pretrigger data. The reference point is 
represented on the screen by a small inverted triangle. 

 Use the dedicated DELAY button to turn the Horizontal Delay on and off. Or, use the Horiz/Acq 
menu Delay Mode On command. 

 Toggle Horizontal Delay on and off to quickly compare signal details at two different areas of 
interest, one near the trigger location and the other centered at the delay time. 

Horizontal Position/Scale Control Window 
Access this control window from the Horiz/Acq menu Position/Scale command. 

 

Overview 

Use the Horizontal Position/Scale control window to set the 
horizontal position and scale of displayed waveforms. You can 
also use it to turn on horizontal delay so the acquisition window 
can be focused on events that occur at a fixed delay after the 
trigger point. 

The dedicated controls on the front panel also perform the same 
functions. 

For information on Delay Mode control see page 99, on Position 
control see page 99, and on Scale control see page 99 . 
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Horizontal Position/Scale Control Window: Delay 
Mode Off 

When horizontal delay is off, the horizontal position control moves the trigger point within the 
acquired waveform. The horizontal scale control expands or contracts the waveform around the 
trigger point.  

When horizontal delay is on, you can delay the acquisition relative to the trigger event. For more 
information on horizontal delay, see Horizontal Position/Scale Control Window: Horiz Delay. 

Horizontal Position/Scale Control Window: 
Position 

 

To Use 

Click the Position control to map it to a multipurpose knob and use 
the knob to change the position.  

Behavior 

The horizontal position control moves the trigger point within the acquired waveform. You can 
select the amount of data that appears before and after the trigger event. To acquire waveforms 
leading up to the trigger event, set the horizontal position control to the maximum time setting. To 
acquire waveforms after the trigger event, set the horizontal position control to the minimum time 
setting. 

The horizontal reference point is shown as a small inverted triangle. 

 Use the dedicated front-panel POSITION knob to change the horizontal position. 

Horizontal Position/Scale Control Window: Scale 

 

To Use 

Click the Scale control to map it to a multipurpose knob and use the 
knob to change the scale. You can also use the increment/decrement 
buttons beneath the control or the pop-up keypad. 

Behavior 

Use the Scale control to adjust the time base. The Scale control scales all live displayed 
waveforms at the same time.  

The scale units depend on the waveform type. In most cases the horizontal units will be time. 
However, the horizontal units can also be frequency. 

 Use the dedicated front-panel HORIZONTAL SCALE knob to change the horizontal scale. 



 100

Horizontal Position/Scale Control Window: Delay 
On 

Access this control window from the Horizontal menu. 

 

Overview 

Use the Horizontal Position/Scale control window to set the horizontal 
delay and the horizontal scale of the displayed waveforms when the 
horizontal delay is on. 

The dedicated controls on the front panel also perform the same 
functions. 

For information on Delay Mode control see page 100 and on Scale 
control see page 101. 

. 

 

Horizontal Position/Scale Control Window: Horiz 
Delay 

 

To Use 

Click Delay Mode or push the front-panel DELAY button to activate 
horizontal delay. Click the Horiz Delay control, and use the 
multipurpose knob to set the delay time. You can also use the 
dedicated HORIZONTAL POSITION knob on the front panel.  

  

Behavior 

Use the Horiz Delay control to delay the acquisition relative to the trigger event. The horizontal 
delay feature is useful when you want to acquire waveform details that are separated from the 
trigger event by a significant interval of time. 

For example, you can trigger the instrument on a sync pulse that occurs once every 10 ms, and 
then look at the high-speed characteristics that occur 6 ms after the pulse. 

 A convenient way to use the horizontal delay is to make quick comparisons between two 
different points in time. Trigger the instrument on one area of interest and then set the horizontal 
delay to acquire the other area of interest. You can then toggle the horizontal delay on and off to 
compare details at the two points in time. 
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Horizontal Position/Scale Control Window: Scale 
Delay On 

 

To Use 

Click the Scale control to map it to a multipurpose knob and use 
the knob to change the scale. You can also use the 
increment/decrement buttons beneath the control or the pop-up 
keypad. 

Behavior 

Use the Scale control to adjust the time base. This control scales all live displayed waveforms at 
the same time.  

When horizontal delay is on, the scale expands or contracts around the horizontal reference point 
instead of the trigger point.  

The scale units depend on the waveform type. In most cases the horizontal units will be time. 
However, the horizontal units can also be frequency. 

 Use the dedicated front-panel HORIZONTAL SCALE knob to change the horizontal scale. 

Resolution Control Window 
Access this control window from the Horiz/Acq menu Resolution command. 

Overview 

Use the Resolution control window to select the number of samples per division for all acquired 
waveforms. 

 

To Use 

Use the multipurpose knob to adjust the Record Length. 

Behavior 

The Duration, Sample Rate, and Resolution controls are readouts only. 
Their settings are impacted by other controls. 

Duration specifies the time across the 10-division screen. 

Sample Rate specifies the number of samples per second that will be 
acquired for each waveform. The faster the sample rate, the more 
accurately the instrument can represent fine details in a fast signal.  

Resolution is similar to the acquisition interval. It can be thought of as 
the time between sample points. In most cases, the acquisition interval is 
the same as the resolution.  

Record Length specifies the total number of samples in the waveform 
acquisition. The maximum record length depends on the amount of 
memory in the instrument. 
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Because the instrument can only store a finite number of waveform data points, there is a trade-off 
between the waveform details and the record length. You can acquire either a detailed picture of a 
waveform for a shorter period of time or a less detailed picture for a longer period of time.  

Acquisition Mode Control Window 
Access this control window from the Horizontal/Acquisition menu Acquisition Mode command. 

  

Overview 

A single waveform data point can be made up of several sequentially 
acquired data points. The waveform data points can also be created from 
a composite of sampled data taken from multiple acquisitions. The 
acquisition modes determine how the waveform data points are produced 
from the sampled data. 

To Use 

Select the acquisition mode by clicking the appropriate button. If you use 
Average or Envelope mode, select the number of waveforms for that 
mode using the multipurpose knob. If you use Waveform Database mode, 
select the number of samples using the multipurpose knob. 

Behavior 

In Sample mode, the instrument creates a record point by saving one or 
more samples during each acquisition interval. Sample mode is the 
default acquisition mode. The instrument does no post processing of the 
acquired samples in this mode.  

In Pk Detect (Peak Detect) mode, the acquisition alternates between saving the highest sample in 
one acquisition interval and the lowest sample in the next acquisition interval. Peak Detect mode 
only works with real-time, noninterpolated sampling. 

The Hi Res (High Resolution) mode averages all samples taken during an acquisition interval to 
create a record point. This average results in a higher-resolution, lower-bandwidth waveform. This 
mode only works with real-time, noninterpolated sampling. 

Model Signal and input conditions Effective bits 

TDS5032B, 
TDS5052B, 
TDS5034B, 
TDS5054B 
TDS5054BE 

1 MHz, 9.2 div, 5 
GS/s sample rate, 
Sample acquisition 
mode 

6.8 bits 

 1 MHz, 9.2 div, 10 
MS/s sample rate, Hi 
Res acquisition mode 

9.1 bits 

TDS5052B, 
TDS5054B, 
TDS5054BE 

500 MHz, 6.5 div, 5 
GS/s sample rate, 
Sample acquisition 
mode 

6.5 bits 

   



 103

Model Signal and input conditions Effective bits 

TDS5032B, 
TDS5034B 

350 MHZ, 6.5 div, 5 
GS/s sample rate, 
Sample acquisition 
mode 

6.5 bits 

TDS5104B 1 MHz, 9.2 div, 5 
GS/s sample rate, 
Sample acquisition 
mode 

6.6 bits 

 1 MHz, 9.2 div, 10 
MS/s sample rate, Hi 
Res acquisition mode 

9.0 bits 

 1 GHz, 6.5 div, 5 
GS/s sample rate, 
Sample acquisition 
mode 

4.7 bits 

 

In Average mode, the instrument acquires and displays a waveform record that is the average 
result of several acquisitions. This mode reduces random noise. Use the multipurpose knob to 
specify the number of waveforms that you want to average. 

In Envelope mode, the instrument acquires and displays a waveform record that shows the 
extremes in variations over several acquisitions. The instrument saves the highest and lowest 
values in two adjacent intervals similar to the Peak Detect mode. Unlike Peak Detect mode, the 
peaks are gathered over many trigger events.  

After each trigger event, the instrument acquires data and then compares the minimum and 
maximum values from the current acquisition with those stored from the previous acquisition. The 
final display shows the most extreme values for all the acquisitions for each point in the waveform 
record. 

In Waveform Database mode, the instrument acquires and displays a waveform that is the 
accumulation of several acquisitions. In addition to time and amplitude, the waveform displays a 
count of the number of times a specific sample point has been acquired. The value at each point on 
the waveform is a counter that reflects the hit intensity. The instrument acquires data after each 
trigger event using Sample mode. It then determines the location of each sample point and 
accumulates it with shared data from previous acquisitions. This is the only mode that can be used 
when doing mask testing with an optical standard. Fast Acq is inhibited in Waveform Database 
mode. 
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Horizontal/Acquisition Setup Control Window 
(Acquisition Tab) 

Access this control window from the Acquisition tab of the Horizontal/Acquisition control window. 

Overview 

Use the Acquisition tab to set the acquisition setups of all live waveforms. The Acquisition 
controls are common to all channels. This means that you cannot acquire in Sample mode on 
channel 1 while channel 2 acquires in Envelope mode. 

  

Acquisition is the process of sampling the analog input signal, digitizing the signal to convert it 
into digital data, and then assembling the signal information into a waveform record. The 
instrument creates a digital representation of the input signal by sampling the voltage level of the 
signal at regular time intervals. The sampled and digitized points are stored in memory along with 
the corresponding timing information. The instrument uses the digital representation of the signal 
for display, measurements, or for further processing. 

Use the controls on this tab to define the sampling method, the acquisition mode, turn Fast 
Acquisitions on or off, access the FastFrame Setup control window, and activate an external 
reference. 

Acquisition Mode 

 

To Use 

Click a button to select the acquisition 
mode. If you use Average or Envelope 
mode, select the number of waveforms for 
that mode using the multipurpose knob. If 
you use Waveform Database mode, use 
the multipurpose knob to select the 
number of samples. 
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Behavior 

A single waveform data point can be made up of several sequentially acquired data points. The 
waveform data points can also be created from a composite of sampled data taken from multiple 
acquisitions. The acquisition modes determine how the waveform data points are produced from 
the sampled data. 

In Sample mode, the instrument creates a record point by saving one or more samples during each 
acquisition interval. Sample mode is the default acquisition mode. The instrument does no post 
processing of acquired samples in this mode. 

In Peak Detect mode, the acquisition alternates between saving the highest sample in one 
acquisition interval and the lowest sample in the next acquisition interval. Peak Detect mode only 
works with real-time, noninterpolated sampling. 

The Hi Res (High Resolution) mode averages all samples taken during an acquisition interval to 
create a record point. This average results in a higher-resolution, lower-bandwidth waveform. This 
mode only works with real-time, noninterpolated sampling. 

Note 

A key advantage of Hi Res mode is its potential for increasing resolution regardless of the input 
signal. The following table indicates that you can obtain up to 15 significant bits with Hi Res 
mode. Note that the resolution improvements are limited to speeds slower than 40 ns/div. 
Additional resolution bits 

40 ns and faster 8 bits >550 MHz 

80 ns to 200 ns 9 bits >110 MHz 

400 ns to 1 µs 10 bits >22 MHz 

2 µs to 4 µs 11 bits >5.5 MHz 

10 µs to 20 µs 12 bits >1.1 MHz 

40 µs 13 bits >550 kHz 

100 µs to 200 µs 14 bits >110 kHz 

1 µs and slower 15 bits <55 kHz 

In Average mode, the instrument acquires and displays a waveform record that is the average 
result of several acquisitions. This mode reduces random noise. Use the multipurpose knobs to 
specify the number of waveforms that you want to average. 

In Envelope mode, the instrument acquires and displays a waveform record that shows the 
extremes in variations over several acquisitions. The instrument saves the highest and lowest 
values in two adjacent intervals similar to Peak Detect mode. Unlike Peak Detect mode, the peaks 
are gathered over many trigger events.  

After each trigger event, the instrument acquires data and then compares the minimum and 
maximum values from the current acquisition with those stored from the previous acquisition. The 
final display shows the most extreme values for all the acquisitions for each point in the waveform 
record. 



 106

Acquiring and displaying a noisy square wave signal illustrates the difference between the modes. 
Note how Envelope mode reduces the noise while Average mode captures its extremes: 

  

In Waveform Database mode, the instrument acquires and displays a waveform that is the 
accumulation of several acquisitions. In addition to time and amplitude, the waveform displays a 
count of the number of times a specific sample point has been acquired. The value at each point on 
the waveform is a counter that reflects the hit intensity. The instrument acquires data after each 
trigger event using Sample mode. It then determines the location of each sample point and 
accumulates it with shared data from previous acquisitions. This is the only mode that can be used 
when doing mask testing with an optical standard. Fast Acq is inhibited in Waveform Database 
mode. 

Fast Acquisitions 
To Use 

Click the button under Fast Acquisitions to turn Fast Acquisitions mode on and off; this has the 
same effect as pushing the front-panel FastAcq button.  

Behavior 

Fast Acquisitions mode keeps the dead time between acquisitions very short. This improves the 
chances of acquiring infrequent events. When Fast Acquisitions are turned on, the front-panel 
FastAcq button is lighted.  

If Fast Acquisitions mode is on and you attempt to activate a feature that conflicts with this mode, 
Fast Acquisitions mode will be inhibited. When the conflicting feature is turned off, in most cases, 
Fast Acquisitions will resume. The following bullet items describe some interactions: 

 Measurements are supported in Fast Acquisitions mode when you display one or two 
channels. If you display three or more channels, Fast Acquisitions mode is turned off, and the 
measurements are displayed. Fast Acquisitions mode is automatically enabled when you 
switch back to displaying one or two channels. 

 Histograms are supported in Fast Acquisitions mode when you display one or two channels. If 
you display three or more channels, Fast Acquisitions mode is turned off, and the histograms 
are displayed. Fast Acquisition mode is automatically enabled when you switch back to 
displaying one or two channels. 

 Deskew is supported in Fast Acquisitions mode when you acquire one or two channels. If you 
acquire three or more channels, Fast Acquisition mode is turned off and the message, Deskew 
not applied in FastAcq when three or more channels are acquired, is displayed. When you 
switch back to acquiring one or two channels, the message, Deskew is re-enabled, is displayed 
and deskew values are applied again. 

 Use the Horiz/Acq menu Fast Acquisitions selection to directly toggle this mode on or off. 
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Roll Mode 

 

To Use 

To enable Roll mode, click Auto on the Acquisition tab of the 
Horizontal/Acquisition control window. Roll mode then starts 
automatically when the resolution is equal to or greater than 2 ms, 
the acquisition mode is Sample or Peak Detect, and 1 or 2 channels 
are on. For Hi Res mode, Roll mode starts when the resolution is 4 
ms or greater. The resolution appears near the lower-right corner of 
the graticule and is controlled by the RESOLUTION knob. Use 
untriggered roll mode to continuously observe a slow process. 
Apply math and measurement operations after you stop the 
acquisition. 

When Roll mode is on, the Acquisition Status Indicator Readout displays Roll. 

 Use the Horiz/Acq menu Roll Mode Auto command to directly toggle this mode. 

Behavior 

Roll mode lets you see acquired data without waiting for the acquisition of a complete waveform 
record. It gives you immediate feedback. For slow time base settings, Roll mode provides a rolling 
display similar to a strip-chart recorder.  

When using Roll mode, you do not have to wait for slow acquisitions to fill the display. When 
Roll mode is enabled, the instrument displays newly acquired data points at the right edge of the 
display while moving the older waveform data points to the left.  

Using single sequence with roll mode causes the acquisition to automatically stop after a complete 
waveform record is acquired. Roll mode is useful when observing a slow process where you 
always want to see the most recent view of that process. Roll mode with single sequence is useful 
to save data for later viewing. For example, at 20 seconds per division and 30 K record length, 
there are 12000 seconds of acquired data points. 

The resolution, record length, horizontal scale, and number of active channels are dependent 
variables. Therefore, the fastest horizontal scale setting when Roll mode starts is 40 ms/div, the 
record length is 500 (resolution is 200 µs), the acquisition mode is either Sample or Peak Detect, 
and 1 or 2 channels must be on. As the record length or the number of on channels grows, the time 
per division required to enter Roll mode is slower as shown in the following table.  

 

1 or 2 
Channels 
On 

 
Resolution 

Record 
Length 

Horizontal 
Scale 

Sample or 
Peak Detect 

 
Hi Res 

 2 ms 500 100 ms/div Yes No 

 2 ms 2000 400 ms/div Yes No 

 2 ms 5000 1 s/div Yes No 

 2 ms 50000 10 s/div Yes No 

 2 ms 100000 20 s/div Yes No 
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 4 ms 500 200 ms/div Yes Yes 

 4 ms 2500 1 s/div Yes Yes 

 4 ms 5000 2 s/div Yes Yes 

 4 ms 50000 20 s/div Yes Yes 

 4 ms 100000 40 s/div Yes Yes 

3 or 4 
Channels 
On 

 

 

4 ms 

 

 

500 

 

 

200 ms/div 

 

 

Yes 

 

 

No 

 4 ms 2500 1 s/div Yes No 

 4 ms 5000 2 s/div Yes No 

 4 ms 50000 20 s/div Yes No 

 4 ms 100000 40 s/div Yes No 

 8 ms 500 400 ms/div Yes Yes 

 8 ms 5000 4 s/div Yes Yes 

 8 ms 25000 20 s/div Yes Yes 

 8 ms 50000 40 s/div Yes Yes 

The maximum record length where Roll mode is allowed is 8 M. 

Interactions of Roll Mode and Other Instrument 
Settings 

Roll mode can interact with other instrument settings:  

 If Roll mode is on and you turn on Fast Acquisitions, Roll mode will be suppressed until you 
turn Fast Acquisitions off. 

 If Roll mode is on, math waveforms and measurements are updated only after acquisition is 
stopped (when you manually stop an acquisition). If you stop an acquisition before a record is 
filled, the math waveform or measurements will be calculated on the partial data. 

 Roll mode is only valid for real-time acquisition modes such as Sample, Peak Detect, and Hi 
Res. Roll mode is ignored in Average or Envelope acquisition modes. 

 Roll mode is suppressed when FastFrame is on. 

 Deskew values are ignored when Roll mode is on. 

 If you attempt to save a waveform when Roll mode is on, only the waveform points in the 
acquisition memory are saved. 
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Incompatible Acquisition Features 
The following table shows which acquisition features and modes are incompatible with other 
features or modes: 

Incompatible with Control/Feature Explanation 

Reference Waveforms 
(Ref1-Ref4) 

Voltage Offset Offset is an acquisition 
control, not a display 
control 

Single shot acquisition Average Acquisitions continue until 
the specified number of 
waveforms have been 
acquired and averaged 

Single shot acquisition Envelope Acquisitions continue until 
the specified number of 
waveforms have been 
acquired for the enveloped 
waveform 

Measurements Roll Measurements are not 
available until you stop 
acquisitions 

Envelope, Average, or 
WfmDb acquisition modes 

Roll Using these acquisition 
modes will turn Roll mode 
off 

 

Sampling Modes  

  

To Use 

To enable a sampling mode, click the Sampling Mode button. 
There are three sampling modes: Real Time Only, Interpolated 
Read Time, and Equivalent Time. 

In Real Time Only sampling, the instrument acquires all the points 
in a waveform record after one trigger event. 

In Interpolated Real Time sampling, the instrument interpolates 
between the samples it acquires when it cannot acquire all the real 
samples it needs to fill up its waveform record. The instrument can 
interpolate either as part of an acquisition or as part of the 
zoom/display behavior. 

Equivalent time sampling starts when the time base setting (horizontal scale) is too fast to let 
the instrument get enough samples with which to create a waveform record using real-time 
sampling. 

 Use the Horiz/Acq menu Sampling Modes command to directly select a sampling mode. 
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Note 

In real-time sampling, the instrument digitizes all of the points it acquires after one trigger event. 
Always use real-time or interpolated sampling to capture single-shot or transient events. 

Behavior 

Equivalent Time mode lets you accurately acquire repetitive waveforms at sample rates much 
higher than the base analog-to-digital converter sample rate. Equivalent time sampling is generally 
not useful for acquiring time-varying, random, or single-shot events. 

The instrument takes a few samples with each trigger event and eventually obtains enough 
samples to construct a waveform record. The instrument takes samples independent of the trigger 
position and displays them based on the time difference between the sample and the trigger. You 
should only use Equivalent Time mode on repetitive signals. 

 

The sampling speeds and the number of channels that you choose affect the mode that the 
instrument uses to sample waveforms in the following ways: 

 The instrument always uses real-time sampling at slower time base settings. Faster time 
settings force the instrument to switch from real-time sampling to equivalent-time sampling. 

 The instrument extends the limit at which it must switch from real-time sampling by using the 
digitizers of channels that are turned off to sample the channel or channels that are turned on. 

The following tables show the time base setting(s) at which the switch from real-time sampling 
(RT) to equivalent-time sampling (ET) occurs for your instrument.  

Sampling mode selection TDS5000B 

Channels on 1 2 3 or 4 

Time base 
≥ 800 ps/pt 

 
RT 

 
RT 

 
RT 

      400 ps/pt RT RT ET 

      200 ps/pt RT ET ET 

   ≤ 100 ps/pt ET ET ET 

 

Sampling mode selection TDS5000BE 

Channels on 1 2 3 or 4 
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Time base 
≥ 800 ps/pt 

 
RT 

 
RT 

 
RT 

      400 ps/pt RT RT ET 

      200 ps/pt RT ET ET 

   ≤ 100 ps/pt ET ET ET 

 

The type of equivalent-time sampling the instrument uses is called random equivalent-time 
sampling. Although it takes the samples sequentially in time, it takes them randomly with respect 
to the trigger. Random sampling occurs because the instrument sample clock runs asynchronously 
with respect to the input signal and the signal trigger. The instrument takes samples independently 
of the trigger position and displays them based on the time difference between the sample and the 
trigger. 

FastFrame Setup Control Window 
Access the FastFrame Setup from the Acquisition tab of the Horizontal Setup control window. 

Control Window Overview 

Use these controls to capture a series of triggered acquisitions at high resolution without wasting 
acquisition memory on the dead time in-between the trigger events.  

  

FastFrame mode combines multiple acquisitions into one large record. By carefully defining the 
trigger conditions, you can use FastFrame to capture only multiple events of the waveform that 
you are interested in. Each captured event is stored sequentially in its own frame. The frames are 
in the order they were captured. FastFrame mode lets you jump to and view the desired frame. 
Time Stamps can display the absolute trigger time for a specific frame and the relative time 
between triggers of two specified frames. FastFrame lets you compare different waveforms. Math 
is done on each frame. 

  

FastFrame provides the following features: 
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 Measure time between triggered acquisitions using time stamps in Sample, Peak Detect, and 
Hi Res mode. 

 Save and recall FastFrame waveforms. 

 Display waveforms in YT mode. 

 Apply math functions to FastFrame waveforms. 

 Confine automatic measurements only to the displayed frame. 

 Overlay multiple frames for easy comparison. 

FastFrame is not compatible with the following features or modes: 

 Equivalent Time 

 Histograms 

 Fast Acquisitions 

 Average 

 Envelope 

Frame Setup 
To Use 

Click the FastFrame button to turn the FastFrame mode on and off. Use the multipurpose knobs to 
select the number of samples per frame and the number of frames. 

Click the Selection Controls button to display only the Selected Frame controls and the Reference 
Frame controls adjacent to the full-screen graticule. 

Select Average or Envelope from the Summary Frame list to replace the last frame with one that is 
the computed average or envelope of all frames in the set. 

Behavior 

The Frame Length is the record length and defines the number of samples in each frame. 

The Frame Count defines the number of frames to store in the acquisition memory of a single 
channel. The product of the frame length and the frame count is constrained within the available 
memory. If more frames are needed, the instrument will automatically decrease the record length; 
if more samples are needed, the instrument will automatically decrease the frame count. 

Note 

Because of overhead associated with each frame, the maximum number of frames that can be 
obtained from a given record length is less than what is theoretically calculated. 
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Frame Viewing 
To Use 

Select the source channel from the drop-down list, and then use the multipurpose knob to select 
the Selected Frame. Click either the Live or All button to determine which frames you want to 
lock together. 

Click the Multiple Frames button to toggle this function between Off or Overlay. When Overlay is 
selected, two additional fields are displayed—Start Frame and # of Frames. These fields allow you 
to select a range of frames that are displayed in the color of the Source channel. 

In Overlay, the frames are superimposed over each other. The Selected Frame is displayed in blue 
unless you are using the Spectral or Temperature palette, then selected waveform is displayed in 
the same color as the other frames.  

(You may find it difficult to distinguish the dark blue Selected Frame if you have selected Spectral 
or Temp for the Color Palette.) 

Behavior 

The Selected Frame displays the frame that you want to view. You can use the multiview zoom 
features of the instrument to magnify the waveform of interest. The Selected Frame can use any 
Channel, Math, or Reference waveform as the source waveform.  

When Multiple Frames is off, the instrument will display one frame at a time. You can use the 
Selected Frame control to scroll through all of the frames until you find the frame of interest. 

When you set Frame Tracking to Live, the channel and math waveforms are locked together. 
Adjusting a channel waveform also adjusts a related math waveform. All reference waveforms are 
locked together, but they are separate from channel and math waveforms.  

When you set the Selected Frame Source Ch1 to Frame 3, then the Selected Frame Ch2, Ch3, Ch4, 
Math1, Math2, Math3 and Math4 are also set to Frame 3. When you set the Selected Frame 
Source Ref1 to Frame 2, then the Selected Frame Ref2, Ref3, and Ref4 are also set to Frame 2. If 
the Frame Tracking is set to Live, changing Selected Frame Ch1 will not affect the Selected Frame 
Ref1 frame or the Reference Frame setting. (Two-channel instruments are limited to only two 
channels.) 

To lock the reference and all selected frames together, use the All button under Frame Tracking. 
When the frames are locked, they maintain the same relative distance from each other as you 
adjust either frame. 

For example: assume that Selected Frame Ch1 is set to Frame 3, Ref1 is set to Frame 4, Reference 
Frame is set to Frame 2 and Frame Tracking is set to All. If you change Selected Frame Ch1 to 
Frame 4, then Ref1 will change to Frame 5 and the Reference Frame will change to Frame 3 
maintaining the relative distance between frames. 

When you select Overlay, the Start Frame and the # of Frames fields are displayed. Use the upper 
multipurpose knob to enter the Start Frame (first frame) in the frame sequence that you want to 
view. Use the lower multipurpose knob to enter the total number of frames that you want to view. 
For example, if you have 1000 frames and you want to view frames 75 through 100, use the upper 
multipurpose knob to enter 75 in the Start Frame field and the lower multipurpose knob to enter 26 
in the # of Frames field. The result of these settings is that frames 75 through 100 are displayed 
superimposed over each other in the color of the selected Source, and the current (selected frame) 
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is displayed superimposed in dark blue, unless you are using the Spectral or Temperature color 
palette. 

Time Stamps 
To Use 

Use these controls to use time stamps with FastFrame. Click the Readouts button to display the 
time stamp readouts in the graticule. Click the Table button to display the time stamps readouts in 
a table format. Select the Reference Frame Source from the drop-down list, and then enter the 
Reference Frame with the multipurpose knobs. 

Behavior 

All other frames are referenced to the Reference Frame when using time stamps. The Reference 
Frame is used to calculate time differences for each frame and displays those differences in the 
graticule.  

When time stamp readouts are turned on, readouts are displayed for the Selected Frame, the 
Reference Frame, and the delta (difference between the two frames). The time stamps are 
displayed in a format that shows the date and time. 

The Time Stamps Table displays the current time stamps and readout information. This table is 
read-only. 

Time Stamp Table 
Access this control window by clicking the Table button in the FastFrame Setup control window. 

To Use 

The Time Stamp table is read-only. Select the source channel from the Selected Source drop-down 
list, and then use the multipurpose knob to select the Selected Frame. Select the Reference Frame 
Source from that drop-down list, and then use the multipurpose knob to select the reference frame. 
Click the FastFrame Setup button to return to the FastFrame Setup control window. 

  

Behavior 

The Time Stamps Table displays the current time stamps and readout information based on the 
selected frame source and reference frame source.  

Using FastFrame Acquisitions 
Consider the following operating characteristics when using FastFrame: 
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 You can push RUN/STOP to terminate a FastFrame sequence. If any frames were acquired, 
they are displayed. If no frames were acquired, the previous FastFrame waveform is 
displayed. 

 Because FastFrame introduces additional processing time into the operation cycle of acquire, 
process, and display, it is best to use Single Sequence Acquisition (see Acquire menu, Stop 
After menu). With Single Sequence selected, you will see the current acquisition sequence; 
otherwise, the display lags the current sequence by one sequence. You can also see the current 
sequence by pushing the RUN/STOP button to stop the acquisition. 

 FastFrame greatly reduces the minimum trigger holdoff time, enabling you to acquire and 
store records at rates of up to 225,000 captures per second (until the number of frames 
requested has been acquired). FastAcq mode also provides exceptionally fast acquisition rates. 
Both modes have advantages. FastFrame preserves the actual data associated with each trigger 
event for further analysis or visual inspection, but only acquires at the fast rate for short bursts 
of time. FastAcq mode combines the data from all trigger events into a single pixel map, but 
can acquire at exceptionally fast rates continuously, not just for short bursts. 

 In single sequence acquisition mode, statistics are calculated using all frames in the current 
acquisition except for Average and Envelope frames. If the currently selected frame is the 
Average or Envelope Frame, measurements are taken on the frame but statistics are still based 
on all frames excluding the Average and Envelope frames. Statistics reset with each new 
single sequence acquisition. 

 On a reference waveform, statistics are derived from all frames in that reference waveform 
when Fast Frame is on. If Fast Frame is off, the statistics reflect only the first frame that is 
displayed. 
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FastFrame Controls 
Access the FastFrame Controls by clicking the Selection Controls button in the FastFrame Setup control 
window. 

  

Overview 

Use this control window to select the viewing frame (Selected Frame) 
when FastFrame is turned on. You can also select the reference frame. 

To Use 

Select the source channel from the drop-down list, and then use the 
multipurpose knob to select the Selected Frame. Select the Reference 
Frame Source from the drop-down list, and then use the multipurpose 
knob to select the reference frame. 

Behavior 

The Selected Frame displays the frame of interest. The Selected Frame 
can use any Channel, Math, or Reference waveform as the source 
waveform. The instrument will display one frame at a time. You can 
use the Selected Frame control to scroll through all of the frames until 
you find the frame of interest. 

Use the Reference frame to establish a reference frame when using 
time stamps. You can view the time stamps by turning on the readouts. 

Autoset 
Use Autoset to automatically set up the front-panel controls based on the characteristics of the 
input signal. This is much faster and easier than manually setting up the controls.  

Note 

Autoset may change vertical position to position the waveform appropriately. It always sets 
vertical offset to 0 V. 

If you use Autoset when one or more channels are displayed, the instrument selects the lowest 
numbered channel for horizontal scaling and triggering. The instrument individually scales all 
displayed vertical channels. If you use Autoset with no vertical channels displayed, the instrument 
turns on and scales channel 1.  

To use Autoset, push the AUTOSET button on the front panel. You can also select Autoset from 
the Horizontal/Acquisition menu. 

 The Autoset Undo button opens in a control window after the instrument completes the 
operation. Click this button to undo only the parameters adjusted by the last Autoset. 

Note 

The Autoset Undo control window remains on the screen until you open another control window. 
After Autoset Undo closes, you can still undo the last Autoset by selecting the Undo Last Autoset 
command from the Edit menu. Although the last Autoset is immediately undone, the Autoset 
Undo control window does not open again. 
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 Select User Preferences from the Utilities menu to display the Prompt Before Action window. 
Click Autoset to toggle between OFF and ON: 

 OFF to immediately perform an Autoset when the AUTOSET button is pushed. 

 ON to display a prompt when the AUTOSET button is pushed. 

Click Close to save your selection. 

The following table lists the Autoset defaults. 

Control Changed by Autoset to 

Selected Channel Numerically lowest displayed channel 

Acquisition Mode Sample 

RUN/STOP RUN 

Deskew, Channel/Probe Unchanged 

Display Style Vectors 

Display Intensity—Overall If less than 50%, set to 100% 

Display Format YT 

Horizontal Position Centered within the graticule window 

Graticule Setting Unchanged 

AutoBright On 

Horizontal Scale As determined by the signal frequency, 
or 100 µs/div 

Record Length and  
Sample Rate 

When a new time-per-division is 
calculated, the sample rate changes to 
maintain the current record length. If the 
sample rate cannot be changed because 
of hardware limitations, the sample rate 
is set to maximum while the record 
length is reduced to maintain the time-
per-division. 

Trigger Position Delay Off 

Trigger A >B Sequence A Only 

Main Trigger Type Edge 

Trigger Source Numerically lowest displayed channel 
(the selected channel) 

Trigger Level 50% of selected channel’s amplitude 

Trigger Slope Positive 
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Trigger Coupling DC 

Trigger Holdoff Minimum setting 

Vertical Scale As determined by the signal level 

Vertical Position As determined by the number of active 
channels 

Vertical Coupling DC unless AC was previously set. AC 
remains unchanged. 

Vertical Bandwidth Full 

Vertical Offset 0 volts 

Zoom Off 
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Trigger Menu 
Use the Trigger menu to set up the instrument to trigger on live waveforms. Several different types of 
triggering are available.  

Trigger Setup Control Window 
Access this control window from one of the Trigger Setup commands on the Trig menu or click the Trig 
taskbar button. 

Overview 

Use the Trigger Setup control window to set up the instrument to trigger on live waveforms.  

  

The left side of the control window contains information on the main trigger types (also known as 
the A Event triggers), sequential triggering, the B Event trigger, and the Trigger Mode and 
Holdoff. When you click one of the buttons on the left side of the control window, the right side of 
the control window displays details on the trigger type.  

The trigger expression near the top right side of the trigger window provides a one-line summary 
of the conditions that must be fulfilled before the instrument will trigger. 

The trigger event establishes the time-zero point in the waveform record. All points in the record 
are located in time with respect to the time-zero point. The instrument continuously acquires and 
retains sample points to fill the pretrigger portion of the waveform record. When a trigger event 
occurs, the instrument starts acquiring samples to build the posttrigger portion of the waveform 
record. Once a trigger is recognized, the instrument will not accept another trigger until the 
acquisition is complete and the holdoff time has passed. 

Note 

If you select an inverted channel waveform as a trigger source, the normal waveform is used 
instead.  
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A Event Trigger Types 

  

To Use 

Click the Trigger Type button you want to 
use. Set the parameters for that trigger type 
in the right side of the control window. 

Behavior 

When you click one of the trigger icons, the 
right side of the screen displays the controls 
needed to use that trigger type. 

The instrument provides the following trigger type categories: 

 Edge triggers are the most commonly used trigger type. You can use edge triggers with 
analog and digital signals. Edge triggers are available on both the Main and Delayed triggers. 

 Pulse triggers are special-purpose triggers that are primarily used with digital signals. The 
following classes of pulse triggers are available: Glitch, Runt, Window, Width, Transition, 
and Timeout. Pulse triggers are only available on the main trigger. 

 Logic triggers are special-purpose triggers that are primarily used with digital logic signals. 
Two of the classes, Pattern and State, trigger the instrument based on the Boolean operator 
you select for the trigger sources. A third class, Setup and Hold, triggers when data on one 
trigger source changes state within the setup and hold times that you specify relative to a 
clock on another trigger source. Logic triggers are only available on the main trigger. 

 Video triggers are used to trigger the instrument on specified fields or lines of a video signal. 
You can use one of several preset video signal formats or set a custom format. 

 Communication triggers are designed to work with communication masks and standards. 

 Use the Trig menu Quick Select submenu to directly access the A Event triggers. 

Sequential Triggering (Horizontal Delay On) 

 

To Use 

Select A-B Seq to use the A Event 
(main) trigger with the B Event trigger 
to capture complex data. The A Event 
trigger arms the trigger system. The 
instrument then triggers on the B Event 
trigger defined by events or time. You 
can also set up the instrument to delay 
the B Event Trigger by a specified time 
period by turning horizontal delay on. 
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Behavior 

When you click one of the trigger icons on the display, the right side of the screen shows the 
trigger sequence. Set the individual controls using the multipurpose knobs. 

Sequential Triggering (Horizontal Delay Off) 

 

To Use 

Select the A-B Seq tab to use the A 
Event (main) trigger with the B Event 
trigger to capture complex data. The A 
Event trigger arms the trigger system; 
the instrument will trigger on the B 
Event trigger defined by events or time.  

Behavior 

When you click one of the trigger icons 
on the display, the right side of the 
screen shows the trigger sequence. Set 
the individual controls using the 
multipurpose knobs. 

B Event Trigger 
To Use 

Use these controls to define the parameters for the B Event trigger.  

 

Behavior 

These controls work together to define the parameters for the trigger event. Use the B Event 
trigger with the A Event trigger to capture more complex events. The B Event trigger uses Edge 
triggering only. The B Event trigger controls are independent from the A Event trigger.  
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Trigger Mode and Holdoff 
To Use 

To set the Trigger Mode, click either Auto or Normal. To set the Trigger Holdoff time manually, 
click Time, and then use the multipurpose knob with the Trig Holdoff control to set the holdoff 
time. The Holdoff setting range is 1.5 µs (minimum holdoff available) to 12 seconds (maximum 
holdoff available). To enable E-mail on Trigger click On. To setup the e-mail on event parameters, 
click Setup. Set the A Event trigger level using the A Trig Level control and the multipurpose 
knob.  

  

Behavior 

Use the holdoff time to delay the trigger system for a specified amount of time between triggers. 
You can set the holdoff time to a value that synchronizes the instrument with an incoming signal 
to generate a stable display and avoid triggering on non-desired events. 

If E-mail on Event has already been set up, clicking E-mail on Trigger enables you to send e-mail 
on a trigger. If E-mail on Event has not been set up, you must first click Setup, and then configure 
E-mail on Event in the setup control window. 

Edge Trigger Control Window 
To Use 

Use these controls to set the Edge trigger parameters.  

 

 Select the edge trigger by pushing the EDGE button on the front panel.  
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Behavior 

Edge triggering is the most common way to trigger an instrument. The trigger occurs when the 
trigger source passes through a specific level on the specified slope (rising or falling). 

Glitch Trigger Control Window 
To Use 

Use these controls to set the Glitch trigger parameters. 

 

Behavior 

Use the Glitch trigger to detect and trigger on a glitch or to ignore a glitch. Glitches are defined as 
pulses that are narrower than a specified time. The trigger occurs when the instrument detects a 
pulse outside (either less than or greater than) the parameters you specify. 

Width Trigger Control Window 
To Use 

Use these controls to set the Pulse Width trigger parameters.  

 

Behavior 

Use the Width trigger to trigger the instrument on a pulse that is either within or outside the 
specified range. The range is defined by the Upper Limit and Lower Limit controls. You can 
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specify widths for either positive or negative pulses. The pulse widths are measured at the voltage 
level specified by the Level control. 

Runt Trigger Control Window 
To Use 

Use these controls to set the Runt trigger parameters.  

 

Behavior 

Use the Upper Level and Lower Level threshold controls to set the voltage ranges that define a 
valid pulse. Runt pulses are short pulses that cross one threshold but fail to cross a second 
threshold before crossing the first threshold again. The pulse widths are measured at the voltage 
level specified by the Level control. These pulses can also be qualified by time or by the logical 
state of other channels. 

Timeout Trigger Control Window 
To Use 

Use these controls to set the Timeout trigger parameters.  
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Behavior 

Use the Timeout trigger to trigger the instrument on pulses longer than the specified time. The 
instrument will trigger at the end of the timeout period. The instrument can trigger on high, low, or 
both high and low pulses. 

Use the Timer control to specify the timeout limit; any pulses wider than the limit will trigger the 
instrument. The timeout limit is measured at the voltage level specified by the Level control. 

Transition Time Trigger Control Window 
To Use 

Use these controls to set the Transition Time trigger parameters. 

 

Behavior 

Use the Transition trigger to trigger the instrument on pulse edges that traverse between two 
thresholds at faster or slower rates than the specified time. You can set up the instrument to trigger 
on positive or negative edges. 

Use the Upper Level and Lower Level controls to define the voltage ranges of interest. The Time 
control specifies the target transition time. 
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Setup and Hold Trigger Control Window 
To Use 

Use these controls to set the Setup and Hold trigger parameters. 

 

Behavior 

Use the Setup and Hold trigger to trigger on setup and hold time violations. The setup and hold 
times define a violation region relative to a clock. Data is considered to be invalid in the violation 
region. The instrument monitors the data and clock sources. When a clock edge occurs, the 
instrument checks the data channel for transitions within the violation region. If any violations 
occur, the instrument triggers with the trigger point located at the clock edge. The setup and hold 
values can be positive or negative. The minimum setup and hold time is 2 ns. Negative setup and 
hold times skew the violation region to locate it before or after the clock edge. The instrument can 
detect and trigger on violations of time ranges that are before or after the clock. 

Use one of the channel inputs as the clock signal and a second channel input as the data input. The 
clocking and data levels are used to determine if a clock or data transition has occurred. 

Logic Pattern Trigger Control Window 
To Use 

Use these controls to set the Pattern trigger parameters. 
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Behavior 

Use the Pattern trigger to trigger the instrument when the logic inputs cause the selected function 
to become True or False. You can also time qualify the trigger—specify that the logic conditions 
must be satisfied for a specific amount of time before the instrument triggers.  

The instrument input channels represent the data inputs. You can set each channel to be logic high, 
logic low, or "don't care".  Use the multipurpose knobs to change the threshold voltages for logic 
levels other than TTL. 

The Pattern Type buttons set the Boolean logic function for the trigger. 

Note 

The Ch3 and Ch4 controls are only available on 4-channel models. 

Logic State Trigger Control Window 
To Use 

Use these controls to set the State trigger parameters.  

 

Behavior 

Use the Logic State trigger to trigger the instrument when all of the logic inputs to the selected 
logic function cause the function to be True or False when the clock input changes state.  

Channels 1, 2, and 3 represent the data inputs, and channel 4 represents the clock input. (The clock 
input is channel 2 on the 2-channel models.) You can set each data channel to be logic high, logic 
low, or a "don't care" value. You can set the channel 4 input to a rising or falling clock edge. Use 
the multipurpose knobs to change the threshold voltages for logic levels other than TTL. 

The Pattern Type buttons set the Boolean logic function for the trigger.  
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Window Trigger Control Window 
To Use 

Use these controls to set the Window trigger parameters.  

  

Behavior 

Use the Window trigger to trigger the instrument when the input signal rises above an upper 
threshold level or falls below a lower threshold level. After setting these levels, you can specify 
whether you want to trigger the instrument as the signal is entering or leaving the threshold 
window. You can further qualify the trigger event in terms of time by using the Trigger When 
Wider option, or by the logical state of other channels using the Trigger When Logic option. 

Note that the Trigger When controls change as you select different combinations of options. 

Note 

The Trigger When Logic option is only available on 4-channel models. 

Video Trigger Control Window 
To Use 

Use these controls to set the Video trigger parameters.  
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Behavior 

Use the Video trigger to trigger the instrument on specified fields or lines of a composite video 
signal.  

Note 

Only composite signal formats are supported. Graphic display formats such as RGB and VGA are 
not supported. 

Select from several preset video signal formats or set a custom format. If using a preset format, the 
Lines and Fields Autoset buttons will optimize the instrument for viewing the fields or lines for 
your chosen format. You can also select a graticule and set the polarity of the scan. 

  

If you select the Custom signal format, no 
Autoset options are available. You must set 
the Scan Type and Scan Rate. Also note that 
you will only be able to specify a value for the 
Holdoff control in units of time. Click on the 
graphic to the left for more information on the 
Scan Type and Scan Rate controls. 

Comm Trigger Control Window 
Note  

Option SM must be installed to have access to Comm triggers. 

To Use 

Use the controls in the window to select the source of the signal, the coding format, and the 
standard to use in testing. Bit rates can be changed using the multipurpose knobs as well. 
Depending on which coding format you use, you can also change the Upper, Lower, and Clock 
level thresholds and the pulse form using the multipurpose knobs.  
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Behavior 

Use the Comm Trigger control window to trigger the instrument in conjunction with mask testing 
on communications codes and standards. The controls work together to define the parameters for 
the trigger event. The standards that appear in the Standard drop-down list depend on the coding 
format that you selected. The coding format also determines whether upper, lower, single, or clock 
threshold levels or pulse forms are used. The standard determines the bit rate. 

Communication Trigger Codes and Standards 
(Option) 

Overview 

The following tables list the Communication Trigger Codes and Standards available with Option 
SM: 

Note 

The communication trigger standards available for an instrument depend on the bandwidth and/or 
configuration of that instrument. 
AMI trigger standards 

Custom 32Mb 
32.064 Mb/s 

97Mb 
97.728 Mb/s 

DS1 
1.544  Mb/s 

DS1A  
2.048  Mb/s 

DS1C  
3.152  Mb/s 

DS2  
6.312  Mb/s 

DS2 Rate Sym 
6.312 Mb/s 

DS2 Rate Coax 
6.312 Mb/s 

DS3 
44.736  Mb/s 

E1  
2.048  Mb/s 

E2  
8.448  Mb/s 

E3  
34.368  Mb/s 

STS–1  
51.84  Mb/s 

  

 
B3ZS trigger standards 

Custom DS3 
44.736  Mb/s 

STS–1  
51.84  Mb/s 

 

 
B6ZS trigger standards 

Custom DS2  
6.312  Mb/s 

DS2 Rate Sym 
6.312 Mb/s 

 

 
B8ZS trigger standards 

Custom DS1 
1.544  Mb/s 

DS1C  
3.152  Mb/s 

DS2 Rate Coax 
6.312 Mb/s 
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CMI trigger standards 

Custom DS4NA  
139.26  Mb/s 

E4 
139.26  Mb/s 

STM1E  
155.52  Mb/s 

STS–3  
155.52  Mb/s 

 

 
HDB3 trigger standards 

Custom E1  
2.048  Mb/s 

E2  
8.448  Mb/s 

E3  
34.368  Mb/s 

DS1A  
2.048  Mb/s 

 

 
MLT3 trigger standards 

Custom 100Base–TX 
125  Mb/s 

 

 
NRZ trigger standards 

Custom 2.5 IBand 
2.5 Gb/s 

FC133 
132.8 Mb/s 

FC266 
265.6 Mb/s 

FC531 
531.2 Mb/s 

FC1063 
1.0625 Gb/s 

FC2125E 
2.125 Gb/s 

G1 ATA 
1.5 Gb/s 

GB Ethernet 
1.25 Gb/s 

FS USB 
12 Mb/s 

HS USB 
480 Mb/s 

 

OC1/STM0 
51.84 Mb/s 

OC3/STM1 
155.5 Mb/s 

OC12/STM4 
622.1 Mb/s 

 

OC48/STM16 
2.488 Gb/s 

OC48–FEC 
2.666 Gb/s 

S400b 
491.5 Mb/s 

S800b  
983.0 Mb/s 

S1600b 
1.966 Gb/s 

XAUI 
3.125  Gb/s 

RapidIO 500M 
500  Mb/s 

RapidIO 750M 
750  Mb/s 

RapidIO 1.0G 
1.0  Gb/s 

RapidIO 1.5G 
1.5  Gb/s 

RapidIO 2.0G 
2.0  Gb/s 

SFI/SPI–5 2.5G 
2.5  Gb/s 

SFI/SPI–5 3.1G 
3.1  Gb/s 

RIO Serial 1G 
1.25  Gb/s 

RIO Serial 2G 
2.5  Gb/s 

RIO Serial 3G 
3.125  Gb/s 

VSR OC192 
1.244  Gb/s 

TFI–5 2.5G 
1.488  Gb/s 

TFI–5 3.1G 
3.11  Gb/s 
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Set to 50% with Comm Triggers 
Overview 

The Set to 50% control sets the trigger threshold to 50% for some Comm triggers and to a high of 
75% with a low of 25% for others.  

Behavior 

When either AMI or MLT-3 code is selected with Comm triggers the Set 50% control measures 
peak-to-peak level and sets an upper threshold value at 75% and a lower threshold value at 25%. 
Other codes work exactly the same as Edge, Width, Glitch, and Timeout triggers; the threshold is 
set to 50%. 

Trigger on A Only (Horizontal Delay Off) 
To Use 

Select the trigger event from the A Event tab and then set up trigger controls for the A Event. 
Next, select the A-B Seq tab and click A Only. Use the Horiz Position control to define the 
amount of pretrigger data. 

 

Behavior 

When you select A Only with Delay Mode off, the instrument looks for the trigger conditions 
specified by the A event. When the instrument recognizes the A event, it acquires the posttrigger 
data. 

 Use the front panel HORIZONTAL POSITION knob to set the amount of pretrigger data. 

Trigger on A Only (Horizontal Delay On) 
To Use 

Select the trigger event from the A Event tab and then set up trigger controls for the A Event. 
Next, select the A-B Seq tab and click A Only. Use the Horiz Delay control to delay the 
acquisition relative to the A Event trigger. 
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Behavior 

When you select A Only with Delay Mode on, the instrument first looks for the trigger conditions 
specified by the A Event. The instrument then delays the acquisition for the time specified by the 
Horiz Delay control before acquiring the data. 

Trigger After Time (Horizontal Delay Off) 
To Use 

Set up the A Event and B Event from their individual tabs. Select the A–>B Seq tab and click Trig 
After Time. Select the trigger delay time with the Trig Delay control. Adjust the Horiz Position 
and B Trig Level controls as necessary. 

 

Behavior 

When you select Trig After Time, the instrument looks for the trigger conditions specified by the 
A event. After the A event arms the trigger system, the instrument triggers on the next B event that 
occurs after the time specified by the Trig Delay control. 

Trigger After Time (Horizontal Delay On) 
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To Use 

Set up the A Event and B Event from their individual tabs. Then select the A–>B Seq tab and click 
Trig After Time. Select the trigger delay time with the Trig Delay control. Use the Horiz Delay 
control to delay the acquisition relative to the B event. Adjust the Ref Position and B Trig Level 
controls as necessary. 

  

Behavior 

Use this trigger sequence to trigger the instrument on the B trigger event after the A event. 

When you select Trig After Time, the instrument looks for the trigger conditions specified by the 
A event. After the A event arms the trigger system, the instrument delays the trigger for the period 
of time specified by the Trig Delay control. After the trigger delay time has expired, the 
instrument looks for the B trigger event. When the instrument detects the B event, it delays the 
acquisition for the period of time specified by the Horiz Delay. 

Trigger on Nth Event (Horizontal Delay Off) 
To Use 

Set up the A Event and B Event from their individual tabs. Then select the A–>B Seq tab and click 
Trig on nth Event. Select the number of B events with the Trig Event control. Adjust the Horiz 
Position and B Trig Level controls as necessary. 
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Behavior 

Use this sequence to trigger the instrument on the nth occurrence of the B event after the A event. 

When you select Trig on nth Event, the instrument looks for the trigger conditions specified by the 
A event. After the A event arms the trigger system, the instrument looks for a specific number of 
B events before triggering and displaying the data. 

Trigger on Nth Event (Horizontal Delay On) 
To Use 

Set up the A Event and B Event from their individual tabs. Then select the A–>B Seq tab and click 
Trig on nth Event. Select the number of B events with the Trig Event control. Use the Horiz Delay 
control to delay the acquisition relative to the B event. Adjust the Ref Position and B Trig Level 
controls as necessary.  

 

Behavior 

When you select Trig on nth Event, the instrument looks for the trigger conditions specified by the 
A event. After the A event arms the trigger system, the instrument looks for a specific number of 
B events before triggering. The instrument then delays the acquisition for the amount of time 
specified by the Horiz Delay control. After the delay time has expired, the instrument displays the 
data. 
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Trigger Holdoff Control Window 
Access this control window from the Trig menu Holdoff command.  

 

Overview 

Use the Trigger Holdoff control window to set the trigger holdoff. 

To Use 

Set Holdoff to Default to trigger after a preset amount of time. To set a 
specified holdoff time, click Time and enter a holdoff time in Trig 
Holdoff using the multipurpose knobs or pop-up keypad. You can also 
set the trigger Level with the multipurpose knob. 

Behavior 

When Holdoff is set to Default, the holdoff time is based on the time 
equal to five times the current horizontal scale setting. You may want 
to manually set the holdoff time to help stabilize the display of 
complex waveforms such as digital pulse trains that may have several 
possible trigger points. 

The Level control can be either the main trigger level when there is no 
B Trigger event or the A Event trigger level when a B Event trigger is 
defined. To change the B Event trigger level, change the B Trig Level 
control under the B Event tab of the Trigger Setup control window. 
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Trigger Mode Control Window 
Access this control window from the Trig menu Mode command. 

 

Overview 

Use the Trigger Mode control window to set the 
Trigger Mode, to force a trigger, or to set the trigger 
level to 50%. 

To Use 

Click one of the buttons at the top of the control 
window to set the Trigger Mode.  

Click Force Trigger once to acquire a waveform record 
without a trigger event. Forcing a trigger is useful 
when the input signal does not contain a valid trigger. 
The instrument recognizes and acts upon the forced 
trigger even when you click the button before the end 
of the pretrigger holdoff. The button has no effect 
when acquisitions are stopped. 

Click Set 50% to set the trigger threshold level of the 
selected trigger channel to 50% of that channel’s 
amplitude. 

Behavior 

These controls operate identically to the controls on the front panel.  

Run/Stop Control Window 
Access this control window from the Horizontal/Acquisition menu Run/Stop command. 

 

Overview 

Use this control window to start and stop acquiring 
waveforms. 

To Use 

Click Run/Stop to toggle waveform acquisition. Click Single 
Sequence to complete a single acquisition sequence. Click 
Force Trigger to immediately start acquiring waveform data 
without a valid trigger event. 

Behavior 

These controls operate identically to the front-panel controls. 

Click Run/Stop once to stop acquisitions. The Status readout at 
the top of the graticule changes from Running to Stopped and 
shows the number of acquisitions. Click Run/Stop again to 
resume acquiring waveforms. 
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Click Single Sequence to complete a single sequence of acquisitions each time you click the 
button. When Single Sequence is enabled, the front-panel single sequence (SINGLE) button is 
lighted.  

In Sample, Peak Detect, or Hi Res acquisition modes, the instrument acquires waveform records 
with the first valid trigger event and then stops. In Average or Envelope acquisition modes, the 
instrument makes the specified number of acquisitions to complete the averaging or enveloping 
task. 

In Waveform Database mode, the instrument acquires and displays a waveform that is the 
accumulation of several acquisitions. In addition to time and amplitude, the waveform displays a 
count of the number of times a specific sample point has been acquired. 

When you click Single Sequence (or press SINGLE) in Equivalent Time mode, the instrument 
continues to recognize trigger events and acquires samples until the waveform record is filled. 

Click Force Trigger once to acquire a waveform record without a trigger event. Forcing a trigger is 
useful when the input signal does not contain a valid trigger. The instrument recognizes and acts 
upon the forced trigger even when you click the button before the end of the pretrigger holdoff. 
The button has no effect when acquisitions are stopped. 

Communication Trigger Coding 

  

Overview  

Use this control window to select the coding format for triggering on a 
communication signal and the standard to use with the coding format. The 
standard sets the bit rate. 

To Use 

Touch the Coding drop-down list to select the coding format to use for 
triggering the communication signal. Touch the Standard drop-down list to 
select the standard to use with the coding format. The bit rate is set by the 
standard selected and is a read only field. 

Behavior 

The coding format determines which standards are available as well as other parameters, such as 
trigger threshold and pulse form. The standard selected determines the bit rate. Changing the bit 
rate causes the standard to change to your own customized standard. 

Comm Trigger Pulse Form 
Overview 

Pulse Form directs the instrument to trigger on a voltage change from the prior bit. This can be 
positive, negative, or neutral if there was no change. Depending on the code used, the pulse form 
can also indicate that triggering is to occur on an eye diagram. 
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To Use 

Touch the pulse form that you want the instrument to use for triggering. Touch 1 to trigger on a 
positive pulse form, 0 on a neutral pulse form, or -1 on a negative pulse form. 

Behavior 

The available pulse forms are determined by which code is used for the signal. For example, the 
only pulse form available for NRZ codes is eye diagram. 

Display Menu 
Use Display menu options to change the way that waveforms appear on the instrument. This 
includes the style, intensity, color, format, text, and persistence. You can also change the graticule 
type and the items that appear on the display, such as date and time. 

Display Setup Control Window (Appearance Tab) 
Access this control window from the Display menu Display Setup command or Appearance command. 

Overview 

Use the controls on the Appearance tab to change the display style, display persistence, waveform 
intensity, display format, and waveform interpolation.  

  

Display Style 

 

To Use 

Click one of the buttons to select the waveform display style. 

Behavior 

Vectors display waveforms with lines drawn between record points. 

Dots display waveform record points as dots on the screen. Dots are 
useful when you want to display multivalued waveforms such as eye 
diagrams.  

Inten Samp (Intensified Samples) shows only the actual samples. When 
you use intensified samples, you identify the actual sample points in an 
interpolated waveform. 
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 Use the Display menu Display Style submenu to directly access the style options. 

Note 

The Vectors and Intensified Samples selections are not available in the XY and XYZ Display 
Formats. 

Display Persistence 

  

To Use 

Click one of the buttons to select the display 
persistence. If you select Variable, click Time 
and then use the multipurpose knobs to select the 
persistence time. Click Reset All to clear the 
persistence. Click Controls to activate the 
Persistence Control window. 

 

Behavior 

Infinite persistence continuously accumulates record points on the waveform until you change one 
of the acquisition display settings. Use infinite persistence for displaying record points that may 
occur outside the normal acquisition envelope. 

Variable persistence accumulates record points on the waveform for a specified time interval. 
Each record point decays independently according to the time interval. 

If you click Off, waveform record points appear for the current acquisition only.  

 Use the Display menu Display Persistence submenu or right-click in the graticule and select 
Display Persistence from the shortcut menu to directly access the persistence options. 

Waveform Intensity 

  

To Use 

Click the Autobright button to turn the autobright feature on 
and off. You can also use the front-panel Intensity knob or the 
multipurpose knobs to manually adjust the display intensity.  

Click the Record View text box to adjust the intensity of live 
waveforms, except when using Fast Acquisition or Waveform 
Database acquisition mode. 

Click the FastAcq/WfmDB text box to adjust the intensity of 
live waveforms when using Fast Acquisition or Waveform 
Database acquisition mode. 
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Behavior 

When AutoBright is On, the intensity of the waveform changes automatically to provide a visible 
waveform. When AutoBright is Off, the display simulates the appearance of analog oscilloscope 
signals. Waveforms that trigger more frequently appear brighter than waveforms that trigger less 
frequently. 

Display Format 

 

To Use 

Click one of the buttons to select the display format. 

Behavior 

YT is the conventional oscilloscope display format that shows a signal 
amplitude on the vertical axis as it varies over time on the horizontal 
axis.  

When you set the vertical position to center the display in YT mode, the 
XY display is at center screen, and each division of display in YT mode 
produces a division of display in XY mode. 

XY plots the amplitude of one waveform against the amplitude of another waveform on a point-
by-point basis. This format is useful for showing the relationship between two signals, such as 
current and voltage waveforms that combine to form an I-V characteristic. When you select the 
XY format, waveforms appear according to their channel pairings. XY format is a dot-only 
display, although it can have persistence. The Vector style selection has no effect when you select 
XY format. 

XYZ plots the amplitude of one waveform record against the amplitude of another waveform 
record on a point-by-point basis. XYZ requires Fast Acquisitions mode. A third waveform record 
modulates the waveform intensity. When you select the XYZ format, waveforms appear according 
to their channel assignments. The XYZ format is not triggered. A –5 division signal (including 
position and offset) on CH 3 produces a blank screen; a +5 division signal produces full intensity. 

Selecting YT or XY only affects the display. The HORIZONTAL and VERTICAL SCALE and 
POSITION knobs and menus control the same parameters regardless of the display format. In XY 
Display format, the horizontal scale continues to control the time base and the horizontal position 
continues to control the portion of the waveform that is shown. If in XY or XYZ, histograms are 
allowed, and horizontal controls are ignored. 

 Use the Display menu Display Format submenu to directly access the format types. 

Notes 

The Vectors and Intensified Samples selections are not available in the XY and XYZ Display 
Formats. 

The XYZ format is only available on 4-channel models and only supported in FastAcq mode. 
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Waveform Interpolation 

 

To Use 

Click one of the buttons to select the interpolation that best displays the 
waveforms. Interpolation globally affects all displayed waveforms. 

Behavior 

The instrument interpolates waveforms in Zoom mode when there is less 
than one sample for each pixel column.  

Because interpolation affects the displayed waveform rather than the acquisition data, it has no 
effect on math, measurements, or optional histograms. These functions are performed on the 
acquired data as compared to the displayed data. 

Sin(x)/x interpolation computes record points along a curve between the actual acquired samples. 
This interpolation is useful when acquiring rounded waveforms such as sine waves. It is good for 
general-purpose uses but may introduce overshoot or undershoot in signals with fast rise times. 

The Sin(x)/x interpolation is also useful to look at high-frequency signals, especially where the 
frequency components are just below the Nyquist frequency. 

Linear interpolation computes record points between actual acquired samples using a straight-line 
fit. Linear interpolation is useful for waveforms with fast rise times, such as pulse trains. 

 Use the Display menu Waveform Interpolation submenu to directly access the interpolation 
options. You may want to set the display style so that the real samples are intensified and 
interpolated samples are dimmed. 

Display Setup Control Window (Screen Text Tab) 
Access this control window from the Display menu Screen Text command or from the Display Setup 
control window. 

Overview 

Use the controls on the Screen Text tab to define text captions that you can add to the instrument 
display. 

To Use 

You can create up to eight lines of text to provide notes for screen shots, printouts, or for other 
instrument users. Click Display to turn the text display on and off. Click Properties to open the 
Text Properties control window where you can define the positioning of the text on the display. 

Behavior 

Click on one of the numbered lines and use the pop-up keyboard to enter up to 64 alphanumeric 
characters of text per line. Click Clear to clear the entire text of the selected line. The screen text 
that you enter is not related to any waveform labels that you may have created. The waveform 
labels help you identify waveforms on the screen, while the screen text is intended to provide 
information or notes for screenshots or printouts. 
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 Here are some tips for working with screen text: 

Position the text on the screen by clicking and dragging the text to the desired location on the 
graticule. 

Display Setup Control Window (Objects Tab) 
Access this control window from the Display menu Objects command, or from the Display Setup 
control window. 

Overview 

Use the controls on the Objects tab to change the appearance of objects on the display. 

  

Click Display Date/Time to show the current date and time on the graticule. 

 Use the Display menu Display Date & Time command to directly toggle the date/time display. 

Graticule Style 

 

To Use 

Click one of the buttons to select the graticule (display grid) 
style. 

Behavior 

Full provides a grid, cross hairs, and frame on the instrument 
display. Use Full to make quick estimates of waveform 
parameters. Grid shows a frame and a grid on the instrument 
display. This style is useful for making quick, full-screen 
measurements with cursors and automatic readouts when 
cross hairs are not needed. 

Cross Hair shows cross hairs and a frame on the instrument display. This style is useful for 
making quick estimates of waveforms while leaving more room on the display for automatic 
readouts and other data. 

Frame shows only a frame on the instrument display. This style is useful with automatic readouts 
and other screen text when other display features are not needed. 
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Use IRE if you are working with NTSC video signals. 

Use mV if you are working with video signals other than NTSC. 

 Use the Display menu Graticule Style submenu to directly access the graticule style options. 

Trigger Level Marker 

 

To Use 

Click one of the buttons to select the trigger level indicator. 

Behavior 

The trigger level markers indicate the voltage level where the 
trigger or threshold levels of the active waveform occur.  

The trigger level indicator does not appear on inactive or reference waveforms.  The Short trigger 
level marker displays a short arrow on the side of the graticule by the active waveform.  

The Long trigger level marker displays a horizontal line through the active waveform. 

LCD Backlight Timeout 

 

To Use 

Click the button to enable the LCD Backlight 
Timeout control. Click Delay and use the 
multipurpose knob to set the delay time before the 
LCD back light turns off. 

Behavior 

The LCD Backlight control turns the LCD backlight off after the amount of time in Delay has 
expired without any screen activity. When the control is set to On and the time has expired, the 
screen blanks out. When the control is set to Off, the screen display remains on.  

This feature is useful to extend the life of your LCD display. 

 Use the Display menu LCD Save Enabled command to toggle the LCD backlight timeout. 
Timeout is On when a check mark appears next to the command on the menu. 

Display Setup Control Window (Colors Tab) 
Access this control window from the Display menu Colors command, or from the Display Setup control 
window. 

Overview 

Use the controls on the Colors tab to change waveform color palettes. You can define colors for 
the live, math, and reference waveforms. If you are using Fast Acquisition or Waveform Database 
acquisition mode, select the FastAcq/WfmDB Palette; for all other acquisition modes, use the 
Record View Palette.  
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Color Palettes 
To Use 

Use the buttons under Record View Palette to define the color for live waveforms. Use the buttons 
under FastAcq/WfmDB Palette to define the color for live waveforms when using Fast 
Acquisition or Waveform Database acquisition mode. Click one of the buttons to select the color 
for displayed waveforms. 

Click the User Edit… button to activate the Display Palette where you can customize the display 
color. 

  

 Use the Display menu Record View Palette or the Fast/Acq WfmDB Palette submenu to 
directly access the color palettes. 

Behavior 

Normal displays hues and lightness levels for best overall viewing. The color of each channel 
waveform matches the color of the corresponding front-panel vertical SCALE knob. 

On the Spectral (Spectral Grading) palette, areas of the waveform with the highest sample density 
appear in blue shades while the areas of lowest sample density appear in red shades. 

On the Temp (Temperature Grading) palette, areas of the waveform with the highest sample 
density appear in warmer colors (red shades) while the areas of lowest sample density appear in 
cooler colors (blue shades). 
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Gray (Monochrome Gray) displays waveforms in shades of gray. Areas of the waveform with the 
highest sample density appear in lighter gray shades while the areas of lowest sample density 
appear in darker gray shades. 

Green (Monochrome Green) displays waveforms in shades of green. Areas of the waveform with 
the highest sample density appear in lighter green shades while the areas of lowest sample density 
appear in darker green shades.  

Select User to display the color that you have previously defined with the User Palette. 

 The Green palette simulates the display of an analog oscilloscope. 

Display Palette 
Access this control window from the Display menu, User Palette… 

  

Overview 

Use this control window to customize the color of your waveform 
display. 

To Use 

Click the Hue, Lightness, or Saturation text box to adjust the percentage 
of each of these attributes. Click the Source drop-down list to select the 
waveform for which you want to change the color. 

Click Reset to return the User palette to the default. Click Setup to 
activate the Display Setup control window. 

Behavior 

Increasing the hue value changes the color to blue tones. Decreasing the 
hue value changes the color to red tones. For best viewing, set the 
lightness to 50.  

Higher numbers tend to wash out the color and lower numbers can darken the color and make it 
difficult to see. Lower saturation values reduce the amount of color displayed in the waveform. 
Higher saturation values increase the amount of color. 

Reference Color 

 

To Use 

Click one of the buttons to select the color scheme for reference 
waveforms. 

Behavior 

Click Default to use the default system color for the selected reference 
waveform.  

Click Inherit to use the same color as the original waveform. 
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Math Color 

 

To Use 

Click one of the buttons to select the color scheme for math waveforms. 

Behavior 

Click Default to use the default system color for the selected math 
waveform.  

 

Click Inherit to use the same color as the waveform that the math function is based on. When the 
instrument is set to XY display mode, multiple math waveforms will inherit the color of the 
primary (first) channel. 

Text Properties Control Window 
Access this control window from the Display Setup control window Screen Text tab, Properties button. 

 

Overview 

Use the Text Properties control window to position text to 
specific locations on the graticule. 

To Use 

Select the line of text from the Screen Text drop-down list 
and then use the X Pos and Y Pos controls to define the 
location of the text on the graticule. 

Behavior 

The text from the drop-down list is the text that you defined 
under the Screen Text tab of the Display Setup control 
window.  

The units for the position controls are in pixels. The 
minimum values are 1 for both X and Y positions. The 
maximum X value is 450 while the maximum Y value is 
390. The origin of the X position is the left vertical graticule 
boundary while the origin of the Y position is the upper 
horizontal graticule boundary.  

Setup opens the Display Setup control window with the 
Screen Text tab selected. Click Setup to enter new lines of 
text. 

You can also position the text on the screen by clicking and dragging it to the desired location. 
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Display Persistence Control Window 
Access this control window from the Display menu, Display Persistence submenu, Persistence Controls 
command. 

  

Overview 

Use the Display Persistence control window to quickly 
change the display persistence or set the persistence 
time. 

To Use 

Click one of the Display Persistence buttons or click Off 
to set the display persistence. Click the Persist Time text 
box, and use the multipurpose knobs to set the 
persistence time. Click Reset to clear the display of 
accumulated waveform points. 

Behavior 

Clicking the display persistence buttons activates that 
type of persistence. Clicking Off turns all persistence 
off. Clicking Reset clears the accumulated waveform 
points from the display and restarts the persistence time. 
Adjusting the persistence time allows you to set the 
length of time to accumulate waveform points when you 
are using Variable persistence.  

 

TDS5032B and TDS5052B 

XY Pair X Axis Y Axis 

Ch 1 and Ch 2 Ch 1 Ch 2 

Ref 1 and Ref 2 Ref 1 Ref 2 

   

TDS50534B, TDS5054B, TDS5104B and TDS5054BE 

XY Pair X Axis Y Axis 

Ch 1 and Ch 2 Ch 1 Ch 2 

Ch 3 and Ch 4 Ch 3 Ch 4 

Ref 1 and Ref 2 Ref 1 Ref 2 

Ref 3 and Ref 4 Ref 3 Ref 4 

   

If you only display one source when you enter the XY format, the instrument automatically turns 
on the other source waveform to complete the XY pair. 
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XYZ format channel assignments 

When you use the XYZ display format, channel waveforms are assigned to the axis indicated in 
the following table. You cannot display math and reference waveforms in the XYZ format. 

 

Channels X Axis Y Axis Z Axis 

Ch 1, Ch 2, and Ch 
3 

Ch 1 Ch 2 Ch 3 

If you only display one or two source channels when you enter XYZ format, the instrument 
automatically turns on the other channels. 

Note 

The XYZ format is only available on 4-channel models and is only supported in FastAcq mode. 
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Cursors Menu 
Use the Cursors menu options to select cursor types, mode, and position, and also to turn cursors 
on and off. 

Cursor Setup Control Window 
Access this control window from the Setup button on the Cursor Type Setup control window, or by 
clicking the Cursor Setup command on the Cursors menu.  

Overview 

Use these controls to set the cursor parameters.  

  

To Use 

Click Cursor in the control window to turn cursors on and off. Select a cursor type by clicking one 
of the Cursor Type buttons. Select the waveform you want to measure from the Source drop-down 
list. Cursor 1 and Cursor 2 each have their own source.  

 If are using H-Bar or V-Bar Cursors and want the cursor source to be the same for both cursors, 
just set the source for Cursor 1. Cursor 2 will have the same value as Cursor 1, unless you change 
it. 

Click the Cursor Positions controls to map the cursors to the multipurpose knobs, then use the 
knobs to move the cursors. To select the cursor mode, click either the Indep (independent) or 
Tracking button. Select a Line Style from the drop-down list. Line styles are available for all 
cursor types. Select a Symbol Style from the drop-down list. Symbol styles are only available on 
Waveform and Screen cursors. 

If you are using XY display format you can also select the XY Cursor Readout from the drop-
down list. Only Waveform and Screen cursors are available in XY display format.  

 The Cursors menu Cursors On command can also be used to toggle the cursors on and off. The 
cursors are on when a check mark appears next to this command. 
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Behavior 

When cursors are turned on, the front panel CURSORS button is lighted. 

Indep (independent) cursor mode moves the cursors independent of each other. In Tracking mode, 
moving Cursor 1 moves Cursor 2 in tandem. However, moving Cursor 2 does not move Cursor 1.  

Symbol style applies only to Waveform and Screen cursors. The Line & X symbol style displays 
only an X when used with waveform cursors in XY display mode such that the vertical line is not 
drawn only the X. 

If you change the display format to XY when H Bar cursors are enabled, the cursor type will 
change to Screen. In normal acquisition mode, changing the display format to XY when V Bar 
cursors are enabled, changes the cursor type to Waveform. In FastAcq acquisition mode, changing 
the display format to XY when V Bar cursors are enabled, changes the cursor type to Screen. 

 To turn the cursors off, push the front-panel CURSORS button. 

Cursor Type Setup Control Window 
Access this control window by pressing the CURSORS front-panel button, clicking the Cursors toolbar 
button, or selecting the Cursor Controls command from the Cursor menu. 

  

Overview 

Use the Cursor Type Setup control window to select source for 
each cursor and the type of cursors for waveform measurements.  

To Use 

Click the Cursor1 button, and then select the waveform that you 
want to measure from the Channel Selector tabs. If you want to 
measure a different waveform from Cursor 2, click the Cursor 2 
button, and then select the waveform to measure from the 
Channel Selector tabs. Click one of the Cursor Type buttons to 
select a cursor type. 

Select a cursor type directly from the Cursors menu Cursor 
Type submenu. 

Behavior 

If are using H-Bar or V-Bar Cursors and want to measure the same waveform with both cursors, 
just select the waveform for Cursor 1. Cursor 2 will have the same value as Cursor 1, unless you 
change it. 

Click Setup to open the Cursor Setup control window where you can specify other cursor 
parameters. 
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Cursor Sources 

  

To Use 

Click the Source drop-down list to 
select the source for the cursor. Click 
the Position text box, and then use the 
multipurpose knobs to adjust the 
position of each cursor. 

Behavior 

You can assign cursor sources to both Cursor 1 and Cursor 2 for any cursor type. If the cursor type 
is V Bars or H Bars, setting the Cursor 1 source sets the Cursor 2 source to the same value. To 
have different sources for Cursor 1 and Cursor 2, set the Cursor 1 source first, and then set the 
Cursor 2 source.  

Only Screen Cursors have both an X and Y position. 

The Multipurpose Knobs Adj buttons appear only with Screen cursors. Click the Adj button to 
assign the multipurpose knobs to the X-axis and the Y-axis.  

Cursor Position Control Window 
Access this control window from the Cursors menu, Cursor Position command. 

 

Overview 

Use this Cursor Position control window to position the cursors 
with the multipurpose knobs. 

To Use 

Select the waveform that you want to measure from the 
Channel Selector tabs. Click one of the cursor position controls 
and use the multipurpose knobs to enter the cursor position. 

Behavior 

The cursor units depend on the cursor type. The cursor position 
readouts appear on the display graticule. When using the IRE 
graticule style, amplitude cursor readouts are shown in IRE 
units. 

Cursor position does not change if the cursor source changes or 
if the waveform is repositioned. 

 Use the pop-up keypad or your external keyboard to specify 
exact numerical cursor coordinates. 
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Horizontal Bar Cursors 
To Use 

To use the horizontal bar cursors, click H Bars in one of the cursor control windows or click H-
Bars from the Cursor Type submenu of the Cursors menu. Use the multipurpose knobs to move 
the cursors. Use the Cursor Source Channel Selector tabs to select the waveform that you want to 
measure. 

Behavior 

Horizontal bar cursors measure vertical parameters (amplitude). Typically the vertical parameters 
are in volts, but depend on the Vertical Units selected in the control window.  

The cursor readouts appear on the graticule when a control window is open. When the control 
windows are closed, the readouts appear on the right side of the screen. Each cursor has its own 
readout with respect to the zero-reference. The ∆ (delta) shows the difference between the cursor 
values.  

Vertical Bar Cursors 
To Use 

To select the vertical bar cursors, click V Bars in one of the cursor control windows or click 
V Bars from the Cursor Type submenu of the Cursors menu. Use the multipurpose knobs to move 
the cursors. Use the Cursor Source Channel Selector tabs to select the waveform that you want to 
measure. 

Behavior 

Vertical bar cursors measure horizontal parameters. Typically horizontal parameters are in time or 
frequency. 

The cursor readouts appear on the graticule when a control window is open. When the control 
windows are closed, the readouts appear on the right side of the screen.  

For time domain waveforms, each cursor has its own readout relative to the trigger point. 
The ∆ (delta) shows the time difference between the cursor values, or the frequency associated 
with the period between the cursors (Hz  =  1/time). 

For frequency domain signals, each cursor has its own readout relative to 0 Hz. The ∆ shows the 
difference in the frequencies between the cursors. 

You can also use vertical bar cursors with measurement gating. Measurement gating enables you 
to limit automatic measurements to within the boundaries of the vertical bar cursors rather than 
use the entire display width. 

Waveform Cursors 
To Use 

To select waveform cursors, click Waveform in one of the cursor control windows or click 
Waveform from the Cursor Type submenu of the Cursors menu. Use the multipurpose knobs to 
move the cursors. Use the Cursor Source Channel Selector tabs to select the waveform that you 
want to measure. 
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Behavior 

Waveform cursors can measure parameters on the same waveform or on different waveforms. The 
cursors measure vertical parameters (typically volts) and horizontal parameters (typically time or 
frequency) simultaneously. An X identifies the cursor location at the point where the cursors 
intersect the waveform. 

The cursor readouts appear on the graticule when a control window is open. When the control 
windows are closed, the readouts appear on the right side of the screen.  

One ∆ (delta) shows the voltage difference between the two cursors while the other  ∆ shows the 
time (or frequency) difference between the cursor values.  

Screen Cursors 
To Use 

To select screen cursors, click Screen in one of the cursor control windows or click Screen from 
the Cursor Type submenu of the Cursors menu. Use the multipurpose knobs to move the cursors. 
Use the Cursor Source Channel Selector tabs to select the waveforms that you want to measure. 

Behavior 

Use screen cursors to indicate an arbitrary X and Y position in the waveform display area 
represented by the intersection of a vertical and horizontal cursor line. Screen cursors measure 
both vertical parameters (typically volts) and horizontal parameters (typically time or frequency).  

Readouts display measurement parameters for both cursors. Vertical readouts display voltage 
values for each cursor with respect to the zero reference point and with respect to each other. 
Horizontal readouts display time or frequency values for each cursor with respect to the trigger 
point and with respect to each other. 

Cursor Modes 
To Use 

To select the cursor mode, click either the Indep (independent) or Tracking button in the Cursor 
Setup control window. 

Behavior 

In Independent mode, you can move one cursor at a time using the multipurpose knobs.  

In Tracking mode, moving Cursor 1 moves Cursor 2 in tandem so that Cursor 2 will always 
remain a fixed distance (time or voltage) from the Cursor 1. However, moving Cursor 2 does not 
move Cursor 1.  

 Select the cursor mode directly from the Cursors menu Cursor Mode submenu. 
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Cursor Style 
To Use 

Select a Line Style from the drop-down list. Line styles are available for all cursor types. 

Select a Symbol Style from the drop-down list. Symbol styles are only available on Waveform and 
Screen cursors. If you are in XY display format, you can also select the XY Cursor Readout from 
the drop-down list. 

Behavior 

Cursor positions are displayed according to line style, symbol style, cursor type, and waveform 
display format. See the following table. The Line & X symbol style displays only the X when used 
with waveform cursors in XY display mode. (The vertical line is not drawn.) 

Symbol 
Style 

Cursor Type Display 
Format 

Cursor Position 

Lines Waveform and 
Screen  

YT Intersection of horizontal and 
vertical lines. Default style for 
Screen cursors. 

Line & X Waveform and 
Screen 

YT Horizontal position is shown by a 
vertical line, the Y-axis is shown by 
an X. Default style for Waveform 
cursors in YT mode. 

X Waveform and 
Screen 

XY Single X indicates the horizontal 
and vertical position. Default style 
for Waveform Cursors in XY mode. 

Cursor readouts are displayed based on the selection in the XY cursor Readout drop-down list. 
This list is only available for Waveform and Screen cursors when you are using XY display 
format. 

XY Cursor 
Readout 

Cursor Type Display 
Format 

Cursor Position 

Rectangular Waveform 
and Screen 

XY Shown as rectangular coordinate 
positions. There are nine readouts 
for Waveform cursors and six for 
Screen cursors. 

Polar Waveform 
and Screen 

XY Shown as polar coordinate 
positions. There are nine readouts 
for Waveform cursors and six for 
Screen cursors. 

Product Waveform 
and Screen 

XY Shown as rectangular coordinates 
and the X vertical value is 
multiplied by the Y vertical value. 
There are six readouts for 
Waveform cursors and three for 
Screen cursors. 
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XY Cursor 
Readout 

Cursor Type Display 
Format 

Cursor Position 

Ratio Waveform 
and Screen 

XY Shown as rectangular coordinates 
and the Y vertical value is divided 
by the X vertical value.  

Cursors Using XY Display Format 
Access this control window from the Cursors menu Cursor Setup command. The Cursor Setup control 
window varies depending on the display format. 

Overview 

Use these controls to set the cursor parameters when you are using XY display format. 

  

To Use 

Select the readout format from the XY Readout drop-down list.  

Behavior 

When you are using XY display format, only Waveform and Screen cursors are available. If you 
change the display format to XY when H Bar cursors are enabled, the cursor type will change to 
Screen. In normal acquisition mode, changing the display format to XY when V Bar cursors are 
enabled, changes the cursor type to Waveform. In FastAcq acquisition mode, changing the display 
format to XY when V Bar cursors are enabled, changes the cursor type to Screen. 

If you change the display format from XY to YT when Screen cursors are enabled, the cursor type 
is changed to H Bars.  

XY Cursor Readouts only appear when you are using XY display format. Rectangular XY 
readouts are the default.  

Rectangular shows the cursor readouts as rectangular coordinate positions. Waveform cursors 
display nine rectangular readouts (∆X, ∆Y, ∆t, X1, X2, Y1, Y2, t1, and t2). Screen cursors display 
six readouts (∆X, ∆Y, X1, X2, Y1, and Y2). 

Polar shows the cursor position as polar coordinate positions. Waveform cursors display nine 
polar readouts (∆r, ∆0, ∆t, r1, r2, 01, 02, t1, and t2). Screen cursors display six polar readouts (∆r, 
∆0, r1, r2, 01, and 02). 

Product shows the cursor position as rectangular coordinates and the X vertical value is multiplied 
by the Y vertical value. Waveform cursors display six product readouts (∆X x ∆Y, X1 x Y1, X2 x 
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Y1, X2 x 2, ∆t, t1, and t2). Screen cursors display three product readouts (∆X x ∆Y, X1 x Y1, and 
X2 x Y2) 

Ratio shows the cursor position as rectangular coordinates and the Y vertical value is divided by 
the X vertical value. Waveform cursors display six ratio readouts (∆Y÷∆X, Y1÷X1, Y2÷Y1, ∆t, 
t1, and t2). Screen cursors display three ratio readouts (∆Y÷∆X, Y1÷X1, and Y2÷Y1).  
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Measurement Menu 
Use Measurement menu commands to select from and set up a variety of automatic measurements. 
Commands are also available on this menu for further in-depth analysis, including snapshots, 
gating (bounding), statistics, communication, and histograms. 

Measurement Setup Control Window 
Access this control window from the Measure menu Measurement Setup command, or the Meas toolbar 
button. 

Overview 

Use the Measurement Setup control window to set up the instrument for automatic measurements.  

  

From this control window, you can: 

 Select a waveform source using the Channel Selector tabs from which you can take the 
measurements. You can measure live waveforms, math waveforms, or reference waveforms. 

 Define amplitude, time, histogram, communications, or other measurements on the selected 
waveforms. 

 Create a list of measurements to appear in the main graticule or in a separate measurement 
window. 

 Define unique the reference levels for each measurement. 

 Use gating to limit the measurements to a specific area of the waveform. 

 Set up measurement statistics. 

 Take a snapshot of all measurements. 

 Set up histograms to evaluate specific regions of the waveform.  

 Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, 
measurements are calculated on an array of acquired waveforms. As the waveforms accumulate 
(with persistence on), your measurement accuracy may increase. However, only one or two 
channels can be displayed when you take automatic measurements using Fast Acquisitions mode. 
If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the 
requested measurements are made. Fast Acquistions mode is not automatically turned back on 
when you select fewer than three channels. 
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Measurement Tabs: Amplitude 

  

To Use 

Use the Ampl tab to select automatic 
amplitude measurements. Select a source 
channel from the Channel Selector tabs, and 
click a measurement button to add the 
measurement to the Measurement list. Click 
Display in the upper-right corner of the control 
window to turn the measurement display on 
and off. 

Behavior 

Measurements are updated approximately 
three times a second, or less for long record 
lengths. Measurements are calculated after 
each acquisition. You can display up to eight 
automatic measurements.  

 Select the individual measurements directly from the Measure menu Amplitude submenu. 

Measurement Tabs: Time 

  

To Use 

Use the Time tab to select automatic time 
measurements. Select a source channel from 
the Channel Selector tabs, and click a 
measurement button to add the measurement to 
the Measurement list. Click Display in the 
upper-right corner of the control window to 
turn measurement display on and off. 

Behavior 

Measurements are updated approximately 
three times a second, or less for long record 
lengths. Measurements are calculated after 
each acquisition. You can display up to eight 
automatic measurements. 

A new control window opens when you click Delay. Enter the parameters for the delay 
measurement and click Ok to return to the Measurement Setup control window. The delay 
measurement is added to the list. 

 Select the individual measurements directly from the Measure menu Time submenu. 
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Measurement Tabs: More 

  

To Use 

Use the More tab to select measurements 
not found under any of the other 
measurement tabs. Select a source channel 
from the Channel Selector tabs, and click a 
measurement button to add the 
measurement to the Measurement list. Click 
Display in the upper-right corner of the 
control window to turn the measurement 
display on and off. 

 

Behavior 

Measurements are updated approximately three times a second, or less for long record lengths. 
Measurements are calculated after each acquisition. You can display up to eight automatic 
measurements. 

A new control window opens when you click Phase. Enter the parameters for the phase 
measurement and click Ok to return to the Measurement Setup control window. The phase 
measurement is added to the list. 

 Select the individual measurements directly from the Measure menu More submenu. 

Measurement Tabs: Histogram  

  

To Use 

Use the Histog tab to select automatic 
histogram measurements. Click a 
measurement button to add the measurement 
to the Measurement list. Click Display in the 
upper-right corner of the control window to 
turn measurement display on and off. 

Behavior 

Measurements are updated approximately 
three times a second, or less for long record 
lengths. Measurements are calculated after 
each acquisition. You can display up to eight 
automatic measurements. 

  

You can also select the individual measurements directly from the Measure menu Histogram 
Measurements submenu.  
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Measurement Tabs: Communications 

  

To Use 

Use the Comm tab to select communications 
measurements, and then click a measurement 
button to add the measurement to the 
Measurements list.  

Behavior 

Measurements are updated approximately 
three times a second (or less for long record 
lengths). Measurements are calculated after 
each acquisition. 

You can display up to eight automatic 
measurements. 

 Most Comm measurements require either Wfmdb or FastAcq mode.  

 You may need to select Infinite Persistence display mode to accumulate enough data for the 
Comm measurement to work. 

 Select the individual measurements directly from the Measure menu. 

Measurement Tabs: Communications More 

  

To Use 

Use the Comm tab to select communications 
measurements, and then click a measurement 
button to add the measurement to the 
Measurements list.  

Behavior 

Measurements are updated approximately 
three times a second (or less for long record 
lengths). Measurements are calculated after 
each acquisition. 

You can display up to eight automatic 
measurements. 

 Most Comm measurements require either Wfmdb or FastAcq mode.  

 You may need to select Infinite Persistence display mode to accumulate enough data for the 
Comm measurement to work. 

 Select the individual measurements directly from the Measure menu. 
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Measurements List 

 

To Use 

To add a measurement to the list, select the waveform 
source, and click one of the measurement buttons. To delete 
a measurement, select the measurement, and click Clear. 
Click Display in the upper-right corner of the control 
window to turn the measurement displays on and off. 

 To delete all measurements in a single step, select all of the 
measurements and click Clear. 

 

Behavior 

This list contains your selected automatic measurements. You can add up to eight automatic 
measurements to the list. The measurements appear on the main screen when the Display button is 
On. 

When you click Clear without selecting a measurement, the last measurement in the list is deleted. 

 To quickly move the measurements from one channel to another, select all of the measurements 
in the list (click the first measurement, hold the left mouse button, and drag the mouse to the last 
measurement), and then select a new channel from the Source control. Similarly, you can change 
all of the measurements from one type to another if you select all the measurements in the list 
and click on a single measurement button. 

Measurement Snapshot Control Window 
Access this control window from the Measure menu Snapshot command, or from the Measurement 
Setup control window. 

Overview 

The Measurement Snapshot lets you see all of the automated measurements for a selected 
waveform at once.  

To Use 

Select the waveform for which you want to take a snapshot. Click the Snapshot button in the 
Measurement control window, or select Snapshot from the Measure menu. Click either General or 
Comm under Snapshot Type to begin the snapshot. You can also copy the snapshot data to the 
clipboard for use in another program, such as Excel. 

Behavior 

When the instrument has completed all of the measurements, the snapshot window is updated with 
the measurements. 



 163

Snapshot executes all of the single waveform measurements once; the measurements are not 
continuously updated. Any measurements previously taken are retained on the display until you 
complete a new snapshot. To take another snapshot, click the Snapshot Again button. 

 Things to consider when taking snapshots: 
• Before taking a snapshot, be sure to properly display the waveform. Snapshot does not warn you 

if a waveform is improperly scaled (clipped, low signal amplitude, low resolution, and so on). 
• To change the source for taking a snapshot, select another channel, math, or reference memory 

waveform, and then execute snapshot again. 

Measurement Statistics Control Window 
Access this control window from the Measurement Setup control window. You can also access statistics 
from the Measure menu Statistics submenu.  

Overview 

Use the Measurement Statistics control window to display statistical calculations on 
measurements. The control window contains controls that determine which statistics are displayed 
in the measurement window. 

  

To Use 

Click Off to turn the measurement statistics display off. 
Click Mean to display the value and the mean  (µ) of each 
measurement. Click All to display all statistics for each 
measurement value (mean  (µ), minimum  (m), maximum  
(M), standard deviation  (σ), and population (n)). Use the 
multipurpose knobs to set the statistics weight. Click Reset 
to restart the statistics calculations. 

 Select the individual statistics directly from the Measure 
menu Statistics submenu. 

Behavior 

Measurement values continue as live updates while the 
statistics accumulate over time. The statistics appear on the 
main screen when a control window is open or on the right 
side of the screen when no control windows are open and 
there are less than four measurements active. The color of 
the statistics match the color of the waveform from which 
the measurement was taken. 

The statistics weight specifies the constant used to calculate the mean and standard deviation; the 
minimum and maximum values are unaffected by weighting. A large value produces statistics that 
vary less over time. 

All statistics (mean, minimum, maximum, standard deviation, and population) are always gathered 
even though the mean may be the only statistic shown. When measurements are turned on, the 
acquisitions take longer because measurements and statistic calculations are done on each 
acquisition.  
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Reference Levels Control Window 
Access this control window from the Measure menu Reference Levels command. 

Overview 

Use the Reference Levels control window to define unique reference levels for each measurement. 
The default reference levels serve most general-purpose measurements. However, you can 
customize all measurements to use different reference levels. 

  

To Use 

Click Min-Max to derive the reference levels from the minimum and maximum values of the 
waveform record. If you want to derive the reference levels based on statistical data, click the 
Histogram or the Histogram mean button.  

Refer to the graphic in the center of the control window and determine the reference levels that 
you want to define. Click the control with the associated reference level, and use the multipurpose 
knobs to adjust the value. If you want the reference levels to be measured by volts, click the 
Absolute button under Units. To measure the reference levels as a percentage, click the Percentage 
button. 

Click either Eye or Pulse to select the signal type. 

Behavior 

The following reference levels are included: High Reference, Mid Reference, Low Reference, and 
Mid2 Reference. 

Define the reference levels as percentages of the signal amplitude or as absolute values in vertical 
units by clicking the appropriate button to define the Units selection. Use Percentage to have 
reference levels track the signal. Use Absolute to set the reference levels to fixed values.  

The top and base levels that the measurement system derives from a waveform influence the 
fidelity of measurements. The measurement system can derive the reference levels from either the 
minimum and maximum values of the waveform or from statistical data.  

The Min-Max selection uses the highest and lowest values of the waveform record. This selection 
is best for examining waveforms with no large, flat portions at a common value, such as sine 
waves and triangle waves.  

The Histogram selection sets the top and base values statistically. The most common values either 
above or below the midpoint are used (depending on whether the high reference point or the low 
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reference point is being defined). Because the statistical approach ignores short-term aberrations 
(overshoot or ringing), the histogram method is the best setting for examining pulses. 

Gating Control Window 
Access this control window from the Measure menu Gating command, or from the Measurement Setup 
control window. 

  

Overview 

Use the Gating control window to limit the measurement area 
of the waveform to the region bounded by the vertical bar 
cursors or to the left and right edges of a Zoom window.  

To Use 

To define the gating area with the vertical bar cursors, click 
Cursor, and then click either Indep or Tracking to select 
the Track Mode. These buttons are only displayed when you 
click Cursor. 

To define the gating area from a Zoom area, click one of the 
four Zoom buttons.  

  

To turn off measurement gating, click the Off button. 

Click Setup to return to the Measurement Setup control window. 

Behavior 

Normally the instrument takes measurements over the entire waveform record. Gating lets you 
limit measurements to a specific portion of the waveform. You can limit gating to the region 
bounded by the vertical bar cursors or to the left and right edges of a Zoom area. 

When you click Zoom (1-4) the Zoom window appears in the lower half of the display. 
Measurements are taken within the boundaries of the Zoom area. You can only take measurements 
on one Zoom area at a time. 

When you click Cursor, measurements are taken within the boundaries of the vertical cursors. Use 
the multipurpose knobs to move the cursors. 

When you use vertical cursors to control the gating, you can also specify the cursor mode. Use the 
independent cursor mode to move the cursors one at a time with the multipurpose knobs. Use the 
tracking mode to have the cursors track one another; moving Cursor 1 automatically moves Cursor 
2 in tandem. 

 Tips for using measurement gating: 

 Click, hold, and drag across the part of the graticule that you want to measure. After you 
define the measurement area, select Measurement Gating from the shortcut menu to place 
gating cursors around the measurement area. 

 Use the same click, hold, and drag method to turn measurement gating off; just select 
Measurement Gating Off in the shortcut menu. 
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Histogram Control Window  
Access this control window from the Measure menu Waveform Histograms command. 

Overview 

Use the Histogram control window to set up a vertical or horizontal histogram. Use vertical 
histograms to measure signal noise and horizontal histograms to measure signal jitter. 

To Use 

Use the Channel Selector tabs to select the source waveform for the histogram measurements.  

Next, click the type of histogram that you want to use for your measurement, Horiz (Horizontal) or 
Vert (Vertical). Once you make this selection, histograms continue to be calculated even if you set 
Display to Off. You must explicitly click the Histogram Mode Off button to stop accumulating 
histogram data. Or, click Reset to start a new histogram. 

Click either Linear or Log to set the scaling. Adjust the size of the histogram box by clicking 
Limits under Adjust Histogram Box, and use the multipurpose knobs to set the box boundaries. 
Move the location of the histogram box by clicking Location under Adjust Histogram Box, and 
then use the multipurpose knobs to set the X and Y Locations.  

Behavior 

A histogram consists of a series of narrow bins into which samples are counted. The histogram 
box defines the graticule area of the histogram and the number of vertical or horizontal bins. 
Horizontal histograms have a maximum of 500 bins while vertical histograms have a maximum of 
200 bins. 

The displayed width or height of the bin that contains the most counts is determined by the Histo 
Size control. The relative sizes for all other bins are scaled proportionally to the bin that contains 
the most counts. 

Histogram limits use the same units as the horizontal and vertical scale controls. When you 
specify the histogram box in terms of location, the Y location control adjusts the bottom edges of 
the histogram while the X location control adjust the left edge of the histogram box. 

 Here are several tips for using histograms: 

 Right-click in the Histogram box to access a shortcut menu that will allow you to quickly 
make changes to the histogram.  

 Use the Measure menu or shortcut menu Reset Histogram command to reset all bin counts  
to 0. 

 Click, hold, and drag across part of the graticule where you want to set up a histogram and 
select Histogram from the shortcut menu. 

 Use the same click, hold, and drag method to remove a histogram from the display. Select 
Histogram Off from the shortcut menu. 

 You can turn the histogram display off and still accumulate histogram data. This enables you 
to view the waveform without having the histogram obscure the data. Turn the histogram 
display on (use the Display button on the right side of the control window) at any time to view 
the histogram. 
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 Use the front-panel channel buttons to turn the source waveform display off so that the 
waveform does not obscure the histogram. Data accumulation continues whether the 
waveform display is on or off. 

 The instrument can perform up to eight automated statistical measurements on the histogram. 
Allow the histogram to accumulate data for a while, and then turn on the desired 
measurements. 

 You can use Fast Acquisitions mode with histograms. However, only one or two channels can 
be displayed. If three or more channels are displayed, the Fast Acquisitions mode is turned 
off. The Fast Acquisition mode is automatically turned back on when you select fewer than 
three channels. 

Delay Measurement Setup 
Access this control window by clicking Delay under the Time tab in the Measurement Setup 
control window, or from the Measure menu Time submenu. 

Overview 

Use the Delay Measurement Setup control window to set up the instrument to measure the delay 
between two waveforms. 

To Use 

Select the source waveforms from the Channel Selector tabs. Use the other controls in the control 
window to select the Delay Edges, Mid Reference point, Mid2 Reference point, and to specify the 
search (Delay) direction. Click Ok to add the measurement to the measurement list, or click 
Cancel to cancel the measurement and return to the Measurement Setup control window. 

Behavior 

This timing measurement is the time between the midreference crossing of two different 
waveforms, or the gated region of the waveforms. 

The graphic in the control window shows the points on the waveforms from which the delay 
measurement will be taken. The graphic is updated each time you change the control settings. The 
Delay direction controls only apply to Source 2. When you click Forward, the instrument starts 
searching for the desired edge at the beginning of the record. When you click Backwards, the 
instrument starts searching for the desired edge from the end of the record. If the edge for Source 1 
is before the edge for Source 2, then the delay is greater than zero. Otherwise the delay is less than 
zero. 

Phase Measurement Setup 
Access this control window by clicking Phase under the More tab in the Measurement Setup 
control window or from the Measure menu More submenu. 

Overview 

Use the Phase Measurement Setup control window to set up the instrument to take phase 
measurements. 

To Use 

Use the Channel Selector tabs to select the target and reference source waveforms. Then use the 
Mid Reference control to specify the voltage reference point in the waveform. Click OK to add the 
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measurement to the measurement list, or click Cancel to cancel the measurement and return to the 
Measurement Setup control window. 

Behavior 

This measurement is the amount of time one waveform leads or lags another waveform. Phase is 
expressed in degrees, where 360° comprise one waveform cycle. The measurement is taken at the 
voltage level specified by the Mid Reference control. 
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Mask Menu 
Use the Mask menu commands to setup a mask, edit or create user masks or setup a limit test. 

Mask Setup Control Window 
Access this control window from the Masks menu and select Mask Setup…. 

Overview 

Use these controls to set up a mask test. You can set the type of mask, polarity, display, and 
alignment.  

Note 

Option SM must be installed to have access to masks other than a User mask. 

  

Mask Types and Standards (Option) 
Overview 

The following tables list the Mask Types and Standards available with Option SM. 

Note 
The standards available for an instrument depend on the bandwidth and/or configuration of that 
instrument. 

 

ITU–T masks 

None 32Mb 
32.064 Mb/s 

97Mb 
97.728 Mb/s 

DS1 Rate 
1.544  Mb/s 

DS2 Rate Sym 
6.312 Mb/s 

DS2 Rate Coax 
6.312 Mb/s 

DS3 Rate 
44.736  Mb/s 

E1 Sym Pair 2.048  
Mb/s 

E1 Coax Pair 
2.048  Mb/s 

E2  
8.448  Mb/s 

E3  
34.368  Mb/s 

E4 Binary 0 
139.26  Mb/s 

E4 Binary 1 
139.26  Mb/s 

STM1E  
Binary 0 155.52  
Mb/s 

STM1E  
Binary 1 155.52  
Mb/s 

 



 170

 

ANSI T1.102 masks 

None DS1  
1.544  Mb/s 

DS1A  
2.048  Mb/s 

DS1C  
3.152  Mb/s 

DS2  
6.312  Mb/s 

DS3  
44.736  Mb/s 

DS4NA  
139.26  Mb/s 

DS4NA  
Max Output 
139.26  Mb/s 

STS–1 Pulse 
51.84  Mb/s 

STS–1 Eye 51.84  
Mb/s 

STS–3  
155.52  Mb/s 

STS–3 
Max Output 
155.52  Mb/s 

 

Ethernet mask 

None 100Base–TX STP 
125  Mb/s 

100Base–TX UTP 
125  Mb/s 

Gigabit Ethernet 
1.25  Gb/s 

1000B–CX Norm, 
TP2 1.25  Gb/s 

1000B–CX Abs, 
TP2 1.25  Gb/s 

1000B–CX Abs, 
TP3 1.25  Gb/s 

XAUI, Near  
3.125  Gb/s 

XAUI, Far  
3.125  Gb/s 

1000B–SX/LX 
1.25  Gb/s 

  

 

SONET/SDH masks  

None OC1/STM0 
51.84  Mb/s 

OC3/STM1 
155.52  Mb/s 

OC12/STM4 
622.08  Mb/s 

OC48/STM16 
2.4883  Gb/s 

OC48–FEC 
2.666  Gb/s 

    

 

Fibre Channel masks 

None FC133 Optical 
132.8  Mb/s 

FC266 Optical 
265.6  Mb/s 

FC531 Optical 
531.2  Mb/s 

FC1063 Optical 
1.0625  Gb/s 

FC1063 Optical  
Draft Rev 11 

FC2125 Optical 
2.125 Gb/s 
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Fibre Channel Electrical masks 

None FC133E Elec. 
132.8 Mb/s 

FC266E Elec. 
265.6 Mb/s 

FC531E Elec. 
531.2 Mb/s 

FC1063E Elec. 
1.0625 Gb/s 

FC1063E  
Norm, Beta, 
Transm 

FC1063E  
Norm, Delta, 
Transm 

FC1063E  
Norm, Gamma, 
Transm 

FC1063E  
Abs, Beta, Transm 

FC1063E  
Abs, Delta, 
Transm 

FC1063E  
Abs, Gamma, 
Transm 

FC1063E  
Abs, Beta, Recv 

FC1063E  
Abs, Delta, Recv 

FC1063E  
Abs, Gamma, 
Recv 

FC2125E  
Norm, Beta, 
Transm 

FC2125E  
Norm, Delta, 
Transm 

FC2125E  
Norm, Gamma, 
Trans 

FC2125E  
Abs, Beta, Transm 

FC2125E  
Abs, Delta, 
Transm 

FC2125E  
Abs, Gamma, 
Transm 

FC2125E 
Abs, Beta, Recv 

FC2125E  
Abs, Delta, Recv 

FC2125E  
Abs, Gamma, 
Recv 

 

 

InfiniBand masks 

None 2.5 Optical 2.5 Gb/s 2.5 Electrical 2.5 Gb/s 

 

Serial ATA masks 

None G1 Tx 1.5 Gb/s G1 Rx 1.5 Gb/s 

G2 Tx 3.0 Gb/s 
(TDS6000 only) 

G2 Rx 3.0 Gb/s 
(TDS6000 only) 

 

 

USB 1.1/2.0 masks 

None FS 12 Mb/s HS:T1 480 Mb/s HS:T2 480 Mb/s 

HS:T3 480 Mb/s HS:T4 480 Mb/s HS:T5 480 Mb/s HS:T6 480 Mb/s 
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1394b masks 

None S400b T1 
491.5 Mb/s 

S400b T2 
491.5 Mb/s 

S400b Optical 
491.5 Mb/s 

S800b T1 
983.0 Mb/s 

S800b T2 
983.0 Mb/s 

S800b Optical 
983.0 Mb/s 

S1600b T1 
1.966 Gb/s 

S1600b T2 
1.966 Gb/s 

S1600b Optical 
1.966 Gb/s 

  

 

Rapid IO LP–LVDS masks 

None Drv  
500  Mb/s 

Drv 
750  Mb/s 

Drv 
1.0  Gb/s 

Drv 
1.5  Gb/s 

Drv 
2.0  Gb/s 

Ext Drv 
500  Mb/s 

Ext Drv 
750  Mb/s 

Ext Drv  
1.0  Gb/s 

Ext Drv  
1.5  Gb/s 

Ext Drv  
2.0  Gb/s 

Rcv 
500  Mb/s 

Rcv 
750  Mb/s 

Rcv 
1.0  Gb/s 

Rcv 
1.5  Gb/s 

Rcv 
2.0  Gb/s 

 

Rapid IO Serial masks 

None RIO Serial 
1.25  Gb/s 

RIO Serial 
2.5  Gb/s 

RIO Serial 
3.125  Gb/s 

 

IOF masks 

none SFI/SPI-5 TA Data 
2.488 Gb/s 

SFI/SPI-5 TC Data 
2.488 Gb/s 

SFI/SPI-5 TA 
Clock 2.488 Gb/s 

SFI/SPI–5 TC 
Clock 2.488  Gb/s 

SFI/SPI–5 RB 
Data 2.488  Gb/s 

SFI/SPI–5 RD 
Data 2.488  Gb/s 

SFI/SPI–5 RB 
Clock 2.488  Gb/s 

SFI/SPI–5 RD 
Clock 2.488  Gb/s 

SFI/SPI–5 TA 
Data 
3.125  Gb/s 

SFI/SPI–5 TC 
Data  
3.125  Gb/s 

SFI/SPI–5 TA 
Clock  
3.125  Gb/s 

SFI/SPI–5 TC 
Clock  
3.125  Gb/s 

SFI/SPI–5 RB 
Data 
3.125  Gb/s  

SFI/SPI–5 RD 
Data  
3.125  Gb/s 

SFI/SPI–5 RB 
Clock 
3.125  Gb/s  

SFI/SPI–5 RD 
Clock 

VSR 
OC192/STM64 

TFI–5  
2.488  Gb/s 

TFI–5 
3.1104  Gb/s 
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IOF masks 
3.125  Gb/s  1.24416  Gb/s 

 

PCI–Express masks 

None PCI–Express 
Transm 2.5  Gb/s 

PCI–Express Recv 
2.5  Gb/s 

 

Mask Display Control Window 

  

To Use 

Click the On/Off control to turn the mask display on or off. Click the Config 
control to activate the Mask Configuration Display control window.  

Behavior 

When the On/Off control is on, the mask is displayed on the graticule. When 
the On/Off control is off, the mask is not displayed. Clicking the Config 
control will replace the Mask Setup control window with the Mask 
Configuration Display control window.  

Mask Alignment Control Window 

  

To Use 

Click the Autoset control to perform an 
autoset on the signal. Click the Autofit 
control to turn the minimize hits function on 
or off. Click the Config control to access 
the Autofit or Autoset Configuration control 
window. 

Behavior 

Clicking the Autoset control causes the instrument to automatically align the mask based on the 
characteristics of the input signal. This function is done once, and that setting is not changed until 
you run the autoset command again or until you change any settings. This is the same as pushing 
the front-panel Autoset control. 

When Autofit is used, the signal is aligned within the mask to minimize the number of hits on each 
acquisition. Settings may change after each acquisition when autofit is used. 

Note 
The interaction between Autofit and Persistence can affect the display of persistence data. Autofit 
moves the waveform vertically and/or horizontally to reduce the number of hits within a given 
mask. If either infinite or variable persistence is enabled, these movements will clear any 
persistence data. If Autofit makes frequent adjustments, there can be little or no persistence data. 
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Clicking the Autoset Config control will replace this control window with the Autoset Mask 
Configuration control window. Clicking the Autofit Config control will replace this control 
window with the Autofit Mask Configuration control window. 

Mask Source Control Window 
To access this control window, select Source… from the Masks menu. 

Overview 

Use this control window to select the source of the signal that you want to test. 

  

To Use 

Click the Ch, Math, or Ref tab to select the source for mask testing. Then click the number (1–4) 
of the channel, math expression, or reference that you want to use. 

Behavior 

When you click the Ch tab and select a channel number, it is used as the source for mask testing. 
You can select only one source at a time for mask testing. 

Mask Margins Control Window 
To access this control window, select Tolerance Setup… from the Masks menu. 

  

Overview 

Use this control to turn the margin mode on or off 
and to set the percentage of margin used for the 
mask test. 

To Use 

Click the On/Off control to turn the mask margin 
tolerance on or off. Click the up and down arrow 
buttons or click the text field to activate the pop-up 
keyboard and set the percentage of margin 
tolerance. 

Behavior 

When the mask margin tolerance is on, you can control the percentage of margin used in the mask 
test. Use the up and down arrow buttons to increase or decrease the percentage in 1% increments. 
A tolerance that is > 0 makes passing a mask test more difficult. A mask test that passes with a 
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tolerance that is > 0 demonstrates that the signal passes the test with a margin for further error. 
Setting the tolerance to < 0 makes a mask test easier to pass. A tolerance that is < 0 can be used to 
demonstrate by how much of a margin the signal fails. 

Mask Pass/Fail Setup Control Window 
To access this control window, select Pass/Fail Setup…from the Masks menu. 

Overview 

Use this control window to set the parameters for passing or failing the mask test, to set the test 
notification mode, to select the polarity for testing, and whether to repeat the test.  

  

Behavior 

Clicking More will show a second control window of failure notifications. When More is clicked 
in the window below, it will return you to the Pass/Fail Setup control window displayed above. 
Use the More Pass/Fail Setup control window to save and/or log failed waveforms and to enable 
E-mail on mask failure.  
More Pass/Fail Setup Control Window 
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Mask Test Pass/Fail Controls 

  

Overview 

Use the # of Wfms (Samples), Fail Thresh, and Test Delay to set the 
parameters for the mask test. 

Note  

If you are using Waveform Database mode, the # of Wfms text box 
changes to a Samples text box. 

To Use 

Click the # of Wfms (Samples) text box to activate the pop-up 
calculator. Enter the number of waveforms to use in a test. In the Fail 
Thresh text box enter the minimum number of waveforms that must 
fail for the test to fail. Enter the number of seconds to wait before 
starting the test in the Test Delay text box. 

Behavior 

Entering a number in the # of Wfms (Samples) text box stops the test when that number has been 
reached. 

If the waveforms or samples that fail are equal to or greater than the number in the Fail Thresh text 
box, the test has failed. If the failed waveforms or samples are less than the number in the Fail 
Thresh text box, the test passes.  

The instrument begins sampling after the number of seconds has passed that is set in the Test 
Delay text box. Use the Test Delay if you need to give the signal source time to stabilize. 

Mask Pass/Fail Test Notification 

  

Overview 

Use the Pass/Fail Test Notification to set the 
mode of notification, send commands, save 
waveforms, send e-mail, print, and log data 
when a waveform fails or a test completes. 

To Use 

Clicking the controls will switch between on and off. If the control is off, click it to turn it on. 
Clicking the More control switches between additional controls and the controls shown in the 
graphic. 

Behavior 

When Beep in the Failure field is turned on, the instrument will beep when a test fails. When Beep 
in the Completion field is turned on the instrument will beep when the test is completed. 
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When SRQ is turned on in the Failure field, it sends a GPIB SRQ command if a test fails. When 
SRQ is turned on in the Completion field, it sends a GPIB SRQ command when a test completes. 

Clicking the Print control sends the waveform to a printer when a test fails. 

Clicking the More control switches to the E-mail, Save Wfm, Log Date, and Path controls. 
Clicking More again returns you to the controls in the graphic. 

Pass Fail Setup More 
Access this control window from the Masks Pass/Fail Setup control window. 

  

Overview 

Use this control window to save a failed waveform, log the date 
and time of a failed waveform, and specify the directory where 
you want to save the waveform or send e-mail on a failed 
waveform. 

  

To Use 

Click E-mail to turn e-mail on mask failure on. Click Setting to set up e-mail on event if you have 
not already done so. Click the Save Wfm control to turn the save waveform function on and off. 
Click the Log Date control to turn the failed waveform log function on and off. Click the Path 
control to specify the path where you want to save the waveform. 

Behavior 

When Save Wfm is turned on, the instrument saves waveform data to a default directory unless 
you specified a different directory using the Path control. A file name is generated by combining 
the date and time. 

When Log Date is turned on, the date and time for each failed mask test is recorded to a file of 
your choice. 

Mask Polarity 

 

Overview 

Use the Mask Polarity control to select whether to test the positive or 
negative pulse or both. 

To Use 

Click the Positive control to set the polarity to positive, the Negative 
control to set the polarity to negative, and the Both control to set the 
polarity to both. 
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Behavior 

When the Positive control is selected, the mask test is performed on the positive pulse. When the 
Negative control is selected, the mask test is performed on the negative pulse. When the Both 
control is selected, the mask test is performed on both the positive and negative pulses. 

Mask Test Repeat 

  

Overview 

Use the controls in the Pass/Fail Test field to start the test or to 
run the test continuously. Use the Controls button to open the 
Controls control window. 

To Use 

Click the Repeat control to run the test continuously. Click the 
On/Off control to start the test. Click the Controls button to open 
the Mask Test Controls control window 

Behavior 

When the Repeat control is on, the test runs continuously. When the On/Off control is clicked, the 
test starts using the parameters from the Mask Setup control window and the Pass/Fail Results 
window is displayed. When the Controls button is clicked the Mask Test Controls control window 
is displayed. 

Mask Pass/Fail Results Control Window 
Access this control window from the Masks menu and select Pass/Fail Results…. 

Overview 

Use this control window to view real time test results, start the test, reset the test at the beginning, 
activate the waveform failure log file, and open the Mask Test Controls control window. 
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Mask Test Summary 
Overview 

Use this window to view real time test results. 

 

To Use 

The Pass/Fail Summary is a read only field. 

Behavior 

The Pass/Fail Summary fields provide a real time summary of the test results. Waveforms or 
Samples Tested shows how many waveforms or samples have been tested in relation to how many 
were specified in the test setup. 

Source indicates what signal source was used for the test. 

Status indicates whether the test has passed, failed, or is passing. Note that passing appears in 
yellow, passed in green, and failed in red. 

Total Hits indicates the total number of data points that violated the mask. 

Failed Wfms shows the total number of waveforms that failed during the test sequence. 

Mask Hits Per Segment 
Overview 

Use this window to view the hits for each mask segment of the test. 

 

To Use 

The Hits per segment is a read only field. 

Behavior 

Each mask test can have up to 16 segments. The data point violations per segment are shown in 
this window. Source indicates the input signal in use for the test. The segments are identified by 
Seg followed by the number of the segment. Only the number of segments used in a test is shown. 
A scroll bar appears if there are more segments used than can be seen at one time. 
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The segments of a mask are the polygonal regions on the screen. Segment one is the left upper 
most polygon. Segments are assigned from top to bottom and left to right on the screen. 

Mask Test Start or Reset 
Access these controls from the Masks Pass/Fail Results Setup control window.  

  

Overview 

Use this control window to start a test or reset the test to the 
starting point. 

To Use 

Click the On/Off control to start the test. Click the Reset 
control to reset the test to the beginning. 

Behavior 

When the test starts, it uses the parameters in the Pass/Fail Test Setup control window. When the 
test is reset, the Total Hits, Failed Wfms, Hits per segment, and Waveforms Tested fields are reset 
to zero. 

Mask Test Controls Control Window 
Access this control window by clicking the Controls button on the Pass/Fail Results Setup control 
window. 

  

Overview 

Use this control window to run a test and view the results. You can 
also reset or start the test and return to the Mask Setup control 
window from this control window. 

To Use 

Click the On/Off control to start and stop the test. Click the Reset 
control to reset the test. Click the drop-down arrow in the Test 
Summary field to select a different source. Status, Total Hits, and 
Failed Wfms are read only fields. Click the Setup control to return to 
the Mask Setup control window. 

Behavior 

This control window allows a mask test to run on a full screen and 
still provide access to the start, stop and reset functions. In addition, 
you can see the test summary for each input selected. 
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Mask Configuration Display Control Window 
Access this control window from the Masks menu and select Config… or from the Masks Setup control 
window. 

Overview 

Use this control window to set whether changes in the scale will also be made in the mask. You 
can also use this control window to return to the Mask Setup control window. 

  

To Use 

Click the Lock Mask to Waveform button to turn it on and off. Click the Masks button to go to the 
Mask Setup control window. 

Behavior 

When the Lock Mask to Waveform button is turned on, any changes you make to the scale, 
vertical position or horizontal position will be reflected in the mask. Turning on Highlight Hits 
displays the hits in a different color so they can be easily seen. When you click the Mask button 
this window closes, and the Mask Setup control window opens. 

Mask Configuration Autoset Control Window 
Access this control window from the Masks menu and select Config… or from the Masks Setup control 
window. 

Overview 

Use this control window to set the vertical, horizontal, and trigger autoset parameters, activate 
autofit or autoset, choose the autoset mode, return to the default autoset configuration, or go to the 
Mask Setup control window.  

Clicking Autoset aligns the signal within the mask. This operates the same as the AUTOSET 
button on the front panel. Clicking Defaults returns the instrument to the default autoset 
configuration. Clicking Masks replaces this control window with the Mask Setup control window.  



 182

  

Mask Autoset Vertical Controls 

  

Overview 

Use these controls to choose whether to have autoset affect 
the vertical scale or position. You can also choose whether 
to have autoset affect DC compensation.  

To Use 

Click the Scale, Position, and DC Compensation controls to 
turn these vertical control functions on or off. 

Behavior 

Turning on the Scale, Position, or DC compensation sets these vertical adjustments up to be 
performed on an autoset. 

Mask Autoset Horizontal Controls 

  

Overview 

Use these controls to choose whether to have autoset affect the 
horizontal scale or position. 

To Use 

Click the Scale and Position controls to turn these horizontal 
control functions on or off. 

Behavior 

Turning on the Scale or Position horizontal control functions sets up these adjustments to align the 
signal within the mask when autoset is done. 
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Mask Autoset Trigger Level Control 

  

Overview 

Use this control to choose whether to have autoset affect the trigger 
level. 

To Use 

Click the Trigger Level control to turn it off or on. 

Behavior 

When the Trigger Level control is turned on, the trigger levels are adjusted to match the signal 
when autoset is performed. 

Mask Autoset Autofit Control 

  

Overview 

Use this control to minimize hits. 

To Use 

Click the Autofit Once control to autofit the waveform after autoset is 
performed. 

Behavior 

When Autofit is turned on, the waveform is autofitted once at the end of every autoset. Autoset 
will take longer but hits will be minimized. Autofit will only move the signal if there are mask 
hits. 

Mask Autoset Mode 

 

Overview 

Use these controls to select whether autoset will be done 
automatically or manually. 

To Use 

Click Auto to have autoset done automatically after a standard 
mask is selected. Click Manual to make adjustments manually. 

Behavior 

If Auto is selected, an autoset is done automatically after a standard mask is selected. The purpose 
of the manual autoset mode is to adjust everything that can be done without having any waveform 
data. 
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Mask Configuration Autofit Control Window 
Access this control window from the Masks menu and select Config… or from the Masks Setup control 
window. 

Overview 

Use this control window to configure the limits for minimizing mask hits, return to default setting, 
or return to the Mask Setup control window. 

  

To Use 

Set the vertical and horizontal maximum levels of adjustment by clicking the control, and then use 
the multipurpose knobs or double-click the control and use the pop-up keypad. Click Autofit to 
align the signal within the mask. Click Defaults to reset the autofit configuration to the default 
values. Click Masks to return to the Mask Setup control window. 

Behavior 

The maximum level of adjustment determines how far Autofit will search for the best fit to 
minimize hits. For example, if you set the Vertical Maximum to 10% div, Autofit searches up to 
and including 10 percent of the vertical divisions for the best fit. Autofit minimizes hits by 
aligning the signal within the mask.  

Clicking Masks replaces the Mask Configuration Autofit control window with the Mask Setup 
control window. 

Note 
The interaction between Autofit and Persistence can affect the display of persistence data. Autofit 
moves the waveform vertically and/or horizontally to reduce the number of hits within a given 
mask. If either infinite or variable persistence is enabled these movements will clear any 
persistence data. If Autofit makes frequent adjustments, there can be little or no persistence data. 
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User Mask Setup 
Overview 

Use this control window to access the Mask Edit control window or to copy a standard mask as a 
user mask. You can also select the standard that you want to copy or edit from the standard drop-
down list.  

Note  

Option SM must be installed to have access to mask types other than a User mask. 

  

To Use 

From the Mask Setup control window, click More, and then click the User Mask type control. 
Click the Edit User Mask control to access the Mask Edit control window. Click the Copy Current 
Mask to User Mask to make the current mask a user mask. 

Behavior 

Clicking the User Mask control gives you access to the User Mask in the standard drop-down list. 
Clicking the Edit User Mask control will replace this control window with the Mask Edit control 
window. Clicking the Copy Current Mask to User Mask control will activate a dialog box where 
you can overwrite the user mask.  

Mask Edit Control Window 
Access this control window from the Mask menu by selecting Mask Edit Setup…. 

Overview 

Use this control window to select the segment and vertex for editing, set the Vertical and 
Horizontal Mask Values, and save or recall masks. 
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To Use 

Click the Mask Segment and Vertex up and down arrows to select the segment or the vertex of the 
mask to be edited. Click Add to add a point to the boundary in the selected segment and just after 
the selected vertex. Click Del to delete the selected vertex from the selected segment. Click Del 
All to remove all points in the selected segment.  

To change the horizontal or vertical values for the selected segment and vertex, click the Mask 
Values Horizontal or Vertical text box to activate the pop-up keypad. To save a mask, click Save 
to activate the Save As dialog box. To recall a previously saved mask, click Recall to activate the 
Recall dialog box. 

Behavior 

The Segment up and down arrows increase or decrease the segment number by one. The Vertex up 
and down arrows increase or decrease the vertex by 1. To set a specific number, click the Vertex 
text box to activate the pop-up calculator.  

Clicking the Add button adds a point to the boundary in the selected segment and just after the 
selected vertex in addition to moving any points that follow the newly added point in the boundary 
up one. For example, if there are 6 points in the boundary of the selected segment and you add a 
point when the selected vertex is 4, then the vertex which was 4 becomes vertex number 5, 
number 5 becomes 6, and vertex 6 is changed to vertex 7.  

Clicking Del deletes the selected vertex from the selected segment and moves any points that 
follow the deleted point down one in the boundary. Clicking Del All deletes all points in the 
selected segment, effectively deleting that segment. 

Clicking the Setup button will return you to the Masks Setup control window. Clicking the 
Controls button will activate the User Mask Edit control window where you can make quick 
changes to a User mask. 
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Recall User Mask 
Overview 

Use this dialog box to recall saved user masks. Masks are saved in C:\TekScope\Masks unless 
you choose another directory. 

  

To Use 

Click the name of the mask file that you want to recall to select it, and then click Recall. You can 
also click the keyboard icon to access the pop-up keyboard and enter the file name. 

Behavior 

The Recall dialog box displays when you click Recall in the Mask Edit control window. Clicking 
Recall replaces the current mask with the mask that you selected in the Recall dialog box. 
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Save User Mask 
Overview 

Use this dialog box to save user masks. Masks are saved in C:\TekScope\Masks unless you 
choose another folder.  

  

To Use 

To save the mask with the default file name, click Save. To enter a different file name, click the 
keyboard icon and use the pop-up keyboard to enter a unique file name. The extension specified in 
the Save as type list will automatically be appended to the file name. 

Behavior 

The Save As dialog box displays when you click Save in the Edit Mask control window. The mask 
is saved in the format specified in the Save as type list. 
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User Mask Edit Control Window 
Access this control window by clicking Controls in the Mask Edit control window. 

 

Overview  

Use this control window to select the segment and vertex for editing 
and set the Vertical and Horizontal Mask Values. 

To Use 

Click the up and down arrows to select the segment or the vertex of 
the mask to be edited. Click the Add control to add a point to the 
boundary in the selected segment and just after the selected vertex. 
Click Del to delete the selected vertex from the selected segment. 
To change the horizontal or vertical values for the selected segment 
and vertex, click the Horizontal or Vertical text box to activate the 
pop-up keypad.  

Behavior 

The Segment up and down arrows increase or decrease the segment 
number by one. The Vertex up and down arrows increase or 
decrease the vertex by 10. To set a specific number click the Vertex 
text box to activate the pop-up calculator. 

Clicking the Add control adds a point to the boundary in the selected segment and just after the 
selected vertex in addition to moving any points that follow up one. Clicking Del deletes the 
selected vertex from the selected segment and moves any points that follow down one. 

Limit Test Setup Control Window 
Access this control window from the Mask menu and select Limit Test Setup…. 

Overview 

Limit testing allows you to use channel, math, or reference waveforms and compare them against 
a template waveform. You set the limits around a template waveform. Let your instrument find the 
waveforms that fall outside of those limits. 

  

Use these controls to set up a limit test. You can create a template, set tolerances, compare data, 
and set up test options from this control window.  
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Create Limit Test Template 
Access this control window from the Mask menu and select Limit Test Setup…. 

  

Overview 

You can specify vertical and horizontal tolerances, 
create, and store the limit test templates. 

To Use 

Click the Source drop-down list to select the source 
you want to use to create the template. 
 

Note 

You cannot use waveforms in FastAcq, wfmDB, FastFrame, roll or XY(Z) modes as a template 
source or as an active mode during limit testing. 

Click the Destination drop-down list to select the location for saving the template. Templates are 
stored in Reference Waveforms Ref1–Ref4 (Ref1–Ref2, for 2-channel instruments) or File. If you 
select File, you can choose the location for saving the template from the Save Reference 
Waveform As dialog box.  

Set tolerances by using the multipurpose knobs or the pop-up keypad. 

 Your template waveform will be smoother if you use Average acquisition mode to acquire it. Use 
Envelope acquisition mode to create template waveforms that include occasional overshoots. 

Behavior 

The Vertical tolerance is adjustable using the upper multipurpose knob and Horizontal tolerance is 
adjustable using the lower multipurpose knob. Adjustments are made in 20 m/div increments. 
Tolerances set the amount the waveform can vary without violating the template. 

The source you select is used to create the template. The Source drop-down list contains the 
following choices: Ch1–Ch4, Math1–Math4, and Ref1–Ref4.  

The Destination drop-down list contains the following choices: Ref1–Ref4 and File (only Ref1–
Ref2 are available on 2-channel instruments). Selecting File activates the Save Reference 
Waveform As dialog when you click Save. Clicking Save when Ref1–Ref4 is selected saves the 
template to the selected reference memory. 
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Compare Limit Test 
Access this control window from the Mask menu and select Limit Test Setup… 

  

Overview 

Use these controls to specify which waveforms to use for limit 
testing and which waveforms to compare them against. 

To Use 

Click the Source drop-down list to select a waveform for 
comparing against the template. 

Click the Template drop-down list to select the template waveform 
to which you want to compare the source waveform. The 
Comparisons readout shows all active comparisons being made. 
You can perform more than one limit test at a time.  

Behavior 

The Source drop-down list contains the following choices: Ch1-Ch4, Math–Math4, and Ref1–
Ref4 (only Ch1–Ch2, Math1–Math2, and Ref1–Ref2 are available on 2-channel instruments). The 
source you select is compared against the selected template during a limit test.  

The Template drop-down list contains the following choices: None and Ref1–Ref4 (only Ref1–
Ref2 are available on 2-channel instruments).  

The default setting for Source is Channel 1 and for Template is None. 

 To easily view the waveform data as well as the template envelope, it is useful to select the Dots 
display style. See the following graphics to compare the two styles: 

  

Dot style 
 

Vector style 
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Limit Test Options 
Access this control window from the Mask menu and select Limit Test Setup…. 

  

Overview 

Use these controls to set up test failure notification, lock the template 
to a waveform, and highlight hits. 

To Use 

Click Config to open the Failure Notification control window where 
you can set up the action you want your instrument to take if the limit 
test fails.  

Clicking the Lock Template to Waveform and Highlight Hits controls 
will switch between on and off. If the control is off, click it to turn it 
on. 

Behavior 

Clicking the Config button under Failure Notification activates the Failure Notification control 
window. You can choose one or more actions that you want your instrument to take if the limit 
test fails.  

Turning on the Lock Template to Waveform locks the source waveform and template such that 
adjusting the vertical position or scale of either affects both. Turning off Lock Template to 
Waveform allows you to move the template and source waveform vertically, independent of each 
other.  

The default for Highlight Hits is On. When highlight hits is on, any points on the source waveform 
that fall outside of the template are highlighted in a different color than the rest of the waveform.  
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Limit Test Failure Notification Control Window 
Access this control window from the Mask menu, select Limit Test Setup…, and then click Config. 

Overview 

Use the Failure Notification control window to set the mode of notification, send commands, save 
waveforms, print, send email and log data when a limit test fails. 

  

To Use 

Click the On/Off buttons to turn that mode of notification on or off. 

Click Path to configure the path for saving waveforms and the Log Date. 

Click Config to open the E-mail on Event Setup control window.  

Behavior 

When a limit test fails and Beep is turned on, the instrument beeps, when SRQ is turned on, it 
sends a GPIB SRQ command, and when Stop ACQ is turned on, the instrument stops acquiring. 

When Print is turned on and a limit test fails, the instrument sends a screen print to the default 
printer. The current page setup is used for the screen shot. There is no specific page setup for limit 
test failures. 

When Save Wfm is turned on and a limit test fails, the instrument saves waveform data to a 
default directory unless you specified a different directory using the Path button. A file name is 
generated by combining the date and time. 

When Log Date is turned on and a limit test fails, the date and time for each failed limit test is 
recorded to a file of your choice. 

When E-mail is turned on and a limit test fails, the instrument sends an e-mail message to the 
specified recipient(s). You must enter an e-mail address and the SMTP server name in the E-mail 
on Event Setup control window before you can turn on E-mail. Clicking Config opens the E-mail 
on Event Setup control window where you can enter the e-mail address(es) and an SMTP server 
name. Check with your system administrator for the correct server name. 
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Limit Test Reset 
Access these controls from the Mask menu and select Limit Test Setup…. 

  

To Use 

Click On/Off to turn the limit test on or off. Click Reset to clear the 
status and highlighted hits. 

Behavior 

When you turn the limit test on, the status will indicate either Passing 
or Failing. When the test is turned off, the status will indicate either 
Passed or Failed. Clicking Reset clears all the highlighted hits and the 
status field. 
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Save Limit Test Dialog Box 
Overview 

Use this dialog box to save limit test templates. Template waveforms are saved in 
C:\TekScope\/Waveforms unless you choose another folder.  

To Use 

Use this dialog box to save the limit test template to a reference location or a file. To save the 
template to a reference location Select the Source from the drop-down list, and then select one of 
the four reference locations. Click Save. 

To save to a file, click the keyboard icon to enter a file name; or select Auto-increment file name if 
you want to save a series of files without typing in a new name each time. The file extension 
specified in the Save as Type list will automatically be appended to the file name. 

  

Behavior 

The file extension specified in the Save as Type list will automatically be appended to the file 
name. 
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Math Menu  
Math menu options enable you to perform mathematical operations on waveforms, build algebraic 
expressions, perform math-on-math operations, analyze histograms, or use advanced spectral 
analysis. 

Math Setup Control Window 
Access this control window from the Math menu Math Setup command, or from the Math toolbar 
button.  

Overview 

Use the Math Setup control window to set up and define math waveforms.  

  

You can define up to four math waveforms (two for the 2-channel models). The controls for each 
waveform are similar, but independent of each other. 

 To easily change the vertical position and scale of a math waveform, click the waveform handle 
on the left side of the screen. Use the multipurpose knobs to change the waveform position and 
scale. 

Math Waveform Properties 
To Use 

Use these controls to change the vertical position and scale of the selected math waveform. Click 
Display to turn the math waveform display on and off. Use the Label to attach a meaningful label 
to the waveform. Use the Units to assign custom vertical units for each math waveform. 

Behavior 

These controls only affect the selected math waveform. The Position control increases or 
decreases the vertical position of the waveform one pixel at a time. The Scale control changes the 
displayed waveform only; it has no effect on the acquisition hardware. 
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Define Edit Expression 
These buttons provide quick access to the Equation Editor and to the Math Parameter control 
window.  

Click Editor to open the Equation Editor control window. Use the Equation Editor to create a 
math equation for the selected waveform. 

Click Avgs to open the Adjust Math Parameters control window. Use the Math Parameter control 
window to define the number of times that you want to average the selected math waveform. 

Predefined Math Expressions 
To Use 

Click one of the buttons to use one of the predefined math expressions to create the math 
waveform based on live (channel) waveforms.  

If the channels are active, you can access each expression directly from the Math menu. 

Behavior 

These buttons provide common predefined math expressions. 

The Ch1-Ch2 and Ch3-Ch4 selections create math waveforms that are the difference between two 
input waveforms. Use these functions to view differential signals. 

The Ch1*Ch2 or Ch3*Ch4 selections create math waveforms that are the product of the two input 
waveforms. For example, you can obtain a power waveform by multiplying a voltage waveform 
by a current waveform. 

Note 

The Ch3-Ch4 and Ch3*Ch4 selections are only available with 4-channel models.  

 Use the Equation Editor to manually create and edit math waveforms. 

Guidelines for Working with Math Waveforms 
Keep the following guidelines in mind when working with math waveforms: 

 Keep math waveforms simple. If the math expression becomes too complex, try separating the 
expression into more than one math waveform and then combining the waveforms (for 
example, Math1 = Math2 + Math4). 

 You cannot use math waveforms with Fast Acquisition mode. 

 Math waveforms cannot be turned on without a math expression. 

 Math waveforms cannot be created from a reference waveform that was saved in Fast 
Acquisition mode. 

 To avoid syntax errors in a math expression, verify the use of operators, parentheses, 
operands, and the spelling of functions before activating the math waveform. 

 The math expression is applied to each frame when working with FastFrame (otherwise 
integral, spectral, or other functions may not work properly). 
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 When working with reference waveforms and FastFrame, if one or more reference waveforms 
are used as part of a math waveform, the number of frames in the math waveform is the 
smallest of all source waveforms (reference, math, or channel waveforms). 

 If one or more reference waveforms are used in a math waveform, the record length is equal 
to the smallest of all the source waveforms (reference, math, or channel waveforms). The 
math is calculated using the first point from each source, followed by the next point, and so 
forth. This is true even if the sources have different times between points in the record. 

Spectral Analysis 
Click Setup to open the Spectral Setup control window to create math equations to analyze 
waveforms in the frequency domain.  

Click Control to open the Spectral Controls control window to define the acquisition, gating, and 
frequency setups for the frequency domain analysis. 

Predefined Spectral 
To Use 

Click one of the buttons to define the current math waveform as a spectral magnitude waveform or 
a spectral phase waveform. 

Behavior 

The math waveform is based on the last active waveform on the screen. Spectral waveforms are 
created from channel waveforms; you cannot create a spectral waveform from math or reference 
waveforms. Click Mag to create a spectral magnitude waveform. Click Phase to create a spectral 
phase waveform. 

Equation Editor Control Window  
Access the Equation Editor from the Math menu, or from the Editor button on the Math Setup control 
window.  

Overview 

Use the Equation Editor control window to define or edit advanced math waveforms. The readout 
shows the math expression as you construct it. New functions are added at the beginning of the 
expression each time that you click one of the function buttons. 

You can create a math expression using one or more of the following methods (see also 
Guidelines for Working with Math Waveforms): 

 On the Time tab, click one or more of the function buttons to insert a time domain function 
into the math expression. Then select one of the waveforms as an operand by clicking one of 
the Channel Selector tabs. Use the edit controls to add additional numbers and operators to 
complete the math expression.  

 On the Meas tab, click one or more of the buttons to add the corresponding defined 
measurements. Use the edit controls and the Channel Selector tabs as necessary to add 
waveforms, additional numbers, and operators to complete the math expression.  

 Use the edit controls with the Channel Selector tabs to create simple math expressions using 
existing waveforms, numbers, and operators.  

 Use an external keyboard to enter the math expression. 
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 Create a math expression from a text editor or from another application. Copy the text to the 
Windows clipboard. Right-click with the mouse to paste the text into the math expression. 

Click Apply to apply the math expression to the selected math waveform. Click Avgs to open the 
Math Parameter Adjustment control window where you can specify the number of times the math 
waveform is to be averaged. 

 If you create a math expression that is longer than the physical space in the control window, you 
can scroll through the expression using the Text Edit controls. 

To edit another math waveform, select the waveform from the Math (n) drop-down list in the 
Equation Editor control window. 

Time Domain Tab  

 

To Use 

Use these controls to insert time domain-based 
functions into the math expression. Click one of the 
function buttons to insert the function into the math 
expression. Click More for additional, available 
functions. 

Behavior 

You can use any of the channels as arguments for the 
function in the following table. Create nested functions 
by inserting one function into the argument portion of 
another. 

 

Available Functions 

Average  Invert  Log 10  

Integral  Sqrt  Log e  

Derivative  Exp   

 

Fabs  Ceil  Floor  

Sin  Cos  Tan  

Min  Max   

 

ASin  ACos  ATan  

Sinh  Cosh  Tanh  
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Some things to consider when working with math waveforms: 

 Scale and position the source waveform so that it is contained on screen. Off-screen 
waveforms may be clipped, resulting in errors in the math waveform. 

 Use the vertical position and vertical offset to position the source waveform. The vertical 
position will not affect the math waveform unless you position the source waveform off 
screen so that it is clipped. 

Spectral Analysis (Freq) Tab  

  

To Use 

Use these controls to insert spectral analysis-based 
functions into the math expression. Click one of the 
function buttons to insert the function into the math 
expression. Then select one of the defined waveforms 
as an argument by clicking one of the Channel 
Selector Tabs.  

Behavior 

You can use any of the channels as arguments for the 
function. Create nested functions by inserting a 
function into the argument portion of another. 

Measurement List (Meas) Tab  
To Use 

Use the list to enter one of the predefined measurements into the math expression. Click the button 
adjacent to an item to insert the measurement into the expression. 

Behavior 

The list contains the measurements defined in the Measurement control window. The buttons are 
only active for defined measurements; they are unavailable for any undefined measurements. 

Measurements are continuously updated on live acquisitions. The most recent measurement values 
are always used in math expressions. 

Variable List (Var Tab) 
To Use 

Click in the text box and use the multipurpose knobs to enter a value for the variable. Click the 
VAR# button to enter that variable into the math expression. Click Controls to access the Math 
Variables control window. 

Behavior 

You can assign up to eight different variables to add to your math expression. Clicking the VAR# 
button enters the variable into the math expression. Clicking the More button accesses the other 
four variables. The Controls button activates the Math Variables control window where you can 
quickly set or change the math variables. 
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Edit Controls  
To Use 

Use the Edit controls to insert numerals, math operators, and variables into a math expression. Use 
the Text Edit controls to move the insertion point (cursor) within the expression. Click an 
individual button to enter its character or operator into the expression.   

Behavior 

The characters are entered into the math expression one at a time. 

Adjust Math Parameters Control Window  
Access this control window by selecting Set Math Averages… from the Math menu.  

  

Overview 

Use this control window to specify the number of times the selected 
math waveform is averaged. 

To Use 

Click the Mathn control to map it to one of the multipurpose knobs. 
Then use the knob to specify the number of times the selected 
waveform should be averaged. 

Behavior 

The selected math waveform is averaged over the number of 
acquisitions shown in the control. Each math waveform has its own 
set of controls.  

The buttons at the bottom of the control window provide access for 
changing other setups after you set the averaging: 

 Editor opens the Equation Editor 

 Spect opens the Spectral Setup control window 

 Setup opens the Math Setup control window 

 



 202

Math Variables Control Window 
Access this control window by selecting Set Math Variables… from the Math menu. 

  

Overview 

Use this control window to quickly set the math variables to use in 
your math expression. 

To Use 

Use the 1-4 or 5-8 tab to access the variables that you want. Click 
in the Var#= text box, and then use the multipurpose knobs to set 
the value for the variable. Click Editor to access the Math Equation 
editor. 

Behavior 

You can set or change the variable values in this control window. 
To add a variable to a math expression, go to the math editor, and 
click the VAR# button. 

 

Spectral Setup Control Window  
Access this control window from the Math menu Spectral Setup command, or by clicking Spect in the 
Adjust Math Parameters control window.  

Overview 

Use these controls to set up a math waveform for spectral analysis. Use the controls on the tabbed 
pages to create a spectral waveform, define the vertical scale units of the waveform, and to lock 
waveforms together. 

After you create the spectral waveform, use the controls on the right side of the control window to 
position and adjust the waveform so that you can view the data you are interested in. 

You can operate the instrument and view spectral (FFT) waveforms using the time-domain 
controls, gating controls, or frequency domain controls. Some of these controls are interactive; 
making changes with one set of controls will sometimes change settings in another control set. 
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Create Spectrum Tab 

  

To Use 

Use these controls to insert spectral 
analysis-based functions into the math 
expression. Click one of the buttons to 
insert the function into the expression. 
Then select one of the input channel 
waveforms to create the Math waveform. 

Behavior 

These controls work similar to the 
controls under the Spectral Analysis 
(Freq) tab of the Equation Editor. 

 

Click Editor to open the Equation Editor if you need to edit the math expression. Click Clear to 
clear the math expression. Click Avgs to open the Math Parameter Adjustment control window 
where you can specify the number of times to average the math waveform. 

After making your changes in the control window, click Apply to apply the changes to the 
waveform without closing the control window. Click OK to apply the changes and close the 
control window. 

Mag Scale Tab  

  

To Use 

Use these controls to specify the vertical 
scale for magnitude waveforms. Click 
one of the buttons to specify the vertical 
units as linear (V, A, W), dBm (1mW into 
50 Ω), or dB (logarithmic).  

Use the multipurpose knobs to set the 
reference level at the top of the screen.  

Use the Reference Level Offset control to 
position the waveform with respect to the 
0 dB reference level without changing the 
reference level at the top of the screen. 

Behavior 

The reference level offset is used to calculate the log magnitude in dB. Adjusting the reference 
level positions the waveform with respect to the top of the screen but does not change the position 
of the waveform with respect to the ground reference marker. 

Changing the reference level offset moves the waveform with respect to its ground reference 
marker. 
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Phase Scale Tab  

  

To Use 

Use these controls to specify the vertical 
scale for spectral phase waveforms. Click 
one of the Scale buttons to specify the 
vertical units in radians, degrees, or as 
group delay.  

Behavior 

Group delay unwraps and differentiates 
the phase. All phase values out of the 
spectral transformation are between π and 
-π even though the actual phase value 
may be outside this range. 

Click Unwrap to work on a continuous phase function to unwrap the phase value and show the 
true range. The phase unwrap begins with a phase value obtained at the first spectral sample after 
DC. 

The Suppression Threshold prevents random noise from making the display unusable. Any 
spectral points with magnitudes less than the threshold will have phase values set to zero (degrees 
or radians). To set a dB level for the suppression threshold, select dB scale from the magnitude 
tab, and then set a horizontal bar cursor to the level on the magnitude spectrum. Read the dB value 
from the cursor and use the multipurpose knob to enter the value as the suppression threshold. 

Control Tracking Tab  

  

To Use 

Use these controls to lock two math 
waveforms together. This is useful when you 
want to generate both a magnitude 
waveform and a phase waveform from the 
same source. 

Behavior 

When you lock the spectral controls 
together, any changes that you make to one 
math waveform are also made to the other 
math waveform. 

You can only lock Math1 with Math2 and 
Math3 with Math4. 

Locking is useful, for example, when Math1 is the spectral magnitude and Math2 is the spectral 
phase of the same signal. Locking forces the magnitude and phase waveforms to track if you 
change the spectral controls. 

Note 

Math3 and Math4 are only available on 4-channel models. 
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Spectral Setups: Acquisition 

 

To Use 

Click the control that you want to change and use the multipurpose 
knobs to adjust the values.  

Behavior 

Rec Length (Record Length) is the total number of samples in the 
waveform acquisition. The maximum record length depends on the 
amount of memory. The record length determines the duration, which 
is expressed in seconds. Samp Rate (Sample Rate) is the number of 
acquisition samples per second. The faster the sample rate, the more 
accurately the instrument can represent fine details in a fast signal. 

The sample rate determines the acquisition duration, which is expressed in seconds. The usable 
bandwidth of the signal equals one half the sample rate and is expressed in hertz. 

Duration is the length of the acquired waveform in seconds. Adjusting the duration usually 
changes the record length without changing the current sample rate. 

Resolution is the time between sample points. Changing the resolution changes the record length 
and the sample rate so that the selected duration setting remains constant. 

Note 

The acquisition controls interact with the gating and frequency domain controls; changing one set 
of controls may change some of the other control settings. 

Spectral Setups: Gating 

 

To Use 

Select the FFT window type from the Window Type list. Use the 
multipurpose knobs to set the gating parameters.  

Behavior 

An FFT Window Type can help reduce spectral noise for many types of 
signals. Some windows provide better frequency resolution at the expense 
of better amplitude measurements. Other windows provide better 
amplitude accuracy over frequency resolution. The choice of window also 
affects the resolution bandwidth. 

Gate Pos (Gate Position) moves the gate that selects the data for the spectral waveform. The gate 
position is the center point in the gate measured in seconds with respect to the trigger point. 

In most cases the phase reference point is located at the center of the gated data. However, if you 
use a Tek Exponential window, the phase reference point is at the 20% point of the gated data. 

Gate Dur (Gate Duration) sets the gate time duration in seconds. The default gate duration is the 
duration of the entire waveform record. The resolution bandwidth is inversely proportional to the 
gate duration. 
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Gate Length displays the gate length in points. The default gate duration is the duration of the 
entire waveform record. 

Note 

The gating controls interact with the acquisition and frequency domain controls; changing one set 
of controls may change the other control settings. 

Spectral Setups: Frequency  

 

To Use 

Click the individual controls, and use the multipurpose knobs to select the 
Center Freq, Freq Span, and Res BW. Click Full to set the frequency span 
to full.  

Behavior 

The maximum frequency span is equal to half of the sample rate. If you 
need a higher frequency span, set the sample rate to a larger value.  

Note 

The frequency domain controls interact with the gating and acquisition controls; changing one set 
of controls may change the other control settings. 
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Spectral Controls: Acquisition  
Access this control window from the Math menu Spectral Controls command or the Controls button on 
the Spectral Setup control window. 

Overview 

Use the time domain acquisition controls to view spectral waveforms. 

 

To Use 

Click the control that you want to change, and use the multipurpose 
knob to adjust the value.  

Behavior 

Rec Length (Record Length) is the total number of samples in the 
waveform acquisition. The maximum record length depends on the 
amount of memory. The record length determines the duration, 
which is expressed in seconds. Long record lengths can slow 
instrument response, but also lower the noise relative to the signal 
and increase the frequency resolution for the spectral math 
waveform.  

Sample Rate is the number of acquisition samples per second. The 
faster the sample rate, the more accurately the instrument can 
represent fine details in a fast signal. The sample rate determines the 
acquisition duration, which is expressed in seconds. 

 

The usable bandwidth of the signal equals one half the sample rate and is expressed in hertz. 
Duration is the length of the acquired waveform in seconds. Adjusting the duration usually 
changes the record length without changing the current sample rate, similar to spectral analyzer 
frequency domain span and center frequency controls. Resolution is the time between sample 
points. Changing the resolution changes the record length and the sample rate so that the selected 
duration setting remains constant. 

Note 

The Acquisition controls interact with the Gating and Frequency domain controls; changing one 
set of controls may change some other control settings. 
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Spectral Controls: Gating  
Access this control window from the Math menu Spectral Controls command or the Controls button on 
the Spectral Setup control window. 

Overview 

Use the gating controls to specify a segment of the time domain record to analyze in the frequency 
domain. 

 

To Use 

Select the FFT window type from the drop-down list. Use the 
multipurpose knobs to set the gating parameters.  

Behavior 

Gate Pos (Gate Position) moves the gate that selects the data for 
the spectral waveform. The gate position is the center point in the 
gate measured in seconds with respect to the trigger point. In most 
cases the phase reference point is located at the center of the gated 
data. However, if you use a Tek Exponential window, the phase 
reference point is at the 20% point of the gated data. 

Gate Dur (Gate Duration) sets the gate time duration in seconds. 
The default gate duration is the duration of the entire waveform 
record. The resolution bandwidth is inversely proportional to the 
gate duration. 

An FFT Window Type can help reduce spectral noise for many 
types of signals. Some windows provide better frequency 
resolution at the expense of better amplitude measurements. 

Other windows provide better amplitude accuracy over frequency resolution. The choice of 
window also affects the resolution bandwidth.  Res BW (Resolution Bandwidth) determines how 
small of a frequency difference can be resolved in the frequency domain output data. It defines the 
bandwidth of filters used to perform the frequency domain analysis. The resolution bandwidth is 
measured in hertz at the 3 dB points on each side of the peak spectral lobe. 

Adjusting the resolution bandwidth controls the gate duration to obtain the desired resolution 
bandwidth. 
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Spectral Controls: Frequency  
Access this control window from the Math menu Spectral Controls command or the Controls button on 
the Spectral Setup control window. 

Overview 

Use the Frequency controls to operate the instrument like a spectral analyzer. 

  

To Use 

Click the individual controls and use the multipurpose knobs to select 
Center Freq, Freq Span, Res BW, and Ref Level (Reference Level).  

Behavior 

The maximum frequency span is equal to half of the sample rate. If 
you need a higher frequency span, set the sample rate to a larger 
value.  

The Ref Level (reference level) control is a position control for the 
spectral waveform. The position appears at the top of the control 
window. The Ref Level control does not change the position with 
respect to the reference marker. 

Note 

The Frequency domain controls interact with the Gating and 
Acquisition controls; changing one set of controls may change the 
other control settings. 

Selecting a Spectral Window  
A spectral window determines what the filter shape of the spectral analyzer will be in the 
frequency domain. It may be described by a mathematical function that is multiplied point-by-
point times the input data to the spectral analyzer. 

 The following spectral windows are available with the instrument: 

 Rectangular 

 Hamming 

 Hanning 

 Kaiser-Bessel 

 Blackman Harris 

 Gaussian 

 Tek Exponential 

 Flattop2 

The windows are listed in the order of their ability to resolve frequencies (resolution bandwidth). 
You can easily observe the shape of a window in the frequency domain by feeding a sine wave 
into the instrument and setting the center frequency of the spectral analyzer to the same frequency. 
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Then reduce the resolution bandwidth to spread out the lobe horizontally. You can then select 
different window functions and observe their shape. 

Window Attributes 
 In the time domain, windows are typically bell shaped and go to zero at the ends of the record. 

For cases where you may be doing impulse response testing, the impulse should be centered 
at the zero phase reference point (for most windows, this is the 50% position of the gate and 
20% for the Tek Exponential window). 

 Different window functions affect the resolution bandwidth of the spectral analyzer. 

 Various window shapes affect the scallop loss. 

 The shape of the frequency domain lobe is determined by the window function. Some 
windows have better resolution bandwidth, but they do so at the expense of side lobe 
attenuation and energy leakage into adjacent bins. For example, a rectangular window 
typically spills energy into many bins showing signals that don’t exist; but it has the best 
frequency resolution. If you are using a window where leakage is occurring, you may want to 
use spectral gating to reduce the amplitude errors when measuring a given frequency. 

Text Edit Controls  
Use the following controls to edit the Math expression.  

 
Moves the text insertion point to the 
left of the first character in the 
expression. 

 
Moves the text insertion point one 
character to the left. 

 
Moves the text insertion point one 
character to the right. 

 
Deletes the character to the left of the 
insertion point. 

 
Clears the entire math expression. 
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MyScope Menu 
Use the MyScope Menu to create a new MyScope control window, open or edit an existing one, 
display the active MyScope window, or recall recently used ones. 

 

MyScope Setup Control Window 
Access this control window from the MyScope menu New Control Window… command. 

Overview 

MyScope allows you to create custom control windows that include only the controls that you use 
regularly. Instead of switching between several control windows, put the controls you use into a 
custom control window. 

  

To Use 

Click + to expand a control category. Click a control to preview it in the pane at the right. Double-
click the control or click the + to expand the control list. (If there is no +, then the control cannot 
be customized further.) Clear the check boxes in the expanded control list to remove any 
components you do not want included in the control. Click and drag the control to your MyScope 
control window. You can also change the placement of the control in your MyScope control 
window by clicking and dragging.  

Click New Tab to add a tab to your MyScope control window. You can have up to eight tabs in 
your MyScope control window. To rename a tab, click Rename Tab or double-click the tab. 

Click User Pref... to specify the user preferences that you want to load with your MyScope control 
window.  
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Click Save or Save As… to save your MyScope control window. Click Close to close the control 
window without saving it. 

Behavior 

Clicking on a control in the list allows you to preview the control in the pane at the right. Selecting 
or clearing the checkboxes for the controls in the list adds or removes components. The control 
will snap to the nearest grid location when you release the mouse. 

 To change a control you have already placed into a MyScope control window, drag it back to the 
preview pane and the appropriate control category will open for quick modifications. 

 

Using MyScope Control Windows 
Overview 

Some MyScope controls operate differently from the same control in the UI. 

Horizontal controls 

The Delay Mode control contains only an On/Off button, Horiz Delay time, and Ref Point. It does 
not show the explanatory graphic that is on the Horizontal Setup control window. 

The Table button on the Time Stamps control activates a pop-up time stamp table. 

Horizontal readouts that are not available in the MyScope window are Resolution, Sample Rate, 
and Duration. 

Trigger controls 

Trigger Type and Trigger Sequence controls have a setup button that is automatically included 
with the controls. The tripper type setup button activates a pop-up control widow that represents 
the right half of the Trigger Setup control window under the A Event tab. Use this setup control 
window to set the parameters for the selected trigger type. The Trigger Sequence setup button 
activates a pop-up control window that represents the right half of the Trigger Setup control 
window under the A->B Event tab. Use this setup window to set the parameters for the trigger 
sequence. 

If you select more than 11 trigger types, the trigger type control will activate a More button to 
accommodate the multiple pages necessary to display more than 11 trigger types. 

Cursor controls 

Cursor multipurpose knob (MPK) and style controls are available but what displays in your 
MyScope control window will depend on what type of cursor you select. For example if you select 
Screen cursors, then Cursor MPKs controls and Cursor Style controls display as shown in the 
following graphic. 
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However if you select V Bars, then Cursor MPKs controls are not available and the Cursor Style 
controls change as shown below. 

  

Measure controls 

Measurement controls always include a Next Ch and Clear All button. The Clear All button clears 
all measurements on all channels. The Next Ch button advances the Source to the next active 
channel and assigns the same measurements to the next channel as were assigned to the previous 
channel. This is a quick way to assign the same measurements to multiple channels. 

Each page of the measurement controls can hold up to 12 measurements. If you select more than 
twelve, a More button appears to accommodate the multiple pages necessary to display more than 
12 measurements.  

Mask controls 

The Mask and Limit Test controls act as shortcuts to the Mask or Limit Test setup control 
windows. 

Utilities controls 

The Set Time and Date, Instrument Diagnostics, E-mail on Event, and User Preferences Utilities 
controls act as shortcuts to the setup control window for these controls. Clicking the Setup button 
in any one of these controls will activate the setup control window for that command. 
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Open or Edit MyScope Dialog Box 
To Use 

Select the MyScope control window that you want from the dialog box, and then click Open. Or 
you can type a file name to select the MyScope control window. Click the Look in drop-down list 
to navigate to other directories. 

Behavior 

This dialog box opens in the default directory, C:\TekScope\MyScope. If you have saved 
MyScope control windows in another directory, click the Look in drop-down list to go to that 
directory. Clicking Open will open the selected MyScope control window. The only available file 
type is .tcw. 

Save MyScope File As Dialog Box 
To Use 

Type a file name in the File name text box, and click Save. To save to a different directory, click 
the Look in drop-down list to navigate to other directories, and then click Save. 

Behavior 

This dialog box opens in the default directory, C:\TekScope\MyScope. If you want to save 
MyScope control windows in another directory, click the Look in drop-down list to go to that 
directory. The only available file type is .tcw. 

When you open the saved MyScope control window, the File name is displayed on the upper right 
corner of the control window. 
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Utilities Menu 
The Utilities menu provides access to utilities used by the instrument such as instrument 
calibration, instrument diagnostics, and user preferences. All utilities are accessible from the menu 
bar only. None of the utilities are directly accessible from the front panel controls or from the 
toolbar. 

Set Time and Date 
Access this control window from the Utilities menu Set Time & Date command. 

Overview 

Use the Set Time and Date control window to set the time and date on the instrument. 

  

To Use 

Click the controls in the window to map them to the multipurpose knobs and use the knobs to set 
the time and date. Click Set time and date now to save your changes. You can also click Get 
current time to set the time using the system clock. This is useful if the instrument clock becomes 
out of sync. 

Behavior 

The controls in this window operate the same as the standard Windows Date/Time Properties 
dialog box. After you click Set time and date now, the system date and time are set to the specified 
values. These controls are provided as a convenience so that you can change the date and time 
without having to go to the Windows Date/Time Properties dialog box. 

 The instrument clock is suspended when this window is open. Click Get current time to 
resynchronize the clock with the PC clock. 
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GPIB Configuration Control Window 
Access this control window from the Utilities menu GPIB Configuration command. 

  

Overview 

Use the GPIB Configuration control window to configure the 
instrument for GPIB (General Purpose Interface Bus) applications. 
GPIB applications enable you to remotely control your instrument (take 
measurements, set controls, perform calculations, and so on). 

To Use 

Click Talk/Listen to enable the GPIB. Click the Address control to map 
it to a multipurpose knob and use the knob to set the GPIB address for 
the instrument. Click Controller to use your instrument to control other 
instruments. Click Off Bus to make the GPIB port unavailable. 

 Note 

The Address controls are only available when you are in Talk/Listen 
mode. 

Behavior 

The instrument is defined as a GPIB talker/listener when you click Talk/Listen. This is the device-
based operation. 

The instrument is defined as a controller when you Click Controller. This is the controller-based 
operation. You cannot use GPIB commands to control your instrument when it is in Controller 
mode. When in Controller mode, clicking Off Bus has no effect. The Off Bus control only makes 
the GPIB port unavailable if you are in Talk/Listen mode. 

LAN Server Status Control Window 
Access this control window from the Utilities menu, LAN Server Status command. 

  

Overview 

This control window allows you to enable the VXI-11 LAN server to 
accept GPIB commands. For more information see Getting Started with 
OpenChoice Solutions manual that was shipped with your instrument. 

To Use 

Click the Start button to enable the VXI LAN server to accept GPIB 
commands. 

Click the Stop button to disable the ability of the VXI-11 LAN server to 
accept GPIB commands. 
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External Signals Control Window 
Access this control window from the Utilities menu External Signals command. 

Overview 

Use the External Signals control window to select the trigger signal to send to the AUX OUT 
BNC connector or to toggle the instrument clock reference source. 

 

To Use 

To send a signal to the AUX OUT BNC connector when the instrument triggers, click either A 
Trig or B Trig. To change the source of the clock reference, click the External Reference In 
button. 

Behavior 

For AUX OUT, the selected trigger signal is routed to the AUX OUT BNC connector so that you 
can trigger another instrument such as a logic analyzer. The output voltage is TTL-compatible, 
negative polarity. 

For External References, the clock reference is routed to the EXT REF BNC connector when you 
select External. You must perform a signal path compensation whenever you change the reference. 

Touch Screen (Option) 
Access the Touch Screen calibration feature from the Utilities menu. 

Overview 

Use the Touch Screen submenu to calibrate the touch screen. 

To Use 

Select Calibrate, and then follow the on-screen instructions to calibrate the touch screen.  

Behavior 

The Calibrate command starts the Touch Screen calibration program.  
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Instrument Calibration Control Window 
Access this control window from the Utilities menu Instrument Calibration command. 

Overview 

Use the Instrument Calibration control window to calibrate the Signal Path Compensation (SPC).  

 

To Use 

Follow the Calibration Instructions and click Calibrate to begin the procedure. 

Behavior 

The only user-accessible calibration is the signal path compensation (SPC). All other calibration is 
accessible to qualified service personnel only. For all calibrations, the Status control should 
indicate Pass. If it does not, contact your local Tektronix service personnel. 

Instrument Diagnostics Control Window 
Access this control window from the Utilities menu Instrument Diagnostics command. 

Overview 

Use this control window to run the instrument diagnostics. 

  

To Use 

Select the diagnostic that you want to run. Use the controls to loop on a specific test for a set 
number of times or to stop as soon as a failure occurs.  

You can run all tests or specific tests using the options on the Subsystem, Area, and Text drop-
down lists. The Diagnostic Status table lists each diagnostic, the results of the test, and the number 
of failures that occurred. 
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Behavior 

This window is mainly intended for service personnel. The diagnostic information can be used as 
part of an incoming inspection or to diagnose potential problems with the instrument. Remove the 
input signals before running any of the diagnostics. If diagnostic failures occur, record the failure 
information and contact your local Tektronix service personnel for more information.  

E-mail on Event Control Window 
Access this control window from the Utilities menu and select E-mail on Event Setup 

Overview 

Use the E-mail on Event Setup control window to set up the conditions under which the 
instrument will send an email, the types of attachments, and message limits. 

  

To Use 

Type the email address(es) to which you want to send a message in the Recipient e-mail 
address(es) box. Use a comma to separate multiple addresses. 

Select the events on which you want to send e-mail using the Send E-mail on check boxes. Use the 
E-mail Attachment check boxes to select the type of attachment to include with the e-mail. Click 
the Settings button to open the Save Options dialog box, and set the parameters for the attachment.  

Enter the number of e-mail messages to be sent by the instrument, up to a maximum of fifty, in the 
Limit text box. Enter the maximum size, up to 2 GBs, for each e-mail message in the Max E-mail 
Size text box. Click the Send button to send a test e-mail. Click the Config button to open the E-
mail Configuration dialog box. 

Behavior 

The maximum number of characters in the Recipient e-mail address box is 252, so you can enter 
any number of e-mail addresses up to a total of 252 characters. You can select one or all of the 
events to send e-mail on. If you do not have a SMTP server address or e-mail address set up, you 
cannot select an event to send e-mail on. 

The screen capture, waveform, and measurement types for the e-mail attachments are determined 
by the type that you select in the Save Options dialog box when you click Settings.  

When the maximum number of messages is reached, the Send E-mail on check boxes are cleared 
and the Current Count is reset to 0. You must select the event again to continue sending e-mail. 
Clicking Reset changes the current count back to 0. 

Attachments that exceed the Max E-mail Size are saved to the hard drive on the instrument. 
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 To save your attachments on the instrument hard drive and still send an email, set the Max E-mail 
Size limit to 0. 

E-mail Configuration Dialog Box 
Access this dialog box from the E-mail on Event Setup control window and click the Config button. 

Overview 

Use this dialog box to enter the address of the mail server to use when sending e-mail on events. 
You must have a server entered in the SMTP Server Address box for your instrument to send e-
mail.  

  

You can customize your e-mail by selecting the number of attempts to make, entering a From 
address, setting the timeout length, entering a login and password if necessary, and entering a host 
name. 

  

To Use 

Enter the SMTP server address. Click OK if you want to accept the default values. Click More>> 
if you want to customize your e-mail. Enter the appropriate information in each box that you need 
to change from the default.  
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Behavior 

The number you enter in the Number Attempts to Send box is the number of times the system will 
try to send the e-mail if it isn’t successful on the first try. The default is 1.  

Entering an address in the From box puts that address in the From field of the e-mail. The default 
value is the instrument model number. Entering your own address allows the instrument to send 
you e-mail if there is a problem with sending the e-mail to the recipient.  

Entering a number in the Timeout box will override the default timeout for sending e-mail to the 
server. 

If your mail server requires a login or password, enter the login in the Auth Login box and the 
password in the Auth Password box.  

Entering a network ID in the Hostname box makes the e-mail appear as though it did not come 
from the instrument. 

User Preferences: Prompt Before Action 
Access this control window from the Utilities menu User Preferences command. 

Overview 

Use the Prompt Before Action tab to indicate whether or not you want the instrument to display 
prompts (confirmation messages) before carrying out certain tasks like deleting files or 
waveforms. 

To Use 

Click a button to enable or disable the control setting. 

Behavior 

The confirmation messages give users the chance to change their minds before taking action. The 
messages generally explain the implications of the action. 

All preference settings are saved when you turn the instrument power off. 

User Preferences: Keypad Defaults 
Access this control window from the Utilities menu User Preferences command. These controls are on 
the Keypad Defaults tab.  

Overview 

Use the Keypad Defaults tab to define the preset trigger levels. 

To Use 

Change the label for the selected preset control by entering a four-character name.  

Click the trigger level controls to map them to the multipurpose knobs and use the knobs to set the 
trigger level values. 

Behavior 

Use this control window to change the trigger level preset values. This can be useful when you 
want to trigger the instrument on nonstandard trigger levels.  
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By default: 

 TTL fixes the trigger level at +1.4 V 

 ECL fixes the trigger level at –1.3 V 

When you set the volts/div less than 200 mV, the instrument reduces the TTL or ECL trigger 
levels below their standards. This is because the trigger level range is fixed at ± 12 divisions from 
the center. For example, at 100 mV, the trigger range is ± 1.2 V, smaller than the standard TTL 
and ECL levels. 

All preference settings are saved when you turn the instrument power off. 

User Preferences: Record Length 
Access this control window from the Utilities menu User Preferences command.  

Overview 

Use the Record Length tab to define how the instrument responds to changes in record length. 

To Use 

Click one of the buttons to define which variable will be held constant when the record length 
changes. 

Behavior 

Record length, sample rate, and horizontal scale are dependent variables. When you change the 
record length, you can choose to hold either the sample rate or the horizontal scale constant. The 
remaining variable will change in response to the record length changes.  

All preference settings are saved when you turn the instrument power off. 

User Preferences: Readouts 
Access this control window from the Utilities menu User Preferences command.  

Overview 

Use the Readouts control window to select a transparent or opaque background and turn Highlight 
readouts on and off. 

To Use 

Click Transparent to set the readout background to transparent. Click Opaque to set the readout 
background to opaque.  

Click Changes On to highlight readouts when you make changes. Enter the time to leave the 
readout highlighted in the Hide After text box. 

Behavior 

When the readout background is set to transparent, the readouts appear behind the waveform. 
When the readout background is set to opaque, the waveform appears behind the readouts. 
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Transparent 
 

Opaque 

The maximum length of time that you can leave readouts highlighted is 5 seconds. The readouts 
that are highlighted are Vertical Scale, Horizontal Delay, Trigger Level, Trigger Source, Trigger 
Slope, and Source Termination. 

User Preferences: Touch Screen 
Access this control window from the Utilities menu User Preferences command.  

Overview 

Use the Touch Screen control window to activate right-click menus via the touch screen and to 
calibrate the touch screen. 

To Use 

Click the On/Off button to turn the right-click menus via the touch screen on or off. Use the 
increment/decrement buttons to set the duration to touch and hold for activating the right-click 
menus. Touch the Test Area to validate that the right-click menus work by touch.  

Click the Calibrate Touch Screen button, and then follow the on-screen instructions to calibrate 
the touch screen.  

Behavior 

The duration that you set determines how long you need to touch and hold before a right-click 
menu will appear. When you touch the Test Area, a right-click menu will appear after the 
specified duration.  

Note 

You cannot activate the right-click menu via the touch screen on a control window or the 
multipurpose knobs. You must use a mouse to activate a right-click menu in these areas.  

The Calibrate Touch Screen button starts the Touch Screen calibration program.  
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Option Installation 
Access this command from the Utilities menu. 

Overview 

Use Option Installation to enable upgrades that you have purchased for your instrument from 
Tektronix. For the most current list of upgrades, go to www.tek.com or contact your local 
Tektronix representative. 

To Use 

Click Continue in the first dialog box. Enter the Option Installation Key provided by Tektronix in 
the Current Option Information dialog box. Click Continue again and follow the instructions to 
install the option. Further instructions and information may be available with the option or 
application documentation. 

Behavior 

Information about installed options and applications is listed in the installation dialog box. The 
installation is acknowledged when complete. 

To run external applications after installation, select the File menu Run Application submenu, 
and select the application name from the drop-down list. 

Tek Secure Erase 
Access this command from the Utilities menu. 

  

Overview 

Use Tek Secure Erase to erase all 
waveforms and instrument setups. 

To Use 

Click OK to erase, or Cancel to exit the 
dialog box. 

Behavior 

Tek Secure Erase removes all reference waveform and instrument setup memory locations. Erased 
setups are replaced with the default factory setups. This is useful if you are using the instrument to 
gather sensitive or secure data. 
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Theory of Operation 
Functional Model 

The instrument has four high-level subsystems or processes (consisting of both hardware and 
software functions) and the data that connects them: 

 Digital Signal Acquisition System. Acquires a waveform record from each signal you probe 
using the following subsystems: 

 Input Channels. Conditions the input signal, primarily through the use of analog hardware, 
before converting the signal to digital form. 

 Trigger System. Recognizes a specific event of interest on the input signal and informs the 
Time base system of the occurrence of the trigger event. 

 Time base System. Triggers the Acquisition system to start an acquisition cycle. In more 
general terms, synchronizes the capturing of digital samples in the Acquisition system to the 
trigger events generated from the Trigger system. 

 Acquisition System. Converts and stores the analog signal to a digital format. 

 Signal Processing and Transformation. Performs transformations or operations on user-
specified waveform data (channel, reference, and/or math waveforms). Automatic 
measurements, spectral waveforms, and histogram generation are examples of signal 
processing and transformation. 

 Display and UI. Provides output (and sometimes input) of instrument-data elements in a form 
suitable to the user and also provides user input control. 
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Process Overview 

  

1 The instrument starts in the idle state; it 
enters this state upon power up, upon 
receiving most control setting changes, or 
upon finishing acquisition tasks. 

2 Control settings are implemented as they 
are requested. When you toggle the 
RUN/STOP control to RUN, the 
instrument starts the hardware. 

3 The instrument acquires samples until the 
pretrigger portion of the waveform record 
(channel) being acquired is filled. 

4 The instrument then begins looking for a 
trigger. Acquiring continues to take 
place, keeping the pretrigger points 
current, until triggering criteria are met or 
a trigger is forced (Auto trigger mode 
only). The instrument accepts the trigger. 

5 The instrument acquires samples until the 
posttrigger portion of the waveform 
record (channel) being acquired is filled. 

6 If averaging or enveloping is on, the 
record becomes part of the multi-
acquisition record that these modes 
produce. The process loops back to step 3 
to acquire additional records until the 
number of acquisitions required for the 
acquisition mode currently set are 
processed, and then processing continues 
to step 7. 

7. At this point the acquisition record is in memory and is available to the instrument for 
measurement of its parameters, display, and so on.  

8. The instrument then checks for a user-specified stop condition and either returns to its idle 
state or continues at step 3, according to what it finds. 

Keep in mind that this instrument samples in real time or random equivalent time; both sampling 
systems provide pretrigger information by using the trigger to stop an already running acquisition. 
Both sampling systems also sample the input after it is scaled, providing improved input 
protection and dynamic range. 
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Signal Connection 
This diagram displays the signal connection model for each input channel. 

  

Input Conditioning 
Use input conditioning to ensure that the instrument acquires the best possible data for processing. 
To do this: 

 Set the vertical scale to control the size of the vertical acquisition window for each channel to 
capture all or part of the input signal’s vertical amplitude. When vertical scaling is set to 
capture a fraction of the input signal (to increase detail), the vertical offset control determines 
which part of the input signal is captured by the vertical acquisition window. (See note) 

 Set the horizontal scale to control the size of the horizontal acquisition window to capture as 
much as you want of the input signal(s). Set the horizontal position to change the trigger 
position or to delay the window relative to a trigger event and to control where in the input 
signal (data stream) that the horizontal acquisition window acquires. (See note.) 

For more background on acquisition windows, refer to Vertical Acquisition Window 
Considerations on page 229 or Horizontal Acquisition Window Considerations on page 231. 

The instrument can automatically obtain and display a stable waveform of usable size. Push the 
AUTOSET button to automatically set the instrument controls based on the characteristics of the 
input signal. Autoset is much faster and easier than a manual control-by-control setup. 

The instrument can also be reset to its factory default settings by pushing the front-panel 
DEFAULT SETUP button.  

Use of some input conditioning controls or features may be limited when other control settings are 
in effect. Voltage offset is incompatible with reference waveforms because offset is an acquisition 
control for live waveforms (channels), not stored waveforms (reference). 
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Note 
The terms vertical acquisition window and horizontal acquisition window refer to the vertical and 
horizontal range of the segment of the input signal that the acquisition system acquires. The terms 
do not refer to any display windows on screen. 

Probes and Signal Connection 
Select the probe or cable that brings the signal into the instrument. Choose the probe or cable that 
best fits your acquisition task, whether it is connecting an active probe to test a digital circuit, or 
connecting to a test fixture through BNC cables to characterize a device. The connection to the 
instrument depends on your application. 

Up to four acquisition channels are available. You can display each channel as a waveform and/or 
use the channel data to create other waveforms, such as math and reference waveforms. 

Tektronix provides a variety of probes and cables for this product. You can also check your 
Tektronix catalog for connection accessories to support your probing requirements. For more 
information about a particular probe, read the documentation that came with that probe. 

Coupling 
All instruments and probes specify a maximum signal level. Do not exceed the limit, even 
momentarily, as the input channel or probe may be damaged. Use external attenuators if necessary 
to prevent exceeding the limits. 

Coupling determines whether an input signal is directly connected to the input channel (DC 
coupling), connected through a DC blocking capacitor (AC coupling), or not connected at all 
(GND coupling).  

The input resistance of each input channel is 1 MΩ or 50 Ω. To properly terminate signals when 
using coaxial cables, or to support active probes designed for a 50 Ω environment, a 50 Ω 
termination resistance can be selected by pushing the front-panel termination button for a 
particular channel. 

All probes expect a specific coupling and input termination. Both coupling and input termination 
are displayed on the screen. If the instrument determines the coupling and termination required by 
the probe, either implicitly because of the TEKPROBE interface or through performing a probe 
calibration, the instrument sets the required coupling and input termination. 

Consider the following when you use 50 Ω termination with any channel: 

 The instrument does not accurately display frequencies under 200 kHz if AC coupling is 
selected. 

 The instrument reduces the maximum volts per division setting for the channel to 1 V from 
10 V (10 V from 100 V with a 10X probe attached), since input amplitudes appropriate for the 
higher settings would overload the 50 Ω input. 

 The instrument switches to 50 Ω termination and DC coupling if you connect an active probe. 
Active probes also reduce the maximum volts per division. 

Scaling and Positioning 
The scaling and positioning controls determine the portion of the input signal received by the 
acquisition system. Set vertical scaling, positioning, and DC offsets to display the features of 
interest on your waveform and to avoid clipping. 
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Waveform data outside of the vertical acquisition window is clipped; that is, the data is limited to 
the minimum or maximum boundaries of the vertical acquisition window. This causes 
inaccuracies in amplitude-related measurements. For more information see Vertical Acquisition 
Window Considerations on page 229. 

  

Acquired waveform 

  

Adjusted Horizontal 
Scale 

Set horizontal scale, position, and resolution (record length) so that the acquired waveform record 
includes the waveform attributes of interest with good sampling density on the waveform. These 
settings define the horizontal acquisition window, described in Horizontal Acquisition Window 
Considerations on page 231. 

Note 
The terms vertical acquisition window and horizontal acquisition window refer to the vertical and 
horizontal range of the segment of the input signal that the acquisition system acquires. The terms 
do not refer to any display windows on screen. 

Vertical Acquisition Window Considerations 
You can set the vertical scale, position, and offset of each channel independently of other 
channels. Vertical scale and offset specify the vertical acquisition window for each channel. Parts 
of the signal amplitude that fall within the vertical window are acquired; parts outside (if any) are 
not. 

The offset control subtracts a constant DC level from the input signal before the vertical scale 
factor is applied, and the vertical position control adds a constant number of divisions of signal 
after the scale factor is applied to the resulting difference. 

The vertical scale and position controls have the following affects on the vertical acquisition 
window and the displayed waveform: 

 The vertical volts per division that you set determine the vertical size of the acquisition 
window, allowing you to scale it to contain all of a waveform amplitude or only part. Figures 
A and B below show two vertical acquisition windows that contain the entire waveform, but 
only the window in Figure B contains the entire waveform in the graticule on screen. 
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Note 
Amplitude-related automatic measurements (for example, peak-to-peak and RMS) will be accurate 
for vertical windows like those shown in Figures A and B below because neither waveform is 
clipped (that is, both waveforms are acquired). But if signal amplitude were to extend outside the 
vertical acquisition window, the data acquired is clipped. Clipped data causes inaccurate results if 
used in amplitude-related automatic measurements. Clipping also causes inaccurate amplitude 
values in waveforms that are stored or exported for use in other programs. 
If the scale of a math waveform is changed so that the math waveform is clipped, it will not affect 
amplitude measurements on that math waveform. 

 The vertical position adjusts the display of the graticule relative to the vertical acquisition 
window (position is a display control). Figure B shows how vertical position moves the 
waveform graticule vertically in the acquisition window to place the acquired waveform in the 
graticule display. That is all position does; it does not determine what data is acquired as do 
vertical scale and offset. 

Figure A 

  

Figure B 

  
 As you vary vertical offset, the middle voltage level moves relative to zero. This moves the 

vertical acquisition window up and down on the waveform. With input signals that are smaller 
than the window, it appears the waveform moves in the window. Actually, a larger signal 
shows what really happens: the offset moves the middle of the vertical acquisition window up 
and down on the input signal. The following figure shows how offset moves the acquisition 
window to control the portion of the waveform amplitude the window captures. 

 Applying a negative offset set moves the vertical range down relative to the DC level of the 
input signal. Likewise, applying a positive offset moves the vertical range up. See the 
following illustration. 
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Horizontal Acquisition Window Considerations 
The instrument lets you define the horizontal acquisition window, that is, set several parameters 
that determine the segment of an incoming signal that becomes the waveform record when 
acquired. (For background, go to Waveform Record on page 235.) These common parameters 
specify a horizontal acquisition window that is applied to all channels in parallel. See Independent 
vs. Shared Window on page 233 for more information. These parameters, shown in the figure 
below, are: 

 Trigger Position: Determines where the trigger event will be located in the waveform record. 
To see more pretrigger data move your trigger position to the right on the graticule. 

 Horizontal Position: Determines the number of pretrigger and posttrigger samples. Samples 
before the trigger point are pretrigger samples and those after the trigger point are posttrigger 
samples. When Delay is off, the horizontal position is the same as the trigger position. 

 Horizontal Delay: Determines the time from the trigger point to the Horizontal Reference. 

 Horizontal Scale: Determines the horizontal size of the window relative to any waveform, 
allowing you to scale it to contain a waveform edge, a cycle, or several cycles. 

  

Horizontal Window with Delay On 
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Autoset Considerations 
Autoset acquires samples from the input signal and attempts to take the following actions based on 
the input data: 

 Evaluate the amplitude range of the input signals and set the size and vertical offset of the 
vertical acquisition window to acquire the signal with good resolution, but without clipping. 

 Set the trigger to the approximate midlevel of the signal being Autoset and switches to edge 
trigger mode. 

 Evaluate the signal transitions and set the horizontal scale to produce a waveform display of 2 
or 3 cycles of the input signal. 

Sometimes Autoset cannot produce a correct display due to the nature of the input signal. If so, 
you may have to adjust the scale, trigger, and acquisition controls manually. Some conditions that 
can cause Autoset to fail are: 

 No signal present 

 Signals with extreme or variable duty cycles 

 Signals with multiple or unstable signal periods 

 Signals with too low amplitude  

 No recognizable trigger signal 

 Signals with a frequency ±20 Hz 

 Signals with a frequency above the bandwidth of the instrument 

Horizontal Acquisition Window Interrelated 
Parameters 

Horizontal Scale, Record Length, Sample Interval, and Resolution are related parameters that 
specify the horizontal acquisition window. Because the horizontal acquisition window must fit in 
the 10 horizontal division display, for most cases, you can set the Time Duration of the horizontal 
acquisition window (10 divs x the scale setting) as described below. By also setting a Record 
Length in samples, you indirectly set the Resolution, Sample Interval, and Sample Rate for the 
horizontal acquisition window (waveform record). The relationship between these horizontal 
elements is: 

1 Time Duration (seconds) = 10 divs (window size) x Horizontal Scale (sec/div) 
2 Time Duration (seconds) = Sample Interval (seconds/sample) x Record Length (samples), where 

Time Duration is the horizontal acquisition window time duration, and 
Sample Interval (sec/sample) = Resolution (sec/sample) = 1/Sample Rate (samples/sec) 

Note that it is the Sample Interval that changes to accommodate the window Time Duration (and 
its scale setting) and the Record Length setting. These elements behave as follows: 

 If the Record Length or Time Duration change, the Sample Interval will vary to accommodate 
the change. The Sample Interval can vary up to the highest Sample Rate, (this corresponds to 
the lowest Sample Interval, and the highest Resolution). 

 If the Sample Interval reaches its lower limit, the Record Length must decrease if the Time 
Duration decreases (you set faster scale settings), or Time Duration must increase (forcing 
slower scale settings) if Record Length increases (you set longer record lengths). The 
equation becomes: 
Maximum Record Length = Time Duration ÷ Min Sample Interval 
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For example, at 200 ps/div and 10 divisions, the record length must be 500 points: 
Max Rec Length 500 samples = (10 divs x 200 ps/div) ÷ 4 ps/sample 
Max Rec Length = 500 samples 

Note 
As implied from the operation just described, Resolution and the equivalent elements, Sample 
Interval and Sample Rate, are derived and cannot be set directly. You can, however, check the 
Resolution at anytime in the resolution readout. Also note that the front-panel RESOLUTION 
knob actually adjusts the Record Length to increase sample density. 
The previous discussion also assumes that Horizontal Scale is held constant. You can hold the 
Sample Rate constant instead by clicking Hold Sample Rate constant on the Record Length tab of 
the User Preferences control window. 

Independent versus Shared Window 
The instrument applies the same horizontal acquisition window to all channels from which it 
acquires data. Unlike the vertical acquisition window that you size and offset independently for 
each channel, the same time/div, resolution (record length), and horizontal position (from the same 
trigger point) apply to all channels simultaneously. One trigger, from a single trigger source, will 
locate a common horizontal acquisition window for all active channels, which you can shift in 
parallel by setting the horizontal position control.  

  



 234

Acquisition Hardware 
Before a signal can be acquired, it must pass through the input channel where it is scaled and 
digitized. Each channel has a dedicated input amplifier and digitizer, as shown in the following 
figure; each channel can produce a stream of digital data from which the instrument extracts 
waveform records. Refer to Signal Connection on page 227 for further description of scaling, 
positioning, and DC offsetting of channels. 

  

Sampling Process 
Acquisition is the process of sampling an analog signal, converting it into digital data, and 
assembling it into a waveform record, which is then stored in acquisition memory. Sampling, then, 
is the process that provides a waveform record per trigger event as shown in the figure below.   

  

The signal parts within the vertical range of the amplifier are digitized as shown in the figure 
below. 
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Sampling Modes 
The acquisition system can process the data as it is acquired, averaging or enveloping the 
waveform data to produce enhanced waveform records. Once the waveform record exists 
(enhanced or not), you can use the post processing capabilities of the instrument to further process 
that record: perform measurements, waveform math, and so on. Refer to Acquisition Mode on 
page 104 for a description of the acquisition modes. 

Waveform Record 
While sampling on the input signal provides the data that makes up the waveform record for any 
given channel, the instrument builds the waveform record through use of some common 
parameters ("common" means they affect the waveforms in all channels).  

The following figure shows how these common parameters define the waveform record. They 
define how much data is taken and from where in the data stream. The parameters are: 

 Sample Interval: The time between sample points taken during acquisition.  

 Record Length: The number of samples required to fill a waveform record. 

 Trigger Point: The trigger point marks the reference zero time in a waveform record. All 
waveform samples are located in time (minus and/or plus) with respect to the trigger point. 

 Horizontal Position: When horizontal delay is off, the horizontal position is the time from the 
first sample taken (first point in the waveform record) to the trigger point (in percent of 
samples before the trigger). The trigger point and the horizontal reference are at the same time 
in the waveform record. 

When horizontal delay is on, the HORIZONTAL POSITION knob controls the horizontal delay 
time. The horizontal delay is the time from the trigger point to the horizontal reference. 

  
The waveform record and its defining parameters (horizontal delay on) 

The figure above shows that the instrument acquires points in order from left to right.  

When all of the points in the waveform record have been sampled and digitized, the waveform 
record is stored in acquisition memory and becomes available for display (or use in math 
waveforms, storage, and so on). 
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Interleaving 
The instrument can interleave channels to attain higher real-time digitizing rates and longer record 
length when only 1 or 2 channels are turned on without equivalent-time sampling. The instrument 
applies the resources of unused channels (that is, channels that are turned off) to sample those that 
are in use (turned on). The following table lists how interleaving extends the maximum digitizing 
rate and record length. 

Interleaving affects on digitizing rate and record length 

Number of 
channels in 
use 

Maximum 
digitizing 
rate 

Maximum 
record length  

One 5 GS/sec 8 M (16 M with Option 
3M) 

Two 2.5 GS/sec 4 M (8 M with Option 
3M) 

Three or Four 1.25 GS/sec 2 M (4 M with Option 
3M) 

Once you set the horizontal scale to exceed the maximum digitizing rate for the number of 
channels in use, the instrument will not be able to get enough samples to create a waveform 
record. At that point, the instrument will switch from real- to equivalent time to obtain additional 
samples.  

Note 
Only record length interleaving is available on the TDS5054BE. The maximum sample rate on the 
TDS5054BE is 1 GS/s regardless of the number of channels in use. 

Triggering Concepts 
Overview 

To use the instrument to sample a signal and digitize it into a waveform record that you want to 
process, you need to set up the trigger conditions. 

The following figure shows how triggers fit into the overall instrument operation. 
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Triggers create meaningful 
waveforms from signal displays. 
This instrument has simple edge 
triggers as well as a variety of 
advanced triggers. 

  

The Trigger Event 

The trigger event establishes the time-zero point in the waveform record. All waveform record 
data are located in time with respect to that point. The instrument continuously acquires and 
retains enough sample points to fill the pretrigger portion of the waveform record (that part of the 
waveform that is displayed before, or to the left of, the triggering event on screen). When a trigger 
event occurs, the instrument starts acquiring samples to build the posttrigger portion of the 
waveform record (displayed after, or to the right of, the trigger event). Once a trigger is 
recognized, the instrument will not accept another trigger until the acquisition is complete and the 
holdoff time has expired. 

Trigger Sources 
The trigger source provides the signal that triggers acquisition. Use a trigger source that is 
synchronized with the signal that you are acquiring and displaying. You can derive your trigger 
from the following sources: 

 Input channels are the most commonly used trigger sources. You can select any one of the 
two or four input channels, depending on your model. The channel that you select as a trigger 
source will function whether it is displayed or not. 

 AC Line Voltage is often used to look at signals related to the power line frequency (for 
example, signals from devices such as lighting equipment and power supplies). Because the 
instrument generates the trigger from the power line, you do not have to use a channel input. 

 Auxiliary Trigger (AUX IN) provides a fifth source that you can use as a trigger input when 
you need to use the four input channels for other signals. For example, you might want to 
trigger on a clock while displaying four other logic signals. To use the auxiliary trigger, 
connect the signal to the auxiliary input connector on the front panel. The input connector is 
not compatible with most probes, nor can you display the auxiliary trigger signal. 

Trigger Types 
 Edge triggers are the simplest and most commonly used trigger type, used with both analog 

and digital signals. An edge trigger event occurs when the trigger source passes through a 
specified voltage level in the specified direction (rising or falling signal voltage). 

 Pulse triggers are special-purpose triggers that are primarily used with digital signals. The 
following types of pulse triggers are available: Glitch, Runt, Window, Width, Transition, and 
Timeout. Pulse triggers are available on the main trigger only. 
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 Logic triggers are special-purpose triggers that are primarily used with digital logic signals. 
Two of the types, Pattern and State, trigger the instrument based on the Boolean operator you 
select for the trigger sources. A third type, Setup and Hold, triggers when data in one trigger 
source changes state within the setup and hold times that you specify relative to a clock in 
another trigger source. Logic triggers are available on the main trigger only. 

 Communication triggers (available only with Option SM) are designed to work with 
communication masks and standards. Mask testing automatically uses Communication 
triggers. 

 Video triggers are used to trigger the instrument on specified fields or lines of a video signal. 
You can use one of several preset video signal formats or set a custom format. 

Trigger Modes 
The trigger mode determines how the instrument behaves in the absence of a trigger event: 

 Normal trigger mode enables the instrument to acquire a waveform only when it is triggered. 
If no trigger occurs, the instrument does not acquire a waveform, and the last waveform 
record acquired remains "frozen" on the display. If no last waveform exists, no waveform is 
displayed. 

 Auto trigger mode enables the instrument to acquire a waveform even if a trigger does not 
occur. Auto mode uses a timer that starts after a trigger event occurs. If another trigger event 
is not detected before the time out, the instrument forces a trigger. The length of time it waits 
for a trigger event depends on the time base setting. 

Auto mode, when forcing triggers in the absence of valid triggering events, does not synchronize 
the waveform on the display. In other words, successive acquisitions are not triggered at the same 
point on the waveform; therefore, the waveform will appear to roll across the screen. If valid 
triggers occur, the display will become stable. 

Trigger Holdoff 
Trigger holdoff can help stabilize triggering. When the instrument recognizes a trigger event, it 
disables the trigger system until acquisition is complete. In addition, the trigger system remains 
disabled during the holdoff period that follows each acquisition. Adjust holdoff to obtain stable 
triggering when the instrument is triggering on undesired trigger events. 

A digital pulse train is a good example of a complex waveform. Each pulse looks like any other, 
so many possible trigger points exist. Not all of these will result in the same display. The holdoff 
period allows the instrument to trigger on the correct edge, resulting in a stable display. 
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At the longer holdoff time for the top waveform, unstable triggering occurs. With a shorter holdoff 
set for the bottom waveform, triggers all occur on the first pulse in the burst to remedy the 
unstable trigger. 

The Holdoff setting range is 1.5 µs (minimum holdoff available) to 12 seconds (maximum holdoff 
available). For more information on how to set holdoff, see page 122. You can also set a default 
holdoff. The default holdoff is the general-purpose holdoff for most applications and varies with 
the horizontal scale. It is equal to five times the current horizontal scale setting. 

Trigger Coupling 
Trigger coupling determines what part of the signal is passed to the trigger circuit. Edge triggering 
can use all available coupling types: AC, DC, Low Frequency Rejection, High Frequency 
Rejection, and Noise Rejection. All of the advanced trigger types use DC coupling only. For a 
description of each coupling type, see the Glossary. 

Horizontal Trigger Position 
Horizontal position is an adjustable feature that defines where the trigger occurs on the waveform 
record. It lets you choose how much the instrument acquires before and after the trigger event. The 
part of the record that occurs before the trigger is the pretrigger portion. The part that occurs after 
the trigger is the posttrigger portion. A longer posttrigger period my be useful when you want ot 
see the effects an event has on your system under test.  

Pretrigger data can be valuable when troubleshooting. For example, if you are trying to find the 
cause of an unwanted glitch in your test circuit, you can trigger on the glitch and make the 
pretrigger period large enough to capture data before the glitch. By analyzing what happens before 
the glitch, you may uncover information that helps you find the source of the glitch. 

Trigger Slope and Level 
The slope control determines whether the instrument finds the trigger point on the rising or the 
falling edge of a signal. The level control determines where on that edge the trigger point occurs. 
See the figure below. 

  

Delayed Trigger System 
You can trigger with the A (Main) trigger system alone or you can combine the A (Main) trigger 
with the B (Delayed) trigger to trigger on sequential events. When using sequential triggering, the 
A trigger event arms the trigger system, and the B trigger event triggers the instrument when the B 
trigger conditions are met. A and B triggers can (and typically do) have separate sources. The B 
trigger condition can be based on a time delay or a specified number of counted events. For more 
details on delayed triggering see page 120. 
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Advanced Triggering 
You can check the advanced trigger status in the readout. The readout indicates the trigger type 
and then shows sources, levels, or any other parameters that are important for the particular trigger 
type. 

  

For details on advanced triggers see pages 240–244. 

Glitch Trigger 
A glitch trigger occurs when the instrument detects a pulse narrower (or wider) than some 
specified time. You can set the instrument to trigger on glitches of either polarity or to reject 
glitches of either polarity. 

Runt Trigger 
A runt trigger occurs when the instrument detects a short pulse that crosses one threshold but fails 
to cross a second threshold before recrossing the first. You can set the instrument to detect any 
positive or negative runt pulse, or only those wider than a specified minimum width. Runt pulses 
can also be qualified by the logical state of other channels. 

Width Trigger 
A width trigger occurs when the instrument detects a pulse that is inside or outside some specified 
time range. The instrument can trigger on positive or negative width pulses. Width triggers can 
also be qualified by the logical state of other channels. 

Transition Time Trigger 
Transition triggering is based on the slope (change in voltage/change in time) of a pulse edge. Use 
the transition trigger to trigger the instrument on pulse edges that traverse between two thresholds 
at faster or slower rates than the specified time. You can set up the instrument to trigger on 
positive or negative edges. 

Timeout Trigger 
A timeout trigger occurs when the instrument does not detect an expected pulse transition within a 
user specified period of time, such as when a signal gets stuck either high or low. If the pulse 
transition occurs prior to a specified timeout time (the expected case), then no trigger results. 
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Pattern Trigger 
A pattern trigger occurs when the inputs to the selected logic function cause the function to 
become True or False. When you use a pattern trigger, you define: 

 The precondition for each logic input: logic high, low, or "don't care"; the logic inputs are the 
instrument channels 

 The Boolean logic function: AND, NAND, OR, or NOR 

 The condition for triggering: the Boolean function becomes True (logic high) or False (logic 
low), and whether the True condition is time qualified 

Pattern trigger logic choices are summarized in the following table: 

Pattern  State Definition 1, 2 

AND 

  

Clocked AND 

  

If all the preconditions selected 
for the logic inputs3 are TRUE, 
then the instrument triggers. 

NAND 

  

Clocked NAND 

  

If not all of the preconditions 
selected for the logic inputs3 are 
TRUE, then the instrument 
triggers. 

OR 

  

Clocked OR 

  

If any of the preconditions 
selected for the logic inputs3 are 
TRUE, then the instrument 
triggers. 

NOR 

  

Clocked NOR 

  

If none of the preconditions 
selected for the logic inputs3 are 
TRUE, then the instrument 
triggers. 

1 For state triggers, the definition must be met at the time the clock input changes state. 

2 The definitions given here are correct for the Goes TRUE setting in the Trigger When menu. If 
that menu is set to Goes False, swap the definition for AND with that for NAND and for OR with 
NOR for both pattern and state types. 

3 The logic inputs are channels 1, 2, 3, and 4 when using Pattern triggers. For State triggers, 
channel 4 becomes the clock input, leaving the remaining channels as logic inputs. (On the 
TDS5000B 2-channel instruments, channel 2 is the clock input.) 
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State Trigger 
A state trigger occurs when the inputs to the logic function cause the function to become True or 
False at the time the clock input changes state. When you use a state trigger, you define: 

 The precondition for logic input channels 1 through 3 (channel 1 on TDS5000B 2-channel 
instruments) 

 The direction of the state change for the clock input, channel 4 (channel 2 on the TDS5000B 
2-channel instruments) 

 The Boolean logic function: AND, NAND, OR, or NOR (not available on the TDS5000B 2-
channel instruments) 

 The condition for triggering: the Boolean function becomes True (logic high) or False (logic 
low) 

State trigger logic conditions are summarized in the following table. 

Pattern  State Definition 1, 2 

AND 

 

Clocked AND 

 

If all the preconditions 
selected for the logic 
inputs3 are TRUE, then the 
instrument triggers. 

NAND 

 

Clocked NAND 

 

If not all of the 
preconditions selected for 
the logic inputs3 are TRUE, 
then the instrument 
triggers. 

OR 

 

Clocked OR 

 

If any of the preconditions 
selected for the logic 
inputs3 are TRUE, then the 
instrument triggers. 

NOR 

 

Clocked NOR 

 

If none of the 
preconditions selected for 
the logic inputs3 are 
TRUE, then the instrument 
triggers. 

1 For state triggers, the definition must be met at the time the clock input changes state. 

2 The definitions given here are correct for the Goes TRUE setting in the Trigger When menu. If 
that menu is set to Goes False, swap the definition for AND with that for NAND and for OR with 
NOR for both pattern and state types. 

3 The logic inputs are channels 1, 2, 3, and 4 when using Pattern triggers. For State triggers, 
channel 4 becomes the clock input, leaving the remaining channels as logic inputs. (TDS5000B 2-
channel instruments, channel 2 is the clock.) 
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Setup and Hold Trigger 
A setup/hold trigger occurs when a data signal changes state inside of the user specified setup and 
hold times relative to the clock. When you use setup/hold triggering, you define: 

 The channel containing the logic input (the data source) and the channel containing the clock 
(the clock source) 

 The direction of the clock edge to use 

 The clocking level and data level that the instrument uses to determine if a clock or data 
transition has occurred 

 The setup and hold times that together define a time range relative to the clock 

Data that changes state within the setup/hold violation zone triggers the instrument. The following 
figure shows how the setup and hold times that you choose position the violation zone relative to 
the clock. 

  

  

  

Setup/hold triggering uses the setup/hold violation zone to detect when data is unstable too near 
the time it is clocked. Each time trigger holdoff ends, the instrument monitors the data and clock 
sources. When a clock edge occurs, the instrument checks the data stream it is processing (from 
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the data source) for transitions occurring within the setup/hold violation zone. If any occur, the 
instrument triggers with the trigger point located at the clock edge. 

Positive settings for both setup and hold times (the most common application) locate the 
setup/hold violation zone so it spans the clocking edge as shown above in the top waveform. The 
instrument detects and triggers on data that does not become stable long enough before the clock 
(setup time violation) or that does not stay stable long enough after the clock (hold time violation).  

Negative settings for setup or hold times skew the setup/hold violation zone to locate it before or 
after the clocking edge as shown above in the center and bottom waveforms. The instrument can 
then detect and trigger on violations of a time range that occurs before or one that occurs after the 
clock.  

Note 
Keep the hold-time setting to no more than 2.5 ns less than one-half the clock period (hold time v 
(period/2) –2.5 ns) or the instrument cannot trigger (this assumes a 50% duty cycle clock). 

Window Trigger 
Use the Window trigger to trigger the instrument when the input signal rises above an upper 
threshold level or falls below a lower threshold level. After setting these levels, you can specify 
whether you want to trigger the instrument as the signal is entering or leaving the threshold 
window. You can further qualify the trigger event in terms of time, or by the logical state of other 
channels. 

Video Trigger 
Use the Video trigger to trigger the instrument on specified fields or lines of a composite video 
signal. Select from several preset video signal formats or set a custom format. Only composite 
signal formats are supported. Graphic display formats such as RGB and VGA are not supported. 

Communication Trigger 
Use the Comm trigger to trigger the instrument in conjunction with mask testing on 
communications codes and standards. The controls work together to define the parameters for the 
trigger event. The standards that appear in the Standard drop-down list depend on the coding 
format that you selected. The coding format also determines whether upper, lower, single, or clock 
threshold levels or pulse forms are used. The standard determines the bit rate.  

Sequential Triggering 
In applications that involve two or more signals, you may be able to use sequential triggering to 
capture more complex events. Sequential triggering uses the A (Main) trigger to arm the trigger 
system, and then uses the B (Delayed) trigger to trigger the instrument if a specific condition is 
met. You can choose one of two trigger conditions: 

 Trigger After Time: After the A trigger arms the trigger system, the instrument triggers on the 
next B-trigger event that occurs after the trigger delay time. You can set the trigger delay time 
with the keypad or the multipurpose knobs. 

 Trigger on nth Event: After the A trigger arms the trigger system, the instrument triggers on 
the nth B event. You can set the number of B events with the keypad or the multipurpose 
knobs. 

Note 
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The traditional delayed trigger mode called "Runs After" is served by the TDS5000B feature 
Horizontal Delay. You can use horizontal delay to delay acquisition from any trigger event, 
whether from the A (Main) trigger alone or from a sequential trigger that uses both the A (Main) 
and B (Delayed) triggers. See Triggering with Horizontal Delay On on page 246 for more 
information.  

Keep in mind the following when using sequential triggers: 

 In most cases, you will set separate trigger sources for the A (Main) and B (Delayed) triggers.  

 Sequential triggering for Trigger after Time or Trigger on nth Event is available for the Edge, 
Glitch, Width, or Timeout types. It is not available for the rest of the trigger types. 

 The B trigger is always the Edge type. 

Triggering with Horizontal Delay Off 
The following figure compares the sequential trigger choices A Only, Trig After Time, and Trig 
on nth Event when horizontal delay is off. Each illustration shows where pretrigger and posttrigger 
data is acquired relative to the trigger event. 
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Triggering with Horizontal Delay On 
You can use horizontal delay when you want to acquire a waveform record that is separated from 
the trigger event by a significant interval of time. The horizontal delay function can be used with 
any trigger setup. You can turn horizontal delay on and off from the front panel, the 
Horizontal/Acquisition control window, and many of the Trigger control windows. The following 
figure compares the sequential trigger choices A Only, Trig After Time, and Trig on nth Event 
when horizontal delay is on. Each illustration shows where pretrigger and posttrigger data is 
acquired relative to the trigger event. 
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Triggering and Horizontal Delay Summary 
The following figure shows all combinations of triggering and horizontal delay. 

  

Display Overview 
This instrument includes a flexible, customizable display that lets you control how waveforms 
appear. The following figure shows how the display features fit into the overall instrument 
operation. 
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Display Elements 
The waveform shown below is displayed as part of the user interface (UI) application. Some terms 
that are useful in discussing the UI follow. 

  

(1) The Display is the area where the waveforms appear. The display comprises the time base and 
graticules, the waveforms, histograms, and some readouts. 

(2) The Graticule is the grid marking the display area. When MultiView Zoom is on, depending on 
the graticule split setting, the upper graticule displays unmagnified waveforms and the lower 
graticule displays magnified waveforms. 

(3) The Horizontal scale readout provides a quick overview of the horizontal settings for zoomed 
and unzoomed waveforms.  

(4) The Horizontal reference is a control that you can position to set the point around which 
channel waveforms expand and contract horizontally on screen as you change the Horizontal Scale 
control. It is also the trigger point when the horizontal delay is 0%. 

See the following figure for some ideas on how to manipulate the display elements. 
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Acquisition Preview 
The acquisition preview attempts to show what the next acquisition will look like when the 
acquisition is delayed due to slow triggers or long acquisition duration, or when the acquisitions 
have stopped. Acquisition preview recalculates math waveforms, but does not represent changes in 
trigger levels, trigger modes, or different acquisition modes. 

Acquisition preview has some limitations. For example, if the record length is changed, the 
waveforms are erased. Changing the horizontal scale can change the record length in some cases.  

Note 
There is no acquisition preview in Fast Acquisitions mode. 

Waveform Display 
In general, the method of displaying a waveform is to:  

 Define the waveform (math and reference waveforms only)  

 Enable the waveform display 

The following table summarizes this process as it applies to the different types of waveforms. 
Waveform To define To display 

Channel: Ch1 – Ch4 Channels are predefined Push the Vertical CH n 
button to toggle the 
channel display on or off. 

Reference: Ref1 – Ref4 Define an active reference 
waveform by: 

 Saving a 
channel, 
reference, or 
math 
waveform to 
one of 
locations Ref1 
- Ref4. 

 Recalling a 
waveform 
previously 
saved to a file 
into one of 
locations  
Ref1 - Ref4. 

Perform these operations 
from the File menu. 

From the Reference Setup 
control window, click 
Display on the Ref n tab 
to toggle the reference 
waveform display on and 
off. 

Math: Math1 – Math4 Create a math waveform 
using existing sources 
(channel, math, and 
reference waveforms; 
measurements).  

From the Math Setup 
control window, click 
Display on the Math n tab 
to toggle the math 
waveform display on and 
off. 
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In general, the method of adjusting (vertically scaling, offsetting, positioning, and so on) the 
waveform display is from the front-panel vertical SCALE and POSITION knobs. Note that math 
and reference waveforms are scaled and positioned from their setup control windows. 

For channel waveforms, the vertical and horizontal controls that you set also adjust the instrument 
acquisition parameters. See the following for more information: 

 Vertical Acquisition Window Considerations on page 229.  

 Horizontal Acquisition Window Considerations on page 231. 

To change the size of the acquisition waveform and zoomed waveform windows, select the 
Graticule Size in the Zoom Setup control window. The 50-50 selection allocates half of the 
available display for the zoomed graticule and half of the available display for the acquisition 
window. The 80-20 selection allocates 80% of the available display for the zoomed graticule and 
20% for the acquisition window. Select Full to use the entire display for the zoomed graticule. 

The display elements are the same for each graticule. 

Customizable Display Elements 
The following table lists customizable display elements and their points of access. 

Display attribute Access Options 

Graticule Style Display menu 
Graticule Style 
command 

or 

Display Setup 
control window 
Objects tab Disp 
toolbar button) 

 Full provides a grid, cross hairs, 
and frame on the instrument 
display. Use for quick estimates 
of waveform parameters. 

 Grid shows a frame and grid on 
the instrument display. Use for 
full-screen measurements with 
cursors and automatic readouts 
when cross hairs are not needed. 

 Cross Hair shows cross hairs and 
a frame on the instrument 
display. Use for making quick 
estimates of waveforms while 
leaving more room on the 
display for automatic readouts 
and other data. 

 Frame shows only a frame on the 
instrument display. Use with 
automatic readouts and other 
screen text when other display 
features are not needed. 

 IRE is used for NTSC video 
signals. 

 mV is used for video signals 
other than NTSC. 

   

Display 
Persistence 

Display menu 
Display Persistence  
submenu commands 

 Infinite persistence continuously 
accumulates record points on the 
waveform until you change one 
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Display attribute Access Options 

or  

Display Setup control 
window Appearance 
tab (Disp toolbar 
button) 

 

of the acquisition display 
settings. Use for displaying 
points that may occur outside the 
normal acquisition envelope. 

 Variable persistence accumulates 
record points on the waveform 
for a specified time interval. 
Each record point decays 
independently according to the 
time interval. 

 Off shows waveform record 
points for the current acquisition 
only. Each new waveform record 
replaces the previously acquired 
record for a channel.  

   

Display Style Display menu 
Display Style 
submenu  
commands 

or 

Display Setup control 
window Appearance 
tab (Disp toolbar 
button) 

 Vectors display waveforms with 
lines drawn between record 
points. 

 Dots display waveform record 
points as dots on the screen.  

 Inten Samp (Intensified 
Samples) shows the actual 
samples on interpolated 
waveforms.  

   

Screen Text Display menu Screen 
Text command 

or 

Display Setup control 
window Screen Text 
tab (Disp toolbar 
button) 

 Up to eight (8) lines of text 
provides notes for screen shots, 
printouts, or for other instrument 
users. 

 Display turns the text display on 
and off.  

 Properties opens the Text 
Properties control window for 
positioning of the text on the 
display. 

 Clear erases the entire text of the 
selected line. 

Color Palette  
(Graticule and 
Waveform)  

Display menu Colors 
command 

or  

Display menu 
Display Palette 
submenu 

 Normal displays hues and 
lightness levels for best overall 
viewing. The color of each 
channel waveform matches the 
color of the corresponding front-
panel vertical SCALE knob. 

 On the Spectral Spectral 
Grading) palette, areas of the 



 252

Display attribute Access Options 

or  

Display Setup control 
window Colors tab 
(Disp toolbar button) 

waveform with the highest 
sample density appear in blue 
shades and the areas of lowest 
sample density appear in red 
shades. 

 On the Temp (Temperature 
Grading) palette, areas of the 
waveform with the highest 
sample density appear in warmer 
colors (red shades) and the areas 
of lowest sample density appear 
in cooler colors (blue shades). 

 Gray (Monochrome Gray) 
displays waveforms in shades of 
gray. Areas of the waveform 
with the highest sample density 
appear in lighter gray shades and 
the areas of lowest sample 
density appear in darker gray 
shades. 

 Green (Monochrome Green) 
displays waveforms in shades of 
green. Areas of the waveform 
with the highest sample density 
appear in lighter green shades 
and the areas of lowest sample 
density appear in darker green 
shades.  

Reference Colors Display menu Colors 
command 

or  

Display Setup control 
window Colors tab 
(Disp toolbar button) 

 Default uses the default system 
color (white) for reference 
waveforms. 

 Inherit uses the same color for 
the reference waveform as the 
original waveform. 

   

Math Colors Display menu Colors 
command 

or 

Display Setup control 
window Colors tab 
Disp toolbar button) 

 Default uses the default system 
color (red) for math waveforms. 

 Inherit uses the same color for 
the math waveform as the 
waveform the math function is 
based on. 

   

Waveform 
Interpolation 

Display menu 
Waveform 
Interpolation 

 Sin(x)/x interpolation 

 Linear interpolation  
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Display attribute Access Options 
submenu 

or 

Display Setup control 
window Appearance 
tab (Disp toolbar 
button) 

Refer to Interpolation on page 255 
for more information. 

   

Waveform 
Intensity 

Display menu 
Appearance 
command 

or 

Display Setup control 
window Appearance 
tab (Disp toolbar 
button) 

 When AutoBright is Off, the 
display simulates the appearance 
of analog oscilloscope signals. 
Waveforms that trigger more 
frequently appear brighter than 
waveforms that trigger less 
frequently. Use the front-panel 
INTENSITY knob or the 
multipurpose knobs to manually 
adjust the display intensity when 
AutoBright is Off.  

 When AutoBright is On, the 
intensity of the waveform 
changes automatically to provide 
a visible waveform.  

   

Display Format Display menu 
Appearance 
command 

or 

Display menu 
Display submenu 

or 

Display Setup control 
window Appearance 
tab (Disp toolbar 
button) 

 YT  

 XY 

 XYZ  

For additional information, see 
Display Format on page 141. 

   

Trigger Level 
Marker 

Display menu 
Objects command 

or 

Display Setup control 
window Objects tab 
(Disp toolbar button) 

 The Short trigger level marker 
displays a short arrow on the 
side of the graticule by the active 
waveform. 

 The Long trigger level marker 
displays a horizontal line 
through the active waveform. 
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Display attribute Access Options 

LCD Backlight  
Timeout 

Display menu 
Objects command 

or 

Display menu LCD 
Save Enabled  
command 

or 

Display Setup control 
window Objects tab 
(Disp toolbar button) 

The LCD Backlight control turns the 
LCD backlight off after the amount 
of time in Delay has expired without 
any screen activity. 

 When LCD Backlight Timeout is 
On and the time in Delay has 
expired, the screen blanks out.  

 When LCD Backlight Timeout is 
Off, the screen display remains 
on.  

 

   

Date and Time Display menu 
Objects command 

or 

Display menu 
Display Date & Time 
command 

or 

Display Setup control 
window Objects tab 
Disp toolbar button) 

Toggle the display of the date and 
time on the graticule. To set the time 
and date, use the Utilities menu Set 
Time & Date command. 
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Operations on the Time Base 
In general, to adjust the time base, use the front-panel horizontal SCALE, RESOLUTION, and 
POSITION knobs. Only channel waveforms can be set directly. 

Here are some key points to remember about how horizontal operations relate to the waveform 
types: 

 Reference waveforms are shown with the horizontal settings in effect at the time that they are 
saved. You cannot adjust these settings. See Saving and Recalling Waveforms on page 289 
more information on reference waveforms. 

 Math waveforms are shown with the horizontal settings derived from the math expression that 
creates them. You cannot change these directly. See Creating or Using Math Waveforms for 
more information on math waveforms. 

 All waveforms are displayed within the horizontal divisions that the graticule provides. 
However, some waveforms may actually be wider or narrower than the display due to 
acquisition rate/time scale combinations and acquisition preview. 

Horizontal Position and the Horizontal Reference 
Point 

The time value you set for horizontal position is measured from the trigger point to the horizontal 
reference point. This is not the same as the time value from the trigger point to the start of the 
waveform record, unless you set the horizontal reference to 0%. See the following figure. 

  

Interpolation 
When the sample density falls to less than 1 sample per display column, the instrument must 
calculate intermediate points to display a waveform. This process is called interpolation. There are 
two options for interpolation:  

 Sin(x)/x interpolation computes record points using a curve fit between the actual values 
acquired. It assumes that all the interpolated points fall along that curve. 

 Linear interpolation computes record points between actual acquired samples by using a 
straight line fit. It assumes that all the interpolated points fall in their appropriate point in time 
on that straight line.  

For example, if an acquired record length is 500 points, a 2x zoom requires interpolation. If a 
record length is 100K, horizontal zoom of 200x produces 1 sample per column (100,000/500 = 
200); therefore, you will see interpolated samples starting at the next faster scale setting. 
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Using the MultiZoom Feature 
Use the instrument MultiZoom feature to magnify an acquisition vertically, horizontally, or in 
both dimensions to let you see the fine detail in your signals without changing the acquisition 
parameters (sample rate, record length, and so on). For example, to temporarily expand the front 
corner of a pulse to inspect its aberrations, push the front-panel MultiZoom button to expand it 
horizontally and vertically.  

To help you use Mulitzoom effectively, consider how it operates on waveforms: 

 When zooming vertically, the instrument expands up to four zoomed areas at one time. The 
zoomed areas can all be on the same waveform or they can be on different Channel, Math or 
Reference waveforms. Each zoomed area has its own vertical position and factor.  

 When zooming horizontally, the Zoom Source is either the acquisition waveform or one of the 
zoomed areas.  

 When zooming either horizontally or vertically, Zoom expands or contracts the waveform by 
the Zoom Factor. 

Automatic Measurements 
All channel, reference, and math waveforms can serve as sources for automatic measurements. 
Some measurements, such as Delay and Phase, require two sources. 

The following automatic measurement categories are available:  

 Amplitude  

 Time  

 More (miscellaneous) 

 Histogram  

 Communication  

The instrument can take and update up to eight measurements at one time. You can apply 
measurements to any combination of sources. For example, you can take all eight measurements 
on Channel 1, or you can take measurements on a combination of channel waveforms, math 
waveforms, reference waveforms, and/or histograms. 

High/Low Method 

The levels that the automatic measurement system derives as the High (top) or Low (bottom) for a 
waveform influence the fidelity of amplitude and aberration measurements. Select among the 
modes the instrument provides for determining these levels: 

 Histogram mode sets the values statistically. It selects the most common value either above or 
below the midpoint (depending on whether it is defining the High or Low reference level). 
Since this statistical approach ignores short term aberrations (overshoot, ringing, and so on), 
Histogram is the best setting for examining pulses. See the figure below. 

 Min-Max mode uses the highest and lowest values of the waveform record. This setting is 
best for examining waveforms that have no large, flat portions at a common value, such as 
sine waves and triangle waves (almost any waveform except for pulses). See the figure below. 
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Reference Levels Method 

A second set of levels affect the fidelity of time-related measurements. For example, the 
measurement system calculates rise time from the waveform edge that transitions from the Low to 
the High reference levels. 

The instrument provides the following calculation methods (see the following figure):  

 Relative Reference is calculated as a percentage of the High/Low range. 

 Absolute Reference is set by absolute values in user units. 

  

Cursor Measurements 
Because cursor measurements give immediate feedback on the amplitude or time values they 
measure, they are usually quick to take and are more accurate than graticule measurements. Also, 
since you can position cursors wherever you want them on the waveform, they are easier to 
localize to a waveform segment or feature than automatic measurements. 

Cursors can measure channel, reference, and math waveforms. You must set the source of each 
cursor explicitly in the Cursor Setup control window.  

Any cursor type can be used for YT display format. XY and XYZ display format can only use 
Screen or Waveform cursors. If FastAcq is on, XYZ display format can only use Screen cursors. 

To use cursors, simply move the cursors on screen and read the results in the cursor readouts. The 
following key points will help you use the cursors effectively. 

Cursor Types  

There are two cursors displayed for all types, Cursor 1 and Cursor 2. You can move cursors with 
the multipurpose knobs or the cursor position controls in the Cursor Setup control window, or 
click and drag them to a new location. 

Cursors are Limited by the Display  
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You cannot move a cursor off the graticule unless you are in Zoom mode. Also, if you resize 
waveforms, the cursors do not track. That is, a cursor stays at its screen position, ignoring changes 
to horizontal and vertical scale and position and vertical offset (Waveform and Screen cursors will 
track a waveform vertically).  

Cursors Ignore the Selected Waveform 

Each cursor measures its source, defined in the Cursor Setup control window. Selecting a 
waveform for scaling on screen (by pushing the CH 3 front-panel button, for example) does not 
change the source that each cursor measures.  

After you have selected the source from the Cursor Setup control window, you can operate the 
cursor from the front-panel knobs and buttons.  

Note 
If a cursor readout does not seem correct, check the source of each cursor in the Cursor Setup 
dialog box. Each cursor readout relates to the amplitude and time base settings of its source. 

Vertical Cursors Measure from the Trigger Point 

Remember that each vertical cursor measures the time from the trigger point to itself. This 
relationship is shown in the following figure. 

  

Note that a vertical cursor readout includes and varies directly with the Delay time, which varies 
directly with the horizontal position set for the time base. To see the amount of time to the first 
point, set horizontal delay to 0.0 and set the horizontal reference point to 0%. Now the horizontal 
position readout shows the time following the first point, and adding this value to the cursor 
readout yields the cursor position on screen relative to first point. (You can find the horizontal 
readout both in the control window and in the readout at the bottom of the screen.) The following 
relationships hold: 

Time from First Point = Horiz. Position (when Horiz. Delay and Ref Position are zero) 

T1 readout = Time to First Point + Additional Time to Cursor  
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Cursor Units Depend on Sources 

A cursor that measures amplitude or time will read out in the units of its source as indicated in the 
table below. Note mixed sources require delta cursor readouts to use the units of the Cursor 1 
source. 
Cursors Standard units1 Readout names 

Horizontal volts, watts, IRE V1, V2, ∆V 

Vertical  seconds, bits, Hz T1, T2, ∆T, ∆F 

Waveform, Screen volts, watts, seconds, bits, 
Hz 

V1, V2, ∆V, T1, T2, ∆T 

1 If the V1 and V2 units do not match, the ∆V readout defaults to the units used 
by the V1 readout. 

Changing Cursor Positions 

Change cursor positions by using the position controls in the Cursor Setup control window, 
dragging the cursor into position using the touch screen or mouse, or by turning the front-panel 
multipurpose knobs.  

Note 
To make small changes with the multipurpose knobs, push the FINE button before turning the 
knobs. When a FINE button is lighted, its multipurpose knob makes smaller adjustments. 

Cursor Types 
Because cursor measurements give immediate feedback on the amplitude or time values they 
measure, they are usually quick to take and are more accurate than graticule measurements. Also, 
since you can position cursors wherever you want them on the waveform, they are easier to 
localize to a waveform segment or feature than automatic measurements. 

The following table defines the cursor types. 
Cursor function Measurements 

  

Horizontal cursors measure vertical parameters (amplitude) 
in volts, watts, or IRE. The cursor readouts are defined as:  

V1 = Level @ Cursor 1 with respect to its source 
ground level 
V2 = Level @ Cursor 2 with respect to its source 
ground level 
∆V = Level @ Cursor 2 - Level @ Cursor 1 

Level is cursor displacement from the source ground 
multiplied by the source in volts/div. The two cursors may 
have different sources and therefore can have different 
volts/div settings. 

  

Vertical cursors measure horizontal parameters. Typically 
the horizontal parameters are in time or frequency, but 
depend on the units you select. The cursor readouts are 
defined as:  

T1 = Time @ Cursor 1 with respect to the trigger 
point 
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Cursor function Measurements 
T2 = Time @ Cursor 2 with respect to the trigger 
point 
∆T = Time @ Cursor 2 - Time @ Cursor 1 

Time is divisions of displacement of the cursor from its 
source trigger point multiplied by the source in time/div. 

  

Waveform cursors measure vertical parameters (typically 
volts) and horizontal parameters (typically time or 
frequency) simultaneously. Each cursor is, in effect, both a 
vertical and horizontal cursor. These paired cursors cannot 
be moved off of the waveform. The two cursors can have a 
different source. 

Use screen cursors to indicate an arbitrary X and Y position 
in the waveform display area represented by the intersection 
of a vertical and horizontal cursor line. Screen cursors 
measure both vertical parameters (typically volts) and 
horizontal parameters (typically time or frequency).  
 

Histograms 
The instrument can display histograms constructed from the selected waveform data. You can 
display both vertical (voltage) and horizontal (time) histograms, but only one at a time. Use 
histogram measurements to get statistical measurement data for a section of a waveform along one 
axis.  
The histogram source can be any channel, math, or reference waveform. 
Turning on histograms starts histogram counting and data accumulation. A sample histogram 
display is shown below. Histogram data is continuously accumulated until you explicitly turn off 
histograms. This allows you to continue collecting histogram data even when you turn off the 
histogram display. 
In addition to using limit controls to set histogram box boundaries, you can also use standard 
Windows drag-and-drop to resize and reposition the histogram box. 
Histograms are not available in FastFrame or Zoom modes. 
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Math Waveforms 
Once you have acquired waveforms or taken measurements on waveforms, the instrument can 
mathematically combine them to create a waveform that supports your data-analysis task. For 
example, you might have a waveform clouded by background noise. You can obtain a cleaner 
waveform by subtracting the background noise from your original waveform. Or, you can 
integrate a single waveform into an integral math waveform as shown below. 

  

With spectral analysis you can analyze waveforms in the frequency domain. The interface is 
similar to a dedicated spectrum analyzer, so you do not need to know the details of the underlying 
algorithms. See the following figure. 
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This instrument supports mathematical combination and functional transformations of waveforms 
it acquires. The following figure shows this concept: 

  

You create math waveforms to support the analysis of your channel and reference waveforms. By 
combining and transforming source waveforms and other data into math waveforms, you can 
derive the data view that your application requires. Create math waveforms that result from: 

 Mathematical operations on one or several waveforms: add, subtract, multiply, and divide. 

 Functional transformations of waveforms, such as integration, differentiation, and so on. 

 Spectral analysis of waveforms, such as testing impulse response. 

You can create up to four math waveforms (two for 2-channel TDS5000B instruments). 

Measurement scalars can be used in math expressions. For example, you can measure the average 
of a waveform (using the measurement capabilities of the instrument) and subtract it from the 
original waveform to define a new math waveform. Measurements 1 through 8 are allowed in a 
math definition, but not measurement functions (such as rise (Ch1)). 

In FastFrame, math is applied to each frame. 

This instrument supports the following operations for math waveforms: 

 Vertical display scaling and positioning 

 Taking automatic measurements 

 Taking cursor measurements 

 Using histograms  

 User defined vertical units 

In addition to the operations listed above, you can save math waveforms as reference waveforms. 

Some operations that you cannot use with math waveforms are: 

 Circular Math-on-Math: You cannot use circular definitions of math waveforms. For 
example, if you define Math2 = Ch1 - Math1, and then define a second math waveform as 
Math3 = Ch2 + Math2, you cannot define a third math waveform as Math1 = Math2 + Ch3. If 
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you do, the Math1 definition is rejected with an error because a circular definition is not 
allowed. 

 Fast Acquisitions: Math is not allowed in Fast Acquisitions mode. 

 Roll Mode: Math is not allowed in roll mode until you push STOP. 

 Different Length Sources: If you use two waveforms (channel and reference waveforms) of 
different lengths, the length of the math waveform will be the shorter of the two lengths. 

Creating Math Waveforms 
You create math waveforms when you create a math expression. You do so by applying numerical 
constants, math operators and functions to operands (see Sources on page 264). You can display 
and manipulate these derived math waveforms much like you can the channel and reference 
waveforms (see Using Math Waveforms on page 330). 

Some examples of typical math waveforms follow: 

To normalize this 
waveform: 

 

Enter this math 
expression: 

(Ch1 - Meas1)/ Meas2, 
where 
Ch1 is the waveform shown at left 
Meas1 = Low of Ch1 
Meas2 = amplitude of Ch1 

  

And get this math 
waveform: 

 

To simulate AC 
coupling on this 
waveform: 

  

Enter this expression: Intg(Ch1-Avg(Ch1)),  
where 
Ch1 is the waveform shown at left 
Avg is the average function 

And get this math 
waveform: 
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Offset, Position, and Scale 

The settings that you make for offset, scale, and position affect the math waveform you obtain. 
Here are some tips for obtaining a good display: 

 Scale and position the source waveform so that it is contained on the screen. (Off-screen 
waveforms may be clipped, resulting in errors in the derivative waveform). 

 Use vertical position and vertical offset to position your source waveform. The vertical 
position and offset will not affect your derivative waveform unless you position the source 
waveform off screen so that it is clipped. 

Math Waveform Sources 
Math waveforms can be created from: 

 Channel waveforms 

 Reference waveforms 

 Measurement scalars (automated measurements) that measure channel, reference, or math 
waveforms, or histograms.  

 Other math waveforms 

 Variables 

Dependencies 

In general, math waveforms that include sources as operands are affected by updates to those 
sources: 

 Shifts in amplitude or DC level of input sources that cause the source to clip also clip the 
waveform data supplied to the math waveform. 

 Changes to the vertical offset setting for a channel source that clip its data also clip the 
waveform data supplied to the math waveform. 

 Changes to the acquisition mode globally affects all input channel sources, modifying any 
math waveforms using them. For example, with the acquisition mode set to Envelope, a Ch1 
+ Ch2 math waveform will receive enveloped channel 1 and channel 2 data, and will also be 
an envelope waveform. 

 Clearing the data in a waveform source causes a baseline (ground) to be delivered to any math 
waveform that includes that source until the source receives new data. 

Math Waveform Expression Syntax 
Build math waveforms using the Predefined Expressions or Equation Editor control window To 
help you create valid math waveforms, these tools block most illegal entries by disabling any 
window element that would create an invalid entry in the math waveform expression.  

Predefined expressions are performed from the Math Setup control window by selecting an 
expression. 

The syntax that follows describes valid math expressions using the Equation Editor:  

<MathWaveform> := <Expression> 

<Expression> := <UnaryExpression> | <BinaryExpression> 

<UnaryExpression> := <UnaryOperator> ( <Term> ) 
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  | <UnaryOperator> ( <Expression> ) 

<BinaryExpression> := <Term> <BinaryOperator> <Term> | <Scalar>  

 <BinaryOperator> <Term> | <Term> <BinaryOperator> <Scalar> 

<Term> := <Waveform> | ( <Expression> ) 

<Scalar> := <Integer> | <Float> | <Meas-Result> 

<Waveform> := <ChannelWaveform> | <ReferenceWaveform> | <MathWaveform> 

<ChannelWaveform> := Ch1 | Ch2 | Ch3 | Ch4 

<ReferenceWaveform> := Ref1 | Ref2 | Ref3 | Ref4 

<MathWaveform> := Math1 | Math2 | Math3 | Math4 

<UnaryOperator> := Invert | Derivative | Integral | Average | Max | Min 

  | Filter | Vmag | Exp | log 10 | log e | sqrt | Spectral Magnitude 

  | Spectral Phase | Spectral Real | Spectral Imag 

<BinaryOperator> := + | - | / | * 

<Meas-Result> := meas1 | meas2 | meas3 | meas4 | meas5 | meas6 | meas7 | meas8 

<Variable> = VAR1 |VAR2 |VAR3 |VAR4 

Math Waveform Differentiation 
The math capabilities of the instrument include waveform differentiation. This allows you to 
display a derivative math waveform that indicates the instantaneous rate of change of the 
waveform acquired.  

Derivative waveforms are used in the measurement of slew rate of amplifiers and in educational 
applications. You can create a derivative math waveform and then use it as a source for another 
derivative waveform. The result is the second derivative of the waveform that was first 
differentiated. 

The math waveform, derived from the sampled waveform, is computed based on the following 
equation: 

Yn = (X( n + 1 ) – Xn) 1/T 

Where:  X is the source waveform 

 Y is the derivative math waveform 

 T is the time between samples 

Since the resultant math waveform is a derivative waveform (see the figure below), its vertical 
scale is in volts/second (its horizontal scale is in seconds). The source signal is differentiated over 
its entire record length; therefore, the math waveform record length equals that of the source 
waveform. 
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Cursor Measurements 

You can also use cursors to measure derivative waveforms. Use the steps in Taking Cursor 
Measurements on page 355. When using that procedure, note that the amplitude measurements on 
a derivative waveform will be in volts per second rather than in volt-seconds as is indicated for the 
integral waveform measured in the procedure. 

Offset, Position, Scale, and Math Waveforms 
The settings that you make for offset, scale, and position affect the math waveform you obtain. 
Here are some tips for obtaining a good display: 

 Scale and position the source waveform so that it is contained on the screen. (Off-screen 
waveforms may be clipped, resulting in errors in the derivative waveform). 

 Use vertical position and vertical offset to position your source waveform. The vertical 
position and offset will not affect your derivative waveform unless you position the source 
waveform off screen so that it is clipped. 

Waveform Integration 
The math capabilities of the instrument include waveform integration. This allows you to display 
an integral math waveform that is an integrated version of the acquired waveform.  

Use integral waveforms in the following applications: 

 Measuring power and energy, such as in switching power supplies. 

 Characterizing mechanical transducers, as when integrating the output of an accelerometer to 
obtain velocity. 

The integral math waveform, derived from the sampled waveform, is computed based on the 
following equation: 

  

Where:  x(i) is the source waveform 

 y(n) is a point in the integral math waveform 
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 scale is the output scale factor 

 T is the time between samples 

Since the resultant math waveform is an integral waveform, its vertical scale is in volt-seconds (its 
horizontal scale is in seconds). The source signal is integrated over its entire record length; 
therefore, the math waveform record length equals that of the source waveform. 

Offset and Position. When creating integrated math waveforms from live channel waveforms, 
consider the following: 

 You should scale and position the source waveform so that it is contained on screen. (Off 
screen waveforms may be clipped, which will result in errors in the integral waveform). 

 You can use vertical position and vertical offset to position your source waveform. The 
vertical position and vertical offset will not affect your integral waveform unless you position 
the source waveform off screen so that it is clipped. 

DC Offset. The source waveforms that you connect to the instrument often have a DC offset 
component. The instrument integrates this offset along with the time-varying portions of your 
waveform. Even a few divisions of offset in the source waveform may be enough to ensure that 
the integral waveform saturates (clips), especially with long record lengths. 

Defining Spectral Math Waveforms 
The math capabilities of the instrument include waveform spectral analysis. This section describes 
how you can control the analysis intuitively with time domain and frequency domain controls. 
These controls merge the time domain controls with the frequency domain controls to provide a 
complete spectral analyzer.  

Signals may be represented by their characteristics in both the time and the frequency domain. By 
combining and transforming source waveforms into spectral math waveforms, you can 
simultaneously view signal characteristics in both domains. 

This spectral analyzer provides a complete set of controls and features that allow you to make time 
and frequency domain measurements without the need to learn extensive details about FFT 
algorithms.  

 Frequency Domain Controls: Use traditional spectrum analyzer controls to set the center 
frequency, span, and resolution bandwidth directly.  

 Time Domain Controls: The time domain controls for the acquired waveform set the time 
duration and the resolution (time between samples). You can easily set the required sample 
rate and record length.  

 Gating Controls: These controls are the bridge that connects the time domain to the 
frequency domain. You can perform spectral analysis on a gated region of the input 
waveform. This gating also determines the resolution bandwidth. 

 Window Functions: Eight different window functions are available to shape the filter 
response. 

 Magnitude Versus Frequency: Display log data in dB, dBm, or linear mode. You can 
display the real or imaginary parts of the spectral magnitude only. Reference level offset and 
reference level controls give complete control over the vertical position and offset of the 
spectrum.  

 Phase Versus Frequency: Display phase data as a function of frequency in radians or 
degrees. You may zero the noise phase for magnitudes below a threshold level. Finally, you 
may select Phase unwrap and dq/dw, group delay. 
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 Spectral Averaging: You can turn on averaging in the frequency domain for phase and 
magnitude waveforms. 

 Multiple Analyzer Control Locks: Up to four spectral analyzers can be used simultaneously. 
They can all be assigned to different gates on the same source waveform or to different 
channel sources. The controls of Math1 and Math2 can be locked, and the controls of Math3 
and Math4 can be locked. When controls are locked, turning a control on one analyzer 
changes the control on the other analyzer to the same value. Other combinations of locking, 
including all four analyzers, are available using GPIB commands. 

The same exclusions for math waveforms apply to spectral math waveforms. In addition, sources 
for spectral math waveforms must be channel waveforms. 

Using the Spectral Math Controls 
The spectral analyzer contains five primary control categories. These are shown in the table below. 
Click one of the links for more information on using each type of control. 

Time controls  Gate controls Frequency 
controls  

Magnitude 
controls  

Phase 
controls  

Source Position Center dB, dBm 
linear, real 
imaginary 

degrees, 
radians, group 
delay 

Duration, 
record length 

Duration Span Ref level Zero threshold 

Duration, 
sample rate 

Window Resolution 
bandwidth 

Ref level 
offset 

Phase Unwrap 

Resolution     

Using the Time Controls 
The operation of the time domain controls for the spectral analyzer is summarized by the 
following rules: 

 Duration selects the time from the beginning to the end of the acquired waveform. You may 
set duration using the record length control or the sample rate control. 

 Resolution determines the time between samples. Duration is kept constant as resolution is 
changed. Therefore, the Resolution control affects both the sample rate and the record length 
simultaneously. 

 Most often, you will want to use a short record length because long record lengths can slow 
instrument response. However, long record lengths lower the noise relative to the signal and 
increase the frequency resolution for the spectral math waveform. More importantly, they 
might be needed to capture the waveform feature that you want to include in the waveform. 
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Examples of how duration and resolution affect the acquired waveform are shown in the following 
figure. 

  

Using the Gating Controls 
Gating determines which portion of the acquired waveform is transformed into the frequency 
domain. The gate has a position and a width control. 

The gate position is the time in seconds from the trigger location to the center 50% position of the 
gate interval (see the figure below). The position and width units are seconds. 

  

The gate must reside within the duration interval of the source waveform. If the source waveform 
duration is adjusted, and the gate position and width would result in the gate being outside of that 
duration, then the gate position or width is set within the limits.  
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The width of the gate affects the resolution bandwidth of the spectral analyzer. Gate width has 
units of seconds. The resolution bandwidth directly controls the gate width, but the numerical 
value is entered in units of Hz. Therefore, the time domain gate markers move as you adjust the 
resolution bandwidth control. 

The data contained in the gated region is transformed into the frequency domain. 

The gate is identified on the display using dashed markers (similar to cursors). The default gate 
width setting is equal to the duration of the source waveform. 

Using the Frequency Domain Controls 
The gated region of the source waveform is transformed into a spectral phase or magnitude 
waveform. The horizontal units are always Hz. The vertical units depend on whether phase or 
magnitude is selected. The frequency domain controls for the spectral waveform are span, center, 
and resolution bandwidth. The spectrum normally appears on the display fit to a screen width of 
10 divisions. 

Span is the frequency at the end of the spectral waveform minus the frequency at the beginning of 
the waveform. The span control maximum value is equal to the current sample rate divided by 
two. Therefore, if you are unable to increase the span to the desired value and if you want to keep 
the same source waveform duration, go to the time base controls and increase the sample rate 
using the resolution control. Or, if you want to also decrease the source waveform duration, adjust 
the sample rate control. If you decrease the sample rate, the span setting may decrease, if 
necessary, to keep the span less than the sample rate divided by two. 

Center is the frequency at the center of the spectral waveform. Center is equal to the start 
frequency plus one half of the span. The adjustment range depends on the sample rate and the 
current span setting. Remember that the span must always be in the interval of zero to one half of 
the sample rate. Therefore, if the span is set to full, the center frequency control will not have any 
adjustment range and will remain at one half of the sample rate. It is necessary to decrease the 
span before the center will have an adjustment range. If you are unable to increase the center to the 
desired value, increase the sample rate using either the sample rate or resolution controls. You 
may also change sample rate by using the HORIZONTAL SCALE knob on the instrument front 
panel. 

Resolution Bandwidth (RBW) is the 3 dB down bandwidth of the spectral analyzer frequency 
response to a sine wave input. The resolution bandwidth is affected by two parameters: 

 Different window functions produce different filter response shapes in the spectrum and result 
in different resolution bandwidths.  

 The gate width of the input data affects the RBW because the RBW is inversely proportional 
to the gate width. So, adjusting the gate width changes the RBW. Gate width has units of 
seconds. The RBW directly controls the gate width, but the numerical value is entered in units 
of Hz. Therefore, the time domain gate markers move as you adjust the RBW control.  

RBW = Window Bin Width ÷ Gate Width 

The Window Bin Width is the resolution bandwidth in units of bins, and depends on the window 
function in use. The Gate Width is in units of seconds.  

The following figure demonstrates the effects of adjusting the center frequency and span. Center 
frequency is a horizontal position control for the spectrum. Span is a horizontal scale control. 
Resolution bandwidth adjusts the bandwidth of the analyzer filters without affecting the span and 
center frequency. 
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Using the Magnitude Controls 
Vertical units can be either linear or log. You may select these choices by clicking the Math menu 
button. Then select the Spectral Analysis Setup command. On the Mag tab, select the desired scale 
type from Linear, dB, or dBm. 

Linear: When the spectrum is linear magnitude the vertical units are the same as the source 
waveform. Usually this is volts. However, it may also be watts or amperes. 

dB: This sets the vertical scale of the magnitude spectrum to dB. Use the Reference Level Offset 
to set which vertical position in the magnitude spectrum will be zero dB. The following equation 
applies: 

dB = 20 log (|X| ÷ Ref) 

Where X is a complex data point in the spectrum and Ref is the Reference Level Offset value. 

dBm: This selects dB as described in the above equation, but also sets the Reference Level Offset 
to a value that is equivalent to 1 mW of power into 50 ohms or volts. Therefore, if the input units 
are volts, then the value is set to 223.6 mV. If the input units are amperes, then the value is set to 
40 mA. If the input units are watts, then the value is set to 1 mW. 
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Reference Level: This sets the vertical position 
of the displayed spectrum. Its value is the 
magnitude at the top of the display screen. 
When this control is adjusted, the spectral 
waveform along with its zero reference marker 
move vertically on the screen as shown. This 
control does not change the spectral data. 

 

Reference Level Offset: This changes the value 
of Ref in the equation for dB shown above. 
Unlike the Reference Level control, this control 
actually changes the output data values in the 
spectrum. Zero dB is shown on the display 
screen by the marker associated with the 
spectral waveform. Adjusting the Reference 
Level Offset causes the spectral waveform to 
move vertically with respect to the waveform 
reference marker as shown. This moves the 
waveform without changing the Reference 
Level control setting. Sometimes it is beneficial 
to adjust this control so that the peak of a 
fundamental is at zero dB. Then you can 
measure other harmonics in terms of how many 
dB they are away from the fundamental. Click 
the dBm button to preset this level to the 
equivalent of 1 mW into 50 ohms. 

 

Real and Imaginary Magnitudes: You can display the linear magnitude of the real data or the 
imaginary data in the spectrum. This is useful if you process the spectrum off line and transform it 
back into a time domain trace. You can save the real and the imaginary spectrum into reference 
memory, and export the waveforms directly into Mathcad, MATLAB, or Excel documents to 
update in real time.  

To turn on a real or imaginary spectrum, click the Math menu button, select Define/Edit 
Expression Editor, and select the Freq tab. Click either the Real or the Imag buttons and enter an 
expression. Click the appropriate channel button, and click Apply. 
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Using the Phase Controls 
You can set the vertical units to Degrees, Radians, or Group Delay in seconds. To do this, click 
the Math toolbar button, click Spectral Analysis Setup, and select the Phase tab. Then select the 
desired scale type from Degrees, Radians, or Group Delay. 

Phase Reference Position: Phase is a relative measurement that must have a time domain 
reference point. The phase value is specified with respect to this phase reference position. 

For the spectral analyzer, the phase reference position is the 50% position of the gate, that is, the 
middle of the gate interval of the data that is input to the spectral analyzer. This is true for all 
window functions except for the Tek Exponential window. This window has a reference point at 
the 20% position of the gate. 

Phase Unwrap: The spectral analyzer produces phase values from –Π to +Π radians or –180 to 
180 degrees. However, when you perform impulse response testing and the phase is continuous, 
then phase values outside these ranges may occur. The spectral analyzer then wraps the data with 
discontinuities in the display from +180 to –180 degrees. Phase unwrap will display the correct 
result by unwrapping the phase.  

Phase unwrap is only valid when the phase spectrum is a continuous function of frequency. 
Therefore, do not use it when analyzing the harmonic content of the typical repetitive signal. 

Suppression Threshold: Random noise in the spectrum may have phase values over the entire 
range. This could make the phase display unusable. However, you can set the suppression 
threshold control to a level in dB. The phase of any complex spectral points with a magnitude 
below this threshold is set to zero. See the following figure for an example. 

  

  

 

Group Delay: When the phase spectrum is a continuous function of frequency, group delay may 
be computed. This is true of impulse response testing where an impulse is fed into the system, and 
the spectrum of the response of the system output is computed. 

Group delay measures how well a system passes a signal in terms of phase distortion. Group delay 
is the derivative of the phase with respect to frequency. 

This feature is not useful for analysis of harmonic content of signals where the phase response is 
not continuous. 
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Impulse Response Testing: When performing impulse response testing of a system, place the 
impulse at the zero-phase reference position of the acquisition. This produces a correct phase 
display. Because the Tek Exponential window has its zero phase reference position at the 20% 
point, more of the impulse response is captured. All other window functions have their phase 
reference position at the 50% position in the gated region. 

There are several ways to adjust the position of the zero phase reference point with respect to your 
input signal: 

 Adjust the spectral analyzer gate position 

 Perform fine adjustment using the front-panel trigger level control 

 Adjust the front-panel horizontal POSITION control 

Using Spectral Analyzer Windows 
In the time domain, a window is a 
bell-shaped function equal in length to 
the gate duration. For most windows, 
this function tapers to zero at both 
ends of the gate region. Before 
computation of the spectral 
transformation, the window is 
multiplied, sample by sample, times 
the input data in the gated region. The 
window function affects the shape of 
the spectral analyzer response in the 
frequency domain. 

The window functions affect the 
ability to resolve frequency in the 
output spectrum and can affect the 
accuracy of the magnitude and phase 
measurements. The preceding figure 
shows how the time domain record is 
processed. 

 

Accurate magnitude measurements require that the input source waveform be stationary within the 
gated region. This means that waveform parameters such as frequency and amplitude should not 
change significantly as a function of time within the gate region that is input to the spectral 
analyzer. Also, the gate width must be greater than or equal to the period of the start frequency of 
the span of the spectral analyzer. That is, there must be at least one cycle of the harmonic being 
measured within the gated region. 

There are eight different spectral analyzer windows: 

Rectangular Hamming  Hanning Kaiser-Bessel 

Gaussian Blackman-
Harris  

Flattop2  TekExponential  
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Your choice of window function will depend on the input source characteristics that you want to 
observe and the characteristics of the window function. The window characteristics are shown in 
the following table. 

Window 3  dB BW 
in bins 

Scallop 
loss 

Nearest 
side lobe 

Zero 
phase 
reference 

Coefficients  

Rectangular 0.89 3.96 dB -13 dB 50% 1.0 

Hamming 1.3 1.78 dB -43 dB 50% 0.543478, 
0.456522 

Hanning 1.44 1.42 dB -32 dB 50% 0.5, 0.5 

Kaiser–
Bessel 

1.72 1.02 dB -69 dB 50% 0.40243, 
0.49804, 
0.09831, 0.00122 

Blackman–
Harris 

1.92 0.81 dB -92 dB 50% 0.35875, 
0.48829, 
0.14128, 0.01168 

Gaussian 2.0 0.76 dB -79 dB 50% a = 3.75 (not 
cosine series) 

Flattop2 3.8 0.0065 
dB 

-90 dB 50% 0.213348, -
0.206985, 
0.139512, -
0.043084, 
0.003745 

Tek 
Exponential 

1.42 0.60 dB  -67 dB 20% na 

3 dB BW in Bins: This is the bandwidth in units of bins, which are the intervals between spectral 
output samples when no zero fill is used. The bandwidth is measured between the points on the 
lobe that are 3 dB down from the peak of the lobe. The bandwidth in hertz may be computed by 
dividing the BW in bins by the gate duration in seconds. This is also referred to as resolution 
bandwidth (RBW). 

Coherent gain: The gain factor normally associated with different window functions is correctly 
scaled into the magnitude spectrum output. Therefore, the magnitudes in the output spectrum do 
not change as different windows are selected.  

Scallop Loss: This is the magnitude error of the spectral analyzer when the frequency of the 
observed signal is exactly half way between two frequency samples of the spectrum when the 
interpolation ratio due to zero fill of the FFT is one. When zero fill is in effect, scallop loss is 
essentially eliminated because of the interpolation in the frequency domain due to zero fill. If you 
work with span settings less than full and you work with larger resolution bandwidth settings, zero 
fill is in effect most of the time. 
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Nearest Side Lobe: This is the difference in magnitude between the spectral lobe peak in the 
spectrum and the next side lobe that occurs due to energy leakage. Different windows have 
different leakage characteristics. The more narrow the resolution bandwidth of the window the 
more leakage in the spectrum. 

Zero Phase Reference: This is the position in the time domain gate that is the reference point for 
phase in the output spectrum. That is, if a sine wave input has its peak at the zero phase reference 
position, then it reads out as zero phase in the spectrum. If the phase is to be correct when doing 
impulse response testing, the impulse in the time domain must be located at this position in the 
gate interval. 

Coefficients: These are used to generate the windows that are constructed from a cosine series. 
For the Gaussian window, the value of "a" is given instead of a set of coefficients. You can find 
descriptions of cosine series windows in the Handbook of Digital Signal Processing Engineering 
Applications by Elliot. ISBN 0-12-237075-9. 

Gaussian Window 
This is the default window function (see the figure below). It is unique in that the time-domain 
shape of an exponential Gaussian function transforms into a Gaussian exponential shape in the 
frequency domain. This window provides optimal localization in both the time and the frequency 
domain 
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Rectangular Window 
This window is equal to unity (see the figure below). This means the data samples in the gate are 
not modified before input to the spectral analyzer. This window has the narrowest resolution 
bandwidth of any of the windows, but it also has the most spectral leakage and the highest side 
lobes. 
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Hamming Window 
This window is unique in that the time domain shape does not taper all the way to zero at the ends. 
This makes it a good choice if you wanted to process the real and imaginary parts of the spectrum 
off line and inverse transform it back to the time domain. Because the data does not taper to zero, 
you could remove the effect of the window function from the result. 
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Hanning, Kaiser-Bessel, and Blackman-Harris 
Windows 

These windows have various resolution bandwidths and scallop losses (see the figures below). 
Choose the one that best allows you to view the signal characteristics you are interested in. The 
Blackman-Harris has a low amount of energy leakage compared to the other windows. The 
Hanning has the narrowest resolution bandwidth, but higher side lobes. 

 

 

Hanning window 

  

  

Kaiser-Bessel window 
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Blackman-Harris window 
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Flattop2 Window 
This window has the lowest scallop loss of any of the windows. It also has a wider resolution 
bandwidth but lower side lobe attenuation. Also, it is unique because the time domain shape has 
negative values. The Flattop2 window is useful for high accuracy magnitude measurements for 
signals that do not require very narrow bandwidth. 
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Tek Exponential Window 
The Tek Exponential window was invented at Tektronix. In the time domain, it is not a 
symmetrical bell shape as is the case with the other windows. Instead, it is exponential with a peak 
at the 20% position of the time domain gate. The frequency domain shape is triangular. Use this 
window for impulse-response testing where the 20% position is the zero phase reference point. 
More of the acquired data record length is used to capture the impulse response. Exact details of 
how to compute its values were published in the article; Impulse-response testing lets a single test 
do the work of thousands by John Pickerd in EDN magazine, April 27, 1995, page 95. 

  

  

Effects of Trigger Jitter 
The instrument acquisition system has a sample clock that is asynchronous with respect to the 
input signal. This means that from one acquisition to the next, samples may be in a different 
position on the waveform with respect to the trigger. Samples may vary in position by up to one 
sample interval.  

There are only two samples per cycle of a signal that has a frequency equal to one half of the 
sample rate. This is the highest nonaliased signal that can be output from the spectral analyzer. 
Thus, at this frequency, one sample of acquisition jitter will show up in the spectrum as 180 
degree phase variations. Therefore, when you analyze phase, make sure to oversample the signal 
sufficiently such that the one sample interval of jitter that is showing up in the phase is acceptable 
to the accuracy you want to achieve. 

Effects of Average and High Res acquisition modes 

The result of averaging the time domain acquisition using either Average mode or Hi Res 
acquisition mode affects the frequency response of the instrument. This is due to the one sample of 
jitter in the acquisition system. Both Hi Res and Average acquisition modes have the same affect 
on the frequency response. These modes cause the response to roll off from a magnitude value of 
one at DC to a magnitude value of 0.63 at Nyquist, which is the frequency equal to one half of the 
sample rate. This is true regardless of the real time sample rate setting. 

Frequency Domain Averaging 
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Turn on averaging for a math waveform by editing the math expression. Sometimes, it is more 
desirable to average in the spectrum than in the time domain. For example, consider a signal that 
has time domain components that are asynchronous to the trigger. If you turn on averaging in the 
time domain, these components may go to zero or produce strange, nondeterministic effects on the 
resultant waveform. Thus, these signal components may end up not appearing in the spectrum. 
However, if averaging is done in the frequency domain instead, then these components will be 
present. 

Recognizing Aliasing 
Aliasing occurs when the input frequency of a signal is greater than one half of the sampling 
frequency (the sample rate). 

Set the sample rate high enough so that the signals in the spectrum appear at their correct 
frequency as opposed to a lower aliased frequency value. Also, complex signal shapes that have 
many harmonics in them, such as a triangle or square wave, can appear to be OK in the time 
domain when in fact many of the harmonics in that signal are aliased. 

One way to check for aliasing is to increase the sample rate and observe whether any of the 
harmonics unwrap to different frequency locations. 

Another way to recognize aliasing is to realize that higher order harmonics usually have 
decreasing magnitudes compared to lower order harmonics. Thus, if you see a series of increasing 
harmonic magnitude values as frequency increases then you can suspect that they may be aliased. 
In the spectral math waveform, the actual higher frequency components are undersampled, and 
therefore they appear as lower frequency aliases that "fold back" around the Nyquist point. (See 
figure below.) You may test by increasing the sample rate and observing if aliases unwrap to 
different frequency positions. 

  

If you have a variable-frequency signal source, another way to observe aliasing is to adjust the 
frequency slowly while watching the spectral display. If some of the harmonics are aliased, you 
will see the harmonics decreasing in frequency when they should be increasing or vice versa. 

Once you have displayed a spectral math waveform, use cursors to measure its frequency 
amplitude or phase angle. See Setting Cursor Sources on page 326 for detailed steps. 

You can use automated measurements to measure spectral math waveforms. See Taking 
Automatic Measurements on page 323 for step-by-step instructions. 

Serial Mask Testing with Option SM 
Serial Mask Testing (Option SM) provides electrical mask testing on communication standards 
and communication triggering.  
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Mask testing consists of two tasks: signal violation detection and pass/fail testing. Signal violation 
detection lets you test communications signals for time or amplitude violations against a 
predefined mask. Each mask consists of one or more polygonal regions called segments. The 
signal waveform data should stay outside of the segments defined by the mask. Any signal data 
that occurs inside a mask segment is called a mask segment violation or "hit."  

You can select from any of the included standard telecommunications masks, or you can define 
your own custom masks. Selecting a mask automatically sets the instrument communications 
triggers to properly display most communication signals in the mask.  

Pass/Fail testing defines the mask testing parameters, including the number of waveforms to test, 
how many mask hits are allowed before failing a test, setting a mask margin tolerance value, and 
what action to perform upon the completion or failure of a test.  

Communication triggering enables you to trigger on and display waveforms for industry-standard 
communications signals. See Mask Types and Standards on page 169 for a list of the supported 
standards on which you can trigger. 

Automatic communication signal measurements enable you to make automatic measurements on 
communications signals. See the Communication Measurement on page 161 tab in the 
Measurement setup window for the available measurements. 

The Serial Mask Testing key features are: 

 Predefined masks for testing or triggering on industry-standard signals, such as ITU-T G.703, 
ANSI T1.102, Fibre Channel, Ethernet, Video, SONET, Rapid IO, USB, IEEE 1394b, OIF 
Standards and their subsets 

 Autoset, which quickly adjusts the instrument’s vertical and horizontal controls to display a 
waveform in a mask  

 Autofit, which positions the signal on each acquisition to minimize mask segment hits 

 Mask margins, which allow you to adjust the default mask margin tolerances 

 Pass/Fail testing to continuously test a specified number of waveforms against a mask 

 A mask editor for creating, saving, and recalling user-defined masks 

 Waveform database technology to perform mask testing based on waveforms accumulated in 
a database, rather than a single waveform stored in acquisition memory 

 Communications triggers to trigger the instrument on industry-standard communications 
signals 

 Automatic measurements on communications signals 

Note 
If a standard listed in this manual is not available on your instrument, it is because the 
configuration or bandwidth of your instrument cannot test that standard. 
Although the TDS5000B Series instruments are not calibrated optical reference receivers, you can 
use them with mask testing to evaluate general optical signal characteristics and wave shape, using 
an external O/E converter. 

Mask Key Points 
There are a number of mask test key points to be aware of prior to using, editing, or creating a 
mask. 

Mask Testing 



 285

Only one mask standard is active at any one time. If you have one mask selected or enabled and 
then select a new mask, the new mask replaces the previous mask. You cannot test to multiple 
standards simultaneously. 

Autofit and Persistence Interaction  

The Autofit function moves the waveform vertically and horizontally in a mask to reduce the 
number of segment hits within a mask. If persistence is set to infinite or variable, each Autofit 
waveform movement clears existing persistence data. If Autofit makes frequent waveform 
movements, there may be little or no displayed waveform persistence data. 

Segments and Mask Hits  

Each mask can have a maximum of 16 segments. Segments can overlap. The number of mask hits 
is the sum of all hits in all segments, regardless of whether or not segments overlap. For example, 
if a waveform crosses over an area where two segments overlap, both segments will count the 
waveform hit. 

Vertices 

Each segment can have a maximum of 50 vertices. Vertices are numbered counterclockwise, with 
vertex one generally located at the bottom left of each segment. The active (selected) vertex is 
indicated by an X. The instrument automatically assigns numbers to vertices during mask creation 
or editing. 

Mask Margin Tolerance 

Mask margin tolerance moves the mask segment boundaries by the specified percentage. Negative 
margins reduce the size of the segment, making it easier to pass a mask test. Positive numbers 
make it harder to pass and allow you to perform margin testing on your design. If a user defined 
mask has more than three segments, turning on mask margins generates an error message. Turning 
mask margin tolerance off redraws the mask segment margins to their default values, but leaves 
the numeric value as it is, allowing you to quickly toggle between default and user-set margin 
values. 

Standards and Bandwidth 

When the instrument system bandwidth (which includes the instrument, attached probes, and/or 
cabling) falls into the range of 1.5 to 1.8 (0.8 for optical signals) times the data signal bit rate, the 
third harmonic of the data signal is significantly attenuated. The instrument displays useful 
qualitative information, but quantitative rise-time measurements under these conditions may not 
be accurate.  

For example, a FC531E Elec mask has a bit rate of 531.25 Mb/s. 1.5 to 1.8 times this value is a 
range of 796.5 MHzBW to 955.8 MHzBW. Therefore, you should not use an instrument with less 
than 1 GHz measurement system for making quantitative rise-time measurements of this standard. 

When just the instrument bandwidth falls within 1.5-1.8 (0.8 for optical signals) times the bit rate 
of a selected mask standard, the instrument displays the message "Consider system bandwidth 
when testing at this bit rate." in the status area above the graticule. 

Levels Used in Taking Eye Measurements 
All eye-diagram measurements are based on the power level, the voltage level, or the time 
locations of edges within each acquisition.  
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The figure below shows an eye-diagram and the areas from which values are taken that are used to 
calculate measurements. 

  

P Values 

The P values include the mean and standard deviation of the vertical location of PTop and PBase. 
These areas are used with a specified sample size to statistically measure the following values: 

 PTopmean, the mean value of PTop 

 PTopsigma, the standard deviation of PTop 

 PBasemean, the mean value of PBase within the Eye Aperture* 

 PBasesigma, the standard deviation of PBase within the Eye Aperture* 
*The Eye Aperture defaults to the center 20 % of the interval from TCross1 to TCross2.  

T1 Values 

The T1 values are vertical and horizontal values associated with the leftmost crossing point. These 
areas are used to establish the following values: 

 TCross1mean, the horizontal mean of the left crossing point at TCross1 

 TCross1sigma, the horizontal standard deviation of the left crossing point at TCross1 

 TCross1pk-pk, the horizontal peak-to-peak deviation of the left crossing point at TCross1 

 PCross1mean, the vertical mean of the left crossing point at PCross1 

T2 Values 

The T2 values are vertical and horizontal values associated with the rightmost crossing point. 
These areas are used to establish the following directions: 

 TCross2mean, the horizontal mean of the right crossing point at TCross2 

 TCross2sigma, the horizontal standard deviation of the right crossing point at TCross2 

 TCross2pk-pk, the horizontal peak-to-peak deviation of the right crossing point at TCross2 

DCD Values 

The duty cycle distortion (DCD) values are horizontal values associated with the rightmost 
crossing point at 50% of the eye height. These areas are used to establish the DCDpk-pk, the 
horizontal peak-to-peak deviation of the left crossing point at half the height of the eye. 
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Communication Triggering (Option) 
Communication (Comm) triggers are one type of trigger. Comm triggers are designed to work 
with communication masks and standards. When you select a mask to test, it is associated with a 
specific communication standard. The mask you select determines the comm trigger needed for 
that standard.  

Note 
Option SM must be installed for communication triggering. 

Eye diagrams that are set up with an external clock use a time base position value large enough to 
guarantee the edge is always before the acquisition record starts. This forces all comm triggers to 
disable the B-Trigger. 

Even though comm triggers are designed to work with masks, you can set up comm triggering 
without using a mask. You can also set up your own mask to use with comm triggers.  

Limit Testing Concepts 
Limit testing is the ability to compare an active signal with a template waveform. The following 
figure shows an active waveform (dark sine wave) being compared to a template waveform 
(shaded area). 

  

Any part of the active waveform that exceeds the template waveform's envelope is a limit test 
waveform violation, which the instrument highlights. You can set the instrument to respond to a 
limit test violation by stopping limit testing, emitting a beep, and so on. The following figure 
shows the highlighted (black) part of the active waveform that exceeds the limit test envelope. 

  

A template is an envelope waveform that consists of minimum/maximum (min/max) pairs of 
sample points. Template envelope waveforms created from 500 point source waveforms contain 
250 min/max pairs; Template envelope waveforms created from10K point waveforms contain 
5000 min/max pairs. 
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The following figure represents how the instrument creates the template waveform limit test 
envelope from user-entered vertical and horizontal division units. Division units are referenced to 
graticule divisions, where 1 major division contains 1000 millidivisions, or mdivs. The minimum 
mdiv unit is 20, which equals one screen pixel. 

  

When a source waveform is compared with an envelope waveform, each source waveform sample 
point value is compared to the vertical and horizontal min/max values of the corresponding 
envelope waveform sample point. Any source waveform data point that is not equal to or within 
the corresponding template envelope min/max values is a violation. 

Saving and Recalling Setups 
This instrument can save a number of different instrument setups for later recall, limited only by 
the space that you have to store the setups. 

By saving and recalling different setups, you can switch from setup to setup without having to first 
manually record your settings and then manually set them. This capability is helpful when you 
want to: 

 Save and recall a setup that optimizes the instrument for displaying and analyzing a certain 
signal. 

 Save a series of setups to help automate a procedure through recall of a sequence of saved 
setups as part of performing the procedure. 

 Save a setup for sharing with a second instrument. 

If you do not have an attached keyboard, you can still name setup files. The Save and Recall 
dialog boxes include a pop-up keyboard that you can use with your mouse or the touch screen to 
enter the setup path name and file name.  

The instrument excludes the following items when saving setups: 

 Channel waveforms and reference waveforms. Control settings (scale, position, and so on) are 
saved but not the waveform data. Upon recall of the setup, the settings are applied, but the 
data is not restored. 

 Math waveforms. Control settings and the math expression are retained but not the waveform 
data. Upon setup recall, however, the math waveform expressions are applied, but math 
waveform data is not restored. 

 User options stored in the Windows registry. These include all options set in the User 
Preferences control window. 

 If you want to save a waveform in a useful format for other applications, such as a 
spreadsheet, use the save or save as function (see Saving and Copying Waveform Data on 
page 289). 

A few other things to remember when saving and recalling setups: 
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 Recalling a setup replaces the current setup with the recalled setup. If you do not want to lose 
your current setup, save the setup file for later recall. 

 Saved setups may contain settings inappropriate for waveforms currently in your instrument. 
For example, if you save a setup that displays a math waveform that is the average of 
reference waveform 1, when you recall the setup, if the reference is empty, the math and 
reference waveforms are not displayed. 

Saving and Recalling Waveforms 
This instrument can save any number of waveforms, limited only by the space that you have to 
store them. 

By saving a waveform, you can recall it at a later time for comparison, evaluation, and 
documentation. This is helpful when you want to: 

 Recall a waveform for further evaluation or comparison with other waveforms. 

 Extend the waveform carrying capacity of the instrument. The instrument supports four 
reference, four channel, and four math waveforms. If you want more than four reference 
waveforms, you can save additional references to disk for recall later. 

The Reference Setup control window contains a Label field for including comments with your 
saved waveforms.  

If you do not have an attached keyboard, you can still enter comments and name reference 
waveform files. The Reference Setup control window includes a pop-up keyboard that you can use 
with your mouse or the touch screen to enter the waveform path name, file name, and comments.  

The instrument recalls each waveform into one of the reference waveform locations (Ref1-Ref4). 
You cannot recall into a channel or a math waveform. 

Saving and Copying Waveform Data 
This instrument supports saving waveform data to a file. The instrument can save waveforms, 
images, and measurements in several formats. You can also copy waveform data to the Windows 
clipboard for use with other applications, such as spreadsheets or math analysis applications. 

A few things to remember when saving waveform data: 

 Waveform data are saved as a series of comma-separated values (CSV), which are amplitudes 
without units. There is no timing information, but data is placed in the file in sequence from 
the first sample in the waveform record to the last. 

 Because the waveform data are saved as CSV, without timing and scaling information, the 
instrument does not save these waveforms directly. (It only saves the data.) If you intend to 
recall a waveform later, save it (see the procedure Saving A Waveform on page 346) using 
file type .wfm. 

 You may also choose to copy a waveform and paste it directly into an application such as 
Microsoft Word or Excel. If so, select your waveform, and then select Copy in the Edit menu.  

File Formats 

To make saved files more useful, select a file format usable by your analysis tools: 

Numeric creates files (.txt) in a numeric format usable by text and word processors. 

Text creates files (.txt) in a text format usable by text and word processors. 
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Bitmap creates files (.bmp) in a bitmap file format usable by many graphic programs. (Available 
for screen captures.) 

JPEG creates files (.jpg) in a compressed image format usable by many graphic programs. 
(Available for screen captures.) 

Spreadsheet creates files (.CSV) in a format usable by spreadsheets (Excel, Lotus 1-2-3, and 
Quattro Pro). 

MATLAB creates files (.DAT) in a format usable by MATLAB. 

Mathcad creates files (.DAT) in a format usable by MathCad.  

Note that the MathCad file is an ASCII file, the first four values of which contain header 
information: 

 The first header value holds the record length. 

 The second header value holds time, in seconds, between samples. 

 The third header value holds the trigger position (expressed as an index in the data position). 

 The fourth header value refers to the fractional trigger position. 

Also note that the delimiters are carriage returns. 
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Spectral Analysis Overview 
You can use math waveforms to perform FFT (Fast Fourier Transform) measurements with the 
instrument. The FFT process mathematically converts the standard time-domain signal (repetitive 
or single-shot acquisition) into its frequency components, providing spectral analysis capabilities. 

The ability to quickly look at a signal’s frequency components and spectrum shape is a powerful 
research and analysis tool. FFT is an excellent troubleshooting aid for: 

 Testing the impulse response of filters and systems 

 Measuring harmonic content and distortion in systems 

 Identifying and locating noise and interference sources 

 Analyzing vibration 

 Analyzing harmonics in 50 and 60 Hz power lines 

Spectral Analysis Features  
 FFT Windows. FFT windows let you match the optimum window to the signal you are 

analyzing. The Rectangular window is best for nonperiodic events such as transients, pulses, 
and single-sequence acquisitions. The Hamming, Hanning, and Blackman-Harris windows are 
better for periodic signals. The Kaiser Bessel window has less spectral leakage than the 
Hanning, Hamming, or Rectangular windows. The Gaussian window provides optimal 
localization in both the time and frequency domain. The Flattop2 window is good for high 
accuracy magnitude measurements for signals that do not require narrow resolution 
bandwidth. The Tek Exponential window is useful for impulse response testing.  

 Waveform Analysis. You can display an FFT waveform on any actively acquired signal 
(periodic or single-shot), the last acquired signal, or any signal stored in reference memory. 

 Vertical Scales. The FFT vertical graticule can be set to either dB or Linear RMS. A dB scale 
is useful when the frequency component magnitudes cover a wide dynamic range, letting you 
show both lesser and greater magnitude frequency components on the same display. A Linear 
scale is useful when the frequency component magnitudes are all close in value, enabling 
direct comparison of their magnitudes. 

 Spectral and Time-Domain Displays. The time signals and FFT waveforms can be shown 
together on the display. The time signal highlights the problem; the FFT waveform helps you 
determine the cause of the problem. 

FFT Process  
The FFT process mathematically converts the standard time-domain signal (repetitive or single-
shot acquisition) into its frequency components. 

The FFT function processes the waveform record and displays the FFT frequency domain record, 
which contains the input signal frequency components from DC (0 Hz) to ½ the sample frequency 
(also called the Nyquist frequency). 
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The FFT Display  
The following illustration shows a typical time-domain waveform and the frequency components 
of that signal as part of the math FFT waveform. 

 

 

FFT Windows  
The FFT process assumes that the 
part of the waveform record used for 
FFT analysis represents a repeating 
waveform that starts and ends at or 
near the same voltage of a cycle. In 
other words, it is an integer number 
of cycles. When a waveform starts 
and ends at the same amplitude, there 
are no artificial discontinuities in the 
signal shape, and both the frequency 
and amplitude information is 
accurate.  

A nonintegral number of cycles in 
the waveform record causes the 
waveform start and end points to be 
at different amplitudes. The 
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transitions between the start and end 
points cause discontinuities in the 
waveform that introduce high-
frequency transients. These transients 
add false frequency information to 
the frequency domain record.  

Applying a window function to the 
waveform record changes the 
waveform so that the start and stop 
values are close to each other, 
reducing the discontinuities. This 
results in an FFT measurement that 
more accurately reflects the actual 
signal frequency components. The 
shape of the window determines how 
well it resolves frequency or 
magnitude information. 

 

FFT Window Characteristics  
Each FFT window is a trade-off between frequency resolution and magnitude accuracy. What you 
want to measure and your source signal characteristics help determine which window to use. Use 
the following guidelines to select the best window. 

 

FFT Window Characteristics Best for measuring 

Rectangular Best frequency, worst 
magnitude resolution. This 
is essentially the same as no 
window. 

Transients or bursts where the signal 
levels before and after the event are 
nearly equal. 

Equal-amplitude sine waves with 
frequencies that are very close. 

Broadband random noise with a relatively 
slow varying spectrum. 

Hamming, 
Hanning 

Better frequency, poorer 
magnitude accuracy than 
Rectangular. Hamming has 
slightly better frequency 
resolution than Hanning. 

Sine, periodic, and narrow-band random 
noise. 

Transients or bursts where the signal 
levels before and after the event are 
significantly different. 

Blackman-Harris Best magnitude, worst 
frequency resolution. 

Predominantly single frequency signals 
to look for higher order harmonics. 

You can also determine the best window empirically by first selecting the Rectangular window, 
and then selecting (in the following order) the Hamming, Hanning, and Blackman-Harris windows 
until the frequency components merge. Use the window just prior to where the frequencies merge 
for the best compromise between resolution and amplitude accuracy. 
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Time Domain Gating  
You can use time domain gating to select a specific segment of your signal for spectral analysis. 
Two controls, gate position and gate duration, determine the location and size of the gate. The 
resulting spectrum corresponds to the frequency components of the signal in the gated segment. 

  

Time domain gating is inversely proportional to the resolution bandwidth of the spectral 
waveform. The narrower the gate, the larger the resolution bandwidth and therefore, the lower the 
frequency resolution. To obtain the best frequency resolution, use as wide a gate as possible. 

Aliasing  
Problems occur when the instrument acquires a signal containing frequency components that are 
higher in frequency than the Nyquist frequency. The frequency components that are above the 
Nyquist frequency are undersampled and appear to "fold back" around the Nyquist frequency, 
showing as lower frequency components. These incorrect components are called aliases. 

To quickly check for aliasing, slowly increase the horizontal scale (time per division setting). If 
the shape of the displayed waveform changes drastically or becomes stable at a faster time base 
setting, your waveform was probably aliased. You can also check for aliasing by turning on peak 
detect acquisition mode. 
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Eliminating Aliasing  
Use the following methods to eliminate aliases: 

 Increase the sample rate by adjusting the horizontal scale to a faster time-per-division setting. 
Since you increase the Nyquist frequency as you increase the time per division, the aliased 
frequency components should appear at their proper frequency. If the increased number of 
frequency components shown on the screen makes it difficult to measure individual 
components, use MultiView Zoom to magnify the FFT waveform. 

 Use a filter on the source signal to limit the bandwidth of the signal to frequencies below that 
of the Nyquist frequency. If the frequency components that you want to view are below the 
built-in bandwidth settings, set the source channel bandwidth to the appropriate value.  

 Push the AUTOSET button. 

 Switch the acquisition to Envelope mode or Peak Detect mode. Envelope mode searches for 
samples with the highest and lowest values over multiple acquisitions and can detect faster 
signal components over time. In Peak Detect mode, the acquisition alternates between saving 
the highest sample in one acquisition interval and lowest sample in the next acquisition 
interval. 

Nyquist frequency 
The highest frequency that any digital oscilloscope can measure without errors is one-half of the 
sample rate or frequency. This frequency is called the Nyquist frequency. The FFT waveform 
displays the input signal frequency components from DC (0 Hz) to the Nyquist frequency. 
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Overview Tasks 
Setting Up Signal Input 

Use this procedure to set scale and position parameters for input signal acquisition. 
Prerequisites 1 Set the acquisition system to run continuously. 

Connect input 
signal 

2 Connect the probe to the input signal source using proper 
probing/connecting techniques. For more details on input setup see 
page 77. 

Select the input 
signal channel 

3 Push a channel button (CH 1–CH 4) to select the input signal channel. 
A channel button lights when its channel is on. 

Select input 
termination 

4 Push an input termination button to toggle between 1 MΩ and 50 Ω 
input termination.  

 Some probes automatically set their termination value. 

Select input 
coupling 

5 Open the Vertical Setup control window by clicking Vert on the button 
bar or selecting the Vertical Setup command from the Vertical menu. 
To change the input coupling, select the appropriate channel tab and 
click: 

 DC to couple both the AC and DC components of an input 
signal. 

 AC to couple only the AC components of an input signal. 

 GND to disconnect the input signal from the acquisition system. 
6 Click Close to close the window. 

Invert the 
channel 

7 Click Invert to toggle inversion of the selected waveform. When 
Invert is On, the selected waveform appears mathematically inverted 
(flipped) on the zero volt axis. No trace of the normal waveform is 
left on the screen. 

Set the vertical 
acquisition 

window 

8 Use the vertical knobs to scale and position the waveform on screen. 
Dragging the waveform handle also positions the waveform. 

9 Open the Vertical Setup control window as described in Step 5. To 
change the offset, click the Offset control, and use the multipurpose 
knob to adjust the offset. 

Set the 
horizontal 

acquisition 
window 

10 Use horizontal knobs to scale and position the waveform on the screen 
and to set the record length. Dragging the reference icon also positions 
the waveform. 

11 Use the Resolution knob to set the record length and sample interval. 
12 If required to stabilize the display, push the trigger LEVEL control to 
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set the trigger level to 50%. 

 

Setting Acquisition Modes 
Use this procedure to set the data acquisition mode and specify acquisition start/stop methods. 

Prerequisites 1 Power on the instrument and set up the horizontal and vertical 
controls and triggering.  

Access the acquisition 
modes 

2 Select Acquisition Mode from the Horiz/Acq menu to open the 
Acquisition Mode control window. 

Select the acquisition 
mode 

3 Click an Acquisition Mode button. For Average and Envelope 
modes only, select the number of acquisitions to average or 
envelope. For WfmDB acquisition mode select the number of 
samples. 

Set the stop mode 4 Push the RUN/STOP front-panel button to toggle between 
starting and stopping acquisitions. 

OR 
Push the SINGLE button to acquire enough waveforms to satisfy 
the acquisition mode. 

Select sampling mode 5 To select the sampling mode, click the Horiz toolbar button, or 
select the Horizontal/Acquisition Setup command from the 
Horiz/Acq menu to open the Horizontal/Acquisition Setup 
control window. Select the Acquisition tab. 

6 Select Real Time Only, Interpolated Real Time, or Equivalent 
Time  

 Real Time Only sampling acquires all the points in a 
waveform record after one trigger event. 

 Interpolated Real Time sampling interpolates between 
the samples the instrument acquires when it cannot 
acquire all the real samples it needs to fill up its 
waveform record. 

 Equivalent time sampling starts when the time base 
setting (horizontal scale) is too fast to let the instrument 
get enough samples with which to create a waveform 
record using real-time sampling. Equivalent time mode 
is intended for repetitive signals only. 

 

Setting Up Roll Mode 
Use the procedure that follows to set up roll mode acquisitions. 
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Prerequisites 1 Power on the instrument and set up the horizontal and vertical 
controls and triggering.  

Enable roll mode 2 Click the Horiz toolbar button to open the 
Horizontal/Acquisition Setup control window. Select the 
Acquisition tab. 

3 Click Roll Mode Auto to enable roll mode. The resolution, 
record length, horizontal scale, and number of active channels 
on are dependent variables. Therefore, the fastest horizontal 
scale setting when Roll mode starts is 40 ms/div, the record 
length is 500 (resolution is 2 ms), the acquisition mode is either 
Sample or Peak Detect, and 1 or 2 channels must be on. As the 
record length or the number of on channels grows, the time per 
division required to enter Roll mode is slower. 

Note 

Envelope and Average acquisition modes inhibit roll mode. Hi 
Res roll mode starts when the resolution is 4 ms or greater. 

Enable single sequence 
roll mode 

4 Push the SINGLE button to start and acquire enough points to 
satisfy the acquisition mode (when the waveform makes it to 
the left edge of the screen). The acquisition mode must be either 
Sample or Peak Detect. 

Turn off roll mode 
acquisitions 

5 To stop acquisitions in roll mode: 

 If you are not in Single Sequence, push RUN/STOP to 
stop roll mode.  

 If you are in Single Sequence, roll mode acquisitions 
stop automatically when a complete record is acquired. 

Disable roll mode 6 Click the Horiz toolbar button to open the 
Horizontal/Acquisition Setup control window. Select the 
Acquisition tab. 

7 Click Roll Mode Off to disable roll mode. Roll mode is also 
disabled when you set the horizontal scale to 200 ms per 
division or faster. At record lengths greater than 500 points, the 
time per division to turn off roll mode becomes slower. 

Note 

Switching to Envelope or Average acquisition mode will 
also turn off roll mode. 
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Using Fast Acquisitions 
Use this procedure to set up Fast Acquisitions mode. 

Prerequisites 1 Set up the horizontal and vertical controls and the triggering.  

Enable Fast Acquisitions 
mode 2 Click the Horiz toolbar button to open the 

Horizontal/Acquisition Setup control window. Select the 
Acquisition tab. 

3 Click Fast Acquisitions to toggle Fast Acquisitions, or push the 
front-panel FastAcq button. 

Set the display 
appearance 4 Click the DISP toolbar button, or select the Display Setup 

command from the Display menu. The Display Control window 
opens on the Appearance tab. 

5 Click one of the Display Style buttons: Vectors, Dots, or Inten 
Samp. Vectors is the default. 

6 For the Display Persistence, click either Infinite, Variable or 
Off. Off is the default, and erases the screen each time a new 
waveform array is displayed. For an explanation of Variable 
persistence, see page 140. 

7 If you select Variable, click Persist Time, and adjust the 
persistence time (decay rate). 

Set the display readout 
options 

8 Select the Display Setup control window Objects tab. 
9 Click Display Date/Time to toggle the date/time display On 

and Off. 

Adjust the intensity 
10 Select the Display Setup control window Appearance tab. 

11 Click the Waveform Intensity AutoBright button to toggle 
AutoBright On and Off.  

 On automatically sets the maximum intensity to the 
value of the most frequent event. 

 Off creates a display like an analog oscilloscope. The 
displayed brightness depends on the trigger rate. 

12 Rotate the front-panel INTENSITY knob to adjust the 
intensity of displayed waveforms, or click the Intensity control 
and enter the intensity value with the keypad or multipurpose 
knob. 
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Select the color palette 

13 Select the Display Setup control window Color tab. 

14 Click a Color Palette button in the Fast/Acq WfmDB Palette. In 
Fast Acquisitions mode, Temp and Spectral show more detail 
than the other color palettes. 

For a definition of each color palette, see page 145.  

 

Time Stamping Frames 
Use Time Stamps to display the absolute trigger time for a specific frame and the relative time 
between triggers of two specified frames. To use FastFrame Time Stamps, do the following steps: 

Prerequisites 1 FastFrame mode should be set up as described in the 
previous example. 

2 Turn on FastFrame 

Turn readouts on or off 
3 In the Time Stamps controls, click Readouts to toggle time 

stamp readouts on or off: Readouts use the following format: 
Sel Ch# F xxx DD MMM YYYY 
HH:MM:SS.mmm µµµ nnn ppp 
Ref Ch# F xxx DD MMM YYYY 
HH:MM:SS.mmm µµµ nnn ppp 
∆ DD MMM YYYY HH:MM:SS.mmm µµµ nnn 
ppp 
Where: 
Sel and Ref Ch# F xxx are the selected or reference 
frame number 
DD MMM YYYY is the date (day, month, and year) 
HH:MM:SS, is the clock time (hours, minutes, and 
seconds) 

mmm µµµ,nnn,ppp is a fraction of a second (to 
picoseconds) 

Select the reference frame 4 In the Time Stamps controls, click Source and select the 
source of the reference frame. 

5 In the Time Stamps controls, click Frame and use the 
multipurpose knob or keypad to enter the number of the 
reference frame. This value sets the starting frame when 
measuring the relative time between two frames. 
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Select the FastFrame and 

time stamps selection 
controls 

To set the Selected Frame and Reference Frame from the 
Selection Controls window: 

6 Click Selection Controls from the FastFrame control window 
to display the FastFrame controls. 

7 In the FastFrame controls window, click Selected Frame 
Source, and select the source of the frame that you want to 
view. 

8 Under Selected Frame, click Frame, and use the 
multipurpose knob or keypad to enter the number of the 
specific frame that you want to view and take time stamps 
on. The frame you select appears on the display.  

Note 
The ∆ is the selected time stamp—the reference time stamp. 

9 Click the Reference Frame Source and select the source of 
the reference frame. Click Frame and use the multipurpose 
knob or keypad to enter the number of the reference frame. 

To lock the reference 
position frames 10 From the Horiz/Acq menu, select FastFrame Setup. 

Note  
You can also get the FastFrame Setup control window by 
clicking the Set Up button on the Selection Controls 
window. 

11 Click either Frame Tracking Live or All to lock the reference 
and position frames together. When the frames are locked, 
they maintain the same relative distance from each other when 
either frame is adjusted: 

 Live locks together the channel and math waveforms. 
All reference waveforms are locked together, but they 
are separate from the channel and math waveforms. 

 All locks together all channel, math, and reference 
waveforms; adjusting one waveform adjusts all 
waveforms. 
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Triggering from the Front Panel 
The front panel provides quick access to the most frequently used trigger controls. The trigger 
readout shows you the state of the trigger system.  

The SLOPE, COUPLING, and SOURCE controls only apply to edge triggering. To access the 
advanced trigger controls, open the Trigger Setup control window by pushing the ADVANCED 
button (See Advanced Triggering on page 240 for more information).  

Use this procedure to set up triggers using the front-panel controls. 
Prerequisites 1 Set the acquisition system to RUN (the RUN/STOP control 

is lighted), and set the vertical and horizontal controls 
appropriately for the signal to be acquired. 

Select the trigger type 2 Push the EDGE button to select edge triggering. Pushing 
ADVANCED opens the Trigger Setup control window to set 
up other trigger types. 

Select the trigger slope 3 Push the SLOPE button to toggle between POS and NEG: 
• POS triggers on a rising edge (positive-going) signal 
• NEG triggers on a falling edge (negative-going) signal 

You can also set the slope in the Trigger Setup control window. 

Select the trigger level 4 To manually change the trigger level for edge triggers (or 
certain threshold levels for logic or pulse triggers), turn the 
LEVEL knob. You can also set the level in the Trigger Setup 
control window. 

Set trigger level to 50% 
5 To quickly set the edge trigger level to 50% of the waveform 

voltage range, push the LEVEL knob. The instrument sets the 
trigger level to the halfway point between the peaks of the 
trigger signal. This function has no effect for the other trigger 
types. 

You can also click Set 50% in the Trigger Setup control window. 

Select the trigger source 
6 Push the up and down arrow buttons to select a SOURCE: 
• CH 1 through CH 4 are the input channels. The channel 

that you select as a trigger source will function whether it 
is displayed or not. 

• EXT is a fifth, nondisplayable auxiliary (external) trigger 
source. To use the auxiliary trigger, connect the source to 
the front-panel AUX IN connector. 

• LINE is the AC line voltage. The oscilloscope is used to 
generate the trigger and you do not have to input a signal. 
The trigger level is fixed at zero volts. 
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Set the trigger coupling 
7 Push the up and down arrow buttons to set COUPLING: 
• DC passes both AC and DC components of the input 

signal.  
• AC passes only the AC components of an input signal.  
• HF REJ attenuates signals above 30 kHz. 
• LF REJ attenuates signals below 80 kHz. 
• NOISE REJECT provides lower sensitivity, reducing the 

chance of falsely triggering on noise. 

Select the trigger mode 
8 Push the MODE button to toggle between NORM and AUTO 

trigger modes: 

• NORM requires a valid trigger event to acquire a waveform. 

• AUTO acquires a waveform even if no valid trigger event 
occurs. 

Be aware that in AUTO mode, the acquired waveforms may not 
be triggered. 

 

Checking Trigger Status 
To see the state and setup of the triggering circuit, use the trigger status lights, readout, and screen. 

Trigger status from trigger 
status lights 1 To quickly determine the trigger status, check the ARM, 

READY, and TRIG'D controls. 

 If TRIG'D is on, the oscilloscope has recognized a valid 
trigger and is filling the posttrigger portion of the 
waveform. 

 If READY is on, the oscilloscope can accept, and is waiting 
for, a valid trigger. 

 If ARM is on, the trigger circuitry is filling the pretrigger 
portion of the waveform record. 

 If both TRIG'D and READY are on, a valid A event trigger 
has been recognized and the instrument is waiting for a 
delayed trigger. When a delayed trigger is recognized, the 
posttrigger portion of the delayed waveform will fill. 

 If ARM, TRIG'D, and READY are off, the acquisitions 
have stopped. 
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Trigger status from 

acquisitions readout 
2 To quickly determine the settings of some key trigger 

parameters, check the Trigger readout at the bottom of the 
display. The readouts differ for edge and the advanced 
triggers. 

Trigger level on display 
3 To see the trigger level on the waveform display, turn on a 

trigger level indicator (marker). See Trigger Level Marker on 
page 144 for instructions on setting the indicator. 

The trigger level indicator remains on the screen as long as the 
channel providing the trigger source is displayed. You can choose 
between two types of trigger level indicators: a horizontal bar and 
an arrow at the right side of the graticule. 

 

Triggering from the Trigger Setup Window 
Some trigger parameters are accessible only through the Trigger Setup control window: 

 Holdoff 

 Trigger level presets 

 Force trigger 

Use the procedures that follow to set up these trigger parameters.  
Set holdoff 

Changing the holdoff time helps to stabilize triggering. To set 
holdoff: 

1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the Mode tab.  

3. Click Default or Time: 

 Default uses the instrument default holdoff time, which is 
five times the current horizontal scale setting. Default 
maintains a good value for general-purpose triggering. 

 Time enables you to enter a holdoff that may allow more 
stable triggering. This time is used at all horizontal scale 
settings. 

4. If using Time, click Trig Holdoff and enter the time value 
using the multipurpose knob. The holdoff range is 1.5  �s 
to 12 seconds. 

Select a preset trigger 
level 5. Push the front-panel ADVANCED button. 

6. On the Trigger Setup control window, select the A Event 
tab. 
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7. Click a Trigger Type button to select a trigger, such as 
Edge, that uses a level adjustment. A trigger uses a level 
adjustment if the Level control appears on the right side of 
the screen with the trigger type setup controls. 

8. Click Level, and then click the keypad icon to open the 
keypad. Click on either TTL, ECL, or USER: 

 TTL fixes the trigger level at +1.4 V. 
 ECL fixes the trigger level at –1.3 V. 

 USER fixes the trigger level at a user preset voltage (see 
Steps 9 through 12).  

When you set the volts/div less than 200 mV, the instrument 
reduces the TTL or ECL trigger levels below standard TTL and 
ECL levels. This reduction occurs because the trigger level range 
is fixed at +12 divisions from the center. At 100 mV (the next 
lower setting after 200 mV) the trigger range is +1.2 V, which is 
less than the typical TTL (+1.4 V) or ECL (–1.3 V) level. 

Define new trigger level 
presets 9. If the menu bar is not displayed, click the Menu toolbar 

button.  

10. Select the Utilities menu User Preferences option. The User 
Preferences control window opens. 

11. Select the Keypad Defaults tab. 

12. Click the appropriate Trig Level and adjust the preset using 
the multipurpose knob or pop-up keypad. 

13. If desired, click a Keypad Label and change the label of 
the preset using the pop-up keypad. 

Force a trigger 
14. Push the front-panel ADVANCED button. 

15. On the Trigger Setup control window, select the A Event or 
B Event tab 

16. Click Edge. 

17. To force the instrument to immediately acquire one 
waveform record, even without a trigger event, click Force 
Trigger.  

Forcing a trigger is useful when, in normal trigger mode, the 
input signal is not supplying a valid trigger. Click Force 
Trigger to quickly confirm that there is a signal present for 
the instrument to acquire. Then determine how to trigger on 
the signal (for example, push LEVEL to set 50%, check the 
trigger source setting, and so on). 
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The instrument acts on Force Trigger even if selected before the end of pretrigger holdoff. 
However, the button has no effect if the acquisition system is stopped. 

Triggering on a Glitch 
Use this procedure to detect and trigger on a glitch or to ignore a glitch. 

Select glitch triggering 
1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the A Event 
tab.  

3. Click Glitch. 

Select the source 
4. To specify which channel becomes the trigger source, click 

Source, and select the source from the list. 

Select the polarity and 
width 5. Click a Polarity button to specify the glitch polarity:  

 Pos looks at positive-going pulses. 

 Neg looks at negative-going pulses. 

 Either looks at both positive and negative pulses. 
6. To specify the width of the glitch, click Width and set the 

glitch width using the multipurpose knob or keypad. 

7. To specify whether to trigger on glitches narrower or greater 
than the width you specify, click: 
 Trig if Width < to trigger only on narrower pulses. 
 Trig if Width > to trigger only on wider pulses. 

Set the level 
8. Click Glitch Trigger Level and use the multipurpose knobs, 

keypad, or front-panel LEVEL knob to set the level that the 
glitch must cross to be recognized by the instrument.  

You can set the level to a value appropriate to either the TTL or 
ECL logic families by clicking TTL or ECL on the Level pop-up 
keypad. 

Set mode and holdoff 9. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page 137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff.  
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Triggering on a Runt Pulse 
Use this procedure to detect and trigger on a runt pulse. The instrument can look for positive or negative 
runt pulses. These pulses can also be qualified by time or by the logical state of other channels. 

Select runt triggering 
1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the A Event 
tab.  

3. Click Runt. 

Select the source  4. To specify which channel becomes the pulse trigger 
source, click Source and select the source from the list. 

Select the polarity 
5. Select a Polarity value to specify the direction of the runt 

pulse. Triggering occurs at the point the pulse returns over 
the first threshold without crossing the second threshold 
level. The polarity selected in the Polarity window 
determines the order that the threshold must be crossed for a 
runt trigger to occur: 

 Pos looks at positive-going pulses. The lower threshold 
must be first crossed going positive, then recrossed going 
negative without the upper threshold being crossed at all. 

 Neg looks at negative-going pulses. The upper threshold 
must be first crossed going negative, then recrossed going 
positive without the lower threshold being crossed at all. 

 Either looks at both positive and negative pulses. Either one 
of the thresholds must be first crossed going in either 
direction, then recrossed going in the opposite direction 
without the other threshold being crossed at all. 

For all three polarity settings, triggering occurs at the point the 
runt pulse recrosses its first threshold. 

Qualify the runt trigger 
6. To qualify the runt pulse trigger, click Trigger When Runt, 

and select from the list: 

 Occurs triggers on all runt pulses. 

 Wider triggers only on runt pulses that exceed the minimum 
width you set. Enter the Width using the multipurpose knob 
or pop-up keypad.  

 Logic triggers on a logic-qualified runt pulse. When the 
instrument detects that a runt has occurred, it checks the 
logical state of two other available channels and triggers 
only if their conditions are met. Each channel can have a 
value of high (H), low (L), or "don't care" (X). A value is 
considered high if the channel input voltage is greater than 
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the specified threshold voltage; a value is considered low if 
the channel input voltage is less than the specified threshold 
voltage. Use the "don't care" selection for any channels that 
will not be used as part of the pattern. (Available only on 4-
channel instruments.)  

Set the thresholds 
7. To set the threshold levels, click Upper Limit or Lower 

Limit, and use the multipurpose knobs or pop-up keypad to 
set the values. 

Tip  
To use the trigger level marker to help in setting the 
threshold levels, open the Display Setup control window, 
and click Long on the Objects tab. 

Set mode and holdoff 8. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page 137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff. 

 

Triggering on a Pulse Width 
Use this procedure to detect and trigger on a pulse that is either wider or narrower than the 
specified range. 

Select width triggering 
1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the A Event 
tab.  

3. Click Width. 

Select the source 4. To specify which channel becomes the trigger source, 
click Source, and select the source from the list. 

Select the polarity 5. To specify the polarity of the pulse, click Pos (for positive-
going pulses) or Neg (for negative-going pulses). 

Set the range 
6. To set the range of pulse widths in units of time, click 

Upper or Lower Limit, and enter the values with the 
multipurpose knobs or pop-up keypad: 

 Upper Limit is the maximum valid pulse width the trigger 
source will look for.  

 Lower Limit is the minimum valid pulse width. The 
instrument will always force the Lower Limit to be less than 
or equal to the Upper Limit. 

7. Click Trigger When, and select Inside to trigger on pulses 
that fall within the specified range, or Outside to trigger on 
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pulses that are outside the range. 

Set the level 8. Click Level and use the multipurpose knob or pop-up 
keypad to set the trigger level. 

Set mode and holdoff 9. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page 137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff. 

 

Triggering on Transition Time 
Use this procedure to detect and trigger on pulse edges that traverse between two thresholds at 
faster or slower rates than the specified time. You can set up the instrument to trigger on positive 
or negative edges. 

Select transition 
triggering 1. Push the front-panel ADVANCED button. 

2. In the Trigger Setup control window, select the A Event tab. 
3. Click Transition. 

Select the source 
4. To specify which channel becomes the trigger source, click 

Source, and select the source from the list. 
Select t he polarity 

5. Select a Polarity value to specify the direction of the pulse 
edge: 

 Pos monitors the transition time (slew rate) of the positive-
going edges of pulses. The edge must first cross the lower 
threshold and then cross the upper threshold. 

 Neg monitors the transition time (slew rate) of the negative-
going edges of pulses. The edge must first cross the upper 
threshold and then cross the lower threshold. 

 Either monitors positive- and negative-going edges of 
pulses. The edge may first cross either threshold and then 
cross the other. 

Set the transition time 
6. The threshold levels and the delta time setting determine the 

transition time (slew rate) setting. The level settings 
determine the voltage component of slew rate 
(Volts/Second). Click the Upper Level or Lower Level 
button and use the multipurpose knobs or pop-up keypad to 
set the values for the upper and lower levels. 

You can set the level(s) to a value appropriate to either the 
TTL or ECL logic families by clicking TTL or ECL on the 
Level pop-up keypad.  
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Tip 
To use the trigger level marker to help in setting the 
threshold levels, open the Display Setup control window, 
and click Long on the Objects tab. 

7. To finish specifying the slew rate (transition time), set the 
time component by clicking Time and using the 
multipurpose knob or keypad to set the delta time value. 

8. Click Trigger When Transition Time < to trigger when the 
transition time is less than the time you set above. Click 
Trigger When Transition Time > to trigger when the 
transition time is greater than the time you set above. 

If you select Trigger When Transition Time > (greater than) 
and the instrument does not trigger, the pulse edge may be 
too fast. To check the pulse edge speed, switch to edge 
triggering. Trigger on the pulse edge and determine the time 
the edge takes to travel between the upper and lower levels 
that you set for this trigger. The instrument cannot transition 
trigger on pulse edges that traverse between threshold levels 
in 600 ps or less. 

Also, to reliably trigger on transition time, a pulse must have a 
width of 7.5 ns or more. A pulse of less width may trigger on the 
wrong slope or not trigger at all. Switch to edge triggering, and 
check the pulse width if you can't trigger on transition time as 
expected. 

Set mode and holdoff 9. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff. 
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Triggering on Pulse Timeout 
Use this procedure to detect and trigger on pulses longer than a specified time. The instrument will 
trigger at the end of the timeout period. 

Select timeout triggering 
1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the A Event 
tab.  

3. Click Timeout. 

Select the source 4. To specify which channel becomes the trigger source, 
click Source and select the source from the list 

Set the level 
5. To set the trigger timeout level, click Level and use the 

multipurpose knobs or pop-up keypad to enter the voltage 
level.  

You can set the level to a value appropriate to either the TTL or 
ECL logic families by clicking TTL or ECL on the Level pop-up 
keypad. 

Set the timer 
6. To set the timeout timer, click Timer and use the 

multipurpose knob or pop-up keyboard to set the time. 

Set the pulse threshold 
7. To set the pulse threshold, click: 

 Stay High to trigger if the signal stays higher than the 
trigger level for longer than the timeout (Timer) value. 

 Stay Low to trigger if the signal stays lower than the trigger 
level for longer than the timeout (Timer) value. 

 Either to trigger if the signal stays lower or stays higher 
than the trigger level for longer than the timeout (Timer) 
value. 

Set mode and holdoff 8. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page 137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff. 
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Triggering on a Pattern 
Use this procedure to trigger the instrument when the logic inputs cause the selected function to 
become True or False. You can also specify that the logic conditions must be satisfied for a 
specific amount of time before the instrument triggers. 

Select pattern triggering 
1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the A Event 
tab.  

3. Click Pattern. 

Define pattern inputs 4. Select an input value from the drop-down list for each 
channel. The channel inputs combine to form a logic 
pattern. Each channel can have a value of high (H), low 
(L), or "don't care" (X). A value is considered high if the 
channel input voltage is greater than the specified 
threshold voltage; a value is considered low if the channel 
input voltage is less than the specified threshold voltage. 
Use the "don't care" selection for any channels that will 
not be used as part of the pattern. 

Set threshold voltages 5. To set the threshold voltages, click on the channel 
threshold control, and use the multipurpose knobs or pop-
up keypad to set each threshold. 

Select logic pattern 
6. Select the Boolean logic function for the combination of 

input channels. The instrument will trigger on a clock edge 
when the input waveforms match the specified logic pattern. 

See Pattern Triggers on page 241 for definitions of the logic 
functions for pattern triggers. 

Set trigger criteria 
7. From the Trigger When Pattern list, select True to trigger 

the instrument when the logic patterns are true. Select False 
to trigger the instrument when the logic patterns are false.  

Set mode and holdoff 8. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page 137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff. 

To define a time qualified 
pattern trigger 9. You can time qualify a pattern logic trigger, that is, you can 

specify the amount of time that the Boolean logic function 
must be True. You must select Less than or More Than for 
the Trigger When Pattern control. Then, click on Trigger 
When Time and set the time using the multipurpose knob or 
keypad. 
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When you select Less Than and specify a time, the input 
conditions must drive the logic function True for less than 
the specified time. Conversely, the True for More Than item 
requires the Boolean function to be True for longer than the 
time you specify.  

The instrument determines the trigger point in the following 
manner: 

 It waits for the logic condition to become True. 

 It starts timing and waits for the logic function to 
become False. 

 It compares the times and, if the time True is longer 
(More Than Time) or shorter (Less Than Time), then it 
triggers a waveform display at the point the logic 
condition became False. This time can be, and usually 
is, different from the time set. 

 

Triggering on Logic State 
Use this procedure to trigger the instrument when all of the logic inputs to the selected logic function cause 
the function to be True or False when the clock (channel 4) input changes state. (The clock input is channel 
2 on 2-channel instruments.) 

Select state triggering 
1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the A Event 
tab.  

3. Click State. 

Define state inputs 
4. Select an input value from the drop-down list for each 

channel. Channels 1, 2, and 3 represent the data inputs on 4-
channel instruments, Channel 1 on 2-channel instruments. 
Channel 4 should be connected to the clock signal on 4-
channel instruments, Channel 2 on 2-channel instruments. 

5. Select either the Pos (rising) or Neg (falling) edge of the 
Clock Channel. 

The channel inputs combine to form a logic pattern. Each channel 
can have a value of high (H), low (L), or "don't care" (X). A value 
is considered high if the channel input voltage is greater than the 
specified threshold voltage; a value is considered low if the 
channel input voltage is less than the specified threshold voltage. 
Use the "don't care" selection for any channels that will not be 
used as part of the pattern. 
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Set threshold voltages 6. To set the threshold voltages, click the channel threshold 
control, and use the multipurpose knobs or pop-up keypad 
to set each threshold. 

Define logic 
7. Select the Boolean logic function for the combination of the 

input channels. The instrument will trigger on a clock edge 
when the input waveforms match the specified logic pattern. 
(The Pattern Type controls do not appear on this control 
window for 2-channel instruments.) 

See Pattern Triggers on page 241 for definitions of the logic 
functions for pattern triggers. 

Set trigger criteria 
8. Use the Trigger When Pattern selection to determine when 

the instrument should trigger. Select True to trigger the 
instrument when the logic patterns go true. Select False to 
trigger the instrument when the logic patterns go false. 

For simplest operation, leave this control set to True. Setting the 
control to False complements the output of the chosen pattern 
function (for example, from AND to NAND or NOR to OR). 

Set mode and holdoff 9. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page 137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff. 

 

Triggering on Setup/Hold Time Violations 
Use this procedure to detect and trigger on setup and hold time violations. The setup and hold times define 
a violation region relative to a clock. Data is considered to be invalid in the violation region. 

Select setup/hold 
triggering 1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the A Event 
tab.  

3. Click Setup/Hold. 

Select the data source 4. To select the channel that is connected to the data signal, 
click Data Source, and select the source from the list. Do 
not select the same channel for both the data and clock 
sources. 

Select the clock source 
and set the edge 5. To select the channel that is connected to the clock signal, 

click Clock Source, and select the source from the list.  
Do not select the same channel for both the data and clock 
sources. 
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6. The Clock Edge determines whether the instrument finds 
the trigger point on the rising edge (left button) or the 
falling edge (right button) of the clock signal. Click a 
Clock Edge button. 

Set the data and clock 
levels 7. To set the data transition level, click Data Level, and use the 

multipurpose knobs or pop-up keypad to set the value. 

8. The instrument uses the clock level to determine when a 
clock edge occurs. The point the clock crosses the clock 
level is the reference point from which it measures setup 
and hold time settings. To set the clock threshold level, click 
Clock Level and use the multipurpose knobs or pop-up 
keypad to set the value.  

Both Clock and Data Levels can be set to a value appropriate to 
either the TTL or ECL logic families by clicking TTL or ECL on 
the Level pop-up keypad. 

Set the setup and hold 
times 9. Click Setup Time, and use the multipurpose knob or pop-up 

keypad to set the setup time relative to the clock.  

10. Click Hold Time, and use the multipurpose knob or pop-up 
keypad to set the hold time relative to the clock.  

Positive setup time always leads the clock edge; positive 
hold time always follows the clock edge. Setup time always 
leads the hold time by at least 2 ns (TS + TH.≥ 2 ns). 
Attempting to set either time to reduce the 2 ns limit adjusts 
the other time to maintain the limit. 

See the figure below for an example of a setup and hold 
violation trigger.  

In most cases, you will enter positive values for both setup and 
hold time. Positive values set the instrument to trigger if the data 
source is still settling inside the setup time before the clock or if it 
switches inside the hold time after the clock. You can skew this 
setup/hold violation zone by entering negative values as shown 
below: 
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Set mode and holdoff 11. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page 137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff. 

  

Set up and hold violation trigger  
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Triggering on Window Threshold Violations 
Use this procedure to trigger the instrument when the input signal rises above an upper threshold 
level or falls below a lower threshold level. 

Select window triggering 
1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the A Event 
tab.  

3. Click Window. 

Select the source 4. To specify which channel becomes the trigger source, 
click Source, and select the source from the list. 

Set the thresholds 5. The upper and lower threshold levels define the voltage 
limits of the window. To set the threshold levels, click 
Upper Level or Lower Level, and use the multipurpose 
knobs or pop-up keypad to set the values. 

Quality window trigger 
6. To qualify the window trigger, select from these Trigger 

When drop-down list combinations. Note that the Trigger 
When controls change as you select different combinations 
of options. 

 Inside Limits and Occurs or Outside Limits and Occurs: 
Trigger the instrument when the signal enters (or leaves) the 
window defined by the threshold levels. 

 Inside Limits and Wider Than or Outside Limits and Wider 
Than: Trigger the instrument when the signal enters (or 
leaves) the window defined by the threshold levels for the 
time specified by Width. 

 Inside Limits and Logic or Outside Limits and Logic: 
When the instrument detects a signal entering or leaving 
the window defined by the threshold levels, it checks the 
logic state of up to two other available channels and 
triggers only if their conditions are met. Each channel can 
have a value of high (H), low (L), or "don't care" (X). A 
value is considered high if the channel input voltage is 
greater than the specified threshold voltage; a value is 
considered low if the channel input voltage is less than the 
specified threshold voltage. Use the "don't care" selection 
for any channels that will not be used as part of the 
pattern. (Logic qualification is only available on 4-channel 
instruments.) 

Set mode and holdoff 7. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page 137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff. 
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Triggering on a Video Signal 
Use this procedure to detect and trigger on a video signal. Only composite signal formats are 
supported. Graphic display formats such as RGB and VGA are not supported. 

Select video triggering 
1. Push the front-panel ADVANCED button. 

2. On the Trigger Setup control window, select the A Event 
tab.  

3. Click Video. 

Select the source 4. To specify which channel becomes the trigger source, 
click Source, and select the source from the list. 

Select the format 
5. Select the video signal format from several preset formats, 

or set a custom format. If using a preset format, click the 
Lines and Fields Autoset buttons to optimize the instrument 
for viewing the fields or lines for your chosen format.  

If you select the Custom signal format, no Autoset options 
are available. You must set the Scan Type (Interlaced or 
Progressive) and Scan Rate.  

Custom scan rates enable you to trigger on non-broadcast video 
signals that have unique scan rates. Select the scan rate that 
includes your signal: 15–20 kHz, 20–25 kHz, 25–35 kHz, 35–50 
kHz, or 50–65 kHz. 

Specify where trigger will 
occur on the video signal 6. Select a value from the Trigger On drop-down list to specify 

where the trigger will occur on the video signal:  

 If you select Field, use the drop-down list to select 
either Odd, Even, or All. 

 If you select Line #, use the multipurpose knob to set 
the line number. Line numbers wrap when their limits 
are reached. The range of line numbers depends on the 
format. 

 If you select the NTSC format, use the multipurpose 
knob to first scroll through all of the odd lines, then the 
even lines. 

 If you select All Lines, the trigger will occur on any and 
all lines. 

Set the holdoff type 7. Specify Holdoff By Time or By Fields, and use the 
multipurpose knob to change the value. If setting a 
Custom format, only the By Time control is available. 
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Select the polarity and 
graticule type 8. Select Normal or Inverted polarity:  

 Normal generally triggers on negative polarity, since 
the sync pulse leading edge is negative for most 
standard formats.  

 Use Inverted when probing circuitry that inverts the 
video signal. 

9. All graticule types are available for selection from the 
drop-down list. The IRE graticule is normally used with 
NTSC signals, and the mV graticule is normally used with 
all other video signals. 

Set mode and holdoff 10. Mode and holdoff can be set for all standard trigger types. 
Refer to trigger mode on page 137 and Set holdoff on page 
122 to learn more about trigger mode and holdoff. 

Triggering on a Sequence 
Use this procedure to set up the instrument to trigger on a sequence.  

Prerequisites 1. The instrument must be installed with a signal connected 
to an input channel. Set the acquisition system to RUN, 
and set the vertical and horizontal controls appropriately 
for the signal to be acquired. 

To trigger on A (main) 
only 1. Click Trig on the toolbar, and select the A->B Seq tab of the 

Trigger Setup control window.  
2. Click A Only to turn off sequential triggering. 

To trigger on B after time 
1. To set the time base to run after an A trigger, a trigger delay, 

and a B trigger, click Trig on the toolbar, and select the A-
>B Seq tab of the Trigger Setup control window.  

2. Click Trig After Time. 

3. To set the trigger delay, click Trig Delay and use the 
multipurpose knob or pop-up keypad to set the time. 

4. To set the B trigger level, click B Trig Level and use the 
multipurpose knob or pop-up keypad to set the level. 
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To trigger on B events 

1. To set the time base to trigger after an A trigger and a 
specified number of B trigger events, click Trig on the 
toolbar, and select the A->B Seq tab of the Trigger Setup 
control window.  

2. Click Trig on nth event. 

3. To set the number of B trigger events, click Trig Event, and 
use the multipurpose knob, pop-up keyboard, or up and 
down arrows to set the number of events. 

4. To set the B trigger level, click B Trig Level, and use the 
multipurpose knob or pop-up keypad to set the level. 

To set up B triggering 
1. To set the B Event trigger, click Trig on the toolbar, and 

select the B Event tab of the Trigger Setup control window. 
Or, from the menu bar, select the B Event (Delayed) Trigger 
Setup command.  

2. To specify which channel becomes the B trigger source, 
click Source and select the source from the list.  

3. Click Coupling and select the trigger coupling to match 
your trigger signal. 

4. To specify the direction of the edge, click a Slope button. 
The left button selects a positive slope and the right button 
selects a negative slope. 

5. To set the B trigger level, click B Trig Level, and use the 
multipurpose knob or pop-up keypad to set the level. Note 
that you can click Set 50% to set the B trigger level to the 
midpoint between the positive and negative peak of the B 
trigger signal. 

 

Triggering on a Communication Signal 
Use this procedure to set up the instrument to trigger on a communication signal.  

Prerequisite 1. The Instrument must have Option SM installed.  

Select comm triggering 
2. Push the front-panel ADVANCED button. 

3. On the Trigger Setup control window, select the A Event 
tab.  

4. Click Comm. 
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Select the source and 
type 5. To specify which channel becomes the trigger source, click 

Source, and then select the source from the list. 

6. Select either Clock or Data from the Type list. If you select 
Clock, you will also need to select the polarity. 

Select coding format and 
standard 7. Select the coding format for triggering on a communication 

signal and the standard to use with the coding format. The 
coding format determines which standards are available as 
well as other parameters, such as trigger threshold and pulse 
form. The standard sets the bit rate. Changing the bit rate 
will change the Standard to Custom. 

8. Depending on the coding format you may also need to set 
the Pulse Form and Threshold Level.  

Select a communications 
mask 9. Follow the Setting up Mask Testing procedure on page 337 

to select the communications mask you want to use. 

 

 

Displaying Waveforms 
This procedure demonstrates the display adjustments you can make. 

Prerequisite 1. The instrument must be installed with a signal connected 
to an input channel. Set the acquisition system to RUN. 

Set vertical display 
parameters 2. Push the CH button of the channel with the connected signal 

to display the waveform. The CH button is lighted. 
3. Adjust the front-panel vertical controls to achieve a good 

display of the waveform. 

Set horizontal display 
parameters 4. Use the front-panel horizontal knobs to adjust the SCALE 

and POSITION of the waveform and to set sample 
RESOLUTION. 

The RESOLUTION knob also sets the record length. (See 
Horizontal Acquisition Window Interrelated Parameters on page 
232 for details.) 

5. Push the LEVEL knob (PUSH TO SET 50%) if required 
to stabilize the display. 

Adjust the horizontal 
reference 6. To adjust the point around which the waveform expands and 

contracts, click on the horizontal reference marker, and 
drag it along the horizontal axis until it aligns to the point 
on the waveform that you want to be stationary on screen. 

Note that if horizontal delay is off, the horizontal reference 
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point is the same as the horizontal position. 
7. Release the Horizontal Reference, and then adjust the 

Horizontal Scale to expand or contract the waveform. 

Using MultiView Zoom with Waveforms 
Prerequisites 

1. The instrument must be installed and operating, with a 
signal connected to an input channel, and horizontal and 
vertical controls and triggering set up. 

2. Obtain a stable display of the waveform to be measured. 

Select Zoom 
3. Click and drag across the segment of the waveform that you 

want to see in greater detail.  

4. Select Zoom (1-4) On from the shortcut menu to magnify 
the highlighted waveform segment. 

The instrument displays the zoomed area on the waveform as 
magnified in the bottom graticule. You can also press the front-
panel MultiView ZOOM button to split the screen and add a zoom 
graticule. 

5. To zoom on multiple areas, repeat steps 3 and 4. 

Focus the MultiView Zoom 
on waveform(s) of interest 6. Push the front-panel MultiView Zoom HORIZ or VERT 

button to select the axis that you want to focus on in the 
zoom graticule. The Zoom control window opens, if it is 
not already present. 

7. To select the waveform that you want to scale or position, 
select the Channel (Ch), Math, or Reference (Ref) 
waveform from the drop-down list. 

8. Use the multipurpose knobs to adjust position and factor of 
the zoomed waveform. Note that as you adjust the factor 
or position the instrument adjusts the Zoom box relative to 
the unmagnified waveform. 

Set up MultiView Zoom 
options 9. Click Setup in the Zoom control window to open the Zoom 

Setup control window. 

10. To change the size of the unmagnified (Acquisition) and 
Zoom windows, select one of the following from the 
Graticule Size drop-down list: 

 50-50 allocates half of the available display for the 
zoomed graticule and half of the available display for 
the acquisition window. 

 80-20 allocates 80% of the available display for the 
zoomed graticule and 20% for the acquisition window.  

 Full uses the entire display for the zoomed graticule.  
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11. Click the Lock and Scroll tab to select a Zoom Lock and 
scroll setting: 

 To scroll a single zoomed area, click Zoom 1–4, and 
then click an AutoScroll button.  

 To scroll multiple zoomed areas simultaneously, click 
Lock, and then click the Zoom 1–4 buttons that you 
want to scroll through. 

Check the MultiView 
Zoom scale and position 

12. To quickly determine the magnification factor and 
position of a zoomed waveform, check the readouts on 
the appropriate tab (Horizontal or Vertical) of the Zoom 
Setup control window. 

Reset MultiView Zoom 13. To reset all Zoom settings to their defaults, click the 
Position Factor Reset button in the Zoom Setup control 
window. 

Taking Automatic Measurements 
Use this procedure to quickly take a measurement based on the default settings for High and Low reference 
levels. 

Prerequisites 
1. The instrument must be installed and operating, with a 

signal connected to an input channel, and horizontal and 
vertical controls and triggering set up. 

2. Obtain a stable display of the waveform to be measured. 

Select the source 
waveform 3. From the toolbar, click Meas to open the Measurement 

Setup control window. 
4. You can use a channel, reference, or math waveform as 

the source. Click the appropriate waveform button on the 
Ch, Math, or Ref Source tab. 
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Take automatic 
measurements 5. Select the tab on the Measurement Setup control window 

that contains the measurement you want to take: Ampl, 
Time, More, Histog, or Comm. 

6. Click the button for the measurement. 

The readout for the measurement and associated statistics is 
automatically displayed, and the measurement is added to 
the Measurements list in the control window.  

Measurements are displayed in the right control window 
area. If the window is occupied or there are too many 
measurements to fit in that area, the measurements are 
displayed in the lower graticule area. 

In roll mode, measurements are not available until after you stop 
acquisitions. 

Note 
If the waveform is clipped by the edge of the graticule, the 
measurement readout will display question marks. 

Remove measurements 
7. To remove the measurement, click Clear. The last 

measurement on the list is removed. To remove any 
measurement, click the name on the Measurements list to 
highlight the measurement, and click Clear. You can also 
click and drag to select and clear several measurements. 

8. Toggle the display of measurements on the graticule by 
clicking the Display button On and Off. 

Display measurement 
statistics 9. From any tab on the Measurement Setup control window, 

click Setup Statistics. The Measurement Statistics control 
window opens. 

10. From the Measurement Statistics control window, click: 

 Off to turn off the display of measurement statistics 

 Mean to display the mean of measurements 

 All to display the Mean, Min, Max, Standard Deviation, 
and Population measurements 

11. To set the number of measurements included in the 
measurement statistics, click Weight n=, and use the 
multipurpose knobs or pop-up keypad to set the 
weighting. 

Set measurement 
reference levels 12. From the toolbar, click Meas to open the Measurement 

Setup control window. 

13. From any tab on the Measurement Setup control window, 
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click Setup Ref Levs to open the Reference Levels setup 
control window. 

14. To set how the instrument determines the base and top of 
the waveform, click Determine Base, Top From:  

• Min-Max to use the highest and lowest values of the 
waveform record. (See Automatic Measurements on 
page 256 High/Low Method for more information.) 

• Histogram to select the most common values above or 
below the midpoint. (See Automatic Measurements on 
page 256 High/Low Method for more information.) 

15. To select the reference level units, click Units:  

• Absolute to set the units to absolute values in user units. 

• Percentage to set the units as a percentage of the 
High/Low range. 

16. To set the reference levels, click on these controls and use 
the multipurpose knob or pop-up keypad to set: 

• High Ref to define the high reference level. The default 
level is 90%.  

• Mid Ref to define the middle reference level. The 
default level is 50%.  

• Low Ref to define the low reference level. The default 
level is 10%.  

• Mid2 Ref to define the middle reference used on the 
second waveform specified in delay or phase 
measurements; the default level is 50%. 

Take a snapshot of 
measurements 17. Select the Snapshot command from the Measure menu, or 

open the Measurement Setup control window and click 
Snapshot on any tab. A window showing all single 
waveform measurements opens. 

Snapshot measurements are taken on the selected waveform. The 
Snapshot window tells you the channel that the measurements are 
being taken on and the reference levels used. 

18. Snapshot measurements are not continuously updated. To 
update snapshot measurements, click Snapshot Again. 

Phase, Delay, and Histogram measurements are not included in a 
snapshot. 
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Localizing a Measurement 
Use this procedure to take a measurement over a segment of the waveform. 

Prerequisites 
1. The instrument must be installed and operating, with a 

signal connected to an input channel, and horizontal and 
vertical controls and triggering set up. 

2. Obtain a stable display of the waveform to be measured. 

Access gating 
3. From the toolbar, click Meas to open the Measurement 

Setup control window. 
4. Click Setup Gating from any tab. The Gating control 

window opens. 

Enable and position the 
gates 5. To select how to define the gated area, click one of the 

following under Measurement Gating:  

 Cursor to set the gated area to the area between the 
cursors. Use the multipurpose knobs to adjust the 
cursors on screen. 

 Zoom (1–4) to set the gated area to the waveform area 
contained in the Zoom (1–4) area. 

 Off to turn off measurement gating. You can also turn 
gating off from the Zoom shortcut menu. 

6. If you selected Cursor, you must also select the Track 
Mode: 

 Indep mode lets you move one cursor at a time using 
the multipurpose knobs. 

 Tracking mode allows you to move both cursors at the 
same time. The cursors track one another; moving one 
cursor moves the other cursor in tandem. 

Setting Cursor Sources 
Use this procedure to target the cursors to a source. 

Prerequisites 1. Display the waveform(s) to be measured on the screen. 

Access cursor setup 2. Push the CURSORS front-panel button, or click Cursors 
on the toolbar to open the Cursor Type Setup control 
window. 

Select the cursor type 3. Click a Cursor Type button. See Cursor Types on page 
259 for an explanation of the cursor types. 

Select the cursor sources 
4. Select a Cursor Source from the Source drop-down list.  
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If you are using H Bars or V Bars there is only one source 
for both Cursor 1 and 2. If you are using Waveform or 
Screen cursors, select a source for both Cursor 1 and 2.  

If a waveform is not available, it appears shaded in the drop-down 
list. 

Change the cursor 
position 

5. To change the position of a cursor, use the multipurpose 
knobs, enter a numeric value in the Curs# Pos controls, 
or click and drag the cursors to a new position. 

Set cursor tracking 
6. To change the cursor tracking mode, click Setup on the 

Cursor Type Setup control window. The Cursor Setup 
control window opens. (All adjustments that you can make 
in the Cursor Type Setup control window can also be made 
in this window.) 

7. Select a cursor Track Mode: 

 Indep makes each cursor moveable without regard to 
the position of the other cursor. 

 Tracking makes both cursors move in unison and 
maintain a fixed horizontal or vertical distance between 
each other. 

8. To turn the display of the cursors on or off, push the 
front-panel Cursor button. 

Set cursor style 
9. For waveform or screen cursors set the cursor style by 

selecting one of the following from the list: 

 Lines display as the intersection of horizontal and 
vertical lines. Lines are the default style for Screen 
cursors. 

 Line & X display the horizontal position as a vertical 
line; the Y-axis is displayed as an X. 

 X displays the horizontal and vertical position as a 
single X. 

Starting and Resetting Histogram Counting 
Use this procedure to quickly take a measurement based on the default settings for histograms. 

Prerequisites 1. Display the waveform(s) to be measured on the screen. 

Open histogram setup 
window 

2. From the toolbar, click the Meas button to open the 
Measurement Setup control window. Click Histogram to 
open the Histogram control window. 
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Set, display, and reset 
histogram source and 

type 
3. Select the Source Ch, Math, or Ref tab, and then select the 

waveform source for the histogram. 

4. Click either Histogram Mode button to start histogram 
counting and display the histogram data:  

 Horiz displays a horizontal histogram that shows how 
time varies in the histogram box. 

 Vert displays a vertical histogram that shows how your 
vertical units vary in the histogram box. 

 Off turns off histogram counting and display. 
Note that this control turns on histogram counting and data 
display. You can only display one type of histogram at a time. 

5. Click Reset to reset the histogram count. Histograms track 
numbers of counts. Clicking Reset resets those counts to 
zero and begins counting from zero. 

6. Click Display to toggle the display of the selected 
histogram on and off. 

Select histogram scale 
7. Click a Histogram Scaling option: 

 Linear displays histogram data linearly. Bin counts 
smaller than the maximum counts are scaled linearly by 
dividing the bin count by the maximum bin count. 

Horizontal histograms have a maximum of 500 bins while 
vertical histograms have a maximum of 200 bins. 
 Log displays histogram data logarithmically. Bin counts 

smaller than the maximum counts are scaled 
logarithmically. Logarithmic scaling provides better 
visual details for bins with low counts. 

Set histogram limits 
8. Click Adjust Histogram Box Limits and use the Top Limit, 

Bottom Limit, Left Limit, and Right Limit controls to set 
the size of the histogram box. The histogram box selects 
the section of the waveform used for histograms. 

9. Click Adjust Histogram Box Location and use the X 
Location and Y Location controls to set the location of 
the histogram box. 

 Right-click and select Clear Data from the short cut menu to clear histogram data. 
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Creating a Math Waveform 
Use this procedure to create a math waveform. Ensure that the sources you want to use exist. The 
sources do not have to be displayed. 

Prerequisites 1. All waveforms and automatic measurement scalars that 
you want to use must be available. 

Open the Math Setup 
control window 

2. From the toolbar, click the Math button to open the Math 
Setup control window. 

Select a math waveform 
3. Select the Mathn tab for the math waveform that you want 

to create, and click Display to toggle it on. 

Tip 
If the waveform that you select already exists, its math expression 
appears in the window. You can still use the waveform by 
clicking Clear, which discards the previous math expression. You 
may also want to select another waveform. 

Select an expression 4. Click one of the Predefined Expression buttons to use a 
predefined math expression, or click Editor to access the 
Equation Editor. 

Define or edit an 
expression 5. Use the Equation Editor control window to define a math 

expression. See Creating Math Waveforms on page 263 
for examples, and use these guidelines:  

 Math definitions are not implemented if the sources are 
not valid.  

 Use the Bksp (backspace) button to remove the last 
entry; click Clear to remove the entire expression and 
start over. 

 Use parentheses to group terms in the expression to 
control execution order, for example, 5(Ch1 + Ch2). 
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Select a function, build an 

expression, and apply to 
the waveform 

6. Select the Time, Freq, or Meas tabs to display the available 
functions.  

7. Click a function button to enter the function in the math 
expression. Click an operand button (+, -, *, /) to insert an 
operand. 

8. Use the Home and arrow buttons to move within the math 
expression. Use the Bksp (backspace) button to delete 
portions of the expression.  

9. Click Apply to apply your new math expression to the 
math waveform. 

Apply averaging 
10. Click Avgs to open the Math Parameters control window. 

The controls in the window apply to the math waveform 
defined by the expression.  

11. Select one of the Mathn = controls, and set the number of 
averages using the multipurpose knobs or pop-up 
keypad. This number of averages affect math waveforms 
if the Avg() function is used. 

Apply expression to 
waveform 

12. Once you have defined the math expression to your 
satisfaction, click Apply. Apply is available on the 
Equation Editor and Spectral Setup control windows. 

 

Using Math Waveforms 
Use the same techniques to work with math waveforms that you use with channel waveforms. 
This procedure demonstrates some common operations that you can perform on math waveforms: 

Note 
Each math waveform that you create derives its horizontal scale and position from the sources you 
include in its math expression. You can adjust these controls for the source waveforms, and your 
adjustments are reflected in the math waveform. You can also magnify math waveforms using 
MultiZoom, and use the mouse for positioning. 

Prerequisites 
1. A math waveform must be defined and displayed. 

Select and display 
2. Click the Math toolbar button to open the Math Setup 

control window. 

3. Select the tab for the math waveform that you want to work 
with. 

 If the waveform that you select is not defined, use the 
Creating a Math Waveform procedure on page 329 to 
define the math waveform. 
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 If the waveform is not displayed, click Display. 

Set scale and position 
4. Click Position and Scale, and use the multipurpose knobs or 

pop-up keypad to size and position the waveform on the 
screen. 

Keep in mind the following: 

 The position is in divisions, so changing the scale can 
make the math waveform disappear until position is 
also changed (the same effect happens with channel 
waveforms). 

 You can click and drag a waveform handle to change 
the waveform vertical position. 

 You can change the waveform vertical position and 
scale by clicking on the waveform handle and using the 
multipurpose knobs to adjust. 

 You cannot adjust the offset of a math waveform.  

 You cannot adjust horizontal scale, position, and 
sample density (resolution) of math waveforms; 
different length source waveforms result in a math 
waveform of the shortest source record length. If you 
adjust these settings for sources of a math waveform, 
the adjustments are reflected in the math waveform. 

Take automatic 
measurements 5. Click the Meas toolbar button to open the Measurement 

Setup control window.  

6. Select the Source Math tab, and click a channel button to 
choose a math waveform. 

7. Select a measurement (for more information, see Taking 
Automatic Measurements on page 358). 

8. To display the measurement, click Display to toggle it to on. 

Take cursor 
measurements 9. Click the Cursor toolbar button to display the cursors and 

open the Cursor control window. 

10. Select the Math tab, and click the numbered button for the 
math waveform that you want to measure. 

11. Select the cursor type by clicking H Bars, V Bars, Screen, 
or Waveform (for more information, see Taking Cursor 
Measurements on page 355). 

12. Use the multipurpose knobs to position each cursor on the 
math waveform to measure the feature that interests you. 

13. Read the results in the cursor readout. The cursor readout 
is displayed under the multipurpose readouts or in the 
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upper right corner of the graticule area. 
Note that amplitude measurements on a derivative waveform are 
in volts per second, and volt-seconds for an integral waveform 
measurement. 

Using a Predefined Spectral Math Waveform 
The following procedure is an example of setting up the instrument to perform spectral analysis of 
a signal. This example uses the probe compensation signal available on the front panel of the 
instrument. 

Install the test hookup 
1. Connect the probe compensation signal to CH 1 through a 

suitable probe. 
2. Press DEFAULT SETUP.  
3. Press AUTOSET. 

Display the waveform 4. From the toolbar, click Vert, and select the Chan 1 tab.  
5. Click Offset, and using the multipurpose knobs or keypad, 

set the offset to 900 mV and the Ch1 Scale to 200 mV. 

Display the spectral math 
waveform 6. From the toolbar, click Math, and select the Math 1 tab.  

7. Click the Predefined Mag button. 
The instrument sets up a predefined magnitude spectral analysis 
waveform. Your waveform should be similar to the one below. 

  
Display the spectral math 

waveform (cont.) 8. Click the Spectral Analysis Setup button. 
9. Use the multipurpose knobs or keypad to set the frequency 

span to 125 kHz and the center frequency to 62.5 kHz (if 
necessary, reduce the sample rate). 

Setup the Cursors 
10. From the toolbar, click Cursors.  
11. To assign the cursors to the spectral analysis math 

waveform, select Math 1 from the list Source list for Cursor 
1. 

12. Use the multipurpose knobs or keypad to set the Curs1 Pos 
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to 0.0 Hz and the Curs2 Pos to 125 kHz. 
The cursor readout now indicates the frequency span set in 
step 9. 

13. Use the multipurpose knobs or keypad to set the Curs2 Pos 
to 62.5 kHz. 

The cursor readout now indicates the center frequency set in step 
9. 

Measure the test results 
14. Use the multipurpose knobs or keypad to set the Curs1 Pos 

to 3.0 kHz and the Curs2 Pos to 11.0 kHz. 

In this example, the cursors are now on the third and 
eleventh harmonic of the probe compensation signal. Read 
the frequencies from the cursor readouts. 

15. Click the Cursor Type Waveform button. Click the Cursor 2 
button and then the Math 1 button.  

Now in addition to the frequency at the cursor locations, the 
cursor readout displays the amplitude at the cursor locations. The 
readout also displays the difference in frequency and amplitude 
between the cursor locations as shown below. 

 

 

Defining a Spectral Math Waveform 
Use this procedure to define a spectral math waveform. First ensure that the sources you use exist. 
Channel sources should be acquiring or have acquired data. These sources do not have to be 
displayed to be used. 

Prerequisites 1. All sources that you will use in your math waveform 
must be available. 

Open the Spectral 
Analysis Setup control 

window 
2. From the toolbar, click the Math button to open the Math 

Setup control window.  
3. Click Spectral Analysis Setup to open the Spectral 

Analysis Setup control window. 

Select a spectral 
waveform 4. Click Mathn, and select the math waveform that you want to 

create from the list. 

5. Click Magnitude to create a magnitude spectral waveform 
or Phase to create a phase spectral waveform. If you want 
an averaged spectral waveform, click Average, and click 
Avgs to set the number of averages. See the step Apply 
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Averaging under Creating a Math Waveform on page 329 
for details.) 

6. Select the tab and channel number for the source waveform.  

Tip 
If you want to redefine your waveform, click Clear button, and 
repeat the above steps. 

Display the spectral 
waveform 

7. To display your spectral waveform, click Apply or OK. 

Set the magnitude scale 
8. Select the Mag tab. 

9. To select the vertical scale factor, click Scale: 

• dB to display magnitude using the log scale, expressed in 
dB relative to the reference level offset. 

• Linear to display magnitude using units equal to the 
source units. 

• dBm to set the reference level offset to predefined values 
for dBm; see next step. 

Tip 

You can adjust the scale and position by clicking the 
waveform handle and using the multipurpose knobs.  

10. To set the reference level, click Reference Level, and use 
the multipurpose knobs or pop-up keypad to set the 
reference level. 

Tip 

Reference level is the value at the top of the display screen. 
It only applies to magnitude waveforms. Adjusting the 
reference level positions the waveform with respect to the 
top of the display, but does not change the position of the 
waveform with respect to its ground reference. 

11. To set the reference level offset, click Reference Level 
Offset, and use the multipurpose knobs or pop-up keypad 
to set the offset. 

Tip 
Offset determines where zero dB is in the output waveform. 
Changing offset moves the waveform with respect to its ground 
reference. When the input is equal to the offset, it will display as 
zero dB in the output. 
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Set the phase scale 
12. Select the Phase tab. 

13. To select the vertical scale factor click Scale: 

 Degree to set the phase units to degrees. Phase is 
displayed using degrees as the scale, where degrees 
wrap from –180° to +180°. 

 Radian to set the phase units to radians. Phase is 
displayed using radians as the scale, where radians 
wrap from –Π to +Π. 

 GroupDelay to unwrap the phase spectrum and display 
its derivative. 

Using the Phase Controls on page 273 provides in-depth information 
on setup for phase displays. 

14. To specify whether to unwrap phase in a spectral analysis 
phase waveform, click Unwrap to toggle. 

15. To set the level in dB that a magnitude in the spectrum 
must exceed to have its phase computed (to reduce the 
effect of noise in your phase waveform), click Suppression 
Threshold, and use the multipurpose knobs or pop-up 
keypad to set the threshold level. If the magnitude is less 
than the threshold, then its phase is set to zero (see Using 
the Phase Controls on page 273 for an example). 

See Using the Phase Controls on page 273 for additional 
information on suppression threshold. 

Set time and frequency 
domain control tracking 16. Select the Control tab. 

17. To enable changing time and frequency domain controls 
for one math waveform to change the same controls for 
another math waveform, click the Track Time/Freq 
Domain Controls buttons to toggle them on or off. 

Select the window type 18. To select the window type, click Window Type, and 
select from the list. For more information on window 
types see Using Spectral Analyzer Windows on page 
274. 

Set the frequency domain 
controls 19. To set the frequency range over which the spectral analysis 

is performed, click Freq Span, and use the multipurpose 
knobs or pop-up keypad to set the frequency range. Higher 
sample rates allow you to set greater frequency spans. To 
set the frequency span to the maximum allowed by the 
current sample rate, click Full. 

20. To set the center frequency of the spectral analysis, click 
Center Freq, and use the multipurpose knobs or pop-up 
keypad to set the center frequency. 
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21. Resolution bandwidth determines how small of a 
frequency difference can be resolved in the frequency 
domain output data. It basically defines the bandwidth of 
the filters used to do the frequency domain analysis. To 
set the resolution bandwidth, Click Res BW, and use the 
multipurpose knobs or keypad to set the resolution 
bandwidth. 

Set the time domain 
controls 22. The Time domain controls determine the sample rate and 

record length of the acquisition. These controls allow you 
to change the duration on the acquisition without changing 
the sample rate. From the Spectral Analysis Setup menu, 
click Resolution and adjust the time interval between data 
samples of the input waveform. 

Note 

Resolution is the inverse of Sample rate. Adjust resolution 
to adjust sample rate. Resolution may also cause a change in 
record length such that the duration is kept constant at the 
value selected by the Duration control. 

23. To adjust the number of seconds over the duration of the 
acquired waveform (record length), click Duration, and 
use the multipurpose knobs or pop-up keypad to adjust the 
duration. 

Note: Changing duration also changes the record length. 

24. Gate position is the position of the phase reference point in 
the gate with respect to the trigger in seconds. The gate 
position and gate duration must be within the acquisition. 
To set the gate position, click Gate Pos, and use the 
multipurpose knobs or pop-up keypad to adjust the gate 
position. 

25. Gate duration and resolution bandwidth are the same. 
Gate duration is displayed in seconds and resolution 
bandwidth in hertz. To set the gate duration, click Gate 
Dur, and use the multipurpose knobs or pop-up keypad to 
adjust the gate duration. 

Take cursor 
measurements 26. From the toolbar, click the Cursors button to display the 

cursors and open the Cursor control window. 

27. Select the Math tab, and click the channel button for the 
spectral waveform that you want to measure. 

28. Select the cursor type. For more information, see Taking 
Cursor Measurements on page 355.  

29. Use the multipurpose knobs to position each cursor on the 
waveform to measure the feature(s) that interests you. 
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30. Read the results in the cursor readout.  

The cursor readout is displayed under the multipurpose 
readouts as shown here or in the upper right corner of the 
graticule area. 

The figure shows the cursor measurement of a frequency 
magnitude on an FFT. The readout reads 0 dB because it is 
aligned with the 1 VRMS level. The other readout reads 
24.4 dB indicating the magnitude of the frequency it is 
measuring is 24.4  dB relative to 1 VRMS. Display of the 
source waveform is turned off. 

The cursor units will be in dB or volts for magnitude waveforms 
and in degrees or radians for those measuring phase.  

31. Select V Bars, and use the multipurpose knobs to align the 
two vertical cursors to points of interest along the 
horizontal axis of the waveform.  

32. Read the frequency difference between the cursors from 
the ∆: readout. Read the frequency of each cursor relative 
to the zero frequency point from the cursors readout. 

Setting Up Mask Testing  
To set the instrument to perform mask tests, do the following procedure. 

Prerequisites 1. Connect the instrument to the source signal, or save the 
source signal to a math or reference waveform memory 
location. 

Access the Mask Setup 
window 2. From the button bar, Click Masks. 

The instrument displays the Mask control window. 

Select a mask test signal 
source 

3. From the Source tab select the channel, math, or 
reference tab, and then select the waveform to use as the 
mask test source. You can only mask test one waveform 
at a time. 

Select the mask type 
4. To specify the mask Type, select the Masks tab. Click the 

appropriate button in the Type field. Click the More button 
to display further selections. 

Note 
Industry standard masks are available with Option SM. 

The window lists mask types and standards that are 
available on your instrument. 

Selecting a mask type and standard adjusts the instrument 
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horizontal, vertical, and trigger settings to those appropriate 
for displaying a waveform of the specified type. If the signal 
is not within the mask, click the Autoset button to center the 
waveform in the mask. If Autoset did not align the signal in 
the mask, adjust the instrument vertical and horizontal 
controls. 

If you click the Autoset button and the Autoset Undo preference is 
On, the instrument will display an Autoset Undo window. Click 
the Undo button to return to the previous settings, or click the 
Close button to remove the window. 

Select the mask standard 5. To specify the mask standard, select a standard from the 
drop-down list.  

Select display parameters 
6. In the Masks tab, click the Display button to toggle mask 

display on or off. The mask must be turned on to do mask 
testing. 

7. Click the Hit Count button to turn on or off hit counting. 
The hit count is shown in the Pass/Fail Results tab. 

8. Click the Display Config button to set mask hit 
highlighting and to lock the mask to the waveform. Lock 
Mask to Waveform resizes the mask to reflect changes in 
the horizontal or vertical settings of the instrument. This 
control is also on the main mask setup window. 

Autoset the signal 
9. In the Masks tab, click the Autoset button to have the 

instrument automatically adjust instrument settings to align 
the waveform to the mask based on the characteristics of 
the input signal. Autoset is done on the first waveform 
acquired after clicking the Autoset button. 

If the Autoset Undo preference is On, the instrument will 
display an Autoset Undo window. Click the Undo button to 
return to the previous settings, or click the Close button to 
remove the window. 

The Autoset Config button opens a configuration window that lets 
you set the vertical, horizontal, and trigger autoset parameters, 
activate autofit or autoset, choose the autoset mode, return to the 
default autoset configuration, or return to the Mask Setup control 
window. 

Enable and set waveform 
autofit parameters 10. In the Masks tab, click the Autofit button to enable the 

waveform autofit function. Autofit checks each waveform 
for any mask hits. If there are hits, autofit repositions the 
waveform to minimize hits. The number of hits reported is 
the number after autofit has minimized hits. 

The autofit Config button lets you set the autofit maximum 
waveform repositioning parameters (as a percentage of the 
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horizontal and vertical divisions), return to default settings, 
or return to the Mask Setup control window. Use the keypad 
to change the vertical or horizontal autofit parameters. 

11. Click the Masks button to return to the Mask control 
window. 

Set mask test tolerance 
margins 12. Click the Masks Setup window Tolerance tab to set the 

percentage of margin used in the mask test. Use the control 
knob, keypad, pop-up keypad, or up and down arrow 
buttons to enter the mask margin tolerance percentage. The 
range of values is –50% to 50%. 

Margin tolerance settings greater than 0% expand the size of the 
segments, making the mask test harder to pass; margin tolerance 
settings less than 0% (negative percent) reduces the size of the 
segments, making the mask test easier to pass. 

Set mask test pass and 
fail parameters 13. Select the Pass/Fail Setup tab of the Masks control 

window.  

14. Use the control knob, keypad, or pop-up keypad to enter 
the number of waveforms to test (number of samples in 
some modes), the failure threshold (the number of 
waveforms that must fail to fail the test), and the delay 
time (the time from when mask test starts to when the 
instrument begins sampling). 

15. Use the Failure field buttons to set what the instrument 
does when a mask test fails; have the instrument beep 
(BEEP), send an SRQ out on the GPIB bus (SRQ), stop 
signal acquisition immediately (Stop Acq), send email (E-
mail), and/or print the instrument screen image to a printer 
(Print). 

You many need to select a sound source to enable the BEEP. See 
Selecting the Sound Source on page 346 for more information. 

16. Clicking the More button displays more failure functions. 
Save Wfm saves the the waveform data of the first 
waveform that causes the test to fail to a .wfm file. Log 
Date saves time, date, and basic test information of the 
first waveform that causes the test to fail to an ASCII text 
(.txt) file. 

Both files are saved to the location specified by the Path button. 
The file name format is YYMMDD-HHMMSS, where YY is 
year, MM is month, DD is day, HH is hour, MM is minutes, and 
SS is seconds. 

17. Use the Completion field buttons to set what the 
instrument does at the completion of a mask test. 

18. Use the Polarity buttons to set mask and waveform 
polarity. Positive tests the positive waveform pulses. 
Negative inverts the mask and tests the negative waveform 
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pulses. Both tests the first half of the tested waveforms in 
positive polarity mode, then tests the remaining waveforms 
in negative polarity mode. 

19. Toggle the Repeat button to On to set the instrument to 
repeat (continue) mask testing on the completion of each 
test. 

Creating a User Mask from a Defined Mask 
(Option) 

Refer to Mask Key Points on page 284 before creating or editing a mask. To create a user mask 
from a defined mask, do the following procedure. 

Access the Mask Setup 
window 1. From the button bar, click Masks and select the Masks tab.  

The instrument displays the Mask control window. 

Select the mask type and 
standard 2. Click the appropriate button in the Type field to select a 

mask type. Click the More button to display further 
selections. 

Note 
Industry standard masks are available with Option SM. 
Only User masks are the only mask type available without 
Option SM. 

3. Select a standard from the drop-down list. 
The control window lists mask types and standards that are 
available on your instrument. 

Copy current mask 
4. Click the User Mask button. 
5. Click the Copy Current Mask to User Mask button. The 

instrument copies the current mask to the user mask 
memory. 

Edit the User mask 6. See Edit User Mask procedure on page 373. 

Save the user mask to 
disk 7. See Saving a User Mask to Disk procedure on page 342. 

You do not need to save the edited user mask to disk, as the 
instrument retains the current user mask in nonvolatile memory. 
However, if you plan to create a number of user masks, you will 
need to store the user masks on disk or the hard drive, as the 
instrument can only load one user mask at a time. 
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Editing a User Defined Mask  
Access the mask edit 

window 1. From the button bar, click Masks, and select the Masks tab.  
2. Click the User Mask button. 
3. Click the Edit User Mask button. The instrument displays 

the Mask Edit control window. 

Enable the mask edit 
controls 

4. Click the Controls button to open the mask edit controls 
window on the right side of the screen. This provides the 
maximum area to display the mask, making editing easier. 

Select a segment 5. Click the Segment field and use the arrow buttons, 
multipurpose knob, or keypad to select a segment to edit. 
The selected (active) segment is highlighted in red. Each 
mask can have up to 16 segments. 

Select a vertex 6. Click the Vertex field and use the arrow buttons, 
multipurpose knob, or keypad to select the vertex to edit. 
The active vertex is indicated with an X on the template 
segment. Each segment can have up to 50 vertices. 

Move a vertex 
7. Click the Horizontal field and use the multipurpose knob or 

keypad to change the selected vertex horizontal position. 
8. Click the Vertical field and use the multipurpose knob or 

keypad to change the selected vertex vertical position. 

Add or delete a vertex 
9. To add a vertex, select the closest vertex that is clockwise 

from where you want to place a new vertex. Click Add to 
add a vertex midway between the selected vertex and the 
next counterclockwise vertex. 

10. To delete a vertex, enter or select the vertex number. Then 
click Delete to delete the selected vertex. The remaining 
vertices located counterclockwise from the deleted vertex 
are renumbered. 

Save the user mask to 
disk 11. See Saving a User Mask to Disk procedure on page 342. 

You do not need to save the edited user mask to disk, as the 
instrument retains the current user mask in nonvolatile memory. 
However, if you plan to create a number of user masks, you will 
need to store the user masks on disk or the hard drive, as the 
instrument can only load one user mask at a time. 
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Saving a User Mask to Disk  
Access the Mask Setup 

window 1. From the button bar, click Masks and select the Masks tab. 
2. Click the User Mask button.  
3. Click the Edit User Mask button. The instrument displays 

the Mask Edit control window. 

Save the user mask to 
disk 4. Click the Mask Save button.  

The instrument opens the Save As dialog box. The default save 
location is in the TekScope/Masks folder. 

5. Enter the mask name in the File Name field. The default 
save type is User Mask Files (*.msk).  

6. Click Save to save the mask to disk. 

Recalling a User Mask from Disk  
Access the Mask Setup 

window 1. From the button bar, click Masks and select the Masks tab. 
2. Click the User Mask button.  
3. Click the Edit User Mask button. The instrument displays 

the Mask Edit control window. 

Recall the user mask from 
disk 4. Click the Mask Recall button.  

The instrument opens the Recall dialog box. The default 
recall location is the TekScope/Masks folder. If the mask 
files are in another folder, use the navigation controls to 
access the appropriate folder. 

5. Select the mask name. 
6. Click Recall to load the user mask into user mask memory 

on the instrument. 

Alternatively, the mask can be recalled by selecting Recall 
from the File Menu. This opens the Recall dialog box where 
you can navigate to and select the mask that you want to recall. 
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Creating a New User Mask  
To create a new user mask that is not based on an existing mask, do the following procedure. 

Set instrument settings 1. Use the communications trigger features to trigger the 
instrument on a signal. The instrument saves these settings 
with the mask information. 

Create an empty user 
mask 2. From the button bar, click Masks, and select the Masks tab.  

3. Click the User Mask button. 
4. Click the mask standard field to display the drop-down list. 
5. Select None from the list.  
6. Click the Copy Current Mask to User Mask button. If you 

are asked if you want to overwrite the current user mask, 
click the Yes button. 

Create an edit new mask 
segments 7. Click the Edit User Mask button to display the user mask 

edit functions. 

8. Click the Segment field, and use the arrow buttons, 
multipurpose knob, or keypad to enter or select segment 1. 

9. Click the Vertex Add button. The instrument draws the 
default new segment shape, a triangle. 

10. Use the instructions on Editing a User Mask on page 341, 
starting at step 5 to edit a segment. 

11. Repeat steps 9 through 11, selecting an unused and 
sequential segment number, to create and edit more 
segments. 

Save the user mask to 
disk 12. See Saving a User Mask to Disk procedure on page 342.  

You do not need to save the user mask to disk, because the 
instrument retains the current user mask in nonvolatile memory. 
However, if you plan to create a number of user masks, you will 
need to store the user masks on disk or the hard drive, because the 
instrument can load only one user mask at a time. 
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Using Limit Testing 
Prerequisites 1. Make sure the waveform that you want to use for a 

template exists. Your source can be either an active or a 
saved channel, math, or reference waveform. 

Create template 
2. Select the source for your template. 
3. Select the destination for storing the template. 
4. Set the tolerances specifying the amount of variation from 

the template. 
5. Click Save to save the template to the location specified in 

step 3. 
You can create multiple templates and save them in Ref1-Ref4 or 
to a location of your choice. 

Select waveform to 
compare 6. Select the source for the waveform that you want to 

compare against the template. 
7. Select the template that you want use for the limit test. If 

the template that you want to use is stored in a location 
other than Ref1–4, then you must first recall the template 
waveform to one of the reference locations. See Recalling 
a Template Waveform on page 357.  

Set up the limit test 
options 8. Click Config to set up the action that you want the 

instrument to take upon failure of the limit test. 

Note 
The instrument can take multiple actions. 

9. Turn Lock Template to Waveform on if you want to be able 
to move the source waveform and the template vertically 
together; turn it off to move them vertically independent of 
each other. 

10. Click Highlight Hits on to show points that fall outside the 
template in a different color. 

Activate limit testing 
11. Click the Limit Test button On to begin testing. 
12. Click Reset to clear the highlighting of points that violated 

the template. 
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Sending E-mail on Events 
Prerequisites You must have Option SM installed to be able to send e-mail on 

Mask Test Failure. 

Setup E-mail on Event 
1. From the Utilities menu, select E-mail on Event Setup. 
2. Enter the recipients’ e-mail addresses in the box.  
3. Click Config, and enter your SMTP server address.  
4. Select the events on which to send e-mail.  
5. Select which types of e-mail attachments you want to 

include. 
6. Set the maximum message limit. (The maximum allowed by 

the system is 50.) 
7. Set the maximum message size. 

The default is 1 MB the maximum is 2 GB. Setting the maximum 
message size to 0 causes attachments to be saved to the default 
location on the instrument hard drive. 

8. Click Send to send a test e-mail.  

Set up e-mail on Limit test 
failure  

1. See Using Limit Testing on page 344 to set up the limit 
test. 

2. Under Failure Notification, click Config, and then click E-
mail On. 

3. Click the Limit Test button On to begin testing. 

Set up e-mail on Mask test 
failure 

1. See Setting up the Mask Test on page 337, and follow the 
procedure for setting up a mask test.  

2. Under Pass/Fail Test Notifications, click E-mail to On. 
3. Click the Pass Fail Test button On to start the mask test. 

Click the Repeat button for continuous mask testing. 

Set up e-mail on Trigger 
1. Select the trigger type. 
2. Select the trigger source. 
3. Set the appropriate parameters for the trigger. 
4. From the Mode tab, click E-mail on Trigger to On. 
5. Press the Run/Stop button to begin acquiring data to 

trigger. 
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Selecting the Sound Source 
Your instrument is shipped with an internal speaker that some of the software features use to send 
an audible alert to the user. To enable this speaker, the sound card in your instrument must be 
turned off. With the sound card off, you will not have access to standard Windows audio features, 
such as the ability to listen to a music CD. 

If you turn the sound card on, the internal speaker is disabled. You will need to connect 
headphones or an amplified speaker to the headphone jack on the instrument to hear the alerts.  

The default setting disables the sound card. 

To turn the sound card on or off, perform the following procedure: 
Access the device 

manager 
1. From the File menu, click Minimize, or press CTRL+M to 

minimize the instrument application. 
2. On your Windows desktop, right-click the My Computer icon. 
3. Click Properties. 
4. In the System Properties dialog box, click the Hardware tab. 
5. Click the Device Manager button. 

Select the source 6. Double-click Sound, video, and game controllers. 
7. Double-click SigmaTel C-Major Audio. 
8. In the Device usage drop-down list, click either Use this device 

(enable) or Do not use this device (disable). 

Save your changes 9. Click OK. 
10. Close the Device Manager dialog box. 
11. Close the System Properties dialog box. 

Saving a Waveform 
Use this procedure to save a waveform or waveforms to a reference location, the instrument hard 
disk, a CD, or third-party storage device. 

Prerequisites 
1. The instrument must be powered up. 
2. Make sure the waveform to be saved exists. Your source 

must be a channel, an active math waveform, or an active 
reference waveform. Display the waveform with the setup 
in which you want to save it. 

Open the Save dialog box 3. From the File menu select Save or Save As. Under Save 
What, click Waveform. 

Select the waveform to 
save 

4. From the Source drop-down list select the waveform that 
you want to save. Only available waveforms are displayed 
in the list. 
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Save the waveform to a 
reference 

5. Select the location (Ref 1–4) under Save in Oscilloscope 
Memory. Click Save to save your waveform to that 
reference location. Data in the existing reference will be 
overwritten. 

Save the waveform to a 
file 6. To save the waveform to a file, select the location to save 

from the Save in drop-down list. The default location is 
C;\TekScope\Waveforms. 

7. Name your waveform file by typing a name in the Name 
text box, or select an existing name from the file list (data in 
the existing file will be overwritten).  
OR 
Select the Auto-increment file name check box to save a 
series of files without typing in a new name each time. For 
more information, see Saving Reference Waveforms Using 
Auto-Increment File Name on page 356. 

Tip 

If you do not have an attached keyboard, click the keyboard 
icon to display a virtual keyboard.  

8. The file extension specified in the Save as Type list will 
automatically be appended to the file name. You can select 
from these file formats: 

 wfm is an internal instrument format 

 csv is usable by spreadsheets such as Microsoft Excel. 

 dat is usable by Mathcad and MATLAB. 

 txt is the standard text file format. 

9. If your file type is other than .wfm, click the Options button 
to set up the Waveform Save Options. 

Set waveform save 
options 10. Select the data format (Data destination) for the waveform 

that you want to export. 
11. Select a valid waveform from the Source list.  
12. Under Waveform Detail, select the Include waveform scale 

factors check box if you want to include waveform details 
like header information (record length, sample interval, 
trigger point information, and so on). If you only want to 
include the waveform voltage values, clear the selection. 

13. Under Waveform Data Range, select the samples that you 
want to save. You can select a range of samples, only the 
samples between the cursors, samples in a Zoom Area, or 
All samples. If you select Samples between cursors, you can 
use the multipurpose knobs to adjust the positions if the 
cursors are active. If they are not, the cursors are activated 
in their most recent positions. 

14. If you are using FastFrame, select the frame range to include 
in the saved waveform: 
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 Frames to enter a range of frames to include in the 
saved waveform  

 All Frames to include all frames in the saved waveform 
15. If you are exporting Fast Acquisitions data, select the data 

ordering from the list. 
16. Click OK, and then click Save to save the waveform file. 

To cancel without saving, click Cancel. 

Saving a Screen Capture 
Use this procedure to save screen captures to the instrument memory, a CD, or third-party storage 
device. 

Prerequisites 1. Images you want to save must be displayed in the 
graticule. 

Open the Save dialog box 2. From the File menu select Save or Save As. Under Save 
What, click Screen Capture. 

Set the screen capture 
options 3. Click the Options button to open the Screen Capture Save 

Options dialog box. 
4. Select a color Palette for your screen capture. 
5. Under View: to save an image of the entire screen, select 

Full-screen; to select an image of the selected graticule, 
select Graticule(s) only; select Hide Menu Toolbar check 
box if you do not want the menu and toolbar included. 

6. Select the type of image from the Image list. To save the 
image exactly as it appears on the screen, select Normal. To 
export the image on a white background, select Ink-saver 
Mode. 

7. Select a data format from the Screen Capture Format list.  
8. Click OK to save the screen capture options, or click 

Cancel to close the dialog box without saving the changes. 

Save the screen capture 
to a file 9. To save the screen capture to a file, select the location to 

save from the Save in drop-down list. The default location is 
C:\TekScope\Screen Captures. 

10. Name your screen capture by typing a name in the Name 
text box, or select an existing name from the file list (data in 
the existing file will be overwritten).  
OR 
Select the Auto-increment file name check box to save a 
series of files without typing in a new name each time.  

11. Click Save. 
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Saving Measurements 
Use this procedure to save measurements to a spreadsheet or text format.. 

Prerequisites 1. Measurements that you want to save must be selected. 

Open the Save dialog box 2. From the File menu select Save or Save As. Under Save 
What, click Measurement. 

Set the measurement 
options 3. Click the Options button to open the Measurement Save 

Options dialog box. 

4. Select either Displayed Measurements or Measurements 
Snapshot.  

5. Select the Measurement Format from the drop-down list. 
6. Click OK to save the measurement options, or click 

Cancel to close the dialog box without saving the changes. 

Save measurements to a 
file 7. To save the measurements to a file, select the location to 

save from the Save in drop-down list. The default location is 
C:\TekScope\data. 

8. Use the default name for your file, or type a unique name in 
the Name text box, or select an existing name from the 
Name list (data in the existing file will be overwritten).  
OR 
Select the Auto-increment file name check box to save a 
series of files without typing in a new name each time.  

9. Select the file type from the Save as type drop-down list 
(.cvs for spreadsheets, .txt for text). This is the same as the 
Measurement format that you selected in the Options dialog 
box. Changing the file type here will also change the 
selected format in the Option dialog. 

10. Click Save.  

Copying Waveform Data 
Use this procedure to copy waveforms, images, or measurements to the Windows clipboard: 

Prerequisites 1. Make sure the waveform, image, or measurement to be 
copied exists; that is, your source must be a channel, an 
active math waveform, an active reference, and so on. 

Select format for copy 
2. Highlight the Select for Copy submenu on the Edit menu. 

The submenu lists all available waveform, image, and 
measurement types available for export: 
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 Full Screen exports a bitmap of all screen contents 

 Graticule exports a bitmap of only the graticule area 

 Waveform exports waveform data 

 Measurements exports measurement data 
Select setup for copy 3. Select Copy Setup from the Edit menu to open the Copy 

Setup control window. 

Set image copy options 
4. Select a color Palette for your copied images. 
5. Select the image View: to copy an image of the entire 

screen, select Full-screen; to copy an image of the selected 
graticule, select Graticule(s) only. 

6. Select the type of image from the Image list. To copy the 
image exactly as it appears on the screen, select Normal. To 
copy the image on a white background, select Ink-saver 
Mode. 

7. Select the Data Format, either BMP or JPG. 

Set waveform copy 
options 8. Select the Waveforms tab.  

9. Select the data format (Data destination) for the waveform 
that you want to copy.  

10. Select a valid waveform from the Source list.  
11. Select the Include waveform scale factors check box if you 

want to include waveform details like header information 
(record length, sample interval, trigger point information, 
and so on). If you only want to include the waveform 
voltage values, clear the selection. 

12. Select the number of samples that you want to copy from 
the Waveform curve data range. Select all samples, a range 
of samples, or only the samples between the cursors. If you 
select Data between cursors, you can use the multipurpose 
knobs to adjust the positions if the cursors are already 
active. If they are not, the cursors are activated in their most 
recent positions. 

13. If you are using FastFrame, select the frame range to include 
in the exported files: 

 All Frames to include all frames in the exported files 

 Frames to enter a range of frames to include in the 
exported files 

14. If you are copying Fast Acquisitions data, select the data 
ordering from the list. 

Set measurement copy 
options 15. Select the Measurements tab.  

16. Select the data format for the measurement that you want to 
copy.  

17. Select Displayed Measurements to copy all measurements 
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that are displayed on screen, or Measurements Snapshot to 
copy the current snapshot data. If there is no valid 
snapshot data, the default snapshot values are copied. 

Copy the data 18. Click Copy to save your setup information. The copy 
operation takes place after you click Copy. 

Creating MyScope Control Windows 
Use this procedure to create your own control windows: 

Prerequisites 1. Select New Control Window… from the MyScope menu. 

Select controls 
2. Click a control group to display the available controls 

within that group. 
3. Click a control. The control displays in the preview 

window. 
4. Clear the checkbox for any control that you do not want to 

appear. Most controls show all controls selected by 
default. 

Place, move, and delete 
the controls 5. Drag the customized control to your MyScope control 

window. You can also move a control after it has been 
placed in the new control window by dragging it. 

6. To remove the control from the custom control window 
select it, and then click the Delete button. 

Create tabs 
7. Click New Tab to add up to eight tabs. 
8. Click the Rename Tab to create a unique name for each 

tab in your control window. 

Set User Preferences 
9. Click the User Pref… button, and then select the user 

preferences that you want to apply to this control window. 
10. By default the preferences are the same as what is 

currently set on your instrument. The preferences you set 
from the MyScope Setup window only apply to your 
MyScope control window. The preferences will take effect 
when the MyScope control window is activated. 

Save 11. Click Save or Save As… to save your MyScope control 
window. 

12. Enter a unique name for your MyScope control window 
and, click Save. (This name will display in the upper right 
corner of the control window when you open it.) The 
default location to save MyScope files is 
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C:\TekScope\MyScope. 

Recall 13. From the MyScope menu, click Open Control Window…. 
14. Select the MyScope control window that you want from 

the Open MyScope Control Window dialog box and click 
Open. 

Editing MyScope Control Windows 
Use this procedure to edit previously defined MyScope control windows. 

Prerequisites 1. Select Edit Control Window… from the MyScope menu. 

Select control window to 
edit 2. Select the MyScope control window that you want to edit 

from the Open MyScope Control Window dialog box. The 
control window that you selected opens in the MyScope 
Setup control window. 

Make changes 3. Edit the control window using the same procedures as you 
did to create the control window on page 351.  

Save 4. Click Save to save your changes to this control window. 
5. Click Save As to save your changes as a different control 

window. Enter a unique name for your MyScope control 
window, and click Save. The default location to save 
MyScope files is C:\TekScope\MyScope.  
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Tasks 
Calibrating Active Probes 

Use this procedure to optimize gain and offset accuracy at the probe tip for each active probe. 
Allow the instrument to warm up for 20 minutes before performing this procedure. Then complete 
the following steps: 
1 If you have not already done so, connect the probe to the instrument. 
2 Connect the probe to the probe compensation terminals as shown. Connect only one probe 

at a time. 
3 Select Probe Cal… from the Vertical menu to open the Probe Calibration control window. 
4 Select the channel to which the probe is attached. 
5 Click Calibrate Probe to begin the calibration procedure. The Probe Status indicator 

changes to Pass when the procedure is complete. If the procedure does not pass, contact 
your local Tektronix service personnel. 

6 Remove the connections from the terminals. 

Calibrating Passive Probes 
Use this procedure to optimize gain and offset accuracy at the probe tip. Allow the instrument to 
warm up for 20 minutes before performing this procedure.  

If you have not already done so, perform the low frequency probe compensation for passive 
probes. 

Note 
The probe calibration procedure is not recommended for the P5050 passive probes. These probes 
have little gain or offset errors. However, you should perform this procedure for other passive 
probes. 

Complete the following steps: 
1 If you have not already done so, connect the probe to the instrument. 
2 Connect the probe to probe compensation terminals as shown. Connect only one probe at a 

time. 
3 Select Probe Cal… from the Vertical menu to open the Probe Calibration control window. 
4 Select the channel to which the probe is attached. 
5 Click Calibrate Probe to begin the calibration procedure. The Probe Status indicator 

changes to Pass when the procedure is complete. If the procedure does not pass, contact 
your local Tektronix service personnel. 

6 Remove the connections from the terminals. 
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Deskew 
Use the following procedure to compensate for timing differences between voltage probes: 
1 Set up the instrument to display all of the channels that you want to deskew. 
2 Push the instrument AUTOSET button. 
3 Adjust the vertical SCALE and POSITION controls for each channel so that the signals 

overlap and are centered on the display. 
4 Adjust the horizontal POSITION so that a rising edge is triggered at the center of the 

display. 
5 Adjust the horizontal SCALE so that the differences in the channel delays are clearly 

visible. 
6 Adjust the horizontal POSITION again so that the first rising edge is exactly at the center of 

the display. The fastest probe is connected to this channel (the fastest probe is usually the 
one with the shortest cable or with the highest bandwidth). 

7 Select Deskew from the Vertical menu to open the Deskew control window. 
8 Select one of the slower channels. 
9 Adjust the deskew time for the slower channel so that its signal aligns with that of the 

fastest channel. The deskew adjustment range is ±75 ns.  
10 Repeat steps 8 and 9 for each additional channel that you want to deskew. 
11 Remove the connections from the probe compensation terminals.   

Note 
To compensate for timing differences between voltage and current probes, order the Probe 
Calibration and Deskew Fixture (067-0405-02). The fixture requires a user-supplied pulse 
generator when used with a TDS5000B Series instrument. 

Signal Path Compensation 
Use this procedure to compensate the internal signal acquisition. You should perform this 
procedure if the temperature has changed more than 5° C since the last signal path compensation 
was performed. 

Note 
When making measurements at vertical scale settings less than or equal to 5 mV, you should 
perform the signal path compensation at least once a week. Failure to do so may result in the 
instrument not meeting warranted performance levels at those volts/div settings. 
1 Power on the instrument and warm up for 20 minutes before continuing with this procedure. 
2 Disconnect any probes that you have connected to the input channels. 
3 Set the instrument to Menu mode. 
4 Select Instrument Calibration from the Utilities menu. 
5 Note any instructions that appear under Calibration Instructions in the resulting control 

window. 
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6 Click Calibrate to begin the procedure. The procedure may take several minutes to 
complete. 

7 Verify that the Status changes to Pass after the procedure is complete. If the Calibration 
Status field indicates anything other than Pass, see Signal Path Compensation Status for 
information on the readout and recommended action.  

Signal Path Compensation Status 
The following table lists the possible calibration status messages for signal path compensation and 
the recommended action. 

Status Meaning and recommended action 

Pass The instrument had warmed up for 20 minutes, there were no failures 
during the signal path compensation procedure, and the current operating 
temperature is within 5° C of the operating temperature when the 
previous signal path compensation was run. 

Fail One or more failures occurred during the signal path compensation 
procedure. Contact your local Tektronix service representative for further 
action. 

Temp The operating temperature is not within 5° C of the previous signal path 
compensation.  

Warmup The instrument has not warmed up for 20 minutes. Wait for the 
instrument to warm up for at least 20 minutes before running the signal 
path compensation procedure. 

Low Frequency Probe Compensation 
Use this procedure to compensate passive probes to ensure maximum distortion-free inputs to the 
instrument. 
1 If you have not already done so, connect the probe to channel 1 on the instrument. 
2 Attach the probe tip and reference lead to the probe compensation terminals as shown. 
3 Press the AUTOSET button on the instrument. 
4 Adjust the probe until you see a square wave with a perfectly flat top on the display. See 

your probe manual for adjustment instructions. 

Taking Cursor Measurements 
Use this procedure to take measurements with cursors. 
1 To open the Cursor control window, press the Cursors button on the front panel, click 

Cursors on the toolbar, or click Cursor Setup from the Cursors menu. 
2 Select the waveform that you want to measure and a Cursor Type from the control window. 
3 Position the cursors with the multipurpose knobs. 
4 Read the cursor information from the Position controls. 

 Select the cursor mode (Tracking or Independent) in the Cursor Setup control window. 
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Creating Reference Waveforms 
Use this procedure to create reference waveforms from active or math waveforms. 
1 Click Save on the toolbar or click Save As from File menu. 
2 Select Waveform from the Save As dialog box. 
3 From the Source list, select the waveform that you want to save as a reference. 
4 Click Ref(n) under Save in Oscilloscope Memory to save the waveform to nonvolatile 

memory. Or select a location from the Save in list to save the waveform to a file, and then 
use the pop-up keyboard to enter a meaningful name for the waveform in the Name text 
box. 

5 Click Save. 

Note 
When you save a waveform as a reference waveform, a file containing the waveform data is 
created in C:\TekScope\Waveforms. The file is named TDS_REFn.WFM, where n is the 
reference waveform number. Do not manually delete this file because the data will no longer be 
available. 

Saving Reference Waveforms using Auto-
Increment File Name 

Use this procedure to repetitively save waveforms without typing in a large number of unique file 
names.  
1 Click Save on the toolbar or click Save As from File menu. 
2 Select Waveform from the Save As dialog box. 
3 From the Source list, select the waveform that you want to save as a reference. 
4 Select Auto-increment file name in the Save As dialog box. 
5 Enter a descriptive name in the Base file name text box. For example, if you are saving a 

series of rise time data files, you can use "Risetime" as the base file name. 
6 The Count text box defaults to "000". Change this if you want to start saving your series of 

files with another 3-digit number. 
7 Change the file type if necessary. 
8 Click Save. 

Your first file is saved as Risetime000.ext , where ext is the file type extension. The next file will 
be Risetime001.ext , and so on. 

If Count reaches 999, it is suggested that you change the base file name to, for example, 
Risetime1on the next save. Your next file will then be saved as Risetime1000.ext. You will 
receive a warning message if you are going to overwrite any existing files with the same name. 

 Use the auto-increment file name feature to save a series of setups, exported images, waveforms, 
and measurements. 
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Recalling Reference Waveforms 
Use this procedure to recall a reference waveform from a file. 
1 Click Recall on the toolbar or select Recall from the File menu. 
2 Select Waveform from the Recall dialog box.  
3 Select the waveform that you want to recall and the Destination (Ref 1–4). 
4 Click Recall to load the waveform into memory. 

You can now use the reference waveforms for measurements, math functions, or other uses. 
Simply select the reference waveform from the Channel Selector tabs on the individual control 
windows. 

Note 
When you recall a reference waveform from a file, a new file containing waveform data is created 
in C:\TekScope\Waveforms. The file is named TDS_REFn.WFM, where n is the reference 
waveform number. This file is deleted when the reference waveform is deleted. 
 

Recalling a Template Waveform 
Use the procedure to recall a template waveform to a reference location. 
1 From the File menu click Recall…. 
2 Under Recall What: click Waveform, and then select the waveform that you want to recall. 
3 Select Ref1–4 from the Destination list. 
4 Click Recall. 

Creating a Spectral Waveform 
Use these steps to display a spectral (FFT magnitude) waveform.  
1 Set the source signal Vertical SCALE so that the signal peaks do not go off screen. Off-

screen signal peaks can result in FFT waveform errors.  
2 Set the Horizontal SCALE control to show five or more cycles of the source signal. 

Showing more cycles means the FFT waveform can show more frequency components, 
provide better frequency resolution, and reduce aliasing. 

3 If the signal is a single-shot (transient) signal, make sure that the entire signal (transient 
event and ringing or noise) is displayed and centered on the screen.  

4 Click Math on the toolbar, or click Math Setup from the Math menu to open the Math Setup 
control window.  

5 Click Setup under the Spectral Analysis section in the control window. 
6 Click the Magnitude button to insert the magnitude function into the math expression.  
7 Click the channel that is related to the time-domain signal that you want to view as an FFT 

waveform. The respective channel is inserted into the math expression. 
8 Select the appropriate vertical scale and FFT window type.  
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Setting up for FastFrame Operations 
Follow these steps to use FastFrame mode: 
1 Set up the Trigger control window to trigger on the signal of interest. 
2 Adjust the horizontal and vertical controls to display a waveform without any clipping. 
3 Adjust the Resolution controls to set the number of samples you want to acquire with each 

acquisition. 
4 From the Horiz/Acq menu, select FastFrame Setup, and then enter the number of frames 

that you want to capture in Frame Count. 
5 Select the type of Summary Frame from the list. Selecting Average or Envelope from the 

Summary Frame list replaces the last frame with one that is the computed average or 
envelope of all frames in the set. 

6 Click the FastFrame button to turn on the FastFrame mode. 
7 After the acquisition is complete, select the frame that you want to view under the Frame 

Viewing section of the FastFrame Setup control window. 
8 If you want to view multiple frames overlaid, select Overlay from the Multiple Frames list. 
9 Click the Start Frame field that is displayed, and then use the upper multipurpose knob to 

enter the Start Frame (first frame) in the frame sequence that you want to view. 
10 Click the # of Frames field, and then use the lower multipurpose knob to enter the total 

number of frames that you want to view. 
11 The selected range of frames is displayed with the frames superimposed over each other in 

the color of the selected Source, and the current (Selected Frame) is displayed 
superimposed in dark blue. 

Taking Automatic Measurements 
Use these steps to take automatic measurements. This procedure assumes that you are using the 
default reference levels.  
1 Open the Measurement Setup control window by clicking Meas on the toolbar or by 

clicking Measurement Setup on the Measure menu. 
2 Select the source waveform using the Channel Selector tabs, or press one of the front panel 

buttons. 
3 Select the desired measurements from the measurement tabs. Each measurement is 

automatically added to the measurement list. 

The measurement is added to the display in the same color as the selected channel waveform. 
When no control windows are open, the measurements are listed on the right side of the graticule. 

Note 

If the waveform is clipped by the edge of the graticule, the measurement readout will display 
question marks. 

 You can select an automatic measurement from the menu bar Measure menu by selecting the 
measurement type (for example, Amplitude) and clicking the measurement. The measurement is 
taken on the currently selected waveform. 
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Setting up a Dual Display 
Use the following steps to set up the instrument for dual display operation. You can use the main 
display for most instrument operations while you use a second monitor to access other PC 
applications that you may have installed. 

You can also drag up to five dockable control windows from the TekScope application onto the 
display of the second monitor. For example, this feature allows you to have the 
Horizontal/Acquisition, the Horizontal Zoom, and the Display Setup Control Windows (half 
screen) open on the second monitor at the same time. In addition to the five dockable windows on 
the second monitor, you can have one dockable window open on the main display. If you open a 
seventh dockable window, whichever window has not been used for the longest amount of time 
will automatically close. 

 You may want to print these instructions, since the operation requires you to power off the 
instrument. 

1 Power off the instrument. 
2 Connect an external monitor to the Video port (upper VGA port) on the side panel of the 

instrument. 
3 Power on the instrument and the external monitor. 
4 After the instrument display appears, click Minimize on the File menu or press CTRL+M to 

minimize the instrument application. 

  

5 Right-click on the desktop and 
select Properties to open the 
Display Properties dialog box. 

6 Click the Settings tab, and 
then click the secondary 
display monitor (the one on 
the right) in the dialog box. 

7 Select the Extend my 
Windows desktop onto this 
monitor checkbox. 

8 Ensure that the color is set to 
16 bit color. 

Caution 
Do not change the display 
settings for the internal 
monitor. The display settings 
must be 640 X 480 pixels. 
The colors must be set to 16 
bit color. Ensure that the 
second monitor is also set to 
16 bit color.  

If you use other settings, the video port may not work properly. You may however, use a 
resolution setting other than 640 X 480 on the second monitor. 
9 Click OK to apply the settings. The new monitor displays additional desktop area. 

You can now drag any item except for the instrument application from the desktop of the 
instrument (including the task bar) to the new monitor 
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 Note 
To disable the external monitor, click the Settings tab in the Display Properties dialog box. Click 
the external monitor and clear the Extend my Windows desktop onto this monitor checkbox at 
the bottom of the dialog box. 

Creating Math Waveforms using Predefined 
Expressions 

Use the following steps to create math waveforms using predefined expressions: 
1 Open the Math Setup control window by clicking Math on the toolbar or by clicking 

Math Setup in the Math window. 
2 Select a Math waveform by clicking one of the tabs in the control window. 
3 Click one of the Predefined Expression buttons in the control window. The predefined 

expression is added to the math expression at the top of the control window and the math 
waveform appears on the screen. 

 You can select Predefined Expressions directly from the Math menu. 

Creating Math Waveforms with the Equation 
Editor 

Use the following steps to create math waveforms using the Equation Editor.  
1 Open the Math Setup control window by clicking Math on the toolbar or by clicking 

Math Setup in the Math window. 
2 Click Editor under the Define/Edit Expression section of the Math Setup control window 

to open the Equation Editor. 
3 Select a Math waveform from the drop-down list. 
4 Select a math function by clicking a button under the tabs on the left side of the Equation 

Editor (for example, click Derivative). 
5 Select a valid waveform to use as an operand from the Channel Selector tabs. 
6 Use other buttons in the Equation Editor as necessary to create the math expression for the 

math waveform. 
7 Click OK to create and display the math waveform. 

 

Exiting the Instrument Application 
On the File menu, click Exit to exit the instrument application. 

To restart the instrument application, launch the TekScope icon from the Windows taskbar, Start 
menu, or your desktop. 
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Minimizing the Instrument Application 
To minimize the instrument application so that you can use other programs on the Windows 
interface, select Minimize from the File menu or right-click anywhere in the graticule and select 
Minimize from the shortcut menu. 

To restore the application, click the application name on the Windows task bar. 

 

Shutting Down the Instrument 
When you push the front-panel On/Standby switch, the instrument starts a shutdown process 
(including a Windows shutdown) to preserve settings and then go into standby mode. Avoid 
disconnecting the power cord to shut down the instrument. 

Note 
It may be necessary to hold the On/Standby switch for up to 20 seconds for the shutdown process 
to initiate. 

To completely remove power to the instrument, perform the shutdown process just described and 
disconnect the power cord from the power source. 

Adding Software Applications to the Instrument 
Because the instrument is an open Windows platform, you can easily install and remove additional 
software applications. Follow the instructions that came with your software and the basic 
Windows instructions to install and remove your application. 

Note 
When adding software to the instrument, avoid making changes to system files. See Windows 
Interface on page 39 for more information. 
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Creating an Emergency Startup Disk 
Now that you have completed the basic installation process, you should create an emergency 
startup disk that you can use to restart your instrument in case of a major hardware or software 
failure. Store this disk in a safe place. 

CAUTION 
Create this disk and store it in a safe place. It may allow you to recover your Windows 2000 
installation without rebuilding the entire instrument hard disk. 

The emergency startup disk contains basic files to restart your instrument. The disk also contains 
files to check and format the hard disk. 

Follow these steps to create the emergency startup disk: 
1 Minimize the instrument application by selecting Minimize in the File menu. 
2 From the Windows taskbar, select Start, Programs, Accessories, System Tools, Backup. 
3 In the Welcome display, click Emergency Repair Disk. 
4 Insert a floppy disk into the disk drive, and then follow the on-screen instructions to create 

the startup disk. 

Backing Up User Files 
Always back up your user files on a regular basis. Use the Windows Backup tool to back up files 
stored on the hard disk. The Backup tool is located in the System Tools folder in the Accessories 
folder.  

Use these steps to back up your files: 
1 Exit the instrument application by selecting the File menu Exit command.  
2 Click the Windows Start button. 
3 Select Programs, Accessories, System Tools, Backup. 
4 Use the Backup Wizard to select the items you want to back up and the destination. You 

can back up to the floppy drive or to a third-party storage device over one of the side-panel 
ports. 

Using Roll Mode 
Use Roll mode when you want to view data at very slow sweep speeds. It is useful for observing 
data samples on the screen as they occur. 

Roll mode turns on automatically at slower sweep speeds. You may want to turn Roll mode off to 
avoid conflicts with other instrument settings. To turn Roll mode off, deselect Roll Mode Auto on 
the Horiz/Acq menu. 
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TDS5000B Series GPIB Programmer Online Help 
You can control the instrument via GPIB from a remote PC or via an Internet or Intranet 
connection. The GPIB programming information is available as a separate WinHelp file that you 
can install. See the instructions in the TDS5000B Series Product Software CD booklet. 

The help file is also available as a PDF file on the TDS5000B Series Product Software CD-ROM 
shipped with the instrument. Refer to the CD-ROM instructions for installation information. 

TDS5000B Series Oscilloscope Applications 
Software 

You can install and run optional application software packages on the instrument. These software 
packages provide advanced capabilities that support several applications such as jitter analysis and 
disk drive measurements. Each application can be purchased and installed on the instrument at any 
time. Contact your Tektronix representative for purchasing information. Follow the installation 
instructions that come with the application. 

Run the application software from the File menu. From the File menu, select the application from 
the Run Application menu item. 

Application software packages have their own online help that is separate from the main 
instrument online help.  

Trigger on A Event Only 
Use this trigger sequence to trigger the instrument after the A event has occurred. 
1 Set the A trigger type and source from the A Event tab in the Trigger Setup control 

window. 
2 Click the A->B Seq tab, and click A Only. 

Triggering on an Event after a Specified Delay 
Use this trigger sequence to trigger the instrument on the B event after a specified amount of time 
after the A event. 
1 Set the A trigger type and source from the A Event tab in the Trigger Setup control 

window. 
2 Set the B trigger type and source from the B Event tab. 
3 Click the A->B Seq tab, and click Trig AfterTime. 
4 Click the Trigger Delay control, and then enter the delay time between the A and B  events. 
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Triggering on a B Event 
Use this trigger sequence to trigger the instrument after a specified number of B events. 
1 Set the A trigger type and source from the A Event tab in the Trigger Setup control 

window. 
2 Set the B trigger type and source from the B Event tab. 
3 Select the A->B Seq tab, and then click Trig on nth Event. 
4 Click the Trig Event control, and then enter the number of B  events that should occur 

before starting the acquisition after the A event. 

Setting up a Histogram  
Use these steps to set up a histogram. 
1 Click Waveform Histograms on the Measure menu. 
2 Use the Channel Selector tabs to select the waveform, and then use the other instrument 

controls to position the waveform in the center of the screen. 
3 In the Histogram Mode section, click either Horiz or Vert to turn on the histogram. 
4 Click Location under Adjust Histogram Box, and then use the multipurpose knobs to 

position the histogram box over the area of interest on the waveform. 
5 Click Limits button under the Adjust Histogram Box, and then use the multipurpose knobs 

to adjust the size of the histogram box. 
6 Select the type of scaling by clicking either Linear or Log under the Histogram Scaling. 

 Click the waveform handle to select the waveform (the waveform is selected if the waveform 
handle appears in reverse video). Hold the left mouse button and drag across the segment of the 
waveform that you want the histogram to cover and then select Histogram from the pop-up list 
on the screen.  

To turn off the histogram, click and drag a box across the screen and select Histogram Off or 
right-click on a histogram box and select Turn Histogram Off from the shortcut menu. 

Taking Automated Measurements on Histogram 
Data 

Use the following steps to take automatic measurements on histogram data. 
1 Set up a histogram box over the waveform on the screen. 
2 Open the Measurement Setup control window and select the Histogram tab. 
3 Click the histogram measurement buttons to add the measurements to the list. 
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Printing the Screen to a Printer 
The easiest way to print the contents of the screen is to press the front panel PRINT button. The 
instrument will print the screen contents according to the settings in the Page Setup dialog.  
1 Use the File menu Page Setup dialog to select the Type of printing, Palette, View, and 

Image before printing. The Type should be Screen-copy, the default.  
2 Use the Print Preview feature to test the appearance of the screen before printing. For 

example, you may want to experiment with the different palettes before sending the data to 
the printer. 

3 Click Print in either the Print Preview dialog box or in the Page Setup dialog box to open 
the Print dialog box. 

4 Click OK to begin printing. 

Copying the Screen for Use in other Applications 
Use the following steps to copy the contents of the screen for use in other applications such as 
WordPad, Microsoft Word, or Paint. 

1 Click Copy Setup on the Edit menu to open the Copy Setup dialog box. 
2 Click the Images tab. 
3 Select the Palette, View, and Image as needed for your application. 
4 Click Copy to paste the image to the clipboard. You can now paste the bitmap image into 

your other applications. 
5 If you want to copy another image to the clipboard, click Copy on the Edit menu or press 

Ctrl+C on the attached keyboard. 

Note 
If you try saving a copy of the screen to the clipboard by pressing the PrtScn button on the 
attached keyboard, the bitmap image will not contain any waveforms. Use the procedure above to 
save a copy of the entire screen (or the graticule) to the clipboard. 

 If your setup information does not change, you do not need to open the Copy Setup dialog box 
each time you want to copy. Use the Edit menu Select for Copy option if you need to change the 
type of items, for example, to copy waveforms instead of images. 

Copying Measurements for Use in Other 
Applications 

Use the following steps to copy the measurements for use in other applications such as WordPad 
or Microsoft Word. 
1 Click Copy Setup from the Edit menu to open the Copy Setup dialog box. 
2 Click the Measurements tab. 
3 Select the Data Format, either Numeric or Text. 



 366

4 Select either Displayed Measurements (make sure that measurements are displayed in the 
graticule via the Measurement Setup control window) or Measurement Snapshot (to copy 
measurement snapshots). 

5 Click Copy to paste the measurements to the clipboard. You can now paste the 
measurements into your other applications. 

Saving Instrument Setups 
Use this procedure to save your instrument setups. 
1 Use the instrument controls to set up the instrument for your application.  
2 Select Save As…from the File menu.  
3 Click the Setup icon. 
4 To save to oscilloscope memory, select one of the 10 locations under Save in Oscilloscope 

Memory. Give the location a meaningful label and click Save. Click OK when asked to 
Overwrite instrument setup. 

5 To save to a file, select a location from the Save in drop-down list. Then enter a name for 
the setup, use the default name, or select Auto-increment file name if you want to save a 
series of files without typing in a new name each time. 

Note 
The data in reference waveforms is not saved with instrument setups. However, the setup 
information includes which reference waveforms are turned on and which are used with math 
waveforms and automatic measurements. If you want to save the reference waveform data, save 
the reference waveform separate from the instrument setup. 

Related topic 

Creating Reference Waveforms see page 356.  

Recalling Instrument Setups 
Use this procedure to recall a saved instrument setup. 
1 Select Recall… from the File menu. 
2 Click the Setup icon on the Recall dialog box. 
3 Select the location where you saved the file from the Look in drop-down list. Then select 

the setup, and click Recall. 

Note 
The data in reference waveforms is not saved with instrument setups. However, the setup 
information does include which reference waveforms are turned on and which are used with math 
waveforms and automatic measurements. If you want to save the reference waveform data, save 
the reference waveform separate from the instrument setup. You can then recall the saved 
waveform to the restored setup. 

Related topic 

Recalling Reference Waveforms see page 357 
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Deleting Instrument Setups 
Use this procedure to delete an instrument setup saved to oscilloscope memory. 
1 Select the Delete submenu from the File menu.  
2 Then select the Setup that you want to delete, or select All Setups. 
3 Use this procedure to delete an instrument setup that you saved to a Windows directory. 
4 Select Recall from the File menu. 
5 Click the Setup icon and then select the directory where the setup was saved from the Look 

in drop-down list. 

6 Select the setup that you want to delete, and then click the  next to the directory. The 
setup is deleted. 

Choosing Color Palettes 
Use the following information to help you select a color palette. 
1 Click Colors on the Display menu, or click Disp on the toolbar, and then click the Colors 

tab. 
2 Click one of the color palettes from the Record View or FastAcq/WfmDB palettes for your 

application based on the following information: 

 Use the Normal palette to display hues and lightness levels for best overall viewing. 
 Use the Green palette to display waveforms and the graticule style in shades of green. The 

Green palette simulates the display of an analog oscilloscope. Areas of the waveform with the 
highest sample density appear in lighter shades while the areas of lower sample density appear 
in darker shades. 

 Use the Temp (temperature) palette to display variable persistence style waveforms. Areas of 
the waveform with the highest sample density appear in warmer colors (red shades), while 
areas of the waveform with lower sample density appear in cooler colors (blue shades).  

 Use the Spectral palette to display variable persistence style waveforms. Areas of the 
waveform with the highest sample density appear in blue shades, while areas of the waveform 
with lower sample density appear in red shades. 

 Use the Gray palette to display waveforms and the graticule in shades of gray. Areas of the 
waveform with the highest sample density appear in lighter gray shades, while areas of the 
waveform with lower sample density appear in darker gray shades. 

 Use the User palette to select the color previously defined or to assign a new color to the User 
palette. 

Note 

To define a color for the User Palette, follow the steps to Customize Color Palettes. 

Customizing Color Palettes 
1 Select the User color palette. 
2 Touch the Edit… button under User. 
3 Touch the Hue, Lightness, or Saturation controls, and use the pop-up keyboard to adjust 

these attributes. 
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Setting the Horizontal Delay 
Use the following steps to set up the horizontal delay mode of the instrument.  
1 Open the Horizontal/Acquisition Setup control window. 
2 Turn on the Horizontal Delay mode by clicking On under Delay Mode or pressing the front 

panel DELAY button. 
3 Use the Horiz Delay control to set the delay time. To view data before the trigger event, 

enter a negative value; to view data after the trigger event, enter a positive value. 

  You can also use the horizontal delay with complex trigger events in the Trigger Setup control 
window by clicking the A->B Seq tab and configuring horizontal delay. 

Comparing Data Using Horizontal Delay 
After setting up the instrument to use the horizontal delay, press the front panel DELAY button to 
turn the horizontal delay on and off. This lets you quickly compare two segments of a signal that 
are separated from each other by a fixed amount of time. 

Using the XY Display Format 
Use the following steps to set up the instrument in XY Display format. 
1 Determine the waveform pairs that you want to use. 
2 Click Appearance on the Display menu or click Disp on the toolbar, and then click the 

Appearance tab. 
3 Click the center button under Display Format to select XY Display mode. 
4 Use the vertical scale and position controls of the waveform connected to the X-axis source 

to set horizontal scale and position of the XY waveform.  
5 Use the vertical scale and position controls of the waveform connected to the Y-axis source 

to set vertical scale and position of the XY waveform. 

 

Using the XYZ Display Format 
Use the following steps to set up the instrument in the XYZ Display format. 
1 Connect the Ch  1 probe to the signal that you want to use for the X-axis. 
2 Connect the Ch  2 probe to the signal that you want to use for the Y-axis. 
3 Connect the Ch  3 probe to the signal that you want to use for the Z-axis. This signal will 

modulate the waveform intensity. 
4 Click Appearance on the Display menu, or click Disp on the Tool bar and then click the 

Appearance tab. 
5 Click the bottom button under Display Format to select XYZ Display mode. 
6 Adjust the vertical scale and position controls to obtain the best display of the XYZ 

waveform. 

Note 
The XYZ format is only available on 4-channel models. 
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Enabling a Network Connection  
Use the following steps to enable network access to the instrument. This procedure requires that 
you begin with the instrument powered off, so you may want to print these instructions before you 
proceed. 
1 Attach a keyboard and mouse to the instrument. 
2 Power on the instrument. 
3 Use the Windows Network Connection Wizard to define the instrument as a network client 

and configure it for your network. You can find the network setup program in the Windows 
Start menu if you select Settings > Control Panel, and then double-click Network. 
Consult with your network administrator for specific instructions for these settings. 

Note 
If you want to disable network access for the instrument, select Start>Settings>Control 
Panel>Network and Dialup Connections>Local Area Connection. Click Disable and Close. 

Selected Waveform versus Deselected Waveform 

  

 

The waveform handle 
determines if a waveform is 
selected or deselected. The 
waveform handle appears in 
reverse video when the 
waveform is selected as 
shown in the graphic for the 
Channel 3 waveform. 

 

Probe Compensation Adjustment 
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Probe Compensation 

  

 

 

Printing Banners 
Use the following steps to print banners. Banners can only be printed on the integrated thermal 
printer. 
1 Open the Print dialog box from the File menu Print command. From the Name drop-down 

list, select Integrated Thermal Printer (the default). Click OK. 
2 Open the File menu Page Setup dialog box. For the Type of printing, select Banner. This 

locks in values for the Orientation, View, and Image controls.  
3 For the Print Scale controls, select the Units you want to use to specify the horizontal scale, 

either inches/division or centimeters/division. Select a value for the Length; these values 
change according to the choice of Units. 

4 Change the Summary Waveform selection if you want to add a screen shot to the 
Beginning, End, or Both ends of the banner. The Summary Waveform is a screen shot that 
gives you an overall view of what was originally on the screen before printing began. It 
contains information that will not appear on the banner such as cursor and measurement 
readouts, histograms, and any screen text or labels that you have added.  

5 Select the Samples to Print to specify which portion of the waveform to print. If you select 
Between cursors and no cursors are present, vertical cursors are activated in their most 
recent position. You can use the multipurpose knobs to change the cursor positions.  

6 Click Print to open the Print dialog box. 
7 Click OK to begin printing. If the banner you produce is unreadable because it is too light, 

open the printer cover and push the lever on the right side of the printer towards the back of 
the instrument as far as it will go. 

Note 
Banner printing is not compatible with: 

 Fast Acquisition mode 

 Persistence display mode 

 XY or XYZ mode 

 Zoom mode 
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Inverting Channel Waveforms 
Use the following steps to invert a channel waveform on the screen.  
1 Select the Invert command from the Vertical menu.  
2 From the Channel Selector tabs, click the waveform that you want to invert. 
3 Click Invert to toggle the button On. The waveform appears flipped on its zero volt axis. 

Other waveforms on the screen remain unchanged. 

 Invert the waveform by clicking the Invert button on the channel’s tab on the Vertical 
Setup control window or by right-clicking on the waveform handle, and then selecting Invert 
from the shortcut menu. 

 

Connecting Probes 

 

Connect the probe tip and the ground lead to the two probe compensation connectors on the instrument as 
shown. If using the probe hook-tip, ensure a proper connection by firmly twisting the tip onto the probe. 

Adjusting Display Contrast 
If you find that the instrument screen is too bright or too dark, use these steps to adjust the LCD 
display contrast to your preference. You need to have a mouse attached to perform this procedure. 
1 Right-click on the Windows desktop. 
2 Select Properties. 
3 Select the Settings tab. 
4 Click Advanced. 



 372

5 Select the Color tab. 
6 Adjust slider controls for desired contrast. 
7 Click Apply, and then click OK. 

Using Mask Testing with Option SM 
Follow these steps to perform mask testing. 

1 Select Mask Setup… from the Masks menu or touch the Masks button on the toolbar to 
display the Mask Setup control window. 

2 From the Masks tab, click the type of mask that you want to use, and then click the 
Standard drop-down list to select the standard that you want to use. 

Note 

The standard that you choose will determine whether you also need to set the polarity for the test. 
3 Make any necessary changes to the Display or Alignment configurations. 
4 Click Hit Count to turn it off or on. 
5 From the Source tab, click the input channel that you want to test. 
6 From the Tolerance tab, make adjustments in the Mask Margin Tolerance. 
7 Click the Pass/Fail Setup tab, and then set the rest of the test parameters. 
8 From the Pass/Fail Setup tab or the Pass/Fail Results tab, click the Pass/Fail Test control to 

run the test. 

Creating a User Mask with Option SM 
Use the Edit control to change a standard mask and create your own. 
1 Select Mask Setup… from the Masks menu, or click the Masks button on the toolbar to 

display the Mask Setup control window. 
2 From the Masks tab, select the type of mask and standard that you want to use as a basis for 

your mask. 
3 Click User Mask, and then click Copy Current Mask to User Mask. 
4 Click OK. The mask that you selected is now a user mask. To alter the mask, click Edit 

User Mask. 
5 Under Mask, use the up and down arrows to select the segment and vertex that you want to 

edit. The selected segment appears in red and a white X indicates the selected vertex. 
6 Click the Horizontal or Vertical control under Mask Values, and use the multipurpose 

knobs to change the horizontal or vertical values of the mask. 
7 Click Save to save your changes as the User Mask. 
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Saving Masks 
Use the Mask Edit Setup control window to save a mask. 
1 Select Mask Edit Setup… from the Masks menu to display the Mask Edit Setup control 

window. 
2 Click Save to open the Save As dialog box. 
3 Select User Mask under Save What. You may need to click More to access the User Mask 

selection. 
4 Enter a file name in the Name box. If you do not have a keyboard attached, click the 

keyboard icon to use the pop-up keyboard to enter the file name. 
5 Click Save to save the mask. The default folder for saving masks is C:\TekScope\Masks. If 

you want to save the mask in a different folder, click the Save in drop-down list, and then 
click a folder to select it. 

Recalling Masks 
Use the Mask Edit Setup control window to recall a mask. 
1 Select Mask Edit Setup… from the Masks menu to display the Mask Edit Setup control 

window. 
2 Click Recall to open the Recall dialog box. 
3 Click User Mask under Recall What, and then click the mask that you want to recall to 

select it. 
4 Click Recall to recall the mask.  

Note 

The default folder for saving masks is C:\TekScope\Masks. If you saved masks in a different 
folder, click the Look in drop-down list to find the folder where your masks are saved. 

 Editing a User Mask 
Use the Mask Edit Setup to alter a user mask. 
1 Select Mask Edit Setup… from the Masks menu to display the Mask Edit Setup control 

window. 
2 Under Mask use the up and down arrows to select the segment and vertex that you want to 

edit. The selected segment appears in red and a white X indicates the selected vertex. 
3 Click the Horizontal and/or Vertical control under Mask Values to change the horizontal or 

vertical values of the mask. 
4 Click Save to save your changes to the user mask. 
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Glossary 
Absolute Value 

Inserts the text FABS( into the math expression. The FABS function takes the absolute value of 
the expression. 

ACos 

Inserts the text ACOS( into the math expression. 

Acquisition Interval 

The acquisition interval is the time between sample points. For mathematical purposes, it is the 
time covered by the waveform record divided by the record length.  

Acquisition Window 

This is the window that defines what data is "cut out" of the input signal to form a waveform 
record. The vertical scale and offset set the vertical size and the vertical center of this window 
independently for each channel. The horizontal scale and position set the horizontal size and 
positions for all channels in parallel. 

Amplitude 

This voltage measurement is the high value minus the low value measured over the entire 
waveform or gated region. 

Amplitude  =  High - Low 

Analog Oscilloscope Sweeps 

 

Area 

Area is a voltage-over-time measurement. The measurement is the area over the entire waveform 
or gated region expressed in volt-seconds. The area above the common reference point is positive 
while the area below the common reference point is negative. 

ASin 

Inserts the text ASIN( into the math expression. 

ATan 

Inserts the text ATAN( into the math expression. 

Auto Trigger Mode 

Auto trigger mode causes the instrument to trigger if a valid trigger event does not occur within a 
set amount of time. Auto trigger mode is useful when probing DC signal levels such as power 
supplies or logic levels that are stuck high or low. It is also useful when looking for activities on 
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signal nodes such as oscillations when you first set up the instrument. The length of time it waits 
for a trigger event depends on the time base setting. 

Average 

Inserts the text AVG( ) into the math expression. Enter an argument to the function. The average 
function produces the average of the argument. 

Averages Button 

Closes this window and opens the Adjust Math Parameters control window. 

Base 10 Logarithm 

Inserts the text LOG( ) into the math expression. Enter an argument to the function. The log 
function produces the base 10 logarithm of the argument. 

Burst Width 

This timing measurement is the duration of a burst (a series of transient events) and is measured 
over the entire waveform or gated region.  

Center Frequency 

The center frequency is the frequency at the center of the frequency span. The maximum center 
frequency is equal to the sample rate divided by two (the Nyquist frequency) minus one half the 
span. The minimum center frequency is equal to one half of the span.  

If the frequency span is set to maximum, then the center frequency will not move. To increase the 
center frequency beyond the present limits, either reduce the frequency span or increase the 
sample rate. To decrease the center frequency beyond the present limits, reduce the frequency 
span. 

Clear Button 

Removes all of the characters from the math expression. 

Channel Selector 

 

The Ch tab contains the controls for each waveform 
connected directly to the channel inputs. 

The Math tab contains the controls for all math 
waveforms. 

The Ref tab contains the controls for all reference 
waveforms. 

Shaded buttons indicate unused or undefined waveforms. 

Note 

Channels 3 and 4 for channel, math, and reference waveforms are only available on 4-channel 
models. 

Clock Edge 

The Clock Edge determines whether the instrument finds the trigger point on the rising edge (left 
button) or the falling edge (right button) of the clock signal. 
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Clock Source Channel 

Select the input channel that is connected to the clock signal. 

Clock Threshold Level 

To set the clock threshold voltage level, click Clock Level, and then use the multipurpose knob to 
set the voltage level. 

Comm Trigger Source 

Use the Source drop-down list to select the channel for the comm trigger source. Use the Type 
drop-down list to select the clock source for the trigger. Use the Polarity drop-down list to select 
the polarity of the clock source. 

Control Window Handle 

  

Cos 

Inserts the text COS( into the math expression. 

Cosh 

Inserts the text COSH( into the math expression. The COSH function computes the hyperbolic 
cosine of x 

Crossing Percent 

Crossing percent measurement is the eye crossing point expressed as a percentage of eye height. 
Crossing Percent = 100 x [(pCross1Mean - pBaseMean)/(pTopMean - pBaseMean)] 

Cycle Area 

The cycle area is a voltage over time measurement. The measurement is the area over the first 
cycle in the waveform or the first cycle in the gated region expressed in volt-seconds. The area 
above the common reference point is positive while the area below the common reference point is 
negative. 
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Cycle Mean 

This voltage measurement is the arithmetic mean over the first cycle in the waveform or the first 
cycle in the gated region. 

Cycle RMS 

This voltage measurement is the true Root Mean Square voltage over the first cycle in the 
waveform or the first cycle in the gated region. 

Data Source Channel 

Select the input channel that is connected to the data signal. 

Data Threshold Level 

To set the data threshold voltage level, click Data Level, and use the multipurpose knob to set the 
voltage level. 

Dead Time 

Dead time is the time that the instrument requires to process an acquisition. The instrument cannot 
acquire any new data until the previous data has been processed. If dead time is long, the 
instrument can miss acquiring infrequent events. 

"Dead time" Between Acquisitions 

 

Delay 

This timing measurement is the time between the mid reference (default 50%) amplitude point of 
two different waveforms. 

Delay Edges 

The Delay Edge buttons determine whether the measurements will be taken on the rising or falling 
edge of the waveform. After selecting an edge, the graphic in the control window is updated to 
show the edge from which the measurements will be taken. 

Derivative 

Inserts the text DIFF( ) into the math expression. Enter an argument to the function. The derivative 
function produces the derivative of the argument. 

Duty Cycle Distortion 

Duty cycle distortion is the peak-to-peak time variation of the first eye crossing measured at the 
MidRef as a percent of the eye period.  
DCD(sec) = 100% x TDCDp-p/(TCross2mean – TCross1mean) 
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Editor Button 

Closes this window and opens the Equation Editor control window so you can edit the math 
expression. 

E-mail on Trigger 

To send e-mails on a trigger event, click the E-mail on Trigger button On. E-mail on Event must 
be configured to enable E-mail on Trigger from the Trigger Mode control window. 

Email on Trigger Setup 

Click to access the E-mail on Event control window where you configure sending e-mail on 
events. 

Extinction Ratio 

Extinction ratio is the ratio of eye top to base. This measurement is only valid when the 
acquisition mode is set to WfmDB, FastAcq is enabled, or the measurement is taken on a reference 
waveform saved in FastAcq mode. 
Ext Ratio=pTopMean/pBaseMean. 

Extinction Ratio Decibel 

Extinction ratio decibel is the ratio of eye top to base expressed in decibels. This measurement is 
only valid when the acquisition mode is set to WfmDB, FastAcq is enabled, or the measurement is 
taken on a reference waveform saved in FastAcq mode. 
ExtdB=10xLog(pTopMean/pBaseMean) 

Extinction Ratio Percent 

Extinction ratio percent is the ratio of eye base to top expressed as a percentage. This 
measurement is only valid when the acquisition mode is set to WfmDB, FastAcq is enabled, or the 
measurement is taken on a reference waveform saved in FastAcq mode. 
Ext Percent=100x(pTopMean/pBaseMean). 

Eye Base 

Eye Base is the base value used in the extinction ratio measurements.  
Eye Base = pBaseMean 

Eye diagram 

A synchronized display of a data stream that shows signal levels and transition regions, typically 
over one cycle. The eye diagram has the appearance of an opened eye. Compared to a normal 
instrument display, the eye diagram generally appears as an untriggered waveform. This is 
because on successive cycles the signal is high and then low. The areas of interest are the 
transition regions and eye opening. 

Eye Height 

Eye height is the measurement of the eye height in volts. 
Eye Height=(pTopMean-3 x pTopSigma) - (pBaseMean + 3 x pBaseSigma) 

Eye Top 

Eye Top is the top value used in the extinction ratio measurements.  
Eye Top = pTopMean. 
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Eye Width 

Eye width is the measurement of eye width in seconds. 
Eye Width = (tCross2Mean - 3 x pTopSigma) - (tCross1Mean + *tCross1Sigma) 

Fall Time 

This timing measurement is the time required for the falling edge of the first pulse in the 
waveform or gated region to fall from the high reference value (default =  90%) to the low 
reference value (default  =  10%) of the final value. 

Fast Acquisition 

 

Force Trigger 

Click this button to force the instrument to trigger and complete the current acquisition regardless 
of whether any other trigger event occurs (if the acquisition is currently running). This has no 
effect if the acquisition system is stopped.  

Frame 

A frame is a segment of the entire data record. When used with FastFrame, each segment contains 
all the data of a single acquisition. Each captured event is stored sequentially in its own frame. The 
frames are in the order they were captured.  

Frequency 

This timing measurement is a measure of the first cycle in a waveform or gated region. Frequency 
is the reciprocal of the period; it is measured in Hertz (Hz) where one Hz is one cycle per second. 

Frequency Span 

The frequency span is the range of frequencies over which the spectral analysis is performed. The 
maximum span is from DC to one half of the sample rate (the Nyquist frequency). A smaller 
frequency span allows a greater range of center-frequency adjustment. If a larger frequency span is 
desired, increase the sample rate. 

The Front-Panel MultiView Zoom Button 
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Glitch Width 

The glitch width controls specify the maximum width of the glitch. Click the Width control and 
set the width with the multipurpose knob. Then click the < button to trigger the instrument only on 
glitches narrower than the specified width; or click the > button to trigger the instrument only on 
pulses wider than the specified width. The trigger graphic shows the criteria that you have 
selected. 

Graphic Indicator 

 

High 

The high level measurement is the value used as 100% whenever high reference, mid reference, or 
low reference values are needed, such as in fall time or rise time measurements. This value can be 
calculated using either the min/max or histogram method. The min/max method uses the 
maximum value found. The histogram method uses the most common value found above the 
midpoint. This value is measured over the entire waveform or gated region. 

High Reference 

The High Reference defines the high reference level of a waveform; the default level is 90%. This 
reference level is used with the Low Reference level in the calculation of rise and fall times. To 
change this level, click the control, and then set the level with the multipurpose knob. 

Histogram Max 

Displays the voltage of the highest nonzero bin in vertical histograms or the time of the rightmost 
nonzero bin in the horizontal histograms. 

Histogram Mean 

Measures the average of all acquired points within or on the histogram box. 

Histogram Min 

Displays the voltage of the lowest nonzero bin in vertical histograms or the time of the leftmost 
nonzero bin in the horizontal histograms. 

Hits in Box 

Displays the number of points in or on the histogram box. 

Horizontal Delay 

Use the Horiz Delay control to enter the amount of horizontal delay when Horizontal Delay Mode 
is On. Click the control and enter a delay value with the multipurpose knob. You can also enter a 
delay value with the front-panel HORIZONTAL POSITION knob. 

Horizontal Delay Mode 

Use the Horizontal Delay button to delay the acquisition relative to the trigger event. When 
Horizontal Delay Mode is On, use the Horiz Delay control to enter the delay time. You can also 
enter the delay time with the front-panel POSITION knob. The Horizontal Delay button functions 
identically to the Delay Mode button on the Horizontal/Acquisition Setup control window. 
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Horizontal Position 

Use the Position control to move the trigger point within the acquired waveform. To acquire 
waveform data only after the trigger event, set the Position control to zero. To acquire waveform 
data leading up to the trigger event, set the Position control to any value greater than zero. Click 
the control and use the multipurpose knob or the front-panel HORIZONTAL POSITION knob to 
enter a value. 

Horizontal Reference Marker 

  

Imaginary Number 

Inserts the text SpectralImag( ) into the math expression. Select one of the waveforms as an 
argument to the function. This function creates a waveform that displays only the imaginary part 
of the FFT. 

Increment/Decrement Buttons 

 

Integral 

Inserts the text INTG( ) into the math expression. Enter an argument to the function. The integral 
function produces the integral of the argument. 

Invert 

Inserts the text INV( ) into the math expression. Enter an argument to the function. The invert 
function inverts the argument within the parentheses. 

Jitter 6 Sigma 

Jitter 6 sigma is six times the RMS value of the edge jitter in the current horizontal units.  

Jitter 6 sigma = 6 x (JitterRMS) 

Jitter Peak-to-Peak 

Jitter p-p is the peak-to-peak value for the edge jitter in the current horizontal units. 
Jitter PP = TCross1PP 

Jitter Root Mean Square 

Jitter RMS is the RMS value of the edge jitter in the current horizontal units. 
Jitter RMS = TCross 1sigma 

Largest Integer 

Inserts the text FLOOR( into the math expression. The FLOOR function takes the largest integer < 
the expression. 
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Leakage 

Leakage results when the time domain waveform used to create the FFT function is periodic but 
contains a noninteger number of waveform cycles. When the record contains a fraction of a cycle, 
there are discontinuities at the ends of the record. These discontinuities cause energy from each 
discrete frequency to leak over on to adjacent frequencies. This results in amplitude errors when 
measuring any given frequency. Different windows have different leakage characteristics. 

Level 

Click to activate the multipurpose knobs and set the threshold on which you want to trigger. 
Different levels are available depending on the code selected. The upper level controls the upper 
level trigger point, lower level controls the lower level trigger point, and clock level sets the clock 
threshold on which you want to trigger 

Logic Pattern 

Select the Boolean logic function for the combination of the input channels. The instrument will 
trigger on a clock edge when the input waveforms match the specified logic pattern. 

Note 

The Pattern Type controls do not appear on this control window for 2-channel models. 

Logic Pattern Inputs 

The instrument input channels represent the data inputs. The channel inputs combine to form a 
logic pattern. Each channel can have a value of high (H), low (L), or "don't care" (X). A value is 
considered high if the channel input voltage is greater than the specified threshold voltage; a value 
is considered low if the channel input voltage is less than the specified threshold voltage. Use the 
"don't care" selection for any channels that will not be used as part of the pattern.  

Logic Pattern Trigger Criteria 

Use the Trigger When Pattern drop-down list to determine when the instrument should trigger. 
Select True to trigger the instrument when the logic patterns are true. Select False to trigger the 
instrument when the logic patterns are false. You can also specify that the pattern is true (or false) 
for a specified amount of time before the instrument triggers. To specify the trigger time, click 
Time and set with the multipurpose knob. The Time control is unavailable when you select True 
or False. 

Logic State Inputs 

Channels 1, 2, and 3 represent the data inputs. Channel 4 should be connected to the clock signal. 
The channel inputs combine to form a logic pattern. Each channel can have a value of high (H), 
low (L), or "don't care" (X). A value is considered high if the channel input voltage is greater than 
the specified threshold voltage; a value is considered low if the channel input voltage is less than 
the specified threshold voltage. Use the "don't care" selection for any channels that will not be 
used as part of the pattern.  

Note 

If you are using a 2-channel model, Channel 1 is the data input and Channel 2 is the clock source.  
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Logic State Trigger Criteria 

Use the Trigger When Pattern selection to determine when the instrument should trigger. Select 
True to trigger the instrument when the logic patterns go true. Select False to trigger the 
instrument when the logic patterns go false. 

Low 

The low level measurement is the value used as 0% whenever high reference, mid reference, or 
low reference values are needed, such as in fall time or rise time measurements. This value can be 
calculated using either the min/max or histogram method. The min/max method uses the minimum 
value found. The histogram method uses the most common value found below the midpoint. This 
value is measured over the entire waveform or gated region. 

Low Reference 

The Low Reference defines the low reference level of a waveform; the default level is 10%. This 
reference level is used with the High Reference level in the calculation of rise and fall times. To 
change this level, click the control and then, set the level with the multipurpose knob. 

Magnitude 

Inserts the text SpectralMag( ) into the math expression. Select one of the waveforms as an 
argument to the function. This function creates an FFT magnitude waveform.  

Maximum 

This voltage measurement is the maximum amplitude. It is typically the most positive peak 
voltage and is measured over the entire waveform or gated region. 

Maximum Value 

Inserts the text MAX( into the math expression. The MAX function accumulates over time the 
maximum value at each point in the vector. 

Mean 

This voltage measurement is the arithmetic mean over the entire waveform or gated region. 

Mean  ± 1 StdDev 

The percentage of points in the histogram that are within one standard deviation of the histogram 
mean. 

Mean ± 2 StdDev 

The percentage of points in the histogram that are within two standard deviations of the histogram 
mean. 

Mean ± 3 StdDev 

The percentage of points in the histogram that are within three standard deviations of the 
histogram mean. 

Median 

The middle point of the histogram box. Half of all acquired points within or on the histogram box 
are less than this value and half are greater than this value. 
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Mid Reference 

The Mid reference defines the middle reference level of a waveform; the default level is 50%. This 
reference value is primarily used for making measurements between edges such as pulse widths. 
To change this level, click the control, and then set the level with the multipurpose knob. 

Mid2 Reference 

The Mid2 reference defines the middle reference used on the second waveform specified in delay 
or phase measurements; the default level is 50%. To change this level, click the control, and then 
set the level with the multipurpose knob. 

Minimum 

This voltage measurement is the minimum amplitude. It is typically the most negative peak 
voltage and is measured over the entire waveform or gated region. 

Minimum Value 

Inserts the text MIN( into the math expression. The MIN function accumulates over time the 
minimum value at each point in the vector. 

Multipurpose Knobs 

 

Natural Antilog 

Inserts the text EXP( ) into the math expression. Enter an argument to the function. The natural 
antilog function raises e to the power of the argument. 

Natural Logarithm 

Inserts the text LN( ) into the math expression. Enter an argument to the function. The LN 
function produces the natural logarithm of the argument. 

Negative Duty Cycle 

This timing measurement is the ratio of the negative pulse width to the signal period expressed as 
a percentage. The duty cycle is measured on the first cycle in the waveform or gated region. 
Negative  Duty  Cycle  =  (Negative  Width)  ÷  Period  ×  100% 

Negative Overshoot 

This voltage measurement is measured over the entire waveform or gated region and is expressed 
as: Negative Overshoot = (Low – Minimum) X Amplitude X 100%. 
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Negative Width Measurement 

This timing measurement is the distance (time) between the mid reference (default 50%) 
amplitude points of a negative pulse. The measurement is made on the first pulse in the waveform 
or gated region. 

Noise Peak-to-Peak 

Noise p-p is the peak-to-peak value of the noise of the top or base of the signal as specified by 
you. To ensure accurate noise values, be sure to set the signal type to Eye when measuring an Eye 
signal. Noise Pk-Pk = PToppk-pk or PBasepk-pk 

Noise Root Mean Square 

Noise RMS is the RMS value of the noise of the top or base of the signal as specified by you. To 
ensure accurate noise values, be sure to set the signal type to Eye when measuring an Eye signal. 
Noise RMS = PTopsigma or PBasesigma 

Normal Trigger Mode 

Normal trigger mode causes the instrument to wait for a valid trigger event before displaying 
waveform data. Normal trigger mode is most useful during single-shot acquisitions. 

 On-Screen MultiView Zoom Menu Item 

  

Peak Hits 

Displays the number of points in the largest bin of the histogram. 

Peak to Peak 

This voltage measurement is the absolute difference between the maximum and minimum 
amplitude in the entire waveform or gated region. 

Period 

This measurement is the time required to complete the first cycle in a waveform or gated region. 
Period is the reciprocal of frequency and is measured in seconds. 
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Phase 

This timing measurement is the amount of time that one waveform leads or lags another 
waveform. The measurement is expressed in degrees where 360° comprise one waveform cycle. 

Phase Argument 

Inserts the text SpectralPhase( ) into the math expression. Select one of the waveforms as an 
argument to the function. This function creates an FFT phase waveform. 

Pk-Pk 

Displays the peak-to-peak value of the histogram. Vertical histograms display the "voltage" of the 
highest nonzero bin minus the "voltage" of the lowest nonzero bin. Horizontal histograms display 
the "time" of the rightmost nonzero bin minus the "time" of the leftmost nonzero bin. 

Pop-up Keypad 

 

Positive Duty Cycle 

This timing measurement is the ratio of the positive pulse width to the signal period expressed as a 
percentage. The duty cycle is measured on the first cycle in the waveform or gated region. 
Positive  Duty  Cycle  =  (Positive  Width)  ÷  Period  ×  100% 

Positive Overshoot 

This voltage measurement is measured over the entire waveform or gated region and is expressed 
as: Positive Overshoot = (Maximum – High) X Amplitude X 100%. 

Positive Width 

This timing measurement is the distance (time) between the mid reference (default 50%) 
amplitude points of a positive pulse. The measurement is made on the first pulse in the waveform 
or gated region. 
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Posttrigger Data 

The data acquired and displayed after the trigger event. You can set the amount of pretrigger data 
with the Horizontal Position control. 

Pretrigger Data 

The data points of the waveform acquired and displayed before the trigger event. You can set the 
amount of pretrigger data with the Horizontal Position control. 

Quality Factor 

Quality factor is the ratio of eye size to noise.  
Quality Factor = (PTopmean – PBasemean)/(PTopsigma + PBasesigma) 

Real Number 

Inserts the text SpectralReal( ) into the math expression. Select one of the waveforms as an 
argument to the function. This function creates a waveform that displays only the real part of the 
FFT. 

Reference Point 

Use the Ref Point control to define the horizontal reference point within the acquired waveform. 
The horizontal reference point determines the location within the acquired data where the scale 
controls will expand or contract the waveform. When Horizontal Delay is on, the reference point 
is the trigger point plus the Horizontal Delay time. When the horizontal delay is off, the reference 
point is the trigger point. 

Resolution Bandwidth 

The resolution bandwidth controls the bandwidth of the spectral analyzer filters. You can adjust 
the resolution bandwidth in units of hertz. The resolution bandwidth is measured at the −3 dB 
points on each side of the peak spectral lobe of the filter. 

Resolution bandwidth is inversely proportional to the gate duration in the time domain. Changing 
the gate duration changes the resolution bandwidth. Changing the spectral analyzer window 
function also changes the resolution bandwidth but will not affect the gate duration.  

To decrease the resolution bandwidth beyond the present limits, increase the time domain gate 
duration. If this is insufficient, increase the record length and then increase the gate duration again. 
You can also try the rectangular or Hamming window to maximize the frequency resolution 
(minimize resolution bandwidth). 

Rise Time 

This timing measurement is the time required for the leading edge of the first pulse in the 
waveform or gated region to rise from the low reference value (default  =  10%) to the high 
reference value (default  =  90%) of the final value. 

RMS 

This voltage measurement is the true Root Mean Square voltage over the entire waveform or gated 
region. 
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Runt Trigger Criteria 

Select Occurs from the Runt drop-down list to trigger on any runt.  

Select Wider from the Runt drop-down list to trigger on a runt pulse of a minimum width. Click 
Width and use the multipurpose knob to set the minimum pulse width. 

Select Logic from the Runt drop-down list to trigger on a logic-qualified runt pulse. When the 
instrument detects that a runt has occurred, it checks the logical state of two other available 
channels and triggers only if their conditions are met. Each channel can have a value of high (H), 
low (L), or "don't care" (X). A value is considered high if the channel input voltage is greater than 
the specified threshold voltage; a value is considered low if the channel input voltage is less than 
the specified threshold voltage. Use the "don't care" selection for any channels that will not be 
used as part of the pattern. 

Note 

The Logic qualification option is available only on 4-channel models.  

Scan Controls 

These controls are available only for the Custom video format. Interlaced and Progressive are 
available for the Scan Type.  

Custom scan rates enable you to trigger on nonbroadcast video signals that have unique scan rates. 
Select the scan rate range that includes your signal: 15-20 kHz, 20-25 kHz, 25-35 kHz, 35-50 kHz, 
or 50-65 kHz. 

Scallop Loss 

Scallop loss is the difference between the actual magnitude and the computed magnitude of a 
signal that is halfway between two frequency bins in the spectral output data. Scallop loss is only 
noticeable when the spectral analyzer is not using zero-fill such as when it is set to full span. If 
zero-fill is in use, then the frequency domain interpolation occurs and there is essentially no 
scallop loss. Zero-fill cannot be directly controlled; it is affected by changing settings of resolution 
bandwidth or gate width. 

Note 

For most settings, descriptions of amplitude accuracy due to scallop loss (as discussed in other 
publications) do not apply to the TDS5000B Series Oscilloscope when used as a spectral analyzer 
because of zero-fill. Full span is the most likely setting where scallop loss might occur. 

Set to 50% 

Click this button to automatically have the instrument search for and set the trigger level to a value 
halfway between the peaks of the trigger source signal. This has the same effect as pushing the 
front-panel LEVEL knob. 

Setup and Hold Time 

Setup time is the amount of time that data has to be stable after crossing the threshold level prior 
to a clock edge. Hold time is the amount of time that data has to be stable before crossing the 
threshold level after a clock edge.  
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Setup and Hold Times 

Use the Setup Time and the Hold Time controls to specify the setup and hold limits. Click one of 
the highlighted areas in the control window, and then use the multipurpose knobs to set the limits. 

Signal to Noise Ratio 

S/N ratio is the ratio of the signal amplitude to the noise of the top or base of the signal as 
specified by you. 
S/N Ratio = (Ptop – Pbase)/(PTopsigma or PBasesigma) 

Sin 

Inserts the text SIN( into the math expression. 

SinH 

Inserts the text SINH( into the math expression. 

Smallest Integer 

Inserts the text CEIL( into the math expression. The CEIL function takes the largest integer > the 
expression. 

Spectrum Analyzer Control Set  

 

Square Root 

Inserts the text SQRT( ) into the math expression. Enter an argument to the function. The square 
root function produces the square root of the argument. 

StdDev (Standard Deviation) 

The standard deviation (Root Mean Square (RMS) deviation) of all acquired points within or on 
the histogram box. 
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Tan 

Inserts the text TAN( into the math expression. 

Tanh 

Inserts the text TANH( into the math expression. 

TekProbe Interface 

The TekProbe interface enables the instrument to sense information about the probe such as the 
serial number and other unique identification information. It also allows the instrument to provide 
power directly to the probe. With this information the instrument can automatically set up its 
requirements to match the characteristics of the probe, such as termination and attenuation.  

Time Stamps 

Time stamps are a convenient way of measuring the time between triggers when using FastFrame. 
To display timestamps click the Readouts button. 

Time Stamp Readout Format 

Time stamp readouts are displayed in the following format: 
Day, Month, Year, 
Hours:Minutes:Seconds.Milliseconds:Microseconds:Nanoseconds:Picoseconds. 

Timeout Trigger Criteria 

Click Stays High to trigger the instrument when the pulse is high for the specified time. Click 
Stays Low to trigger the instrument when the pulse is low for the specified time. Click Either to 
trigger the instrument if the signal has not crossed the threshold value for the specified time. 

Timeout Value 

The timeout value determines when the instrument will trigger. To set the timeout value, click the 
Timer control and then use the multipurpose knob to set the time. 

Transition Time Trigger Criteria 

Click Time and set the target transition time with the multipurpose knob. Click the < button to 
trigger the instrument when the transition time is less than the specified time. Click the > button to 
trigger the instrument when the transition time is greater than the specified time.  

Trigger Coupling 

The trigger coupling determines what part of the signal is passed to the trigger circuitry. All 
trigger types except edge triggering use DC coupling only. Edge triggering can use all 
available coupling choices. 

 DC coupling passes all input signals to the trigger circuitry. 

 AC coupling passes the input signals above 60 Hz to the trigger circuitry. 

 Low frequency rejection attenuates signals below 80 kHz before passing the signal to the 
trigger circuitry. 

 High frequency rejection attenuates signals above 50 kHz before passing the signal to the 
trigger circuitry. 
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 Noise rejection provides stable triggering by increasing the trigger hysteresis. Increased 
hysteresis reduces the trigger sensitivity to noise but may require greater signal 
amplitude.  

Trigger Delay 

Use the Trig Delay control to trigger the instrument a specified period of time after the A trigger. 
After the A trigger arms the trigger system, the instrument triggers on the next B trigger event that 
occurs after the time that you specify with the Trig Delay control. Click Trig Delay, and then use 
the multipurpose knob to enter the delay time.  

Trigger Events 

Use the Trig Event control to trigger the instrument a specified number of events after the A 
trigger. After the A trigger arms the trigger system, the instrument triggers on the nth B trigger 
event. Click Trig Event, and use the multipurpose knob to enter the number of B trigger events. 
You can also click the increment/decrement buttons to enter the number of B trigger events. 

Trigger Graphic 

The trigger graphic displays a visual indicator of the trigger criteria. Depending on the trigger 
type, the graphic will be updated as you define the trigger parameters. 

Trigger Graticule 

All graticule types are available for selection from the drop-down list. The IRE graticule is 
normally used with the NTSC signals, and the mV graticule is normally used with all other video 
signals.  

Trigger Holdoff 

After a trigger event, the instrument will not accept another trigger event until after the holdoff 
value is exceeded. Holdoff is usually specified in units of time, but other units may be used. 

Trigger Holdoff: Default 

After a trigger event, the instrument will not accept another trigger event until after the holdoff 
value is exceeded. Holdoff is usually specified in units of time, but other units may be used. 

When the Trigger Holdoff is set to Default, the instrument automatically calculates the trigger 
holdoff time. It is normally equal to five times the current Horizontal Scale setting. 

Trigger Holdoff: Time 

After a trigger event, the instrument will not accept another trigger event until after the holdoff 
value is exceeded. Holdoff is usually specified in units of time, but other units may be used. 

When the Trigger Holdoff is set to Time, you can manually adjust the value with the multipurpose 
knob. Use this option when the signal that you want to trigger on has several possible trigger 
points. Use the Trigger Holdoff control to delay the trigger system for a specified amount of time 
between triggers so that you can obtain a stable display. 

Trigger Level 

The trigger level determines the voltage level at which the trigger point occurs. Adjust the trigger 
level with the front-panel LEVEL knob, or click the Level control and adjust with the 
multipurpose knob. 
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Trigger Level Marker 

  

Trigger On 

Select a value from the Trigger On drop-down list to specify where the trigger will occur on the 
video signal. The Trigger On drop-down list contains the options Field, All Lines, and Line #. 

If you select Field, use the drop-down list to select Odd, Even, or All. 

If you select Line #, use the multipurpose knob to set the line number. Line numbers wrap when 
their limits are reached. The range of line numbers depends on the chosen Format. 

Note 

If you select the NTSC format, use the multipurpose knob to first scroll through all of the odd 
lines, and then the even lines. 

Trigger Polarity: Glitch Trigger 

The Polarity buttons set the glitch polarity. Click Pos to trigger on a positive-going pulse. Click 
Neg to trigger on a negative-going pulse. Click Either to trigger on positive or negative glitches. 

Trigger Polarity: Runt and Transition Time Trigger 

Select the polarity from the drop-down list. Click Positive to trigger on a positive-going pulse. 
Click Negative to trigger on a negative-going pulse. Click Either to trigger the instrument on 
either polarity.  

Trigger Polarity: Width Trigger 

The polarity buttons define the polarity of the pulse width. Click Pos to trigger on a positive-going 
pulse. Click Neg to trigger on a negative-going pulse. 

Trigger Slope 

The trigger slope determines whether the instrument finds the trigger point on the rising edge or 
the falling edge of the signal. 

Trigger Source 

The trigger source determines the source of the trigger signal. The input channels are the most 
commonly used trigger sources and are available for all trigger types. 

Trigger Summary 

The trigger summary provides a one-line summary of the trigger setups. Use the trigger summary 
to get an overview of the trigger setups without having to look through all of the trigger tabs. 
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Trigger When 

To qualify the trigger for Window triggering, select from these drop-down list combinations: 

Inside Limits and 
Occurs or 
Outside Limits 
and Occurs 

 

Trigger the instrument when the signal enters (or leaves) the 
window defined by the threshold levels. 

 

Inside Limits and 
Wider or Outside 
Limits and Wider 

Trigger the instrument when the signal enters (or leaves) the 
window defined by the threshold levels for the time specified by 
Width. 

 

Inside Limits and 
Logic or Outside 
Limits and Logic 

When the instrument detects a signal entering or leaving the 
window defined by the threshold levels, it checks the logic state 
of up to two other available channels and triggers only if their 
conditions are met. Each channel can have a value of high (H), 
low (L), or "don't care" (X). A value is considered high if the 
channel input voltage is greater than the specified threshold 
voltage; a value is considered low if the channel input voltage is 
less than the specified threshold voltage. Use the "don't care" 
selection for any channels that will not be used as part of the 
pattern.  

Note 

The Logic qualification option is only available on the 
4-channel models. 

Trigger Width Limits 

To trigger on a pulse width outside a range of limits, select Outside from the Trig When drop-
down list and set the Upper Limit and Lower Limit with the multipurpose knobs. To trigger on a 
pulse width within a range of limits, select Inside from the Trig When drop-down list and set 
Upper Limit and Lower Limit with the multipurpose knobs or pop-up keypad. The graphic in the 
control window shows the criteria that you have selected. 

Typical DSO Acquisitions 

 

  

Upper and Lower Threshold Levels 

Use the upper and lower threshold levels to measure the transition time as shown in the trigger 
graphic. To adjust the upper threshold level, click Upper Level and then use the multipurpose 
knob to set the voltage level. To adjust the lower threshold level, click Lower Level and then use 
the other multipurpose knob to set the voltage level. 
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Upper and Lower Threshold Values 

The upper and lower threshold levels define the voltage limits of a runt pulse. To adjust the upper 
threshold level, click the Upper Limit control and then use the multipurpose knob to set the 
voltage level. To adjust the lower threshold level, click the Lower Level control and then use the 
other multipurpose knob to set the voltage level. 

Video Trigger Autoset 

Autoset automatically sets the video trigger controls for the selected format, and optimizes the 
vertical sensitivity and time per division for viewing video lines and fields. Click Lines or Fields 
to optimize the settings. These controls do not appear if you select the Custom format. 

Video Trigger Format 

Select Custom if you have a nonstandard format, or select one of the predefined video signal 
formats from the drop-down list: NTSC, PAL, SECAM, 1080i/60, 1080p/24, 720p/60, 480p/60, 
1080i/50, 1080p/25, or 1080/24sF. 

Video Trigger Holdoff 

Specify Holdoff By Time or By Fields, and use the multipurpose knob to change the value. If 
setting a Custom format, only the By Time control is available. 

Video Trigger Polarity 

Select Normal or Inverted polarity. Normal generally triggers on negative polarity, since the sync 
pulse leading edge is negative for most standard formats. Use Inverted when probing circuitry that 
inverts the video signal. 

Waveform Count 

Displays the number of waveforms that have contributed to the histogram. 

Waveform Handle 

  

Waveform Label 

  

Window Trigger Levels 

The upper and lower threshold levels define the voltage limits of the window. To adjust the upper 
threshold level, click the Upper Limit control, and then use the multipurpose knob to set the 
voltage level. To adjust the lower threshold level, click the Lower Level, control and then use the 
other multipurpose knob to set the voltage level. 
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XY format pairs 

When you use the XY display format, channel and reference waveforms are assigned to the axis 
indicated in the following tables. You cannot display math waveforms in XY format. 
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